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Where To Begin

You can choose how you want to learn Microsoft® Works,
depending on how experienced you are with the Macintosh TM,

and how much help and practice you want to have before you
begin using Microsoft Works on your own .

If

	

Do this

You want some practice before Start with the Lessons manual.
you begin using Microsoft

	

You'll use actual Microsoft
Works on your own

	

Works software and sample
files to practice many features
of the Microsoft Works tools .

You want to start using Micro-

	

Go right ahead and begin. With
soft Works for your own tasks,

	

the Using Microsoft Works
and you are an experienced

	

manual as a guide, you'll learn
Macintosh user

	

about all you can accomplish
with Microsoft Works .
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Welcome

Welcome to Microsoft Works all the office tools you may
ever need :

•

	

The Word Processor with drawing and mail merge
•

	

The Database with reporting
•

	

The Spreadsheet with charting
•

	

Communications

Use the Microsoft Works tools to automate your work . The limits
are up to you .

XV



xvi Welcome

The Word Processor

Use the Word Processor to write and edit text . Cut and paste
electronically to polish your prose . Change the margins and watch
Microsoft Works make everything fit . Change words quickly and
easily by searching and replacing. Reformat your document with
a few clicks of the mouse . Draw lines, circles, and boxes for extra
flair. Paste in a chart or a picture to illustrate your text .

The Database

Use the Database to file information. Add new records and remove
ones you don't need. Sort lists to organize your reports . Have
Microsoft Works find the information you're looking for . Prepare
numerous reports from one set of information with each report
providing just the facts you need .

The Spreadsheet

Use the Spreadsheet to calculate numbers . Set up elaborate formu-
las and let Microsoft Works get the answers for you . Change your
assumptions, change your numbers see what you get. Use built-
in calculations to make your work easier . Look at opposite ends
of a giant Spreadsheet document at the same time .
Use the Spreadsheet's charting capability to see what your
Spreadsheet numbers look like in charts . Change a number in
a Spreadsheet document and see how it affects your chart
instantly. Try different comparisons using the same document .
Spot trends at a glance, or see who's got the biggest piece of
the pie .

Communications

Use Communications to send your information over the tele-
phone. Talk to commercial information services to find out the
latest stock quotes or information on almost any other topic .
Exchange documents with other computer users . Keep in touch
with a computerized bulletin board .

Using the Tools Together

Microsoft Works is four tools, but one program . That means you
can work with several tools at once and move information from
one tool to another. For example, you can write a letter with the
Word Processor, check an address in the Database, project future
sales with the Spreadsheet, and see how your projections look
with the Spreadsheet's charting capability . Then you can copy



the chart into your letter and send it off to a colleague with
Communications .
Using both the Word Processor and the Database, you can person-
alize your form letters and print mailing labels to send them out .
Or, you can insert stock quotations you receive with Communica-
tions into a Spreadsheet document to see how your portfolio is
doing.

About This Manual

Read this manual when you're ready to start using Microsoft
Works for your own tasks. This manual assumes you have read
your Macintosh owner's guide and are familiar with basic tech-
niques, such as choosing commands, selecting text, and working
with windows.
This manual is divided into six parts . The first part, "Common
Tasks," guides you through tasks that you'll perform every time
you use Microsoft Works. These include tasks such as creating,
saving, and printing a document. The next four parts explain the
individual Microsoft Works tools : the Word Processor, the Data-
base, the Spreadsheet with charting capability, and Communica-
tions. The last part of the manual, "Using the Tools Together,"
explains how to integrate information from the different tools .
The information on each tool is presented in this way :

•

	

The first chapter of each part shows what a document looks
like and explains how to begin using the tool .

•

	

The middle chapters explain, step by step, how to use the tool
to perform specific tasks .

•

	

The final chapter describes the commands you can use with
the tool .

To learn how to perform a certain task, you should first read the
step-by-step description . Then turn to the last chapter on the tool
for details on the specific command or dialog box you'll be using .
The appendices explain how Microsoft Works uses disk space,
using an external drive or a hard disk, using Microsoft Works with
other applications, using Microsoft Works with the LaserWriter
printer, choosing commands from the keyboard, and tool capaci-
ties and memory limits for various tools .
For a definition of any term you are unfamiliar with, look in the
index for the entry that contains the term followed by the word
"defined."

About This Manual xvi i

About this manual



xviii Welcome

About documents and About Documents and Files
files

Getting started

Product support

Note The full name of this product is Microsoft Works . This
manual uses the name "Works" for short .

Throughout this manual, the words "document" and "file" are used
to represent two distinct items .
A document is the information held in the Macintosh's memory .
When you create a new document, the information exists only in
memory until you save it on a disk. Once saved, the information
stored on the disk is called a file . When you open a file from a
disk, the Macintosh puts a copy of the information into its
memory and leaves the original on the disk . The information held
in memory is called a document . If you make changes to this
document and then save it, the new information will replace the
file currently on the disk .

•

	

You create a new. . .
•

	

You make changes to a. . .
•

	

You save a. . .
•

	

You print a. . .
•

	

You close a. . .

•

	

You open an existing . . .
•

	

You delete a . . .

Getting Started

document

For instructions on how to copy your master Works Program disk
and start Works, see the section entitled "Getting Started" in the
other Works manual, Lessons.

Notice that the Works Program disk has the Set Startup command
set so that you bypass the Finder and go immediately to the Open
dialog box. If you want to change this arrangement, see your
Macintosh owner's guide for instructions .

Product Support

If you have a question about Works and you can't find the answer
in your manuals, call our Product Support staff by dialing the tele-
phone number on your registration card. When you call, please
have the following at hand :

•

	

The product number on your disk label
•

	

Your Works manuals



Common Tasks

Many routine tasks are common to all of the tools in Microsoft
Works. In each tool, you'll use the same commands and pro-
cedures to perform these tasks .

1



2 Common Tasks

This part of the manual contains two chapters describing common
tasks and commands :

•

	

Chapter 1, "Common Tasks and Procedures," explains the tasks
you'll perform every time you use Works, such as opening
files, creating and closing documents, getting help, and
printing .

•

	

Chapter 2, "Common Tasks Command Reference," describes
the menus and commands common to all tools in Works .



1 Common Tasks and
Procedures

Many routine tasks are common to all of the tools in Microsoft
Works. This chapter shows you how to perform these common
tasks :

•

	

Open a file and create a new document .
•

	

Save a document .
•

	

Close a document .
•

	

Delete a file .
•

	

Use the help information .
•

	

Print a document, including headers and footers .
•

	

Quit Works .

For information on using tools together, like copying a chart
to the Word Processor, see "Using the Tools Together," the last
part of this manual .

Opening a File and
Creating a New Document

When you start Works, you'll see the Open dialog box . You use
the Open dialog box to open files from a disk . You can also create
new documents from this dialog box, as well as with the New
command.
You can have up to ten windows on the desktop at once. The
maximum number depends on how much memory your Macin-
tosh has, and how large your documents are . If you have some
documents that you refer to often, like an address list and a tele-
phone message form, you can leave these on the desktop while
you're working on other documents . Whenever you need to look
up a name or take a message, bring the document you want to
the front by using the Window menu .

3



4 Common Tasks

To open an existing
file

In the Open dialog box, you can also select the Resume Works
file to open the document or documents you had on the desktop
the last time you used Works. For more information, see "Quitting
Works" in this chapter .
For information on using files not created with Works, see
Appendix B, "Using Works with Other Applications ."

Opening a File from a Disk

Works lets you open files in the internal disk drive or in an
external disk drive .
To open an existing file :

0

/

Types of files you can choose from

Choose Open from the File menu .
Works displays the Open dialog box, listing all files and folders
on the current disk.

Open File :

RII Works
Types

Word
Processor

U Addresses
•

	

Article
•

	

Budget
•

	

Final Report
•

	

Requests
•

	

Results
•

	

Resume Works
•

	

Sales Projections
•

	

Scores

List of files and folders (all files
or just the type you choose)

1rB
Data
Base

Spread Communications
Sheet

[ Open

Cancel

•

	

Select the name of the file you want to open .
•

	

Click the Open button .

Works opens a window with a document that is a copy of the
file you selected . You can work with this copy, which is in the
memory of the computer . The original file remains on the disk
until you replace it by saving changes to it, or until you remove
it from the disk.

® Works Rr . .\

Eject	)

1

Name of current disk
Name of current disk or folder



If you want to look at a listing of a specific type of file in the

	

To list one type of file

Open dialog box, such as Word Processor or Database files, you

can tell Works to list only those .

To list files of one type :

D Click the icon for the tool whose files you want to see .

The list changes to show only files of the type you chose and all

folders .

Creating a New Document

You can create a new document in Works with either the New

command or the Open command.

To create a new document from any tool, use the New command. To create a new

document from a tool

Choose New from the File menu.

Works displays the Create New Document dialog box .

•

	

Click the icon for the type of document you want to create .

•

	

Click the OK button .

0

El

Works opens a new document window on top of the other

windows on the desktop .

You can also create a new document from the Open dialog box,

	

To create a new

which appears when you start Works or when you choose the

	

document from the

Open command from the File menu .

	

Open dialog box

To create a new document from the Open dialog box :

Click the icon for the type of document you want to create .

•

	

Click the New button.

Works opens a new document window on top of any other

windows you may have on the desktop .

Saving a Document

All the information that you produce with Works stays in your

Macintosh's memory until you close the document or quit Works

or until the power goes off. If there's a power failure you could

lose a lot of work. That's why you should save your documents

frequently. When you save a document, Works stores it safely on

a disk. Then, if the power goes out, or you accidentally turn off

the computer, you'll have a recent copy to work with .

Chapter 1 Common Tasks and Procedures 5



6 Common Tasks

This section explains how to save documents and continue work-
ing. You can also save when you close a document or quit Works .
To find out more about this type of saving, see "Closing a Docu-
ment" and "Quitting Works" in this chapter .

To save a document

	

The first time you save a document, you give it a name .
for the first time

0

Type a name here, up to 32 characters .
Click here to eject the disk
and replace it with another .

Fl

Choose Save As from the File menu .
Works displays the Save As dialog box, which is ready to
accept the name you type .

Works Program I

Untitled

Save

LI EKport File

[ Cancel

Click here to save the
document with the
name you typed.

Ejecc

® Works P o

t

Click here to cancel the save
and go back to the document.

Type a name for the document. You can use any characters
from the keyboard, except a colon, including spaces and both
uppercase and lowercase letters .
Since there is little free space on the Works Program disk,
you'll probably want to save your documents on another disk .
Use the Eject button to change to another disk .
If the disk you insert is not initialized, Works asks if you want
to initialize it . Click the Two-Sided button to initialize the disk
if you're asked.
If you have another disk drive, you can use the Drive button
to switch to the other disk drive, then save the document on
a disk in that drive .



4 Click the Save button or press the Return key . (Or click the
Cancel button, if you decide not to save .)

Works saves the document on the disk you've chosen, and then
you can continue using the document . If you've inserted a dif-
ferent disk to hold the document and you choose any command,
Works asks you to insert the Works Program disk . Insert that disk
to continue working with Works .

If you're working with a document that you've already saved, you To save changes to
can save changes as you work .

	

a document

a

0

Choose Save from the File menu .

Works saves your changes, and you can continue working with
the document .

When you want to save both the original file and the changes

	

To save a document
you've made to it, you can save the document with a different

	

with a different name
name .

Choose Save As from the File menu .
Works shows you the current name of the document .
Type a new name for the document .
The new name you type replaces the current one in the
text box.
Click the Save button or press the Return key .
If another file with the name you've typed is already on the
disk, Works asks if you want to replace it with the document
you're saving. You can replace it, type a different name, or
cancel the command .

Works saves the document with the new name . The name of the
document on the desktop changes to the new name . The original
file remains on the disk with its old name. If you later want to
remove the original file, see "Deleting a File" in this chapter .

Note When you use the Save As command, Works treats Data-
base documents a little differently than the others. For more infor-
mation, see "Save As" in Chapter 2 and "Saving a Selection with a
Different Name" in Chapter 8 .

Chapter 1 Common Tasks and Procedures 7



8 Common Tasks

To save a document
to be exported

To delete a file

If you know you'll be exporting a file from Works to another pro-
gram, you'll need to save it as a text file. This means that only the
data, and not the formatting information, is saved .

C

For more information, see Appendix B, "Using Works with Other
Applications ."

Closing a Document

To close a document When you want to remove a document from the desktop, you
close it .

0

0

Choose Save As from the File menu .
•

	

Follow all the regular procedures, then click the Export File
option.

•

	

Click the Save button .

Choose Close from the File menu, or click the close box in the
upper-left corner of the window .
If you've made any changes to the document, Works asks if
you want to save the changes .
You can choose to save your changes, throw them out, or can-
cel the close . For instructions on saving, see "Saving a Docu-
ment" in this chapter .

•

	

Click the Yes button to save changes, or the No button if you
don't want to save changes .

Works closes the document and removes it from the desktop .

Deleting a File

When you delete a file, Works erases the file from the disk com-
pletely. You might want to delete a file if you need room on a
disk to save another document, or if you've saved a document
with another name and want to discard the original file .

Choose Delete from the File menu .
Works shows you a list of files to choose from .



List of files and folders on the current disk

4

Delete File :

(~j Works Program I

•

	

Article
•

	

Budget
•

	

Final Report
•

	

Requests
•

	

Results
•

	

Resume Works
•

	

Sales Projections
•

	

Scores

Free Space : 133K

Amount of free space
on the current disk

If you need to, click the Eject button to change disks or the
Drive button to change disk drives .

•

	

Select the file you want to delete .
•

	

Click the Delete button .
Works asks you to confirm that you want to delete the file .
Click the Yes button to delete it .

Works deletes the file from the disk .

Getting Help

0

(o] Works Pr . . .

1	Eject

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

(Delete

Cancel

Click here to eject the disk
and put in another disk .

Choose Help from the Window menu .
The Help window appears at the bottom of your screen .

Chapter 1 Common Tasks and Procedures 9

Works Help explains briefly how to use any command in Works .

	

To get help
To get help :



10 Common Tasks

The pointer turns into a question mark when you choose Help .

File Edit Window Search Format Font Style. . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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The new Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .

Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

The window contains general information about Help and the
tool you're using. When you move the pointer outside the
Help window, it turns into a question mark .n Choose the command you want help on just as you normally
choose a command from a menu .

Works displays information about the command you chose in the
Help window .

To see more information, you can scroll the Help window just
like any other window . To get help on another command, just
choose it from a menu . To leave the Help window open and
continue working on your document, click anywhere in the
document. To close the Help window, click its close box.

Help (WP
Word Processing

Microsoft Works Help gives you information about commands for the tool you are using . If
you are using the Word Processor, you can get help on Word Processor commands . If you
are using the Database, you can get help on Database commands, and so on .

If you need more information than Help gives ) refer to the Using Microsoft Works page
number next to each command name . Your manual provides more details and examples for .-~.
each command .



Printing a Document

You can print documents from all the Works tools except Com-
munications. In Communications, you can print only the contents
of the active window by using the Print Window command .
Although you adjust the format for each tool differently, you print
them all the same way using the File menu .
Works comes ready to print using both the regular and wide
ImageWriter printers . Your Macintosh owner's guide has details
on how to set up the ImageWriter. For information on printing
with the LaserWriter, see Appendix C, "Printing with the Apple
LaserWriter ."
When you're working with the Database, you must be in a report
window to print or adjust the page setup . For more information,
see Chapter 9, "Making a Report ."
Before you print, it's a good idea to save your document . For
more details on saving, see "Saving a Document" in this chapter .

Setting Up the Page

Before you print a document, choose the Page Setup command
from the File menu to specify exactly how you want it to be
printed. The Page Setup command lets you specify paper size,
printing orientation, special effects, headers, footers, and margins .
To change page specifications :

El Choose Page Setup from the File menu .
The Page Setup dialog box appears .
Click the appropriate options, and type any information that
Works needs .
Click the OK button or press the Return key .

Works stores your specifications with the document, so you only
have to change them once . For a complete description of the
available options, see "Page Setup" in Chapter 2 .

Chapter 1 Common Tasks and Procedures 11
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specifications
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To use custom paper With Works, you can print on any size paper that fits in your
printer. To use a paper size other than those offered, click the
Custom Size option in the Page Setup dialog box. For example,
click Custom Size if you are printing mailing labels . Then you can
specify the exact dimensions of your paper in the Paper Width
and Paper Height boxes .
When you want to print information at the top or bottom of every
page, you use a header or footer. The same header or footer will
appear on every page of a document, except that page numbers
will appear sequentially .
Headers and footers are set up in the same way . In the Page Setup
dialog box, you tell Works what information to print by typing it
exactly as you want it to appear. To indicate information such as
the current date, page number, or document name, or to have
certain information in bold or italic type, Works provides a set of
formatting commands ; for example, &I specifies that what follows
should be printed in italic type. For a list of all formatting com-
mands, see "Page Setup" in Chapter 2 .

To use headers and
footers

Header:

Footer:

&CJanuory Article

'&LSusen StnntonOrCO PORO D

Formatting commands won't appear
in the printed document .

Headers and footers in Works have been designed to work the
same way in each tool, so you need to learn only one procedure .
However, in the Word Processor, some additional options are
available to you ; for more information, see "Headers and Footers"
in Chapter 4 .
If you don't want the header or footer to print on the first page of
your document, choose Title Page from the Format menu before
you print. The Title Page command does not change the format
of the first page ; it only prevents the header or footer from
appearing .



Printing Your Document

When you're satisfied with your page setup, you are ready to print
your document .

0

Works begins to print your document .

You can cancel the Print command at any time .

D

Choose Print from the File menu .
The Print dialog box appears. Unless you change the settings
in this box, Works will print one copy of your entire docu-
ment using the preset options Faster (for standard quality)
and Automatic (for paper feed) .
Make any desired changes to the print specifications .
Click the OK button to accept your specifications and start
printing.

Hold down the Command key and type a period ( . ) .

Works may continue to print briefly until the printer's memory is
empty. After printing stops, Works returns you to the document
window.

If you come across a particular window of information that you'd
like to have on paper, you can print just that window with the
Print Window command from the File menu . When you use this
command, the printer does not automatically move the paper to
the top of the next sheet . This lets you print two or more win-
dows on one sheet of paper . When you want to start on a new
sheet, choose the Eject Page command .

Quitting Works

When you choose Quit from the File menu, Works records which About Resume Works
documents you have on the desktop in a file named Resume
Works .
The next time you start Works, you can select the Resume Works
file in the Open dialog box to restore the documents that were
on the desktop when you left it. You can also double-click the
Resume Works icon from the Finder . With Resume Works, you
won't have to open individual files in order to pick up where
you left off.

Chapter 1 Common Tasks and Procedures 13

To print a document

To cancel printing in
progress

To print only the
active window
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To quit Works To quit Works :

0 If you want to set up the Resume Works file in a particular
way, arrange your desktop as you want it to appear the next
time you use Works . (Close any documents that you don't
want to appear when you next open Resume Works.)
Choose Quit from the File menu .
If you've made changes to any open document since the last
time you saved, Works asks whether or not you want to save
changes for each document.
For each document, click Yes to save changes or No if you'd
rather not .

Works saves any changes and takes you to the Finder . A list of
your open documents is recorded in a file called Resume Works .

You can rename the Resume Works file from the Finder just like
any other file. By using different names, you can save different
arrangements of files and open each arrangement whenever you
need it. For example, you might save and rename one arrange-
ment of documents that you want to be on the desktop every
time you start Works. This could include a phone list, a to-do list,
and a memo template. Or, you can set up any group of related
documents that you use to perform a regular task, and rename
it to reflect its function . You can have as many renamed Resume
Works files as you want .

Note The Resume Works file contains a list of the documents
from your desktop, not copies of the documents themselves .
If you include a document in a Resume Works file, then make
changes to that document by opening and editing it individually,
the latest version will appear on your desktop when you next
open Resume Works .

Works does not save any information about untitled documents
in the Resume Works file . To include these documents, save each
one with the Save As command to give it a name before you
choose Quit from the File menu .
When you want to work with a certain desktop arrangement, you
have to start up with the same disks in the disk drives as when
you quit, or Works may not be able to find all the files you need .
If Works can't find the files, it displays an alert box telling you so .



2 Common Tasks
Command Reference

This chapter describes the commands (shaded below) common to
all applications in Microsoft Works . These commands are available
on four menus: the Apple, File, Edit, and Window menus .

About MS-Works . . .

Alarm Clock
Calculator
Choosey
Control Panel
Key Caps
Note Pad
Puzzle
Scrapbook

File
New . . .
Open . . .

	

,0
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Close
Save

	

s
Save As . . .
Delete . . .

. . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . . ~P
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

Edit

C

You can invoke some Works commands from the keyboard, as
well as by using the mouse . The available Command-key combina-
tions are shown on the menus and in Appendix D .
An alphabetical list of commands appears in the index under
"Command."

Window

15
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About MS-Works
.
About MS-Works . . .

Alarm Clock
Calculator
Choosey
Control Panel
Key Caps
Note Pad
Puzzle
Scrapbook

New

Open . . .

	

0
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Close
Save

	

S
Save As . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . .

	

,P
Print lUindow
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

	

€Q

The Apple Menu

About MS-Works

The About MS-Works command shows how much memory is
available for documents. It also provides some basic information
about the Works program .
For a discussion of the desk accessories listed on the Apple menu,
see your Macintosh owner's guide .

Note While desk accessories should not interfere with the
functioning of Works, sometimes problems do occur . If Works
malfunctions while a desk accessory is present, try removing
the accessory from your disk .

The File Menu

New

The New command creates an empty document in a new window .
If you already have ten windows on your desktop, the New com-
mand is dimmed until you remove one or more of the windows
by closing them .
When you choose New, Works displays a dialog box in which you
choose the type of document you want to create.

To create a new document, click the icon corresponding to the
type of document you want to create, either Word Processor,
Database, Spreadsheet, or Communications ; then click the OK but-
ton. You can also double-click an icon to create a new document .
The window containing the newly created document becomes the
active window, and the menu bar changes to reflect the Works
tool you have chosen .



Open

The Open command opens a file from the disk and displays
a copy of it on your screen .
If you already have ten windows on your desktop, the Open
command is dimmed until you remove one or more windows
by closing them.

Open File :

0
All Works
Types

Word
Processor

13Works Program I

DB

Data
Base

C4M

Spread Communications
Sheet

Open

N €

Cancel 1

] Works Pr . . .

	Eject	i

The list box contains a list of files and folders on the current disk .
You may have to scroll the list to see all the names . The name of
the current disk appears above the Eject and Drive buttons.
Click the icon for a particular tool to see only files of that type
and all folders in the list box . Clicking the All Works Types icon
displays all Works files and folders .
Click the Import File option after clicking a document type to
display only those files that can be imported to Works. For more
information, see Appendix B, "Using Works with Other Applica-
tions ."
To open a file, either select the filename from the list box and
then click the Open button, or double-click the filename .
The document appears on the desktop in a new window, which
is active. It has the same size and location on the screen as it had
when you last saved it. The menu bar changes to reflect the type
of document you have selected .
There are four other buttons in the Open dialog box :
New If you click the icon for one of the document types, you
can click the New button to create a new document of that type .
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Open

File
New . . .
Open . . .

	

: :o. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Close
Save

	

'S
Save As . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . .

	

,P
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

	

'Q
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Close

File
New . . .
Open . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Close
Slue
Saue Hs . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . .

	

.P
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

	

,Q

Save

File
New . . .
Open . . .

	

0

Close
Save S
Saue Hs . . .
Delete . . .

Page Setup . . .
Print . . .

	

P
Print Window
Eject Page
Print Merge . . .

Quit

	

'Q

s, o

:, S

Cancel Click the Cancel button to cancel the Open command .
Eject Click the Eject button to eject the current disk from the
disk drive. You can then insert the disk containing the file you
want to open .
Drive Click the Drive button to list the files on the other disk
drive (if you have one).

Close

The Close command closes the active document and removes it
from your screen .
You can also close a document by clicking the close box in the
document window's title bar . If you have made changes to the
document since you last saved it, an alert box appears .

Cancel No f

Save changes to Requests (OR)?

11

	

Yes
C	

Yes Click the Yes button to save the changes .
No Click the No button if you don't want to save the changes .
Cancel Click the Cancel button to cancel the Close command .
In this case, the document isn't closed and the changes aren't
saved. Works returns you to the document you were working
on when you chose the Close command .

Save

	

The Save command saves the active document on the disk con-
taining the file associated with the document . Works saves the
document with its current name and replaces the old copy of the
file on the disk. Works also stores the location and size of the win-
dow with your saved document .
After you save a document, it remains active, so you can continue
to work on it. It is a good idea to save your work periodically : a
power failure may cause you to lose changes you've made since
you last saved .
If the document to be saved has not been saved previously, Works
displays the Save As dialog box. For more information, see "Save
As," below .



Save As
The Save As command saves new documents or new versions of
existing files . Works also saves the location and size of the win-
dow along with your data .
When you choose Save As, Works displays a dialog box . (You'll
also see this dialog box if you choose the Save command for a
document that has not been previously saved .)

r < ; ( II Wk

Save Document As :

Untitled

Save

] Works Program

Cancel

Works Prog .,

f Eject

Save Document As If the document has a name already, Works
proposes it in the text box . To accept the proposed name, and
replace the file with the same name on the disk, click the Save
button. To save the document under a different name, so you'll
retain the existing file and also save the version with your latest
changes, edit the proposed name or type a new one .
If the name you type has already been used for a different docu-
ment on the disk, or if you don't change the proposed name,
Works asks if you want to replace the existing file on the disk .
Click the Yes button to replace the file on your disk with the
active document. Click the No button to see the Save As dialog
box again. You can then type a different name for the document .
Eject Click the Eject button to eject the current disk. You can
then insert a different disk on which to save the document .
Drive If you have an external disk drive or a hard disk, you
can save the document on another disk drive . Click the Drive
button to change to the disk drive on which you want to save
the document.

Chapter 2 Common Tasks Command Reference 19

Save As

File
New . . .
Open . . .

	

: :O
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Close
Save
Save As . . .
Delete . . .

Page Setup . . .
Print . . .

	

::p
Print Window
Eject Page
Print Merge . . .

Quit

	

::Q
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Delete

File
New . . .
Open . . .

	

,O
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Close
Save

	

s
Save As . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . .

	

tP
Print Lllindow
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

	

o

After you save a document with Save As, it remains on the screen,
but its name changes to the new name you gave it . You can con-
tinue to make changes to it and then save it, either with the same
name using the Save command, or with another name using the
Save As command .

Note When you click the Save Selected Records option for a
Database document, the Save As command works slightly dif-
ferently than described above . For more information, see "Save
Selected Records Only," below .

Depending on which Works tool you're using, there may be one
or two other options in the dialog box .
Export File Click this option before you click the Save button if
you want to save only the text of your document and not the for-
matting information. Use this option when you want to export a
Works file to use in another program .
For more information, see Appendix B, "Using Works with Other
Applications ."
Save Selected Records Only Click this option before you
click the Save button if you previously used the Match Records or
Record Selection command in the Database, and you want to save
only those selected records . Remember to specify another name
for the document so that you don't replace your complete Data-
base document with this new smaller one . This is a special case
of the Save As command in which Works does not replace the
current window with the new document .

Delete

The Delete command deletes files from your disk .

Delete File :

Works Pr . . .

® Works Program I

•

	

Article
•

	

Budget
•

	

Final Report
•

	

Requests
•

	

Results
•

	

Resume Works
•

	

Sales Projections
•

	

Scores

Free Space : 133K

[	Eject

U

	

(•3

Delete

(Cancel
.



The list box contains the names of all files and applications
(except Works) on the current disk . You may have to scroll the
list to see all the names . The name of the current disk is shown
above the buttons.
To delete a file from your disk, select the file you want to delete
and then click the Delete button, or double-click the filename .
Free Space This number gives the amount of unused space, in
bytes, on the current disk.
In addition to the Delete and Cancel buttons, there are two other
buttons in this dialog box :
Drive Click the Drive button to list the files on the disk in the
other disk drive .
Eject Click the Eject button to eject the current disk from the
disk drive. You can then insert the disk containing the file you
want to delete .

Important You cannot undo the Delete command . If you delete
a file, it is not retrievable . However, if the document associated
with the deleted file is open when you make the deletion, you
can recover your information by saving the document .

Page Setup

The Page Setup command controls the appearance of a printed
document.
When you save a document, Works stores the settings chosen
with this command along with the document.

Note In the Database, Page Setup is available only when a report
window is active .
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Page Setup

File
New . . .
Open . . .

	

0
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Close
Save

	

s
Save As . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . .

	

, P
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

	

Q
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ImageWriter	 v2,2 	[ OK

Paper:

	

US Letter
•

	

US Legal

•

	

Computer Paper

Orientation

	

Special Effects :

o 114 Letter
•

	

International Fanfold
•

	

Custom Size

Li Tall Adjusted
0 50 4 Reduction
Li No Gaps Between Pages

Cancel

Works comes with the ImageWriter printer driver, which can be
used with both the standard and wide ImageWriter printers . If you
use a printer driver other than this one, the dialog box you see
may differ slightly from the one you see here .
Paper Click an option:

US Letter

	

8-1/2" by 11"
US Legal

	

8-1/2" by 14"
Computer Paper

	

15" by 11"
(this option works only with
a 15" ImageWriter )

A4 Letter

	

8-1/4" by 11-2/3"
(European letter size)

International Fanfold

	

8-1/4" by 12"
Custom Size

	

Defined by you

While all margins are set to 0, you can specify custom-sized paper
to a maximum height of 273" and a maximum width of 273" . To
use a width of more than 15", you must click the icon for wide
printing orientation . The minimum height for custom-sized paper
is 1", and the minimum width is 1" . When all margins are set to 1,
the minimum height and width is 2.1" . If you use continuous form
paper, measure the height of the paper between the perforations .
If you use continuous form labels, measure the distance from the
top edge of one label to the top edge of the next label .

Paper Width : 8 .5

[Ii H1 Paper Height : 11

Header:

Footer:

Left Margin : Right Margin : 11

Top Margin : Bottom Margin : 11



Note Custom Size paper is not an available option when you use
a LaserWriter printer .

Orientation Click one of the icons :

Tall

	

Vertical orientation
Wide

	

Horizontal orientation

Special Effects Click any options you want :

Tall Adjusted

	

Vertical orientation ; prints pic-
tures with correct proportions

50% Reduction

	

Prints your document at half
the normal size

No Gaps Between Pages

	

Prints your document over
the perforation with no extra
spacing

Print Row and Column Numbers Click this option if you
are printing a Spreadsheet document and you want the row and
column headings (numbers and letters) to appear .
Paper Width If you click the Custom Size option, type the
paper width in inches here .
Paper Height If you click the Custom Size option, type the
paper height in inches here .
Header If you want page headers, type the text you want Works
to use for the header in this text box. Works prints the header at
the top of each page, one-half inch from the top edge of the
paper.
Footer If you want page footers, type the text you want Works
to use for the footer in this text box . Works prints the footer at
the bottom of each page, one-half inch from the bottom edge of
the paper.
Works provides a set of formatting commands to use in headers
and footers . You can tell Works to print parts of the header and
footer at the left, right, or center of a page ; to include the page
number, date, time, and document name ; and to print in bold
or italic .
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Type

	

To

&L

	

Align the characters that follow at the left margin .
&C

	

Center the characters that follow .
&R

	

Align the characters that follow at the right margin .
&P

	

Print the page number .
&D

	

Print the current date .
&T

	

Print the current time .
&F

	

Print the name of the document .
&B

	

Print the characters that follow in bold .
&I

	

Print the characters that follow in italic .
&&

	

Print a single ampersand .

You can include any number of these instructions in a single
header or footer. For example, you would type &LTelephone
Report&C&D&R&P in the header text box to print "Telephone
Report" in a header at the left margin on each page, the current
date centered in the header, and the page number at the right
margin. You can use either uppercase or lowercase letters in
formatting commands .

Note When a Word Processor document is in the active win-
dow, you can use the Font and Style menus to adjust the font and
style of headers and footers . You can also print consecutive page
numbers in headers throughout a series of documents . For more
information, see "Headers and Footers" in Chapter 4 .

Margins The margin settings determine the amount of space
between the edge of the paper and the printed document .
The margins are preset to 1" at the top, bottom, and sides . To
change a margin, press the Tab key to move the selection into
the box you want, then type the number of inches (such as 0 .5,
2, or 2.75) .

Note For a Word Processor document, if you set right and left
margins that conflict with the indent markers on the ruler, Works
displays an alert .



Quality The Quality setting you choose determines the print

resolution. The higher the resolution that is, the more dots used

to form characters the better the quality. If you click 50

Reduction in the Page Setup dialog box, the Quality options are

dimmed .

Click

	

For

Best

	

High resolution (sharpest)

Faster

	

Medium resolution (less sharp, but prints faster)

Draft

	

Low resolution (least sharp, but prints fastest)

Prints text only, no graphics

Page Range To print all the pages in the document, click All .

To print a range of pages from the document, click the From

option and type the first page number of the range you want to

print. Then press the Tab key to move the insertion point into

the To box, and type the last page number of the range you want

to print.

Copies Type the number of copies you want .

Paper Feed Click Automatic if you are using continuous form

paper. Click Hand Feed if you are using single sheets of paper .
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Print

The Print command

tings from the

you set.

prints the active document using the set-

any manual page breaks

Print

File

Page Setup command and
New . . .
Open . . .

	

#;O
,	

Close
Save

	

,S
Save As . . .
Delete . . .ImageWriter

	

,,.2 .2
r O A

Quality :

	

0 Best

	

® Faster

	

0 Draft

Page Range: ® All

	

C From : To : Cancel ~ Page Setup . . .

Copies : 1 Print . . .

	

: .p

Paper Feed : 0 Hand Feed® Rutomatic
Print Window

Eject Page

Print Merge . . .

Quit

	

#;Q
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Print Window

File
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Close
Save

	

S
Save Os . . .
Delete . . .
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Page Setup . . .
Print . . .
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit
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Eject Page

File
New . . .
Open . . .

	

::O
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

.

[:lose
Save

	

,# S
Save Os . . .
Delete . . .

. . . . . . . . . . .

Page Setup . . .
Print . . . ::p
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

Print Window

The Print Window command prints the contents of the active
window.
When you choose Print Window, Works prints only the data you
see in the window, without the title bar, scroll bars, and size box .
The sheet of paper is not ejected from the printer, except when
printing with an Apple LaserWriter, so you can print several
related windows on a single sheet of paper .

Eject Page

The Eject Page command ejects the paper in the ImageWriter
to the top of the next sheet of paper .
Eject Page is most useful for bringing the paper in your printer
to the top of the next page after you use the Print Window
command .



Print Merge

The Print Merge command is available only for Word Processor
documents . For information on how to use it, see "Print Merge"
in Chapter 5 .

Quit

The Quit command ends a Works session .
If you have made changes to any open documents but have not
saved them, Works displays an alert box for each document.

Cancel f

Save changes to Sales Projections (SS)?

Yes Click the Yes button to save the changes .
NO Click the No button if you don't want to save the changes .
Cancel Click the Cancel button to cancel the Quit command .
If you click the Cancel button, the document is not saved, and
you return to the document named in the alert box .
For a description of how to save your document before you
choose Quit, see "Save" and "Save As" in this chapter .
When you quit, Works saves a list of the files associated with your
open documents in a file called Resume Works . The next time
you start Works, you can select the Resume Works file in the
Open dialog box. Works then restores the documents that were
on the desktop when you quit .
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Print Merge

File
New . . .
Open . . .

	

#:0
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Close
Save

	

#:S
Save As . . .
Delete . . .
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Print Window
Eject Page
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Quit

Quit
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Print Window
Eject Page
Print Merge . . .
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Quit
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Undo

Edit
Undo

	

:ft:Z

Cut

Edit
Undo

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

[:ut :#: U
Copy
Paste
Clear

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . .

Copy

Edit
Undo

. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut
[:opy

	

:#:[:

The Edit Menu

The first five commands on the Edit menu are common to all
tools in Works. For related information specific to a particular
tool, see the part of this manual which pertains to that tool .

Undo

The Undo command reverses the effects of the last editing
command made.
When you cannot undo something, the command is dimmed .

Important You cannot undo the Delete command or any other
command from the File menu .

Cut

The Cut command removes the current selection from your
document and places it on the Clipboard .
You can cut text from anywhere in a document, including the
entry bar in Database and Spreadsheet documents .
In the Spreadsheet, use the Cut and Paste commands to move data
to another Spreadsheet document or to a document from another
tool. Within a single Spreadsheet document, however, use the
Move command to rearrange your data . For more information,
see "Move" in Chapter 16 . In the Database and Word Processor,
information within a single document can be moved with Cut
and Paste .

Copy

The Copy command copies the current selection and places it on
the Clipboard. Your document remains unchanged .
You can copy text from any part of a document, including the
entry bar in Database and Spreadsheet documents .
When you are editing in the entry bar, you can copy text by
selecting it and choosing Copy. Works puts a copy of the selected
text on the Clipboard, replacing the Clipboard's contents . After
you copy a selection, you can paste it at the insertion point in
the entry bar .



Paste

The Paste command pastes the information currently on the
Clipboard into the active document at the insertion point .
In the Spreadsheet, the Paste command pastes all cell properties
for every cell pasted, including the formula or value, number for-
mat, grid status, style, alignment, and protection status . If you
want to paste only values without any formulas use the Paste with
Options command; for more information, see "Paste with Options"
in Chapter 16 .

Clear

The Clear command removes the selection from your document,
but does not place it on the Clipboard . Use Clear when you want
to delete rather than move or copy information .

The Window Menu

The Full Window command displays the active document using
the full size of the Macintosh screen . The Small Window com-
mand displays the document in a slightly smaller size or in the
size you previously made the window .
To set the size for Small Window, drag the size box in the lower-
right corner of the window . Use Small Window when you want
to view portions of several documents simultaneously .
The size and screen position of the window are stored with a
document when you save it . The next time you open the file,
Works automatically restores the size and position of its window .
You can switch back and forth between Full Window and Small
Window at any time. When you choose either command, the
menu changes to reflect the other command ready for you to
switch back again . You can also switch between Full Window and
Small Window by double-clicking the title bar or size box of
a window.
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Show Clipboard
Hide Clipboard

Window
Full Window
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Show Clipboard/Hide Clipboard

The Show Clipboard command opens the Clipboard window . This
window contains the last selection you cut or copied since you
turned your Macintosh on .

You cannot edit the contents of the Clipboard .
To close the Clipboard window, click its close box, choose Close
from the File menu, or choose Hide Clipboard from the Window
menu .

Help

The Help command leads you to the Works help system .
When you choose Help, Works displays a window :

Word Processing

Microsoft Works Help gives you information about commands for the tool you are using . If
you are using the Word Processor, you can get help on Word Processor commands . If you
are using the Database, you can get help on Database commands, and so on .

If you need more information than Help gives, refer to the Using Microsoft Works page
number next to each command name . Your manual provides more details and examples for
each command .

Help (WP)	
4
rQ

The window contains general information about the tool corre-
sponding to the active window. It also directs you to additional
information about each command available for the tool .
When the Help window is active, the pointer becomes a question
mark anywhere outside the Help window . To get help about any
command, pull down a menu and choose the command . A de-
scription of the command, as well as a page number from this
manual, is displayed in the window .
For example, if you want a brief explanation of the Save As com-
mand, choose Save As from the File menu while the Help window
is active. A description of Save As is displayed in the window .



You can scroll vertically in the Help window, change its size and
position, and close it, just as with other Works windows .
You can leave the Help window open while you work on a docu-
ment. To make the document active, click anywhere within the
document window .
To close the Help window, click its close box .

Activate Window

The Activate Window command is actually a group of commands
that changes according to the windows you have open on the
desktop. There is always one command for each open window .
The only exceptions are the Help and Clipboard windows .
Each command that appears in this part of the Window menu
activates the window containing the document with the same
name as the command .
Use this command to activate a window quickly . The command
name shown here is just an example ; your menu will show what-
ever windows you have open.
You can activate the last window in the list of document names
by pressing Command-, (comma). Works brings the window to
the front, and moves the document name to the top of the list . In
this way, you can easily move through a series of open
documents .
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The Word Processor

You can write just about anything with the Word Processor :
letters, memos, reports, press releases, advertising copy, or even
a novel .

33
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The next three chapters show you what you need to know about
writing with the Word Processor :

•

	

Chapter 3, "Writing and Editing," shows what a Word Proces-
sor document looks like, how to enter and edit text, and how
to change the font, the type style, and the type size .

•

	

Chapter 4, "Formatting a Document," explains ways to arrange
your writing on the page, and how to draw lines and shapes
within a document .

•

	

Chapter 5, "Word Processor Command Reference," describes
the Word Processor commands .

If you want to use the Word Processor with other tools for
example, to make form letters or mailing labels with Database
information, or to copy charts from the Spreadsheet see "Using
the Tools Together," the last part of this manual.



3 Writing and Editing

When you write and edit with the Word Processor, you don't
have to retype whole pages to make a change. You just insert,
delete, or correct your text, and Works automatically adjusts the
lines within paragraphs and repaginates. After you finish editing
with the Word Processor, you have a finished product, ready
to print.
This chapter shows you how to :

•

	

Recognize the parts of a Word Processor document, and create
a new document .

•

	

Enter text .
•

	

Undo an editing mistake .
•

	

Select text and pictures .
•

	

Delete text and pictures .
•

	

Cut, copy, and paste .
•

	

Find and replace text .
•

	

Change fonts, type styles, and type sizes .
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An Overview

A Word Processor document looks like this :

Both the first line indent
marker (u) and the left indent
marker () are here .

El

V

a File Edit Window Search

_0	 tic (WP)
IO

	

I

	

2

	

I3

	

I4

	

5

	

6	iii	iiiii	Ill	Ill	IiiIIIIIIIIII	II!	III	I!!	III>	 I

Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

At major stops along the way, citizens of Alpine towns and
cities will turn out to greet the racers with fireworks displays

St . Etienne May 10
Geneva May 15
Chamonix May 18
Bern May 25
Interlaken

	

May 26

Click the Word Processor icon .
Click the New button.

Right indent marker
Name of document

Format Font Style

Lucerne May 2 8
Zurich May 29
Chur June 3
Lugano June 10
Milan

	

June 12

The shape and line are created

	

Page number
with the Draw command .

The headline is given emphasis with
commands from the Style menu .

To create a new Word Before you can type or edit a document, you need to create
Processor document

	

a new document or open an existing file .
When you start Works or choose Open from the File menu, the
Open dialog box appears .

To create a new Word Processor document :

Works opens a new Word Processor document . You can begin
typing.



Typing

To write with the Word Processor, you type text . The Word Pro-
cessor stores the text in your Macintosh's memory until you close
the document .
Text is made up of characters letters, numbers, symbols, and
spaces are all characters to the Word Processor .
The Word Processor takes care of fitting your words onto lines as Wordwrap
you type. When you reach the end of a line, any word that doesn't
fit within the right indent marker automatically moves to the next
line. This is called wordwrap .

F

	

File Edit Window Search Format Font Style

-0 Untitled IWRIP

I4iiiIiii 1 iiiIiil	2

	

5

	

6	<<<liii~3iiiIiii~4iiiliii	1111111	hill
y I i

French, Swiss, and Italian regional leaders plan to attend the

.afireworks ceremonies in their respective c - i

len ing their support to the success of the race .

Wordwrap lets you type complete paragraphs without pressing
the Return key . If you insert text in the middle of a paragraph,
wordwrap automatically adjusts the lines ; if you delete text in the
middle of a paragraph, wordwrap closes up the empty space .
As with an electric typewriter, the Return key in the Word Pro-

	

The Return key
cessor ends a line and starts a new one . But the Word Processor
Return key actually types an invisible character, called a return
character. This character signals the end of a paragraph for
wordwrap.
You should press the Return key only at the end of a paragraph .
Wordwrap makes a neat paragraph of anything between return
characters.
If you want to control the ends of lines yourself as in poetry
or lists, for example you can press the Return key at the end
of each line . A single line with a return character at the end is just
a short paragraph to the Word Processor . Wordwrap won't affect
these lines .
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To insert a blank line

	

You can also use the Return key to insert blank lines into your
document .

0

Position the insertion point here .

=p	 Article (WP)

Position the insertion point where you want to insert the
blank line.

i File Edit Window Search Format Font Style

0 ~21111111 4
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The new Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .
Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and
cities will turn out to greet the racers with fireworks displays .

1111111 5 I	I	11111 I
6iii1

Press the Return key once if you're at the beginning of
a paragraph, or twice if you're anywhere else in the text .

A blank line is inserted just above the insertion point .
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=_0	 Article (WP)
0

	

l1

	

I2

	

I3

	

l4

	

I5

	

~6
----------------------------- ---------------------------------- -----------------------------------------------

The new Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .

fTeams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and
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You can insert text anywhere in a document by moving the
insertion point .

0 Position the pointer and click to move the insertion point
to where you want to insert some text .
You may need to press the Return key, the Tab key, or the
spacebar to put the insertion point where you want it .
Begin typing .

Your text pushes the insertion point and any following text to
the right .

Each Macintosh font contains optional characters for foreign
letters, accents, and commercial, mathematical, and scientific sym-
bols. For information on how to use these characters, see your
Macintosh owner's guide .
As you continue to type text into your Word Processor document, Page breaks and page
you will notice that a horizontal dotted line appears on your

	

numbers
screen. This is a page break indicator. For more information about
page breaks, see "Formatting an Entire Document" in Chapter 4 .
When the page break has scrolled up on the screen so that it is
the first line in the window, the page number in the vertical scroll
box changes to show the page number corresponding to the first
line of text in the window .

Undoing a Mistake
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To insert text

To type optional
characters

In many cases, the Undo command cancels the last action you've

	

To undo a mistake
taken. You can undo most Word Processor commands from the
Edit, Format, Font, and Style menus .
To undo a mistake :

Choose Undo from the Edit menu .
If Undo isn't appropriate or allowed for the last action you
took, the command is dimmed .

0

If you save your text often (every ten minutes or so), you may
prevent major mistakes that you can't undo. Saving a document
stores a copy of it on your disk. For more information, see "Saving
a Document" in Chapter 1 .
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Selecting Text and Pictures

When you want to do something with a picture or a block of
text remove it, for example you must first select it. Works
shows a selection by reversing the highlight turning black
letters or pictures on a white background into white on black .
You can select a character, a word, a line, a sentence, a paragraph,
any size block of text, or a picture. In most cases, you must select
text and pictures separately. However, if, while you are selecting
a block of text, you also select a complete picture, then both the
text and picture will be selected .
To select a line or paragraph quickly, move the insertion point to
the left edge of the document between the left edge of the win-
dow and the left margin of the text . When you're at the correct
place, the I-beam pointer becomes an arrow pointer . Click to
select a line of text, or double-click to select an entire paragraph .

Click here to select the line .
Double-click here to select the paragraph .

r 1~ File Edit Window Search Format Font Style
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Double-click a word to select it .
Drag across a character to select it .



To select text by dragging :

a

0

Position the pointer on one edge of what you want to select,
and press the mouse button . Drag to select as much as you
want, then release the button .

A picture can be a drawing from a drawing program such as Mac- TO select a picture
Paint, a line or figure you draw with the Word Processor, or a
chart from the Works Spreadsheet. When you select a picture,
a blinking dashed line around it shows you that it's selected .
To select a picture :

Click on or to the left of the picture .
Choose Select Picture from the Edit menu .

If there are several pictures in the same area, keep choosing
Select Picture without moving the insertion point, until the one
you want is selected .

You can also select an entire document without dragging .

	

To select an entire
You may want to do this to change the font or format all the

	

document
way through .

0 Choose Select All from the Edit menu .

Works selects all the text and pictures in the document .

If you decide your selection doesn't cover exactly what you want, To change a selection
you can extend or reduce the selection .
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To select by dragging

Original selection
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0

To extend the selection, position the pointer at the end of the original
selection. Hold down the Shift key and the mouse button, and click
or drag until your selection is complete .

Article (WP)

The ne-, , Hilltoi' '=:1iiiik per will hit. tlie :=.1 ipe iti the '_ire t. Al :'in e
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Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the war, citizens of Alpine towns and

I aa taIi Q ~aopoo9

II

a

Hold down the Shift key and click or drag at the side of the
selection to extend or reduce it.

r i File Edit Window Search Format Font Style

Deleting

To remove something from a document, you delete it. You can
delete single characters with the Backspace key, or select any
amount of text and delete it with the Cut or Clear command from
the Edit menu or with the Backspace key . You can undo any of
these actions with the Undo command from the Edit menu .

To delete a single

	

Sometimes you may want to delete a single character by back-
character

	

spacing.

Position the insertion point to the right of the character you
want to delete .
Press the Backspace key .

Works removes the character from your document .

To delete a blank line You can delete a blank line to close up the space between two
paragraphs .

Position the insertion point at the left edge of the first line of
the paragraph you want to move back .
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Insertion point

File Edit Window Search Format Font Style

The blank line is deleted .
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The new Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .
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Press the Backspace key .
Works deletes the blank line between the two paragraphs .
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The new Hilltop Climber will hit the slopes in the Great Alpine
ace, sponsored by the Wheeler Bicycle Company .

Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and
cities will turn out to greet the racers with fireworks displays .

Insertion point

-----------------------------------

You can press the Backspace key twice to join two paragraphs
into one .
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To cut a selection

r
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The near Hilltop Climber will hit the slopes in the Great Alpine

Race, sponsored by the Wheeler Bicycle Company.f Teams from

around the world will challenge each other on the tough

mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and

cities will turn out to greet the racers with fireworks displays .

To delete a selection

	

To delete text, you first need to select it .

Select whatever you want to delete .
Press the Backspace key or choose Cut or Clear from the Edit
menu .

Works removes the selection from your document . If you chose
Cut, Works puts your selection on the Clipboard .

Cutting, Copying, and Pasting

The Cut command takes a selection out of its current location and
puts it on the Clipboard . The Copy command leaves the selection
where it is, but also puts it on the Clipboard . The Paste command
copies the contents of the Clipboard into a new location . The
Clipboard is a place in your Macintosh's memory that holds infor-
mation temporarily .
You can cut a selection to move it to another location or to
delete it entirely .
To cut a selection :

Select the information you want to cut .
Choose Cut from the Edit menu .

The selection remains on the Clipboard until you cut or copy
another selection . Turning off the computer erases the Clipboard .
If you try to cut a bigger selection than Works has space for in
memory, Works tells you so you can select a smaller portion .



II

The selection remains on the Clipboard until you cut or copy
another selection. Turning off the computer erases the Clipboard .
If you try to copy too much, Works tells you so you can select a
smaller portion .

You paste the contents of the Clipboard into a location you

	

To paste a selection
choose in a document. Once you have cut or copied a selection
to the Clipboard, you can paste it into as many locations as
you want.
Each time you cut or copy information, the new selection
replaces the old one on the Clipboard . Turning your Macintosh
off erases the Clipboard . So if you want to paste a selection that
you've cut or copied to the Clipboard, you should do so before
cutting or copying anything else, and before turning your com-
puter off.
To paste a selection :

Cut or copy a selection to the Clipboard .
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You can copy a selection to put the same information in other

	

To copy a selection
places.
To copy a selection :

Select the information you want to copy .
Choose Copy from the Edit menu.

0
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Move the insertion point to where you want to paste the text .
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Choose Paste from the Edit menu .
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The near Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .

Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

IAt major stops along the way, citizens of Alpine towns and
cities will turn out to greet the racers with fireworks displays .

St . Etienne

Pasted text

You can repeat steps 2 and 3 as many times as you want .

You can cut and paste between documents, as well as within a

document. When you paste pictures, you can also change their

sizes. For more information, see Chapter 20, "Moving Information

Between the Tools ."

Finding Text

If you're looking for a word or phrase, or want to move quickly

to specific text within a document, the Word Processor can find

it for you .

To find text

	

With the Find command, Works finds all occurrences of the text

you specify. This can include instances where the text is embed-

ded in other text. For example, if you tell Works to find "able",

it will highlight those four characters in "valuable" . If you want

Works to ignore such occurrences, click the Match Whole Words

Only option.

May 10 Lucerne May 2 6



Also, Works ignores capitalization in the text you specify to be
found. If you want to find only those occurrences of text where
the capitalization is exactly as you type it in the text box, click
the Check Upper/Lowercase option .
To find text:

0

4

Choose Find from the Search menu .
Works asks you what you want to find .

F

	

File Edit Window Search Format Font Style

Type the characters you want to find .
Click one or both of the options if you want .
Click the Find Next button .

Works highlights the first occurrence of the string of characters
if it is in the document . You'll see a message telling you if your
string of characters isn't there.

If you want Works to look for another occurrence of the text you
specified, click the Find Next button again .
If, while you are typing or reviewing your document, you come
across a word that is misspelled, for example, you can select the
word, and then choose Find . The selected word will appear in the
Find What box, so you don't need to type it . You can then find
any other occurrences of the misspelled word .
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To replace a single

selection

Replacing Text

You can replace selected text in a single location by typing over

it. You can also have the Word Processor find a word or phrase

for you in a document. Then, you can choose to replace every

occurrence of it at once, or decide for each case individually .

To replace a single selection :

0

F

	

File

Select the text that you want to replace .

Select the text you want to replace .

E

Edit Window Search Format Font Style

F

	

File

Type the new text.

Article (WP)
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The text you type replaces the text that you selected .
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The new bicycled will hit the slopes in the Great Alpine Race,
sponsored by the Wheeler Bicycle Company .
Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and
cities will turn out to greet the racers with fireworks displays .
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The new Hillt.o

	

lirribei will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .
Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and
cities will turn out to reet the racers with fireworks displays .

Type the replacement text .
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You can also replace the selection with the contents of the
Clipboard by using the Paste command .
For more extensive search and replace actions, use the Replace

	

To find and replace
command from the Search menu. The Replace command finds and text
replaces text. You can replace all occurrences of the text, or you
can go through and selectively replace each occurrence, one at a
time. As with the Find command, you can click options to specify
whether Works searches for whole words only and/or for text
with matching uppercase and lowercase letters . You can also
select the text you want to replace before choosing the Replace
command, then have it automatically appear in the Find What
box.
To replace text :

El

4

Choose Replace from the Search menu .
A dialog box appears asking you what you want to find and
what you want to replace it with .
Type the text you want to find .
Press the Tab key to move the insertion point into the second
box, and type the replacement text .
Click one or both of the options if you want .

The word "bicycle" will be replaced
with the words "Mountain Wheeler".

r
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Replace With :

Canoe

Mountain Wheeled

fl Match Whole Words Only

	

® Check Upper/Lowercase

r Replace All [RCE	) `~ Find Next ~,

Find What : bicycle

0 Click one of the buttons to either start or cancel the search .
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Sometimes a word or phrase occurs often, but you want to
replace it in only one place . Use the Find Next button to find suc-
cessive occurrences of the specified text until you see the one
you want to replace. Or use the same button to verify each occur-
rence of the specified text before you replace it. After each re-
placement, you can look for another occurrence .
There are several other buttons in the Replace dialog box . These
tell Works to automatically replace all occurrences of the speci-
fied text, replace one occurrence and find the next, or replace
only the occurrence you've just found .
For more information on the options and buttons in the Replace
dialog box, see "Replace" in Chapter 5 .

Changing the Appearance of Text

You can change the font, type style, and type size to add emphasis
to or increase the impact of parts of your text. The font (such as
Boston) is the design of the characters . Each font can have dif-
ferent type styles (such as bold) and type sizes (such as 10 point) .
You can change these characteristics as you're typing, or you can
make a selection and then change them for the entire selection .

To change the font

	

To change the font of existing text :

0 Select the text you want to change .
Choose the font you want for your selection from the Font
menu .

The Font menu lists the fonts that you have on the Works Pro-
gram disk. You can add and remove fonts and font sizes on your
disk using the Font Mover program that comes on your Macintosh
System Disk. For more information, see your Macintosh owner's
guide .

To change the type

	

Different type styles can change the way your text looks, making
style or type size

	

it bold or italic or some other shape . Different type sizes can add
emphasis to parts of a document .
To change the type style or size of existing text :

El Select the text that you want to change .
Pull down the Style menu .
Choose the style or size you want for your selection .



Not all sizes are recommended for all fonts . Recommended sizes
for the font of the selected text appear in outline type on the
Style menu. Other sizes appear in normal type . If a size is not
recommended, you can still use it, but your text will look some-
what rougher than text in the recommended sizes .

To change the font, style, or size while you're typing :

0 Select the font, style, or size that you want to use by choosing
from the Font and Style menus.
Start typing.

Everything you type will have the characteristics you chose until
you change them again. If you move the insertion point to text
with different font characteristics, whatever you type will appear
with those characteristics .

You can also change the type style as you type by using the
Command-key equivalents displayed on the Style menu .

Plain 10 point Boston font is the standard Word Processor typeface .
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4 Formatting a Document

The format of a document is how it appears on your screen or on

paper. With Works, you can have the Word Processor do much of

the formatting while you type . For example, you can specify that

the first line of each paragraph should be indented half an inch .

The Word Processor will then take care of the indenting all you

do is type and press the Return key at the end of each paragraph .

This chapter shows you how to :

•

	

Change spacing .

•

	

Change the justification of text .

•

	

Use the ruler to adjust indentation .

•

	

Set tabs and make columns and tables .

•

	

Copy a format.

•

	

Format and print a document with headers and footers .

•

	

Draw lines, boxes, and circles.

You can have as many different formats as you want within a sin-

gle document, but each format you choose will affect an entire

paragraph. For example, if you double-space most of a report, but

want to single-space and indent quotations, make the quotations

separate paragraphs. Once you've set up a format, you can copy

it whenever you want to use the identical format .

Changing Spacing

The Word Processor lets you use single, one-and-a-half, and

	

To change spacing

double spacing .

To change the spacing in a document :

El Position the insertion point in the paragraph you want to

change, or select one or more paragraphs .

Use the Select All command from the Edit menu if you want

to select the entire document .

53
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4

Choose Spacing from the Format menu .
Click the type of spacing you want .
Click the OK button or press the Return key .

1-1/2 spacing
Single spacing

Article (WP)
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The new Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .

Tearris from around the world will challenge each other on

the tough mountain slopes of France, Swit2erland, and Italy .

At major stops along the way, citi2ens of Alpine towns and

cities will turn out to greet the racers with fireworks displays .

Double spacing

The spacing you set remains in effect until you change it . Because
spacing is associated with individual paragraphs, if you move to a
paragraph with different spacing, the menu will show whatever
spacing is associated with that paragraph .

Changing Justification

Text is justified along one or both edges of the page . Most type-
writers give you left-justified text . Most newspapers and magazines
are fully justified (so that text in columns lines up evenly along
both edges). The Word Processor lets you do left, right, and full
justification. You can also center text, such as titles, captions, or
lines of poetry .



When you create a new document, your text will start out left-
justified .
To change the justification :

II

Works changes the justification for the paragraph that contains the
insertion point or for the paragraphs you've selected .

Left

File Edit Window Search format Font Style

Position the insertion point in the paragraph whose justifica-
tion you want to change, or select one or more paragraphs .
Use the Select All command from the Edit menu if you want
to select the entire document .
Choose a type of justification from the Format menu .
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Wheeler President. Hiram Albert. Wheeler is extremely pleased
by the new bike his company has produced . From his home
in Wheeling, West. Virginia, he said :

"This is a great. momentt in m y life . When I was a young
man, the Wheeler Flying Eagle took the world by storm . Now
the Hilltop Climber will do the same . I'm taking my summer

vacation in the Canadian Rockies--with m y own Hilltop
Climber!"

Centered

Article (WP)

Every major television network will coffer the race in some
detail . Since all the bicycles in the race will be Hilltop
Climbers, `-e expect. to have a lott of free product exposure
from the race .

Justified

The justification you set remains in effect until you change it .
Because justification is associated with individual paragraphs, if
you move the insertion point to a paragraph with different justifi-
cation, the menu will show whatever justification is associated
with that paragraph.
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The Ruler

You use the ruler to set indentation and tab stops . Ruler settings
apply to the first paragraph in a selection or the paragraph con-
taining the insertion point . The ruler comes with standard settings
indicated by markers. When you create a new document, the ruler
is already showing .

To see the ruler

	

If the ruler isn't showing :

a

0

Choose Show Ruler from the Format menu .

The ruler appears at the top of the window .

Right tab stops

r

	

File Edit Window

Right indent marker

Search at Font Style
Artic a (WP

l iiiiiijiIIIiiIIiiI

Q

Both the first line indent
marker (•) and the left indent
marker () are here.

As you move the insertion point to paragraphs with different
settings, you can see the markers change in the ruler . When you
adjust settings with more than one paragraph selected, your new
settings affect the entire selection .

To hide the ruler

	

If you'd like to see more of what you're typing, you can make the
ruler disappear .

Indenting Text

The Word Processor lets you set indentation on both the left and
the right. You can set one indentation for the first line of a para-
graph, and the same or a different indentation for the rest of the
paragraph . If you indent only the first line of a paragraph, you get
the standard paragraphs that you see in books . If you indent from
both the left and right margins, you set off a portion of text for
emphasis.

Left tab stop

Choose Hide Ruler from the Format menu .

6ii11



If you indent only the lines after the first line of a paragraph, you
have what is called "hanging indentation ." This lets you prepare
a standard bibliography, for example, or itemize points effectively
with numbers or bullets .
You can automatically indent the first line of every paragraph,
so that you don't have to press the Tab key each time you start
a new paragraph .

Choose Show Ruler from the Format menu if the ruler isn't
showing.
The ruler appears at the top of the window .
Drag the first line indent marker along the ruler to the posi-
tion you want .
To see the first-line indent marker (u), drag the > marker at
the left edge of the ruler . You'll see the box appear .

II

As you type, the first line of each paragraph will automatically be
indented .

You can also use this method on previously typed text . Just select
the paragraph(s) and follow the procedure above. To change
every paragraph in the document use the Select All command
from the Edit menu. The first line of each selected paragraph
changes as soon as you release the button .

Only the first line of the paragraph is indented .
First line indent marker
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Fireworks in the Alps

At rnaj stomas along the wayycitizens of Alpine towns and
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To set hanging

	

You can set up hanging indentation by indenting the lines follow-
indentation

	

ing the first line of a paragraph . You can do this either before you
begin to type or on previously typed text that you select .

a

4

r

D

=0

Choose Show Ruler from the Format menu if the ruler isn't
showing.

•

	

Drag the first line indent marker a little to the right, so you
can see the entire left indent marker .

•

	

Drag the left indent marker to the position you want for the
hanging indent.
Drag the first line indent marker back to the left edge of
the ruler .

To set up hanging indentation, put the first line indent
marker (.) to the left of the left indent marker (~) .

File Edit Window Search Format Font Style
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Race, sponsored by the ~Nheeler Bicycle Company .

Teams from around the world will challenge each other
on the tough mountain slopes of France, Switzerland,
and Italy .

At maj or stops along the way, citizens of Alpine towns
and cities wil turn out to greet the racers with fireworks
displays .

These three paragraphs all have hanging indentation .

To indent an entire

	

You can set an indentation that applies to an entire paragraph .
paragraph

	

You can do this either before you begin to type or on previously
typed text that you select .

Choose Show Ruler from the Format menu if the ruler isn't
showing.

•

	

Drag the first line indent marker to the position you want .
•

	

Drag the left indent marker to the same position .

0



Setting Margins

Indentations and margins are not the same in Works . When you
set an indentation, that space is added to whatever margin you set
with the Page Setup command from the File menu . For example, if
the left margin is 1" and the left indent is .5", the text will begin
1 .5" from the left edge of the paper .
Indentation affects text in the selected paragraph(s) or the para-
graph containing the insertion point. You indent to move text in
from the margins, which you set with the Page Setup command .
For instructions on setting margins, see "Printing a Document" in
Chapter 1 . The margins you set apply to the entire document .

Note If the side margins you set conflict with the position of the
indent markers, Works changes the right indent marker to a hol-
low triangle to alert you to the problem .

Setting and Using Tabs

Tabs let you skip across the page by measured amounts . Tabs are
measured in inches rather than in number of characters, so that
text lines up no matter what font, size, or style of type you're
using.
If you want to type in two or more columns, you can set a left tab
stop for each column after the first one, so that you don't have to
type spaces to get to the proper location . Right tab stops help you
align columns of numbers along a single digit .

Setting Tab Stops

In a new Word Processor document, tab stops are preset at every To set tab stops
half inch on the ruler, but you can't see them . You can remove
these by setting your own. When you set a tab stop, all preset tab
stops to the left of the new one are lost .
You can set different tab stops for each paragraph you want to
modify .
To see the tab stops on the ruler that correspond to a particular
paragraph, select the paragraph containing tab stops .
Pressing the Tab key moves the insertion point to the right . When
you move to a left tab stop, that tab stop determines the left edge
of the next text you type .

Chapter 4 Formatting a Document 59

Setting margins



60 The Word Processor

Right tab stops anchor the right edge of text . They're most useful
for aligning columns of numbers, so that you can type them easily .
To set tab stops :

II

To reverse a tab stop from right to left, or vice versa, just click it .

a

a

Choose Show Ruler from the Format menu if the ruler isn't
showing.
Position the pointer in the blank area below the ruler markings
at each place you want to set a tab stop, and click once for a
left tab stop and twice for a right tab stop .

0	Articl WP)

Fireworks in the Alps

At major stops along the way, citizens o Alpine towns and
cities will turn out to greet the racers wi

	

fireworks displays .

"The Hilltop Climber has arrived in style! Try
precision rnachineLy on the toughest terrain!"

Left tab stop

Drag the tab stop to a new location .

When you release the mouse button, the text in the selected
paragraph(s) or the paragraph containing the insertion point
realigns under the new tab stop .

To remove a tab stop :

Drag the tab stop down into the text .

Right tab stops

r
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this piece of

To move or remove a If you want to change a tab stop's location, or just want to remove
tab stop

	

it, you can drag it .
To move a tab stop :

When you release the mouse button, the tab stop disappears .
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Using Tabs for Tables

By setting a series of tab stops, you can make a table. You can use

tables to list facts or figures in several columns .

To make a table :

Set a left tab stop for each column of the table .

•

	

Move the insertion point to the left edge of the screen and

press the Tab key .

Works aligns the insertion point with the first tab stop .

•

	

Type the first entry for the first line .

Press the Tab key to move to the second column and then

type the next entry.

•

	

When you finish with the last entry of the first line, press the

Return key .

0

4

Copying a Format

If you have different sections throughout a document that require

the same format, you can set the format for one paragraph and

then copy that format to other paragraphs .

The formats you can copy are justification, indentation, tabs, and

spacing.

To copy a format :

Position the insertion point anywhere in the paragraph whose

format you want to copy.

Choose Copy Format from the Format menu .

•

	

Move the insertion point to anywhere within another para-

graph.

Choose Paste Format from the Format menu .

II

El

4

Works changes the format in the second paragraph to match that

of the first .

You can repeat steps 3 and 4 to copy the same format to as many

paragraphs as you want . If you want to copy a format to several

adjacent paragraphs, select them all before pasting the format .
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To set a page break

Formatting an Entire Document

Some formatting options work on the printed document as
a whole .

•

	

You can set manual page breaks to keep related information
together, or unrelated information apart .

•

	

With headers and footers, you can repeat information about a
document, such as the title or date, at the top and bottom of
every page .

•

	

You can include automatic page numbers in headers or
footers.

•

	

You can specify a title page at the beginning of a document on
which headers and footers don't print.

Page Breaks

Works automatically sets page breaks in all documents . You can
leave these as they appear, or change them with the Format menu .
To set a manual page break :

Move the insertion point to the line you want to be at the top
of the page .
Choose Insert Page Break from the Format menu, or press
Shift-Enter .

0

A dotted line appears just above the line containing the insertion
point. When you set a manual page break, Works automatically
repaginates the entire document from that point on .

by
in

Page break indicator

File Edit Window Search Format Font Style

2

	

I3

	

I4

	

I5

	

6IIJ	III	III	lii	III	lillill	I!!	III	Iii	III	III
I

the new bike his company has produced . From his home
Wheeling, West Virginia, he said :

"This is a great moment in my* life . When I was a young
man, the Wheeler Flying Eagle took the world by storm .
Now the Hilltop Climber will do the same . I'm taking my
summer vacation in the Canadian Rockies--with m y own
Hilltop. . . Climber. ". . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Every major television network will cover the race in some

Insertion point

Article ([LIP)	



If you decide not to break a page at a particular spot, you can
remove the manual page break .
To remove a manual page break :

0

You cannot remove an automatic page break ; however, you can
force Works to adjust the position of automatic page breaks by
inserting manual page breaks so that Works repaginates the
document .

Headers and Footers

Headers and footers contain information that helps you to identify
a document. They are not displayed on the screen, but appear
only when you print a document.
Headers and footers often contain the title of the document, the
name of the author, and the date . Or, a header might center the
word "Confidential" at the top of every page .
You can create headers and footers in the Word Processor in any
font, size, or style . Headers and footers can have text aligned at
the left, right, or center, and can include page numbers, too .
To tell Works to include the date, time, or page number, or to
align text in a particular way, you use a set of formatting com-
mands. For a list of these commands, see "Page Setup" in
Chapter 2 .
To set a header or footer :

Choose Page Setup from the File menu .
The lower half of the Page Setup dialog box has two text
boxes in which you can type headers and footers. The inser-
tion point is in the box for a header .

•

	

Type the information for the header, including any formatting
commands, such as &L or &D .

•

	

Move the insertion point to the Footer box and type the
information for the footer .
Click the OK button or press the Return key .

0

4

Click anywhere in the line just below the dotted line .
•

	

Choose Remove Page Break from the Format menu .

When you print the document, the formatting commands will not
appear, but Works will align the text as you specified, and include
the page number, date, and time, if you included them .

Chapter 4 Formatting a Document 63

To remove a manual
page break

To set a header or
footer



64 The Word Processor

To change the

	

In the Word Processor, but not in other Works tools, you can use
typeface of a header

	

any available font, style, or size for header and footer text.
or footer To change the typeface of a header or footer :

0

4

Choose Page Setup from the File menu .
Choose a font from the Font menu .
Choose a style and size from the Style menu .

Click the OK button or press the Return key .

When you print your document, the header and footer will be in
the font, size, and style you've selected .

Setting Consecutive Page Numbers
You may want to break a very large project into parts . You'll find
it easier to switch between smaller documents than to move
around in a single very large document . You can give each part
its own header and footer for identification .

r
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In the Word Processor, but not in the other tools, you can print a
series of documents that each start with a beginning page number
that you specify .

From the Word Processor, choose Print from the File menu to
print the first document in the series .

•

	

Activate the next document you want to print .
•

	

Choose Set Page # from the Format menu .
In the dialog box, set the starting page number for the next
document in the series. (Just add one to the last page number
of the document you just printed .)

•

	

Choose Print to print the second document in the series .

0

4

Repeat steps 2 through 5 for each succeeding document in the
series .

Setting a Title Page

You may not want to have headers and footers on the first page of
a document. By designating the document as having a title page,
you tell Works to wait until the second page before printing any
headers and footers .
To set a title page :

D Choose Title Page from the Format menu .

Works starts the headers and footers on the second page . It does
not change the format of the first page in any other way .

Drawing Lines and Shapes

You can use lines and shapes to make your written documents
look more distinctive . Insert thin vertical lines between the col-
umns of a newsletter . Create organizational charts, or put a box
around a key article . Frame charts, photographs, and illustrations .
Keep track of revisions by crossing out deletions and circling
insertions .
Using the Word Processor's drawing capability, you can draw

	

To draw a line or
lines, boxes, rounded boxes, and circles in three line thicknesses .

	

shape
You can draw right over or next to text and pictures .
To draw a line or shape :

0 Choose Draw from the Edit menu .
•

	

Select a line width or a shape .
•

	

Click the OK button .
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The pointer turns into a cross (+) when you move it into the
active window .

r ri File Edit Window

For lines :

0

Fl

r

	

File Edit Window

For shapes :

0

Pointer

Search Format Font Style

Article (WP)	

At major stops along the ray, citi2ens of Alpine towns and
cities will turn out to greet the racers with fireworks displays .

St . Etieririe May 10 + Lucerne May 28
Geneva May 18 Zurich May 29
Charnonix May 18 Chur June 3
Bern May 25 Lugano June 10
Iriterlakeri

	

May 2 6

	

Milan

	

June 12

"The Hilltop Climber has arrived in style! Try this piece of
precision machinery on the toughest terrain!'

Position the cross where you want the line to begin .
Press the mouse button and drag to draw a line .
Release the mouse button to end the line .

To draw a vertical line,
press the mouse button here . . .

. . . and release it here .

O

	

3

	

4

"The Hilltop Climber has arrived in style! Try this piece of
precision machinery o n the toughest terrain!"

Put the cross where you want to anchor any corner of your
box or circle.

At major stops along the ay, citi2ens
cities will turn out to gree the racers

of Alpine
with fireworks

towns and
displays .

St. Etienne May 10 Lucerne May 28
Geneva May 15 Zurich May 2 9
Chamonix May 18 Chur Jurie 3
Bern May 25 Lugano June 10
Interlaken May 26 + Milan June 12
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Hold down the mouse button and drag in any direction .
Release the mouse button when you're satisfied with the size
of the box or circle .
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St . Et ienne May 10
Geneva May 15
Chamonix May 18
Bern May 25
Iriterlakeri

	

May 26

To draw a shape,
press the mouse button here . . .

Article (WP)

I-

Choose Draw Off from the Edit menu .

I-
At major stops along the way, iti2ens of Alpine towns and
cities will turn out to greet the scars with fireworks displays .

"The Hilltop Climber has arrived in st le! Tr this iece o fy

	

y

	

p
precision machinery on the toughest terrain!"

. . . and release it here .

Click on or to the left of the pattern .
Choose Select Picture from the Edit menu .

4

When you're finished drawing, you have to turn off Draw before
you can type or edit text .

Now you can type within or over anything you've drawn .

When you want to move, cut, or size a line or shape you've
drawn, you have to select it . Works treats these objects just like
regular pictures or charts .
To select a Draw pattern :

Works puts a blinking dashed line around the selected pattern .
You can cut, copy, paste, move, or size selected patterns . If there
is more than one picture in the window, keep choosing Select
Picture, without moving the insertion point, until the pattern
you want is selected .

For more information on working with pictures, see "Editing
Pictures" in Chapter 20.
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5 Word Processor
Command Reference

The Apple, File, and Window menus are identical for all Microsoft
Works tools. For information on these menus, see Chapter 2,
"Common Tasks Command Reference."
This chapter discusses all the shaded commands shown below .
The Print Merge command is included here because you use it for
a Word Processor document.

File
New . . .
Open . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Close
Save
Save As . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . .

	

P
Print Window
Eject Page
Print Merge . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Quit

	

€Q

Format
Hide Ruler

. . . . . . . .. . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. .

Spacing. . .
. . . . . . . . . . ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . .

/Left
Centered
Right
Justified

. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Format
Paste Format

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .

Insert Page Break
Title Page
Set Page # . . .

Edit

Select All
Select Picture

Draw . . .

Prepare to Merge . . .
Show Field Data

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
D

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Font
/Boston
Monaco
Geneva
Chicago
Athens

Style
Normal Text
Bold

Underline
®wfllwG
Superscript
Subscript

. . . .. . . . . . . . . . . . . . . ... . . . . . . . . . . . .. . . . . . ... . . . . . . .. . . . . . ... . . . .

~ Po8o4
/fl Q tpoaof
f Poeot
14 Point
11113 [Pti
~o aoa©~
X41 Pollof

Search

B
I
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Undo

Cut
Copy

	

€C
Paste
Clear

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . .
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Print Merge

File
New . . .
Open . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . .

Close
Save
Save As . . .
Delete . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . .

Page Setup . . .
Print . . . P
Print Window
Eject Page
Print Merge . . .

Quit

You can invoke some Works commands from the keyboard, as
well as by using the mouse . The available Command-key combina-
tions are shown on the menus and in Appendix D .
An alphabetical list of commands appears in the index under
"Command ."

The File Menu

The File menu is described in detail in Chapter 2, "Common Tasks
Command Reference ." The Print Merge command is included here
because it applies only to the Word Processor.

Print Merge

The Print Merge command is available only for Word Processor
documents into which at least one placeholder has been entered
with the Prepare to Merge command.
After all placeholders have been entered with the Prepare to
Merge command, the merging process begins when you choose
Print Merge.
When you choose Print Merge, Works displays the Print dialog
box .
If a Database document you specified with Prepare to Merge is
not open, or if a field name you specified with Prepare to Merge
cannot be found, Works displays an alert box, and cancels the
Print Merge operation .
You can use Record Selection rules in the Database if you want to
merge with only part of your Database document .
For more information, see "Prepare to Merge" in this chapter,
and Chapter 21, "Merging: Creating Mailing Labels, Form Letters,
and Forms ."



The Edit Menu

The first five commands on the Edit menu are common to all
tools in Works. For information on these commands, see "The Edit
Menu" in Chapter 2 .
This section explains additional Edit menu commands that are
available in the Word Processor .

Select All

The Select All command selects the entire contents of a
document .
This is useful when you want to change the font or set an
indent for an entire document .

Select Picture

The Select Picture command selects a Draw pattern, a chart, or
a picture .
Use Select Picture when you want to cut, copy, paste, or size any
of the following: a line or shape created with the Word Proces-
sor's Draw command, a chart from a Spreadsheet document, or
any other graphic material imported from a program such as Mac-
Paint. Graphics from outside Works are imported via the Scrap-
book, and are identified there as "PICT ."
When you paste a picture into a new location, you can enter text
anywhere in and around the picture; for example, you could type
a label for a chart . However, if you use Select Picture to move the
same picture once again, only the original picture will be selected .
The text you added in the Word Processor remains where it is,
unless you select and move it separately .
To select a picture, click on or to the left of the picture, and
choose Select Picture. If there is more than one picture in the
same area, keep choosing Select Picture, without moving the
insertion point, until the picture you want is selected .
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Select All

Edit
Undo

Cut
Copy
Paste
[:tear

Draw . . .

A

U

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Select All
Select Picture

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

D
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Prepare to Merge . . .

	

M
Show Field Data

Select Picture

Edit
Undo

	

Z
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

.

Cut
Copy
Paste
Clear

Select All
Select Pic:tune

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

.
Draw . . .

	

Prepare to Merge . . . : M
Show Field Data

U
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Draw
Draw Off

Edit
Undo Z

Cut
Copy
Paste
Clear

U
C

€U

Select All
Select Picture

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Draw . . .

	

D

Prepare to Merge . . . €.M
Show Field Data

Draw/Draw Off

The Draw command draws lines, circles, and boxes in a Word
Processor document .

Select Draw Pattern :

Cancel

O O
O O I

I

	

0 K

	

To select a shape or line width in the dialog box, either click it
and click OK, or double-click it. Works returns to the Word Pro-
cessor document and changes the pointer to a cross (+) .
As you drag the pointer in your document, Works draws the
shape or line you chose .
When you choose Draw, the menu item automatically changes
to Draw Off. If you wish to change to another shape or line width,
choose Draw Off, then choose Draw again and click the appropri-
ate shape. To return to regular text processing, choose Draw Off .
To delete any shape you've drawn, select it with the Select Pic-
ture command, then cut it. Select Picture does not affect text
within the picture selection .
For more information on working with shapes, see "Editing
Pictures" in Chapter 20 .



Prepare to Merge

The Prepare to Merge command specifies information to be
merged into a Word Processor document from a Database docu-
ment. To print the merged information, use the Print Merge com-
mand from the File menu .
Before you choose Prepare to Merge, be sure that the Database
document from which you want to merge data is open . When you
choose Prepare to Merge, Works displays a dialog box that asks
you to select from which Database document and from which
field the data is to be taken .

LUheeler~ PR Articles
Addresses

Prepare to Merge :

Select Merge Data Base :

	

Select Merge Field :
Title
Publication
Date
Comments
Author
PR Rep

Cancel Merge

Select Merge Data Base From the list of Database documents
in the list box on the left, select the document from which the
merge data is to be taken .
The field names of the Database document you select will then
appear in the list box on the right .
Select Merge Field Select the field name from which the merge
data is to be taken .
When you click the Merge button, a placeholder a rectangle
containing the Database document name and the field name
is inserted into your Word Processor document at the insertion
point.
If you close a specified Database document, delete a specified
field, or change a specified field name, Works displays a mes-
sage "NOT ON DESKTOP" or "FIELD NOT IN DB" in the
appropriate placeholders .

Chapter 5 Word Processor Command Reference 73

Prepare to Merge

Edit
Undo
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Cut
Copy
Paste
Clear
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C
U

select All
Select Picture
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Prepare to Merge . . . :#:M
Show Field Data
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Show Field Data

	

Show Field Data/Show Field Names
Show Field Names

Edit
Undo

Cut
Copy
Paste
Clear

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Select All
Select Picture

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Draw . . .

Find

Search
Find . .. F
Replace . . . #, R

Go To Page # . . . ;#;G

C

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Prepare to Merge . . .
Show Field Data

The Show Field Data command displays the contents of the fields
in the first record to be merged into a Word Processor document
just as they will be shown in the final document .
When you choose Show Field Data, the menu item changes to
Show Field Names.
When you choose Show Field Names, Works again displays the
placeholders .

The Search Menu

Find

The Find command searches for text that you specify .

Find What :

E Match Whole Words Only 0 Check Upper/Lowercase

Cancel ] Find NeHt
l

Find What Type the text you want to search for . This can be
as short as a single character or as long as 80 characters . You can
search for any alphanumeric characters and all symbols on the
Macintosh keyboard .
If you select any occurrence of the text before you choose Find,
it will appear in the Find What box .
Match Whole Words Only Click this option to find only those
occurrences of the text that have leading and trailing word breaks
(spaces, punctuation, and tabs). This tells Works to find only
those occurrences of the specified text not embedded in other
text .



Check Upper/Lowercase Click this option to find only those
occurrences of the text having uppercase and lowercase charac-
ters that match what you type .
When you click the Find Next button, Works finds and selects the
first occurrence of the specified text after the insertion point . The
search continues to the end of the document, then goes to the
beginning and searches forward to the point at which the search
began .
To find additional occurrences of the specified text, click the Find
Next button after each occurrence is selected .
To cancel the search at any time, click the Cancel button .
If Works cannot find the specified text in your document, it
displays an alert box .
The next time you choose Find, the last text you specified is
selected in the Find What box unless different text is selected in
the document . If that is the text you want, click the Find Next
button. Otherwise, type the new text you want to search for .

Replace

The Replace command finds and replaces specified text either
selective occurrences of the text or all occurrences .

Find What :

Replace With :

0 Match Whole Words Onlg

	

LI Check Upper/Lowercase

y Cancel ) (Replace All . then
r

f

t
Find NeHt 1

Find What Type the text you want to search for . This can be as
short as a single character or as long as 80 characters . You can
search for any alphanumeric characters and all symbols on the
Macintosh keyboard.
If you select any occurrence of the text before you choose
Replace, it will appear in the Find What box .
Replace With Type the replacement text, up to 80 characters .
Match Whole Words Only Click this option to find only those
occurrences of the text that have leading and trailing word breaks
(spaces, punctuation, and tabs). This tells Works to search for
only those occurrences of the specified text not embedded in
other text .
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Replace

Search
Find . . . ~€ F
Replace . . .

	

:#:R
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Go To Rage # . . .

	

G
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Go To Page #

Search

Go To Page # . . .

	

G

Find . . .

	

€;F

Replac:e . . .

	

R

Check Upper/Lowercase Click this option to find only those

occurrences of the text having uppercase and lowercase charac-

ters that match what you type .

Works starts the search at the insertion point. The search contin-

ues to the end of the document, then goes to the beginning and

searches forward to the point at which the search began .

Replace All Click this button to replace all occurrences of the

specified text in the document .

Replace, Then Find Click this button to replace the selected

text and then go to the next occurrence of the specified text .

Works selects the next occurrence, but does not replace it .

Replace Click this button to replace the current selection only .

Find Next Click this button either to start a search or, if an

occurrence of the specified text has been found, to leave it as

is and search for the next occurrence .

To cancel the search at any time, click the Cancel button .

As you selectively find and replace text, Works scrolls automati-

cally to the next occurrence of the specified text . If Works cannot

find the specified text in the document, it displays an alert box .

The next time you choose Replace, the last text you specified is

selected in the Find What box unless different text is selected in

the document. If that is the text you want, click a button to start

the search. Otherwise, type the new text you want to search for .

Go To Page #

The Go To Page # command scrolls a document to the page you

specify and places the insertion point at the beginning of the

first line.

Go To Page # :

Cancel

1

t OK ,

Works proposes the page number currently displayed in the

scroll box. Type the number of the page you want to find, then

click OK.



The Format Menu

Show Ruler/Hide Ruler

The Show Ruler command displays the ruler .

r
File Edit Window Search Format Font Style

Untitled WP .P
0

	

I

	

2

	

I3

	

I4

	

I5

	

6	III	II!	III	III	III	III	1	1	1	1	1	1	1	II!	III	III	111	III	II .
	 I	 i

The ruler is calibrated in inches . The indent markers and tab stops
reflect the settings for either the first paragraph of a selection or
the paragraph containing the insertion point. If you make a change
to the indent markers or tab stops on the ruler, the change applies
to all of the selected paragraphs or the paragraph containing the
insertion point . You can move indent markers, and insert, delete,
and move tab stops on the ruler .
When the ruler is displayed on the screen, the Show Ruler com-
mand on the menu changes to Hide Ruler. Hide Ruler allows you
to display approximately two additional lines of text in your docu-
ment window.
The ruler displays the following information about how a para-
graph is formatted :

•

	

The amount of space the first line is indented from the left
margin. This is indicated by a small solid box .

•

	

The amount of space all lines, subsequent to the first, are
indented from the left margin. This is indicated by a small
solid triangle pointing right .

•

	

The amount of space all lines of a paragraph are indented from
the right margin. This is indicated by a small solid triangle
pointing left .

Note Margins are defined and displayed in the dialog box of
the Page Setup command from the File menu .

•

	

The position of left tab stops . Initially, there are left tab stops
every 0.5". When you insert any new tab stops, all preset tabs
to the left of the new tab stop are lost . To insert a left tab
stop, point to a position in the blank area below the ruler
markings and click .
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Show Ruler
Hide Ruler

Format
Hide Ruler

. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Spacing . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Left
Centered
Right
Justified

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Format

	

K
Paste Format

	

Y

Insert Page Break
Title Page
Set Page # . . .
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Spacing

Format

Hide Ruler
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Spacing . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Left

Centered

Right

Justified
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Format

Paste Format
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Page Break

Title Page

Set Page # . . .

Left

Centered

Right

Justified

Format

Hide Ruler

Spacing . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

,Left

Centered

Right

Justified
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Format

Paste Format
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Page Break

Title Page

Set Page # . . .

∎ The position of right tab stops . Initially, there are no right tab

stops. To insert one, point to a position in the blank area

below the ruler markings and double-click. To change a tab

stop from right to left, or vice versa, click it .

Spacing

The Spacing command controls the line spacing in a document .

Select Spacing :

® 1 (single)

0 1 112

O 2 (double)

Cancel

When you click the OK button, Works adjusts the selected para-

graphs, or the paragraph containing the insertion point, to the

spacing you chose .

Left/Centered/Right/Justified

These formatting commands position selected paragraphs, or the

paragraph containing the insertion point, between the indent

markers.

Left

	

All lines are aligned with the left indent marker.

Centered

	

Each line is centered between the indent markers .

Right

	

All lines are aligned with the right indent marker .

Justified

	

All lines start aligned with the left indent marker

and end aligned with the right indent marker. Spaces

between complete words in each line are expanded

evenly to give the appearance of evenly spaced text .

In all four cases, only complete words are placed on a line .



Copy Format/Paste Format

	

Copy Format
Paste Format

The Copy Format and Paste Format commands copy the format
of one paragraph to another paragraph or to a range of paragraphs .
To copy a format, position the insertion point anywhere in the
paragraph whose format you want to copy, then choose Copy
Format .
To paste the format, position the insertion point anywhere in the
paragraph you want to reformat, or select a range of paragraphs .
Then choose Paste Format .
The following formatting information is copied with Copy Format
and Paste Format :

•

	

Left and right indents
•

	

First line indent (of a paragraph)
•

	

Left and right tab stops
•

	

Spacing
•

	

Justification

The Insert Page Break command inserts manual page breaks for
a printed document .
With Works, pagination is automatic . This command, however,
allows you to manually insert page breaks in places other than
where pages would automatically break .
When you choose Insert Page Break, Works puts a thin dotted
line immediately above the insertion point to indicate the page
separation. When you insert a manual page break, Works automati-
cally repaginates the entire document, starting at that point .
When you put the insertion point in the line following a manual
page break, the command changes on the menu to Remove Page
Break. If you choose this command, Works removes the manual
page break indicator .
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Format
Hide Ruler

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Spacing . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
,Left
Centered
Right
Justified

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Copy Format :#:K
Paste Format

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Insert Page Break
Title Page
Set Page # . . .

Insert Page Break/Remove Page Break

	

Insert Page Break
Remove Page Break

Format
Hide Ruler

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Spacing . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

.Left
Centered
Right
Justified

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Copy Format
Paste Format

Title Page
Set Page # . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Page Break
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Title Page
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Format
Hide Ruler

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Spacing . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Left
Centered
Right
Justified

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Format
Paste Format

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Page Break
Title Page
Set Page # . . .

Set Page #

Format
Hide Ruler

. . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Spacing . . .
. . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Left
Centered
Right
Justified

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Format
Paste Format

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Page Break
Title Page
Set Page # . . .

Title Page

The Title Page command tells Works not to print headers and
footers on the first page of a document . It does not affect in any
other way the format of existing text on the first page .
When you choose Title Page, the command appears with a check-
mark beside it on the menu .
To print headers and footers on the first page, choose Title Page
when it is checked . Works removes the checkmark .

Set Page #

If you specify in the Page Setup dialog box that page numbers are
to be included in a header or footer box, the Set Page # com-
mand tells Works what number to begin numbering pages with .

Set Starting Page # : 1

f~	OK	~l

In the Set Starting Page # box, type the page number for the first
printed page. Works proposes 1 . Then click OK.



The Font Menu

The commands in the Font menu tell Works which fonts to use
to display and print a document . The preset font for the Works
Word Processor is Boston 10 .
You can change fonts before you type text by selecting the font
you want and then typing the text . Or you can change the font of
text already in your document . Just select the text, then choose a
font. The font of the selection will be changed, but the styles and
sizes will remain unchanged.
You change styles and sizes with the Style menu .

Note If you are using a LaserWriter printer, you should replace
the Boston font with a font recommended for the LaserWriter,
such as Times or Helvetica. For more information, see your
LaserWriter manual .

To save space on your disk, you should use the Font Mover to
remove those fonts and sizes that you don't use . For more infor-
mation, see your Macintosh owner's guide .

The Style Menu

The Style menu commands tell Works which type styles (such as
Bold or Underline) and type sizes to use in displaying and printing
a document .
The sizes shown in outline type on the menu are those recom-
mended for the font currently selected on the Font menu. You
can choose any size for any font, but those that are not recom-
mended will produce a rougher appearance .
Choose the styles and size you want, then start to type .
If you want to change the styles and sizes of previously typed
text, select the text, then choose the commands you want . The
checkmarks on the menu indicate those commands currently
in effect.

Only one size can be checked at a time . However, you can check
multiple styles, such as Bold and Underline . When you choose
Normal Text, all other style characteristics are cancelled .
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Font
/Boston
Athens
Monaco
Geneva
Chicago

Style
,/Normal Text
Bold

	

. . B
I telir.

	

I

Underline
Oa~Daao
ad~7d0~
Superscript
Subscript

.. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . .. . . .. . . . . . . . . . . . . . . .. . . . .

D Poao~
fl 0 POaa~
fl Poao4
14 Point
fl POeot
~0 PoOo4
~ 1 Poao~
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Some of the choices from the Style menu are illustrated below .

r

	

File Edit Window Search Format Font Style

_E1	 Article (l1IP)
0

	

2

	

3

	

4

	

5

	

6

The new Hilltop Climber will hit the slopes in the
sponsored by the T .i •

	

Jar- B tiscJe c rr

Teams from
the tough me

Fireworks i

At major sto
cities will tur

St. Etien e
Geneva
Chamon1

Outline

~Ift ash¢ ~bop¢a9

round the world will challenge each other on
untain slopes of France, Swit.~erland, and Italy .

the Alps

s along the way, citi ens of Alpine towns and
i out to greet the raders with fireworks displays .

May 10th
May 15
Ma 18

Underline
Bold

Lucerne
?urich
Chur

Italic
Plain

I\IIay 28th
May 29
Tune 3

Shadow
Superscript



The Database

The Works Database automates your filing system . With your
information stored in the Database, you'll have quick access to any
combination of records . If you want a list of sales leads in Cincin-
nati, or restaurant names that begin with "S" in Buffalo, just ask
the Database. If the information is there, the Database will find it .
Printed reports put Database information down on paper . From
one set of information, you can print many different reports . Each
report will contain just the particular information you want to
pull from the Database document .
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This part of the manual explains how to create and use Database
documents :

•

	

Chapter 6, "Creating a Database Document," shows you two
ways to view a Database document, and how to create a new
Database document and add information to it . It also explains
how to correct mistakes as you make your entries .

•

	

Chapter 7, "Editing a Database Document," shows how you
can change your information or the way it's presented . It also
explains how to use computed fields .

•

	

Chapter 8, "Organizing a Database Document," shows you how
to quickly put your information in order, how to find what you
need, and how to make several smaller, specialized Database
documents out of one large one.

•

	

Chapter 9, "Making a Report," shows you how to define and
print a report . You'll learn how to sum the contents of your
fields and produce a grand total at the end .

•

	

Chapter 10, "Database Command Reference," describes the
commands you can use with the Database .

If you want to merge Database information into a Word Processor
document, see Chapter 21, "Merging : Creating Mailing Labels,
Form Letters, and Forms ."



6 Creating a Database Document

This chapter explains how to get started with the Database .
It shows you how to :

•

	

View a Database document in a form window and a list
window.

•

	

Set up a new Database document .
•

	

Add new fields .
•

	

Switch between list and form windows .
•

	

Make entries .

An Overview

When you first create a new Database document, you set up fields
to contain information . After you set up a field, you also deter-
mine how you want it to store information as text, perhaps, or
as a date or number. Once you've specified all your fields, you're
ready to add information .
You can add information to a form or a list . Because a form shows
all the fields on the screen at one time, it's easier to enter full
records using a form . If you only have a few fields, however, you
may find it easier to make entries to a list . Either way, all the
information goes into a single Database document. You can organ-
ize and review your information in either a list window or a form
window.
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Looking at a form

	

Looking at a Form

When you first set up a Database document, you create a form

and fill it out.

First Name

Last Name

Salutation

Company

Title

(Barbara

Smith

1 Ms .

Board Member 1

Entry bar

r

	

File Edit Window Organize format Report

=_p	 Addresses (08)

wheeler BicU cle C 'rrip .any

Looking at a list

	

Looking at a List

Address

City

State

lip

12122 Broad Street

flew 0rleans

LA

17010 1

Birthday Jariuar'a 1 , 1 9 1

i5ii4i 111 -2222

Record

This example from an address file shows a single record in a form

window. All the information about one person or subject the

name, address, and so forth makes up one record .

Each record is divided into fields of information . The address is

one field, the city and state are others. Each field has a name so

that you know what sort of information to fill it with . And when

you enter information for example, "2122 Broad Street" you

make an entry in a field . Sometimes, entries are called field data .

When you want to see many records at once to make compar-

isons, for example you can list them .



Deselect box

i File Edit W

LI	 Addresses (DO)	
First Name Last Name
Barbara. . . . . . . . . . . . . . .
Thomas. . . . . . . . . . . . . . .
Hiram. . . . . . . . . . . . . . .
Paul. . . . . . . . . . . . . . .
Homer. . . . . . . . . . . . . . .
Robert. . . . . . . . . . . . . . .

. . . . . . . . . . . . . . .

Smith. . . . . . . . . . . . . .
Reinhardt. . . . . . . . . . . . . . .
Wheeler. . . . . . . . . . . . . . .
Winthrop

	

Mr .. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . .
Winslow

	

Mr .. . . . . . . . . . . . . . .

	

. . . . . . . . . . .
Sawyer

	

Mr .. . . . . . . . . . . . . . .

	

. . . . . . . . . .
Schmidt

	

Miss. . . . . . . . . . . . . . .

	

. . . . . . . . . .
Dolan

	

Mr .. . . . . . . . . . . . . . . .

	

. . . . . . . . . .
Poulin

	

Mrs .. . . . . . . . . . . . . . .

	

. . . . . . . . . .
Stanton

	

Ms .. . . . . . . . . . . . . . .

	

. . . . . . . . . .
. . . . . . . . . . . . . . .

Entry or field data
Record selector boxes

Remember that a Database document can be much larger than

a window. You move around a large document by scrolling .

The scroll bars at the right and bottom of the window show you

where you are in a Database document and enable you to scroll .

If the document is not larger than the window, no scroll bars

will appear.

Salutation Address

	

I Ciity
Ms .

	

2122 Broad Street. . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .
Mr .

	

1212 Evergreen Lane

Mr	1 020 Wheeler Way. . . . . . . . . . . . . . . . . . . . . . . . . .

Entry bar

	

Field name

inflow Organize Format Report

11 22 Haught Drive. . . . . . . . . . . . . . . . . . . . . . . . . .
72 Maritime. . . . . . . . . . . . . . . . . . . . . . . . . .
3999 Duke Street. . . . . . . . . . . . . . . . . . . . . . . . . . .
3957 Palm Court. . . . . . . . . . . . . . . . . . . . . . . . . .
9357 Circle Court. . . . . . . . . . . . . . . . . . . . . . . . . .
111 Maple Street. . . . . . . . . . . . . . . . . . . . . . . . . .
3976 Cherry Court. . . . . . . . . . . . . . . . . . . . . . . . . .

Planning a Database Document

New Orleans. . . . . . . . . . . . . . . . .
Santa Clara
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State

LA

CA. . . . . . . . . . . . . . . . . . . . . . . . . . .

Zip

70101

95050 . . .
Wheelerville

	

OH

	

44444. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .
Hillside

	

NY

	

10800. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .
Chicago

	

IL

	

60609. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .
Chicago

	

IL

	

60610. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .
Wheelerville

	

OH

	

44444. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .
Cincinnati

	

OH

	

39555. . . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . .
Wheelerville

	

OH

	

44444. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .
Cincinnati

	

OH

	

44839. . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .

Record

Horn
(504

(415

(614
(914

(312

(312

(614
(373

(614
(373

There's nothing complicated about setting up a Database docu-

ment. It's easy to rearrange your information with the Works

Database you can play with your document until it looks just

the way you want. But a little bit of advance planning might help .

The most important thing to remember is that you work with

your Database information using the fields you set up .

For example, if you set up an address list, you could set up two

fields, "Name" and "Address" . Your first record might look some-

thing like this :

r

		

,
File Edit Window Organize Format Report

=p	 Untitled (DB)

(Name
jHiram Wheeler

Address11020 Wheeler Way,Wheelerville, OH I

Planning a Database

document
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A Database document like this has room for everyone's name and
address. But it's not designed well for searching or sorting . A
better way to set up a document like this is to make a separate
field for each component that you might want to search for or
sort on :

F

	

File Edit Window Organize Format Report

0

I Hira m
Wheeler

M

Wheeler Bicycle Company

Chairan

(614) 432-1235

1 020 Wheeler Way

Wheelervilie

IOH

44444

January 3, 1938 ,

Setting Up a New Database Document

To set up a new

	

When you set up a new Database document from scratch, you
Database document

	

have to create a new Works document. Because there's no infor-
mation in the document yet, Works asks you to set up fields first .
After you name one or more fields, you'll be able to start entering
your information.

Create a new Database document. (Choose New from the
File menu .)
Works creates an empty document with the name "Untitled,"
and asks you for the name of the first field .

Now you can find all the people who live in Ohio, or work for the
Department of the Interior. Or anyone whose first name is John
and whose zip code is 44444 . Or any combination you can think
of. Even if you don't set up fields in the most useful way when
you first create a new Database document, you can always go
back and add new fields at any time .



4

•

	

Type the name of your first field .
A field name must begin with a letter, and it cannot contain
certain characters, such as asterisks, parentheses, or hyphens .

•

	

Click the Add Field button or press the Return key.
The new field with the name you typed appears in the form
window, and the dialog box reappears so that you can set up
another field .

Field Name :

Untitled2

: Done ) tRdd Field,

Type a name for the second field and for as many other fields
as you want .
Works adds each field below the previous one .

•

	

Click the Done button when you've added all the fields you
want .

The dialog box disappears, and the first field is selected .
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To add a new field

Adding a New Field

You can add a new field whenever you want.

a Choose Add New Field from the Edit menu .
Works displays a dialog box asking you for the field name .
Type a name for the field .
Click the Add Field button or press the Return key .

If you're in a list window when you add a field, Works adds the
field to the right of the rightmost field and scrolls to the new
field. Works puts the field name at the top of the new column .

New field in a list

r

	

File Edit Window Orgonize Format Report

a
Work Phone

504) 222-1111. . . . . . . . . . . . . . . . . . . . . .
415) 333-4444. . . . . . . . . . . . . . . . . . . . . .
614)432-1235. . . . . . . . . . . . . . . . . . . . . .
212) 121-2121. . . . . . . . . . . . . . . . . . . . . .
312) 343-3434. . . . . . . . . . . . . . . . . . . . . .
312) 999-6666. . . . . . . . . . . . . . . . . . . . . .
614) 432-2939. . . . . . . . . . . . . . . . . . . . . .
373) 387-3877. . . . . . . . . . . . . . . . . . . . . .
614)747-7474. . . . . . . . . . . . . . . . . . . . . .
614) 393-3939. . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . .

May 3, 1955. . . . . . . . . . . . . . . . . . . . . . .
June 23, 1949. . . . . . . . . . . . . . . . . . . . . . .
April 18, 1958. . . . . . . . . . . . . . . . . . . . . . .
October 20, 1961. . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . .

Addresses (OR)
Birthday

	

Title

January 1, 1931

	

Board Member. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
Januarly 2, 1928

	

Board Member. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
January 3,

	

1838

	

Chairman. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
January 4, 1948

	

Board Member. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
March 28, 1950

	

Board Member. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
December 5, 1941 Board Member. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
Secretary. . . . . . . . . . . . . . . . . . . . . . .
Lawyer. . . . . . . . . . . . . . . . . . . . . . .
Assistant. . . . . . . . . . . . . . . . . . . . . . .
Office Manager. . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . .

Company

	

Name of Spouse

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

Wheeler Bicycle Con-. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Con-. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Con-. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Con-
Wheeler Bicycle Con-. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Corr. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Corr. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Corr. . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Corr. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Wheeler Bicycle Con-. . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

If you're in a form window when you add a field, Works adds
the new field in the first blank area it finds that is large enough
to accommodate a field .



r

	

File Edit Window Organize Format Report

	

,

_O	 Addresses IOU)

First Name

Last Name

Salutation

Company

Title

York Phone

Hiram

'Wheeler

Mr .

Name of Spouse

Wheeler Ehusycle C:ornpany

Chairman

(514) 432-1235

Address

City

State

Zip

Birthday

Home Phone

New field in a form

1 020 Wheeler 'W .yy

Wheeler iille

OH

. 44444

I ,January 3 :1

1(5141 432-1234
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You can move any field at any time when you're using the Data-
base. Notice, however, that the position of a field in the list win-
dow is not related to its position in a form window. For more
information, see the two sections on sizing and arranging fields
in Chapter 7 .
There's also another way to add a field in a form window . Move
the pointer to wherever you want the upper-left corner of the
field to be. Then hold down the mouse button and drag to the
right far enough to accommodate the field name and field data .
When you release the button, Works displays a dialog box asking
you for the field name .
If you're making a new Database document, each field in a form
window consists of a double box, with the field name in one box
and space for your entry in the other box .
The Format menu lets you change the way fields show up on the
form. For example, in the previous illustration, there are no boxes
around the field names . To find out how to change the format of
your field, see "Changing the Appearance of Fields in a Form
Window" in Chapter 7 .
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To switch by
choosing a command

To switch by
clicking the mouse

Switching Between List and Form Windows

You can switch between list and form windows by choosing a
command or clicking the mouse .
To switch windows by choosing a command :

0 Choose Show List or Show Form from the Format menu .

If you pull down the Format menu when you're in a list window,
the first menu item switches to Show Form, so that you can go
back to the form when necessary .

You can also move between list and form windows by clicking
the mouse .
To move from a form window to a list window :

0 Double-click anywhere in the white space of a form window .

Works displays the list, and scrolls to display the record that was
displayed in the form window.

To move from a list window to a form window :

Double-click the box to the left of any record .0

Works displays the form, with the record you selected showing .

Making an Entry

To make an entry

	

An entry is the content of a field for a single record . An entry can
be blank or it can contain some information. To enter information
into an entry, you first select the entry, then start typing . You can
type information into an active entry in your Database document
in either a list window or a form window. When an entry is
active, you can change its contents.
To make a Database entry :

0 Select an entry by clicking it .
The entry you click becomes the active entry .



F

1

_~	 Addresses (OD)
Work Phone

,504) 222-1111
415)333-4444
614)432-1235
212)121-2121
312)343-3434
312) 999-6666
.614) 432-2939
373) 38?-3877
614) 747-7474
614) 393-3939

=D

In a list window, you can select an entry only in a record that

already contains information, or in the first blank record .

r i File Edit Window Organize Format Report

1

First Name I

(Last Name I

Salutation I

Company

Title

(York Phone
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Click an entry to select it.

File Edit Window Organize Format Report

Barbara

Smith

Ms .

Wheeler Bicycle Company

Board Member

(504) 222-1111

Start typing.

When you type, the information appears in the entry bar at the

top of the screen (but not in the active entry) . The cancel box

and the enter box appear to the left of the entry bar.

Birthday		(Title
January 1 , 1931. . . . . . . . . . . . . . . . . . . . . . .
Januarly 2, 1928
January y .3.,. 1938. . . .

	

.

May 3, 1955	:	
June 23, 1949. . . . . . . . . . . . . . . . . . . . . . .
April 18, 1958. . . . . . . . . . . . . . . . . . . . . . .
October 20, 1961. . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . .

Board Member. . . . . . . . . . . . . . . . . . . . . . .
Board Member. . . . . . . . . . . . . . . . . . . . . . .
Chairman. . . . . . . . . . . . . . . . . . . . . . .

January 4, 1948

	

Board Member
March .28 , .1 950	Board. Member	
December 5, 1941 Board Member. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
Secretary. . . . . . . . . . . . . . . . . . . . . . .
Lawyer. . . . . . . . . . . . . . . . . . . . . . .
Assistant
Office Manager. . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . .

Addresses (DD)

Address I

City I

(State I

(zip I

I Birthday I

Home Phone

Click anywhere in a field

to select the entry.

(Company

2122 Broad Street

New Orleans

LA

70101

Wheeler Bicycle Co
Wheeler Bicycle Con-
Wheeler Bicycle Con
Wheeler Bicycle Con
Wheeler .Bicycle e .Con
Wheeler Bicycle Con
Wheeler Bicycle Con-
Wheeler .Bicycle e .Con
Wheeler Bicycle Con
Wheeler Bicycle Con-. . . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . .

January 1 , 1918

504) 111-2222

Name of Spouse

,
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To enter what you
type

r

	

File Edit

If you make a mistake, you can make corrections or cancel the
typing. The cancel box restores the entry to what it was before
you began typing. The enter box enters what you type .
The Database can read times and dates in most formats that you
might want to use, but converts them to its own standard formats .
For information about typing dates and times, see "Changing the
Format of a Field" in Chapter 7 .
You can type up to 250 characters for an entry . Even if the field is
too narrow to display all the characters, you will see the full entry
in the entry bar .
To put information into the Database, you enter it . When you
enter information, you tell the Database that you're finished typ-
ing. The Database stores the entered information as an entry.
To enter information in a list window :

Do this

Click here to undo your typing.
Click here to enter your typing .

Window Organize Format Report

Tot

Click the enter box
or press Enter
Press Return

Press Tab

Press Shift-Return

Press Shift-Tab

To enter the information and

Leave the selection where it is .

Move the selection to the same field in
the next record .
Move the selection to the next field in
the same record .
Move the selection to the same field in
the preceding record .
Move the selection to the preceding field
in the same record .



To enter information in a form window :

Do this

Click the enter box
or press Enter
Press Return

Press Tab

Press Shift-Return

Press Shift-Tab

To enter the information and

Leave the selection where it is .

Move the selection vertically to the next
field in the same record.
Move the selection horizontally to the
next field in the same record .
Move the selection vertically to the
preceding field in the same record .
Move the selection horizontally to the
preceding field in the same record .

In a form window, if you press Return or Tab when the last field
in a record is selected, Works moves the selection to the next
record. If you press Shift-Return or Shift-Tab when the first field in
a record is selected, Works moves the selection to the preceding
record .
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7 Editing a Database Document

You'll often need to update your Database documents, changing

old information and adding new. This chapter explains how to :

•

	

Select information.

•

	

Change the appearance of fields in a form .

•

	

Change the way information is displayed in a field .

•

	

Calculate with the Database .

•

	

Rename a field .

•

	

Size and arrange fields in both form and list windows .

•

	

Divide a list window into panes .

•

	

Insert a record .

•

	

Show a grid.

•

	

Copy information .

•

	

Make corrections and remove information .

If you want to add new fields to an existing Database document,

see "Adding a New Field" in Chapter 6 .

If you want to rearrange and organize your information, rather

than change it, see Chapter 8, "Organizing a Database Document."

Selecting Information

Before you perform an action on any part of a Database docu-

ment, you select it. You can select entries, fields, or records . Then

you can perform actions like sorting, removing, or copying . When

you make any selection, Works displays the number of the record

containing the active selection at the left of the cancel box . This

number is called the record indicator .

In a list window, you can select an entry, a field (column), a

	

To select information

record (row), or a block of entries. You can also cancel (remove)

a selection by clicking the deselect box at the far left of the field

names.

97
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When you make a selection of more than one entry, only one
entry is active at a time. This entry is bordered in white . You can
move through the selection, moving the active entry, by pressing
the Return or Tab key .

e

Barbara

Rd dre
First Name Last Name Salutation Address

Smith. . . . . . . . . . . . . . . Ms .. . . . . . . . . . . . . .

sses (DB)
City (State (Zip

(504)
(415)

10800 (914). . . . . . . . . . .

	

. . . . . .

)

)
39555

	

(373)

(614)
44839

	

(373)

70101
95050

44444

60609
10

44444

(614

(312
606 (312

44444 (614

t

Click an entry to select it .
Double-click an entry to
change its field attributes .

r

	

File Edit Window Organiz

T .h.omas. . . . . . . . . . . . .
Hiram. . . . . . . . . . . . . . .
Paul. . . . . . . . . . . . . . .
Homer. . . . . . . . . . . . . . .
Robert. . . . . . . . . . . . . . .
Shelley. . . . . . . . . . . . . . .
Richard. . . . . . . . . . . . . . .

f
Leslie. . . . . . . . . . . . . . .
Susan

First Name

Last Name

Salutation

Company

Title

York Phone

Reinhardt

Wheeler. . . . . . . . . . . . . . .
Winthrop. . . . . . . . . . . . . . .
Winslow. . . . . . . . . . . . . . .
Sawyer. . . . . . . . . . . . . . .
Schmidt. . . . . . . . . . . . . . .
Dolan. . . . . . . . . . . . . . .
Poulin. . . . . . . . . . . . . . .
Stanton

Click here to select all entries in a record .
Click the deselect box to cancel a selection .

In a form window, you can only select an entry .

Click anywhere in a field to select the entry .

F

	

File Edit Window Organize Format Report

E; .~r-b .-r .,

Smith	I
(Ms .

Name of Spouse

Double-click an entry to
change its field attributes .

Barbara

Wheeler Bicycle Company

E:c r-d r tern ber

1(504)222-1111 I

2122 Broad Street New Orleans

	

L A
Mr :

	

1212 Evergreen Lane. . . . . . . . . . . . . . . . . . . . .
Mr .

	

1 020 Wheeler Way

Mr .

	

1 122 Hau ht Dr .. . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . .
Mr .

	

72 Maritime. . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . .
Mr .

	

3999 Duke Street
Miss

	

3957 Palm Court. . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . .
Mr . 9357 Circle Court
Mrs . 111 Male Street
Ms .

	

3976 Cherry Court

Addresses (DB)

Address

City

State

Zip

Click a field name to select
all entries in the field .
Double-click a field name
to change its name .

Format Report

New Orleans

(LA

170101	1

Birthday

Home Phone

Santa Clara. . . . . . . . . . . . . . . . . .
Wheelerville

Hillside. . . . . . . . . . . . . . . . . .
Chicago. . . . . . . . . . . . . . . . . .
Chicago. . . . . . . . . . . . . . . . . .
Wheelerville. . . . . . . . . . . . . . . . . .
Cincinnati. . . . . . . . . . . . . . . . . .
Wheelerville. . . . . . . . . . . . . . . . . .
Cincinnati

12122 Broad Street

January 1,1931	I

1(504)111 -2222

Double-click a field name
to change its name .

,



In either type of window, when you select an entry, it becomes

active and you can change its contents in the entry bar. When you

select a field, you can move it, size it, change its name, or change

its attributes .

The content of the active entry is displayed in the entry bar . Even To select in the

though it is not highlighted, it is selected ; anything you type will

	

entry bar

replace what is displayed. To edit the entry, you can select any

part of it .

Double-click to select a word,

or drag to select more text.

F-

D

D

1

First Name (Last Name Salutation
Barbara. . . . . . . . . . . . . . .
Thomas. . . . . . . . . . . . . . .
Hiram. . . . . . . . . . . . . . .
Paul. . . . . . . . . . . . . . .
Homer. . . . . . . . . . . . . . .

File Edit Window

menu .

on

Smith

	

Ms .. . . . . . . . . . . . . . .
Reinhardt

	

Mr .. . . . . . . . . . . . . . .
Wheeler

	

Mr .. . . . . . . . . . . . . . .

. . . . . . . . . . . . . . .

2122 EIri ~aii

. . . . . . . . . . . . . .

. . . . . . . . . . . . . .

. . . . . . . . . . . . . .
Winthrop

	

Mr .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Winslow

	

Mr .	:	

. . . . . . . . . . . . . .

Addresses (OR)	

2122' E;road Street

1212 Evergreen Lane. . . . . . . . . . . . . . . . . . . . . . . . . .
1 020 Wheeler Way. . . . . . . . . . . . . . . . . . . . . . . . . .
11 22 Haught Drive. . . . . . . . . . . . . . . . . . . . . . . . . .
72 Maritime. . . . . . . . . . . . . . . . . . . . . . . . . .
3999 Duke Street. . . . . . . . . . . . . . . . . . . . . . . . . .
3957 Palm Court. . . . . . . . . . . . . . . . . . . . . . . . . .
9357 Circle Court. . . . . . . . . . . . . . . . . . . . . . . . . .
111 Maple Street. . . . . . . . . . . . . . . . . . . . . . . . . . .
3976 Cherry Court. . . . . . . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . . . . .

Changing the Appearance

of Fields in a Form Window

When you set up a new Database document, the records are

displayed in a form window with borders around each field name

and each entry. The field name is in bold type, and the entry is in

plain type. You can change the way records are displayed to get

different effects .

To add or remove borders around field names or entries :

Choose Border Field Name or Border Field Data from the

Format menu .

Click to position the insertion point.

. . . . . . . . . . . . . . . . . . . . . . . . . . .
Wheelerville . , .
Hillside. . . . . . . . . . . . . . . . .
Chicago. . . . . . . . . . . . . . . . .
Chicago. . . . . . . . . . . . . . . . .
Wheelerville. . . . . . . . . . . . . . . . . . . . . . . . . . .
Cincinnati. . . . . . . . . . . . . . . . .
Wheelerville. . . . . . . . . . . . . . . . .
Cincinnati. . . . . . . . . . . . . . . . .

To display field names or entries in bold type :
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(504
(415

44444 (614
10800 (914
60609

	

(312
60610

	

(312. . . . . . . . . . .

	

. . . . .
44444

	

(614. . . . . . . . . . .

	

. . . . .
(373
(614
(373

OH

	

39555. . . . . . . . .

	

. . . . . . . . . . .
OH

	

44444
OH

	

44839. . . . . . . . .

	

. . . . . . . . . . .

IHorn

Choose Bold Field Name or Bold Field Data from the Format

To put borders

around field names

or entries

To put field names or

entries in bold type

City State Zip
New Orleans L A 70101. . . . . . . . . . . . . . . . .

	

. . . . . . . . .
Santa Clara

	

C A 95050
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A command that is currently in effect is checked on the menu .
To remove a checkmark, choose the command .
Some of the different appearances you can create are shown
below. The commands you choose affect all fields and records
in a document .

_LI
First Name

Last Name

Salutation

(First Name

(Last Name

Salutation

(Barbara I
Smith

Ms .

Company Wheeler Bicycle Compani

Bold tiel~Bold field name
Border

Bold entry
Plain field name

Addresses (08)

Address

City

State

Zp

Address 1

State

2122 Broad Street

INew Orleans
LA

70101

Plain text
No border

2122 Broad Street

New Orleans

LA

70101

No border
Border

Changing the Format of a Field

There's more to formatting in the Database than using borders
or bold type . You can also set field attributes that determine what
kind of information can be kept in a field, and how that informa-
tion is displayed. For example, you can specify that a field named
"Total Cost" contain only numbers displayed as dollar amounts .
Field attributes apply to field data in both lists and forms . The nor-
mal settings are left-aligned plain text for non-numeric characters
and right-aligned Fixed format for numbers .
Field attributes include the type of field, the way numbers are
displayed, the alignment and style of text, and the number of
decimal places to be displayed. You can also specify that a
numeric field be computed or that a date field include the day
of the week.



With the Set Field Attributes command, you can customize the
appearance of your data whenever you want . Because the field
type determines which other attributes are available to you,
you should choose the field type first .
To set or change field attributes :

0

4

Select a field or an entry in the field .
•

	

Choose Set Field Attributes from the Format menu .
The Set Field Attributes dialog box appears .

•

	

Click the options you want for the field .
Click the OK button .
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To set or change field
attributes

For a complete description of the options available in the Set Field
Attributes dialog box, see "Set Field Attributes" in Chapter 10 .
When you specify a date field with the Set Field Attributes corn-

	

To type a date
mand, the Database gives you a choice of short, medium, or long
displays . You can also choose to have the day of the week dis-
played with the medium and long displays . You can type the date
in any of the following formats, and the Database will display it
in the form you chose in the Set Field Attributes dialog box :

•

	

08/10/86
•

	

8-10-86
•

	

8.10.86
•

	

08/10/1986
•

	

Sun, Aug 10, 1986
•

	

Aug 10, 1986
•

	

August 10, 1986
•

	

Sunday, August 10, 1986

Then, depending on the options you choose, Works displays the
date like this :

Display
Medium
Long

Show Day Unchecked
Aug 10, 1986
August 10, 1986

Show Day Checked
Sun, Aug. 10, 1986
Sunday, August 10, 1986

You can enter the current date in an entry by pressing
Command-D.
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To type a time

	

Works displays time using a 12-hour clock, even if you enter a
time in 24-hour format .

What is a computed
field?

If you don't use 24-hour time, remember to include the "am" or
"pm". If you don't specify this, Works displays "AM" .
You can enter the current time in an entry by pressing
Command-T .

Important You can change a text field to a date, time, or num-
ber field after you enter the data. However, if the data is not in
an acceptable format when you change the type of field, Works
deletes the data. You can change a date, time, or number field to
a text field and retain all your data .

Calculating with the Database

A computed field contains the results of a calculation based on
the contents of other fields . For example, a computed field in a
payroll Database document might calculate weekly wages by mul-
tiplying the "Hours Worked" field by the "Dollars Per Hour" field .
Computed fields aren't meant for complex numerical analysis .
They allow addition, subtraction, multiplication, division, and
exponentiation. (Exponentiation raises one number to the power
of another; for example, 2"2 = 4 and 13=8 .) In computed fields,
you can use all Spreadsheet functions, except those that use
ranges as arguments . For detailed information on the Spreadsheet
functions, see Chapter 15, "Spreadsheet Functions ." For making
projections or performing sophisticated calculations, use the
Spreadsheet .

If you type Works displays

8:04 8:04 AM
20:04 8:04 PM
8:4 pm 8:04 PM
20:4 8:04 PM



You designate a computed field in the Set Field Attributes dialog

	

To make a computed

box .

	

field

To make a computed field :

El

El

r

	

File Edit Window Organize
Format

Report

4

Select a numeric field .

Choose Set Field Attributes from the Format menu .

Click the Computed option.

Click the OK button.

Works returns you to the form or list you were looking at . The

equal sign in the entry bar shows you that Works needs a formula

for the calculation.
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To tell Works what you want to compute, you enter a formula .

A formula for a computed field can contain field names, operators,

functions, and numbers. To include a field name, you can either

type the name yourself or click the field name and have Works
put it in the entry bar for you . A formula can contain up to 238

characters .

To enter a formula

Requests (DB)

ood. . . . . . .
iquids

to

~d

Supplier

My Meat Company

City

Spokane

country

U' A ':1999:t:	

Telephone

3 r S-497 3

Total Cost

. . . . . . . . . . . . . . . . . . . . . . .
Etienne's Fish Shop

. . . . . . . . . . . . . . . . . .
Marseilles

. . . . . . . . . . . . . . . . . . . .
France 40-CICi-i7Q

Dickerson's

Care

Snack SF Holyhead Great Britain (1)4921 11111

2

treat

e saucy

CafE

	

Set
Will

kel l

	

Type:

Field

TeHt
Numeric
Date
Time

Iruldil

SComputed

Attributes For Total lost

Style :

Places

1
L Cancel

c?!7ttt

Bold
Underline
Commas

L

. . . . . . . . . . .

OK

Display : Align :
Left

~	

~rbos

~d

dgrouESpir

Brazi

, . , .

	

(Th

abr

k:o
"'

	

C)
Pek

Siar

Fitz

Pas .E'r Id 1

c.=) General
C) Fried
® Dollar`"

Percent

r IVr!'ii' .t'

_ Scientific

ISdIS~

2

C) Center
~i) Right

Decimal

. . . . . . .
and

. . . . . . . . . . . . . . . . . . . . . . .
pr Marca de Lopez

. . . . . . . . . . . . . . . . . .
Pamplona Spain 232 •

	

• 2
	 :	

•

S ~k, ,`, ` ~t. •2 }:2

I&I.I

k~ #> . }

l .! !.

	

I. 11f

	

. 1 .1

~f»

	

:}

	

t } sy

L

t #, . 2y, #

. . ~ k̀ ~t.~}

~ 2

~ < }

	

~#`.

	

,f~

` ~#, #~~`2>2
:~`;;,x

kk2 2

	 . • • •. ......I.•
? 2? 2k 2csik2t2 {2x#
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To rename a field

To enter a formula for a computed field, first follow the
procedure for designating a computed field, above . Then :

Type the formula at the insertion point .
It might look something like this :

El

Mathematical operator
First field name

r ~i file Edit Window

0

4

1

Supplier
ood

	

My Meat Company

quids . Etienne's Fish Shop
e

	

Dickerson's Snack Sr. . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
Dreiviertel Pfund. . . . . . . . . . . . . . . . . . . . . . .
Cafe Hansi

rest Williams's Fruit. . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
e sauc' Kelly 's Barbie Treat :. . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . .
A . Joshi Pastries. . . . . . . . . . . . . . . . . . . .
Abrahamsson Bakers

Konditori Andersen. . . . . . . . . . . . . . . . .
Peking Duck Mart

Renaming a Field

Drgunize

City
Spokane

Marseilles	
Holy head. . . . . . . . . . . . . . . . . .
Munich. . . . . . . . . . . . . . . . . .
Vienna

Christchurch. . . . . . . . . . . . . . . . . .
Melbourne. . . . . . . . . . . . . . . . . .
Jodhpur. . . . . . . . . . . . . . . . . .
Goteborg

Copenhagen. . . . . . . . . .
Beijing

Forma

~ a=Number on Teorn*I_:ost per F

	

r
=_Q	 Requests (DO)

County
IJSA

Fr.anc :e	

y

Great Britain. . . . . . . . . . . . . . . . . . . .
Germany. . . . . . . . . . . . . . . . . . . .
Austria. . . . . . . . . . . . . . . . . . . .
New cealand. . . . . . . . . . . . . . . . . . . .

•

	

Click the enter box or press the Enter key .

Works calculates the contents of the new field from the formula
you typed. If you included a nonexistent field name in the for-
mula, Works displays an alert box .

Selected entry
Second field name

t Report

Telephone
(999) 375-4973

40-0 CI -
. . . . . . . . . . . . . . . .

' :0492 .:' 11111. . . . . . . . . . . .
22 00 00
43 00 00
	-:' i rJiiO

456-777
674-444

756434

grouF S iro A nopoulos

	

olym is

	

Greece

	

1999

Works replaces the old name with the new one .

You can also double-click the field name to see the Field Name
dialog box .

$0 .00
$0 .00

$0 .00

$Ci .00

$Ci .OO
. . $0 .00

$0 ..00

$0 .00

$0 .00
$0 .00

If you decide to change the name of a field, you can rename it .
To rename a field :

Select the field .
•

	

Choose Change Field Name from the Edit menu .
The Field Name dialog box appears . The current name is
selected, so you can just type the new name to replace it .

•

	

Type the new name in the dialog box .
Click the OK button or press the Return key .



Sizing and Arranging Fields
in a Form Window

You can change the size and arrangement of fields in a form
window whenever you want .
To change the size of a field in a form window:

El

0

Position the pointer on the right edge of the field data box .
The pointer turns into a two-way arrow. (If you have removed
the borders from the field data, move the pointer to where the
box would normally be . When you're at the right place, the
two-way arrow appears.)
Hold down the mouse button and drag to the right or left until
the box is the size you want .

r

	

File Edit Window Organize Format Report

1

	

(999) 37-49735

Requests (DR)

(TeamIUSA

Requested FoodIHamburgers

(Local Supplier?IYes

Cost per PersonI $5 .10

(SupplierIMy Meat Company

CityISpokane

PeepsI	10

Comment I High-protein food
Available I May) June

CountryI US A

Press the mouse button here . . .
. . .and drag until the field is the size you want.

Position the pointer over the field name .
The pointer turns into a hand .
Drag the field to its new location .
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1ccc1

	

_4C47

You don't have to leave fields where you first create them .
Works lets you move fields to wherever they make the most
sense to you .
To move a field in a form window :

To change the size of
a field

To move a field
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To change the width
of a field

r

	

File Edit Window Organize Format Report

Requests (0B)	

El

1

	

10

Team I US A

(Requested FoodIHamburgers

(Local Supplier?IYesI

Cost per PersonI $5 .10

Supplier I My Meat Company

CityISpokane

Peeps Iii

(CommentIHigh-protein food

Available I May, June

(CountryIUSA (999) 378-4973(Telephone

If a field won't fit where you want to put it, you'll have to make
room for it. You can make it smaller, or make surrounding fields
smaller, or move another field out of the way . If you try to move
one field over another field, Works displays an alert box .

Sizing and Arranging Fields
in a List Window

The width or placement of fields in a new list may not satisfy you .
They're all the same width, and their order is based on the order
in which you first typed the field names. But in an address book,
for example, you might want the "First Name" field to be wider
than the "Middle Initial" field . And it would make more sense to
have "Last Name" as the first field, rather than "Zip Code" or
"State." Works lets you size and arrange your fields however
you want them at any time .
To change the width of a field in a list window :

Position the pointer on the right edge of the field name box .
The pointer turns into a two-way arrow .



F i File Edit Window

Team
USA
France
England
Germany
Austria
New Zealand
Australia
India
Sweden
Denmark
China
Greece

~~~~~ ~~ ~~~~ ~~~~~~
~~ .

.~~~
. .~ . . . .~ .~. . . .~~

narrow a field.

z~~m&~ ~o~~ ~~r~~ ~«^ adjust tu~~^~ ~~^~~^gux~u~4 size, a dotted ~~°~=~u~u~'
~~

	

~

	

shows ~~~~~

	

~-~r ~~v

~~'~~~~]~~~ ~~~~~ ~~e7~~ ~~^~K~K~ ~~'~ ~%~~~ ~~~~~^~ ~~,^~~ ~~~~,

~~,,~~1~aK~ ~K~ the

.--

	

-_~~ ..- .-- field

	

--- .-

~

	

.^~~`~ ~~K~ widen ~~~ field, or ~~~ ~~

	

~

	

.~u.~

	

right

	

~uu~~

	

~~~~u~~ ~~~~~ ~~ u ^~~ narrow ~~.

T^^ move a field in a list window :

~--~' ~^^^~~~~~'~ `^ ~--~' --~~--- ^~	~ field -field you want - ` ^

move,

Drag t~~ ~~ ~~~~l ^~ to t%~~~ ~~ ^^"~'t K~~~ l=~~,
~~

	

~~
~~ you drag, Works highlights * u~~e field names tu~~~~=~^~~

	

~~7~~~~

	

~

	

~ you

pass over .

Dragging

		

mx vv~x«the u~~ete^~ Food" field ~~~~
~ ~~~~ &~J~

F ^ -

	

-

	

-'^ 'File Edit
~~ NnK~o00

Organize Format
N~

	

~~
Report

.~

	

~

	

`~

Drag to the right to
widen a field.

~"~r'p~an".z ~ Format Report~

	

~
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Yes

'

^

To move a field

Requests 1DB ~
ITeam Peeps equested Fo o Cost per Person Local Available Immerlt

USA 1O Harriburqer $5 .1 U

	

Yes

	

May, .Jurie
France 7

	

~ $1 .50

	

Yes

	

May, June

	

Suoplennen

England 6 Fish arid c:hps $5 .40

	

No

	

May, June

	

English fav

Germany 8
Austria 5 $4 .25

	

Yes

	

May, June

	

High-prote~
, New 6 ~ $2 .70

	

No

	

January

	

South Paci

Australia 8 $6 .10

	

Yes

	

August, September Spicy barb

India 6 $2 .05

	

No

	

May, June
~ Sweden 5 $1 .95

	

Yes

	

May, Jijne

	

Fillinio

Denmark 6 $4 .60

	

Yes

	

May, June

	

Best with "

China 7 $5 .90

	

No

	

May, June

	

Rare et

~ !Greeoe

	

~ 5 $3 .95

	

Yes

	

Mayiune

	

Includes 3

May, June

	

High-proteir
May, June

	

Supplement
May ) June

	

English favu
May ) June

	

High-carbo ~
May, June

	

High-proteii
January SouthP
August ) September

	

barbe~:Spiog .,
May, June

	

Appetizer ~
May, June

	

Filling
May, June

	

~Best with br
May, June

	

Rare treat
~May, June

	

~Includes 3 fi

6 Fish arid Chips $5 .40 ~No
8 Brozen $1 .10 Yes
5 Wiener Schriitz' ~ $4 .25 Yes
6 Kiwis $2 .70 ~No

8 BarbequedShri $6 .10 Yes
6 Sarnosas $2 .05 No

5 Knaokebrod $1 .95 Yes
6 Poise $4 .60 Yes
7 Pressed Duck $5 .90 No

5 Moussaka $3 .95 Yes
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Works scrolls horizontally when you get to the edge of the
window.
When Works highlights the field that you want to be adjacent
to the field you're moving, release the mouse button .

The field you're moving is inserted to the left of the highlighted
field if you're dragging left, or to the right if you're dragging right .

Dividing a List Window into Panes

When you have a large Database document with many fields and
records, it can be time-consuming to scroll back and forth if you
want to compare information in entries that are far apart . To make
it easier for you to look at your information, Works provides split
bars that divide a list window into panes . The panes scroll
together along the direction of the split. The two panes on either
side of the vertical split bar scroll together vertically . The two
panes above and below the horizontal split bar scroll together
horizontally. Dividing a window into panes lets you hold one pane
stationary on the screen while you scroll through another pane to
find particular information .

To divide the window You can divide the window into both side-by-side and top-and-
into two panes

	

bottom panes .

0 Position the pointer on either the horizontal or vertical split
bar.
The pointer turns into a two-way arrow .
Drag the split bar until it lines up with the right edge of the
field or the bottom edge of the record at which you want to
divide the Database document.

When you release the mouse button, the list window divides into
two panes .



Team Humber on Team
Argentina. . . . . . . . . . . . . . . . .
Australia. . . . . . . . . . . . . . . . .
Austria. . . . . . . . . . . . . . . . .
Brazil. . . . . . . . . . . . . . . . .
Canada. . . . . . . . . . . . . . . . .
China. . . . . . . . . . . . . . . . .
Denmark. . . . . . . . . . . . . . . . .
Egypt. . . . . . . . . . . . . . . . .
England. . . . . . . . . . . . . . . . .
France. . . . . . . . . . . . . . . . .
Germany. . . . . . . . . . . . . . . . .
Greece. . . . . . . . . . . . . . . . .
Holland. . . . . . . . . . . . . . . . .
India. . . . . . . . . . . . . . . . .
Italy. . . . . . . . . . . . . . . . .

Requests (OR)
Requested Food I Cost per Person (Local Supplier?

Barbequed Shrimp. . . . . . . . . . . . . . . . . . . . .
"'iener :3chnitzel. . . . . . . . . . . . . . . . . . . . .
Lamb. . . . . . . . . . . . . . . . . . . . .
Pea Soup. . . . . . . . . . . . . . . . . . . . .
Pressed Duck. . . . . . . . . . . . . . . . . . . . .
Poise. . . . . . . . . . . . . . . . . . . . .
Dates. . . . . . . . . . . . . . . . . . . . .
Fish and Chips. . . . . . . . . . . . . . . . . . . . .
Bouillabaisse. . . . . . . . . . . . . . . . . . . . .
Brezen. . . . . . . . . . . . . . . . . . . . .
Moussaka. . . . . . . . . . . . . . . . . . . . .

Avail
1.ay, J

Yes Auqus .
h•1 .a y ,
h•1 .a y , .J
h~1 .vy , ~-
~~1 .vU ,

Jijiij

May
flay ,

June,

May, ,_
Play . ._
J. anuarI

r a File Edit Window Organize Format Report

With four panes, you can see even more parts of a Database doc-
ument at once because you can scroll each pane both vertically
and horizontally .
To divide the window into four panes :

0

r

Drag each split bar into the positions you want .

File Edit Window Organize Format Report

Egy pt
England
France
Germany
Greece . . .
Holland .. . . . . . . . . . . . . . . . .
India. . . . . . . . . . . . . . . . .
Italy. . . . . . . . . . . . . . . . .

5. . . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . .

5. . . . . . . . . . . . . . . . . . . . . . .
5. . . . . . . . . . . . . . . . . . . . . .
8. . . . . . . . . . . . . . . . . . . . . . .

9

Split bar in its initial position

i

Split bar that has been dragged to the right

Steaks. . . . . . . . . . . . . . . . . . . . .
Barbequed Shrimp. . . . . . . . . . . . . . . . . . . . .
'w'iener Schnitzel. . . . . . . . . . . . . . . . . . . . .
Lamb. . . . . . . . . . . . . . . . . . . . .
Pea Soup. . . . . . . . . . . . . . . . . . . . .

Dates . . . . . . . . . . . . . . .
Fi=.h and Chip_.. . . . . . . . . . . . . . . . . . . . .
Bouillabaisse. . . . . . . . . . . . . . . . . . . . .
Brezen. . . . . . . . . . . . . . . . . . . . .
Moussaka. . . . . . . . . . . . . . . . . . . . .
Goudse Kaas
Samosas. . . . . . . . . . . . . . . . . . . . .
Gnocchi. . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .
$1 .10

$2 .95
$2 .05

Chapter 7 Editing a Database Document 109

Nc'

	

July ,
No

	

May. . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . .
'Yes

	

May, J. . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . .
Yes

	

flay ,. . .
'Yes May, U. . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Yes

	

June,: . .
Nc' May ,. . . . . . . . . . . . . . . . . . . . . . . . . . . .
N':'

	

May ,
flay , J
Januar

,

To divide the window
into four panes
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To close a pane

To insert a record

Now you have four sets of scroll bars . Each scroll bar controls the
two panes that are in line with it. For example, the upper scroll
bar controls the two upper panes, and the left scroll bar controls
the two left panes. Otherwise, the scroll bars work normally .

To close a pane :

a Drag the split bar back to the far left or upper edge of the
pane .

Inserting a Record

You can add a new record between other records, in both a list
and a form window.
To insert a record :

0 Select a record in a list window, or scroll to a particular
record in a form window .
Choose Insert Record from the Edit menu .

Works inserts a blank record before the selected or displayed
record .

New blank record inserted in a list window

File Edit Window Organize Format Report

3
LI	 Requests lOB)

Number on Team (Requested Food Cost per Person Local Supplier? AvailTeam
LISA

	

10

	

Hamburgers

	

$5.10

	

''es

	

May,
r

	

auillab is - e

	

$1 .~CI

	

Yes

	

MaFrance

England
Germany. . . . . . . . . . . . .
Austria
New zealand . . .. . . . . . . . . . . . . . .
Australia. . . . . . . . . . . . . . .
India. . .

	

. . . . . . . . . . .
Sweden
Denmark
China

E.

b

5

. . . . . . . . . . . . . . . . .

Fish and Chips
8

	

Brezen
Wiener Schnitzel. . . . . . . . . . . . . . . . . . . . .

b

	

Kiwis
B

	

B.3rbequed Shrimp
}anlo= a=. . . . . . . . . . . . . . . . .

$5..40	
$1 .1 Ci. . . . . . . . . . . . . . . . . .
$4 .25. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
$2 .?0
$5 .10. . . . . . . . . . . . . . . . . . . . .$ L,CIC

. . . . . . . . . . . . . . . . . . . . . . . .

No

Knac:kebrod

	

:$1 .95. . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
P':'lse

	

$4 .50

	

Yes. . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Pressed Duck

	

$5 .9CI

	

Ni:'

May .,
Yes

	

May ). . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . .
Yes

	

N1 .ay , L

. . . . . . . . . . . . . . .

N -

	

anuar
Yes

	

Auqusi. . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . .
'1'es

. . . . . . . . . . . . . .



3

New blank record inserted in a form window

F

	

File Edit Window Organize Format Report

Requests (DB)

Team

(Requested Food!

(Local Supplier?

Cost per Person I

Supplier

ICity!

Showing the Grid

In a list window, lines separate each column and row . You can
choose to turn this grid on or off.

a Choose Show Grid or No Grid from the Format menu .

Here's how each choice looks :

F

	

File Edit Window Organize Formot Report

(Number on Team! I

(Comment!

Available !

ICountry!

Addresses (DO)

F

	

File Edit Window Organize
Format

Report

Addresses (DO)

ITelephone!
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,

~Mw

To show or hide the
grid

First Name !Last Name Salutation ! Address !City !State !Zip !Ho

Barbara Smith Ms . 2122 Broad Street New Orleans L A

	

70101 (504

Thomas Reinhardt Mr . 1212 Evergreen Lane Santa Clara C A

	

95050 (41 5

Hiram Wheeler- Mr . 1 020 Wheeler Way Wheelerville OH

	

44444 (61 4

Paul Winthrop Mr . 11 22 Haught Drive Hillside NY

	

10800 (91 4

Homer Winslow Mr . 72 Maritime Chicago IL

	

60609 (31 2

Robert Sawq eri Mr . 3999 Duke Street Chicago IL

	

60610 (31 2

First Name (Last Name (Salutation I Address City !State !Zip Ho

Barbara Smith

	

Ms 2122 Broad Street New Orleans LA

	

70101 (50 •. . . . . . . . . . . . . . .
Thomas Reinhardt

	

Mr 1212 Evergreen Lane Santa Clara C A

	

95050 (41. . . . . . . . . . . . . . . .. . . . . . . . . . . . . .
Hiram. . . . . . . . . . . . . . . Wheeler	Mr :	 1 020. . . . . . . .Wheeler Way. . . . . . . . . . . . . . Wheelerville. . . . . . . . . . . . . . . . . OH

	

44444 (61. .

	

. . . . .
Paul Winthrop

	

Mr . 11 22 Haught Drive Hillside NY

	

10800 (91

Homer Wiris low

	

Mr . 72 Maritime Chicago IL

	

60609 (31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

. .

	

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . .
Chicago

. . . . . . . . .
ILRobert Sawyer

	

Mr . 3999 Duke Street 60610 (31
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Copying Information

You can copy individual records, fields, or entries, and blocks of
records, fields, or entries . Copying within and between documents
saves you from having to retype similar information . For example,
if you have ten people in your address book who live in Seattle,
Washington, you can type the city and state once, and copy the
rest. Although you can copy in both list and form windows, it's
easier in a list window, because you can copy multiple records
at once .

To copy a record

	

Some records are only slightly different from one another . To save
time and typing, you can copy one of these records and change
the copies where necessary .
To copy a record :

El

4

To copy an entry

Works inserts a new row containing the copied information
above the selected row, and moves the following records down
to accommodate the new one .
There are times when you'll want two or more records to have
the same entry for a particular field . To copy an entry into the
same field of the next record :

0

Make sure you're in a list window .
•

	

Click the record selector box at the left of the record you
want to copy.

•

	

Choose Copy from the Edit menu .
Select the row where you want the copy to go .

•

	

Choose Paste from the Edit menu .

Select the entry below the one you want to copy.
•

	

Press Command-" .
Works displays the copied information in the entry bar .

•

	

Click the enter box or press the Return key .

Works copies the information into the selected entry .



~~^~ ~]~[=~~^~ ~K~~~~~^~p~~~~~

	

^~~

	

~~~^~~~U~ ^~
~-
~

	

~~ ~ ~~~~ -~~~~~~

	

copies ~~ an entry ~ ~~ l[ ~-~~-

	

~`-n-~~~~

Fl

F
m~ File Edit

NN'K~_~KD00 -~r`~~aK0'ze
Format Report

-

	

-

	

--

10

	

I

	

I Cincinnati

•

	

~~~~~^~ ~~~~r~~ you're `~~ ~~ ~~~~ window.-'~~~~~`~ ~

	

~

	

--~~

Select the entries you want to copy.

First Name jiast Name lsalutationlAddress
B arbara
Thomas
Hiram
Paul
Homer
Robert
Shelley
~Richard
Leslie
Susan
David

11

.

Smith ~Ms .
Reinhardt Mr .
Wheeler Mr~~~~~~~~~~~~~~~
\/inthropMr .
Wislow ~Mr .
Sawyer Mr .
Sohmnidt Miss
Dolan Mr .
Poulin Mrs .
Stanton Ms .
~Morgan

	

~Mr

[`iDCiDDafi

First Name Ilast Name Salutation Address

Addresses K DB)

21 22 Broad Street
1212 Evergreen Lane
1 020 Wheeler Way
11 22 Haught Drive
72 Maritime~
3999 Duke Street
3957 Palm Court
9357 Circle Court
111 Maple Street
3976 Cherry Court
9373 Manor Road

Drag the mouse to select
the en ' you

	

t to

•

	

Choose Copy from the Edit menu .

Select the entries to receive the copy .

•

	

Choose Paste from the Edit menu .

r
m~

File Edit NN'ndo00 Organize Format Report

jcity
New Orleans
Santa Clara
~Wheelerville
Hillside
Chicago
Chicago
Wheelerville
Cincinnati
Wheelerville

Icity
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Make sure there are empty
entries to receive the copy.

A ddresses 1DB)

State Zip

	

Home

-'

~~~~ N~~~~N~^~ multiple~~~~N ~~ mmm~~

copies ~~~ ~~~~ ~~N~~~~~
~~N ~www ~~mm~w

~

Barbara Smith M s .

	

2122 Broad Street

	

New Orleans 70101	 L A (504)~
Thomas Reinhardt Mr .

	

1212Evergreen Lane Santa Clara CA

	

95050 . (415)
Hiram Wheeler Mr

	

1 020 Wheeler Way Wheeler ille OH

	

44444 (614)
Pal Winthrop Mr

	

1122 Haught Dr .

	

Hillside NY

	

1O8OO ~(914)
Homer

	

~Winslo^x Mr .

	

72 Maritime

	

Chicago U.

	

6O6O9 (317)
~

Robert Sawyer Mr .

	

3999 Duke Street

	

Chicago IL

	

6O61O (312)
Shelleg Schmidt Miss

	

3957 Palm Court

	

\/heelerville OH

	

44444 (614)
Richard Dolan Mr .

	

9357 Circle Court

	

Cincinnati OH

	

.39555 (373)
Leslie Poulin Mrs

	

111 Maple Street

	

Wheelerville OH

	

~44444 (614)
Susan Stanton Ms .

	

3976 Cherry Court

	

Cincinnati OH

	

44839 (373)
David Mr .

	

9373 Manor Road I:: in i::inin, .t i OH

	

~.448~9 . (373)norgan .

	

.~ .

	

~

IState hip tHorn
LA

	

7O1O1 (5O
C4

	

~95O5O (41
OH

	

44444 (61
NY

	

10800
IL

	

60609 (31
UL

	

60610
OH

	

44444 (61
OH

	

39555 (37
~OH

	

44444 (61'
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To correct a typing
mistake

r

	

File Edit Window Organize Format Report

Now you can select these two blocks of entries to copy and paste
into the next two records .

El

4

10
p	 Addresses lOB)	
First Name (Last Name Salutation i Address
Barbara

	

Smith

	

Ms .

	

2122 Broad Street. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .
Thomas

	

Reinhardt. . . . . . . . . . . . . . .
Hiram. . . . . . . . . . . . . . .
Paul. . . . . . . . . . . . . . .
Homer. . . . . . . . . . . . . . .
Robert. . . . . . . . . . . . . . .
Shelley. . . . . . . . . . . . . . .
Richard. . . . . . . . . . . . . . .
Leslie. . . . . . . . . . . . . . .

_ Susan

David . .

Martin
Laura

Cincinnati

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Wheeler. . . . . . . . . . . . . . .
Winthrop. . . . . . . . . . . . . . .
Winslow. . . . . . . . . . . . . . .
Sawyer. . . . . . . . . . . . . . .
Schmidt
Dolan. . . . . . . . . . . . . . .
Poulin. . . . . . . . . . . . . . .
Stanton

Morgan

Cook. . . . . . . . . . . . . . .
Martin

Mr .

	

1212 Evergreen Lane. . . . . . . . . . . . . . . . . . . . . . . . . .
Mr .

	

1 020 Wheeler Way. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .
Mr .

	

11 22 Haught Dr .. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .
Mr .. . . . . . . . . . . . . . .
Mr .. . . . . . . . . . . . . . .
Miss

Mrs .. . . . . . . . . . . . . . .

Making a Correction

When you find a typing mistake in an entry, you can correct it .
To correct a typing mistake :

Select the entry containing the mistake .
•

	

In the entry bar, put the insertion point to the right of the
mistake .

•

	

Press the Backspace key to back over the entry .
Type the correction.

•

	

Click the enter box or press the Enter key .

72 Maritime. . . . . . . . . . . . . . . . . . . . . . . . . .
3999 Duke Street. . . . . . . . . . . . . . . . . . . . . . . . . .
3957 Palm Court
9357 Circle Court. . . . . . . . . . . . . . . . . . . . . . . . . .
111 Maple Street. . . . . . . . . . . . . . . . . . . . . . . . . .
3976 Cherry Court. . . . . . . . . . . . . . . . . . . . .
9373 Manor Road
9292 First Street. . . . . . . . . . . . . . . . . .
2838 Pine Valley

Select these entries . . .

JCity State lip

	

jHome
New Orleans L A 70101 (504)

Santa Clara C A 95050 (415)

Wheelerville OH 44444 (614)
Hillside

	

NY

	

10800 (914). . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . .

	

. . . . . . .
Chicago

	

IL

	

60609 (312). . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . .

	

. . . . . . .
Chicago

	

IL

	

60610
Wheelerville

	

OH

	

44444
Cincinnati

Wheeler yule

OH

OH
(~=mcinnati OH

	

44:339
Cirn_ innati

	

iiH

	

44839

39555 (373)

44444 (614)
(373)

(312)

(614)

(373)

. . ,and paste them here .

Then you can select the four identical blocks of entries and copy
and paste them into the next four records . You can repeat this
process to fill your records as often as you need to .

,.~



When you select text in the entry bar, you can replace it by

	

To replace selected
typing or by using the Cut, Copy, or Paste commands from the

	

text
Edit menu .
To replace selected text by typing :

El

a

Select text in the entry bar by dragging across it .
Type the replacement, or press the Backspace key to remove
the whole selection.
The text you type replaces the original text .
Click the enter box or press the Enter key .

The new text appears in the selected entry .

You can also select just one word of an entry in the entry bar by
double-clicking it .

Removing Information

Works lets you remove information from a Database document in
three different ways :

•

	

Cutting takes information out of a Database document and puts
it on the Clipboard. This is useful for cutting and pasting as
well as for removing information . You can cut records, entries,
and blocks of data .

•

	

Clearing permanently removes records, fields, entries, or
blocks. Cleared information does not go on the Clipboard .

•

	

Deleting a field removes a field from the Database document,
including the field name and all entries. This is useful for
removing an entire field that you don't need anymore .

If you delete a field or cut or clear information, then decide you
don't like the result, you can use Undo to put everything back .
If you cut a field or entry, Works cuts the contents, but leaves

	

To cut information
a blank field or entry in its place. If you cut a record, Works
removes the record and closes up the empty space .
To cut information :

Chapter 7 Editing a Database Document 1 1 5

0 Select the information you want to cut .
Choose Cut from the Edit menu .
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To clear information

Works takes the information out of the Database document and
places it on the Clipboard. You can paste what you cut back into
the Database document at a location you select .

When you clear information ; Works blanks the selected entries . If
you clear a field, entry, or record, Works clears the contents, but
leaves a blank field, entry, or record in its place .
To clear information :

Select the information you want to clear.
Choose Clear from the Edit menu .

El

a

El

Works removes the information from the Database document, but
does not put it on the Clipboard . If you reconsider, choose the
Undo command before you do anything else .

To delete a field

	

When you delete a field, Works removes it from the document
and closes up the space it left behind .
To delete a field :

Select the field.
Choose Delete Field from the Edit menu .

The field disappears . If you decide you really didn't want to delete
the field after all, you can use the Undo command .

To paste the contents If you cut a selection, you can paste it back into a Database docu-
of the Clipboard

	

ment at a location you select .
To paste the contents of the Clipboard :

Select a record or field, or the upper-left entry of a block of
entries that you want to paste to .

[. Choose Paste from the Edit menu .

Works fills in the selected entries with the information from the
Clipboard .



8 Organizing a Database
Document

This chapter shows you how to organize a Database document
so that you can find information easily .
You'll learn how to :

•

	

Sort information. Put your information in alphabetical, numeri-
cal, or chronological order, backwards or forwards .

•

	

Find information. Scroll to view those fields that contain the
characters you specify .

•

	

Match records . Quickly call up the records that contain the
information you specify .

•

	

Use record selection rules . Use up to six criteria to have
Works show you records with specific information only .

By using record selection rules and then saving the selected
records with another name, you can create subsets of your Data-
base document . This chapter shows you how.

Sorting Information

If your records aren't in the order you want, you can sort them .
Sorting arranges records in alphabetical, numerical, or chronologi-
cal order, either backwards or forwards . You can sort on any field,
in both form and list windows.
Sorting is more than just putting A before Z in your Database
document. You can do successive sorts on different fields to
group your records just the way you want them . Each sort is
done individually by repeatedly choosing the Sort command .
For a multi-level sort, you first sort on the field you're least
interested in. For example, to get an address list in order by last
name and then by first name, you'd first sort on the first name
field. For each level of a multi-level sort, Works retains the order
of all previous sorts .

117
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To sort

Multi-level sorting lets you presort a large mailing, for example .
You can group the records in your mailing list in order by last
name, first name, city, state, and zip code . When you put labels
on your mass mailing, it will already be sorted by each of these
categories .
Depending on the type of information a field contains, the Sort
command from the Organize menu presents different options :

If you select
this type of field

	

You can choose these options

Text

	

Alphabetical order or reverse
Numeric

	

Numerical order or reverse
Date or Time

	

Chronological order or reverse

Note There are some instances when you may want to put
numbers into a text field rather than into a numeric field . For
example, a numeric field cannot show the leading zero in a zip
code such as 08080, so a field containing zip codes should usually
be text .

To sort information :

Select the first field you want to sort on .
You can either click the field name or select any number of
entries in a field to select the field to sort on.
Choose Sort from the Organize menu .
Works tells you which field you're sorting on, and gives you
a choice of sorting sequences .

El
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~
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Repeat the procedure for any other fields you want to sort on .
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Finding Information Quickly

To find information

	

Sometimes you need to locate specific information in a Database
quickly

	

document. For example, suppose you want to find the entries in
the Requests sample document that mention "Pressed Duck ."
To find the entries :

0 Choose Find Field from the Organize menu .
Works displays a dialog box .
In the text box, type the information you're looking for .
Click the Find Next button .

Works highlights the first entry that contains your information .
When Works looks for the information, it searches all fields in one
record, then searches the next record, and so on .

F ri File Edit Window Organize Format Report

Pressed Duck

Requests (DB)
Number on Team Requested Food I Cost per Person Local Supplier? Araila

Yes

	

May, Ju
Yes

	

August, : . : . : .

Yes

	

May, Ju

No

	

May Ju

Yes

	

Ma Ju

f	
No May, Ju

Yes May, Ju

No Jul Al
Na May, Ju
Yes May Ju
Yes May Ju
Yes

	

Ma JU

Steaks. . . . . . . . . . . . . . . . . . . . .
Barbequed Shrimp
Wiener Schnitzel .. . . . . . . . . . . . . . . . . . . . .
Lamb. . . . . . . . . . . . . . . . . . . . .
Pea Soup

Freed Crock:

Poise

6. . . . . . . . . . . . . . . . . . . . . . .
8. . . . . . . . . . . . . . . . . . . . . . .
5. . . . . . . . . . . . . . . . . . . . . . .
5. . . . . . . . . . . . . . . . . . . . . . .
8. . . . . . . . . . . . . . . . . . . . . . .

5

. . . . . . . . . . . . . . . . . . . . .
Dates. . . . . . . . . . . . . . . . . . . . .
Fish and Chips. . . . . . . . . . . . . . . . . . . . .
Bouillabaisse. . . . . . . . . . . . . . . . . . . . .
Brezen. . . . . . . . . . . . . .
Moussaka

$? .20. . . . . . . . . . . . . . . . . . . . . . . .
$6 .10. . . . . . . . . . . . . . . . . . . . . . . .
$4 .25. . . . . . . . . . . . . . . . . . . . . . . .
$5 .60. . . . . . . . . . . . . . . . . . . . . . . .
$1 .2G

$4 .6G. . . . . . . . . . . . . . . . . . . . . . . .
$2 .05. . . . . . . . . . . . . . . . . . . . . . . .
$5 .40. . . . . . . . . . . . . . . . . . . . . . . .
$1 .5G. . . . . . . . . . . . . . . . . . . . . . . .
$1 .10. . . . . . . . . . . . . . . . . . . . . . . .
$3 .95

6

Argentina. . . . . . . . . . . . . . . . .
Australia. . . . . . . . . . . . . . . . .
Austria. . . . . . . . . . . . . . . . .
Brazil. . . . . . . . . . . . . . . . .
Canada

china . . . . . . . . . . .
Denmark. . . . . . . . . . . . . . . . .
Egypt. . . . . . . . . . . . . . . . .
England. . . . . . . . . . . . . . . . .
France

Germany. . . . . . . . . . . . . . . . .
Greece

Matching Records

The Match Records command is a shortcut to seeing a subset of
a Database document. You type a few characters or words and let
Works match the records that contain that information . When
Works is done, you will be looking at only those records that
contain the information you specified .

To continue finding entries that contain the information you
specified, choose Find Field again. The characters you typed will
still be in the text box, so you just click the Find Next button .



You don't even have to type a whole word or number just
enough information to begin a match, like "Chi" when you're
searching for records containing "Chicago" .
Suppose you want to find all the records in the Database
document, Addresses, that contain the word "Hillside" :

0 Choose Match Records from the Organize menu .
Works displays a dialog box .
In the text box, type the information you want Works to look
for. For this example, you would type Hillside

L i Click the OK button.

Works displays any records that contain your information . If none
does, Works tells you so, and lets you try again .

All records that contain Hillside

File Edit Window Organize Format Report

D

E	Addresses (OB)
First Name Last Name Salutation Address

	

City

	

State Zip

	

Ho

Paul. . . . . . . . . . . . . . . . .
Shirley. . . . . . . . . . . . . . . . .
Jeanne. . . . . . . . . . . . . . . . .

Winthrop

	

Mr .

	

1 122 Haught Dr .

	

Hillside

	

NY

	

10800

	

(91. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .

	

. . .
Hanes

	

Ms .

	

2310 Hillside Dr .

	

New Orleans

	

LA

	

70101

	

(SC. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .

	

. . .
Ms .

	

1301 Cherry Lane

	

Hillside

	

NY

	

10800

	

(91. . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . .

	

. . . . . . . . .

	

. . . . . . . . . . .

	

. . .Barnes
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To find matching
records

Match Records is a limited command you can't do anything
with the displayed records except scroll them, view them in a
form window, remove the grid, or print the window . You can also
cut, copy, or clear the information .
To be able to see all the records and use the rest of the Database

	

To see all records
commands, you must go back to the full Database document .

Choose Match Records again to remove the checkmark on the
menu .

Works displays all your records and makes available all the Data-
base commands .
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Using selection rules

Parts of a selection
rule

Using Selection Rules

When you're looking for very specific information, you can set
up record selection rules . Works follows your selection rules as
it searches for the information you want . Then Works shows you
only those records that meet your selection rules . Selection rules
are especially useful when you want to print your information in
a report.

How Selection Rules Work

Record selection rules aren't as complicated as they sound . You
go through a record selection process yourself when, for example,
you look in your address book for people who work in San Diego .
You tell yourself, "Look for people who are business associates
and work in San Diego ." Or, in the language of selection rules :
"Type" field contains Business, and "Location" field contains San
Diego.
In the same way, you use selection rules in Works to find informa-
tion that meets your criteria, usually to make some sort of deci-
sion. For example, the auditor of a department could have Works
find all months in which the department director spent over the
allotted S300 per month and months in which the director trav-
eled frequently, to see the impact of travel on the budget .
A record selection rule is made up of three components : a field
name, a comparison phrase, and some record comparison informa-
tion. The field name corresponds to a field in the active Database
document. The comparison phrase comes from the following list :

•

	

equals ∎ is not blank
•

	

is greater than ∎ contains
•

	

is greater than or equal to ∎ begins with
•

	

is less than ∎ ends with
•

	

is less than or equal to ∎ does not contain
•

	

is not equal to ∎ does not begin with
•

	

is blank ∎ does not end with

For text fields, you'll have all the above phrases available . For
numeric, date, or time fields, you'll have the first eight of the
above list .

The record comparison information is what you type yourself to
have Works use for the comparison .



To make a simple record selection rule :

U

4

Choose Record Selection from the Organize menu .
A dialog box appears containing the fields in your Database
document, a list of comparison phrases, and a box in which
to type record comparison information .

Team
Requested Food
Local Supplier?
Au a liable
Number on Team

Record Comparison Information :

Selection Rules : No Rules fire I n Effec

Organize

Record Selection :

∎

Cancel

	

1

	

Delete Rule ,~

equals
contains
begins with
is greater than
is greater than or equal to

∎

Install Rule ,~		Select	

Fields in the open
Database document

Ii File Edit llJindow

Selection rules are displayed here .

Comparison phrases

Format Report
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Comparison information
goes here.

•

	

From the left box, select the field you want Works to use in
the comparison .
You may have to scroll to see all the fields in the box .

•

	

From the right box, select the appropriate comparison phrase .
You will need to scroll to see all the phrases .
Type the record comparison information in the space
provided .

•

	

Click the Install Rule button .
Works displays the completed selection rule .

To make a simple
selection rule

I 1

I I

I I I

I I

1 I

	

I I
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s

F

	

File Edit Window

O €€
r

Cancel

Organize

Team
Requested Food
Lo~:al Supplier?
Available
Number on Team

∎

Record Comparison Information :

Selection Rules : Local Supplier? is no equal to YES

•

	

And ® Or

0 Dr

•

	

€€ O €'
•

	

C) Dr

ODr

Delete Rule

Recorct Selection :

After you click Install Rule, Works
blanks out the Record Comparison
Information box, so you can type
something else for the next rule.

Setting up more

	

Setting Up More Complex Rules
complex rules

Format Report

is greater than
is greater than or equal to
is less than
is less than or equal to
is not equal to

∎

nstall Rule Select

Click the Select button to have Works find the records that
meet your selection rule .

Works searches through your Database document looking for
records that match up . It then displays just those records .
If Works can find no matches, it displays an alert box .

When you're looking at selected records, you see a subset of
the total Database document . The rest of the records are still in
memory.
If you want to look at all your records again, choose Show All
Records from the Organize menu . If you'd like to turn your selec-
tion into a separate Database document, see "Saving a Selection
with a Different Name" at the end of this chapter . You might want
to do this if you made a selection in order to give someone a sub-
set of your Database document, or to make mailing labels from a
subset of your document .

A single selection rule helps to find information but with
Works, you can be much more specific . Connectors ("And" and
"Or") let you link together up to six selection rules .



After you set up a single selection rule, but before you carry out

	

Using connectors
the selection with the Select button, Works presents you with
these two connectors to choose from :

∎ And lets you link together multiple selection rules . Each addi-
tional rule eliminates more of the records in your Database
document, so you zero in on the ones you need . When you
use "And" between two selection rules, Works selects only
those records that satisfy both rules .

∎ Or lets you choose between multiple selection rules . If a
record doesn't match the first rule, it might match the second
or third.

You can use these connectors separately or in combination . For
example, a developer examining real estate holdings in E1 Paso
might use selection rules like these :

Location equals E1 Paso
And Type equals Shopping Center
Or Location equals E1 Paso
And Type equals Residential

These rules eliminate all other properties, such as office buildings
or hotels, and all properties not in E1 Paso . Notice that the follow-
ing set of rules would not produce the same result :

Location equals El Paso
And Type equals Shopping Center
Or Type equals Residential

Because the "And" connector takes precedence over the "Or" con-
nector, this set of rules would select records containing shopping
centers in E1 Paso, and all residential properties (regardless of
location) .
You can also use connectors to extend a comparison, setting up a
range of items, rather than a single item, to match . An example of
a range is :

Sales are greater than $100,000
And Sales are less than $1,000,000
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To add further ru es To add further rules to your original rule :

If you already clicked the Select button after installing your
first rule, choose Record Selection from the Organize menu
again. Otherwise, you're ready to add another rule .

•

	

Click And or Or.
•

	

Select a field name.
Select a comparison phrase .

•

	

Type the comparison information .
Click the Install Rule button .

II

4

6

The next set of connectors becomes available .

File Edit Window

I

Organize

Team
Requested Food
Local Supplier?
Huailable
Number on Team

Record Comparison Information :

Record Selection :
4
0

Selection Rules : Local Supplier? is not equal to YES

Q And

find

® Or Huailable contains MAY

® Or

Cancel

• r

• r

•

	

r

Delete Rule Install Rule Select

Format Report

All installed rules are displayed here .

You can continue to add rules in this manner until the dialog box
is full. When you're done, click the Select button to select the
records that match your selection rules .

Changing Your Mind

If you make a mistake or decide not to make a particular selec-
tion, or if you just want to see all the records, you can cancel the
record selection rules or make new ones .

,



El Select different items from the list boxes or type new com-
parison information before you click the Install Rule button .
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Until you click the Install Rule button, you can change any part

	

To change part of
of your rule .

	

a rule
To change part of a rule :

To remove a rule after you click Install Rule :

	

To remove a rule

El Click Delete Rule .

Works erases the last installed rule . You can repeat this step for
as many rules as you have .

To see all of your records :

	

To see all records

0 Choose Show All Records from the Organize menu .

Saving a Selection with a Different Name

If you have a main Database document that you use to store most
of your information, you can create several smaller documents
from it. The smaller documents would contain subsets of the
information in the main Database document .
For example, a subset of a customer list might contain shipping
addresses for the northeast region . If you save the northeast
region data alone in another file, you can print mailing labels for
northeast customers using a form in the Word Processor . For
more information, see Chapter 21, "Merging: Creating Mailing
Labels, Form Letters, and Forms ."
To create a subset of a Database document :

	

To create a subset

Use the Record Selection command to display only the records
you want to include in the smaller document .
Delete any fields you don't need in the smaller document .
Choose Save As from the File menu .
The Save As dialog box appears, giving you a chance to save
the information with a different name or on a different disk .
Type a new name for the smaller Database document .
Click the Save Selected Records Only option .

a

a

4

11
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11

Switch to another disk, if you want .
Click the Save button.

Works saves the smaller Database document with the name you
just typed. The original document remains safely on the disk,
unchanged. If you want to work with the new subset of data,
you need to open the new file .

Note This is a special case for the Save As command in which
the newly saved document does not replace the existing docu-
ment on the screen . This lets you save subsets of a large Database
document without affecting the data currently in memory .



9 Making a Report

To print information from a Database document, you need to first
set up a report definition . This definition specifies the contents
and format of a particular report . A report is a printed listing, in
tabular form, of either a selected subset of information in a Data-
base document, or all the information. You can set up several dif-
ferent report definitions for each Database document, depending
on the information you need, by selecting certain records or
including only particular fields .
This chapter explains how to set up a report definition and use
reports with the Database. You'll learn how to :

•

	

Set up a report definition in a report window, including speci-
fying fields to be totaled . You'll also learn how to store the
definition with the Database document, so you can print
updated reports without having to set up a new report defini-
tion each time .

•

	

Copy subtotals and totals to the Clipboard to review the
numbers before printing or to use the numbers in a Word Pro-
cessor or Spreadsheet document .

•

	

Prepare your information and print a report.
•

	

Work with reports by selecting and changing a previously
defined report. You'll also learn how to duplicate and delete
a report definition.
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A report prints a table of information, with a record on each row,
like this :

1

For information on other ways to print Database information,
see Chapter 21, "Merging: Creating Mailing Labels, Form Letters,
and Forms ."

Requests Report August 10, 1986

Team Number on Team Requested Food Cost per Person Local Supplier?
Argentina 6 Steaks $7 .20 Yes
Australia 8 Barbequed Shrimp $6 .10 Yes
Austria 5 Wiener Schnitzel $4 .25 Yes
Brazil 5 Lamb $5 .60 No
Canada 8 Pea Soup $1 .20 Yes
China 7 Pressed Duck $5 .90 No
Denmark 6 Polse $4 .60 Yes
Egypt 9 Dates $2 .05 No
England 6 Fish and Chips $5 .40 No
France 7 Bouillabaisse $1 .50 Yes
Germany 8 Brezen $1 .10 Yes
Greece 5 Moussaka $3 .95 Yes
Holland 4 Goudse Kaas $2 .95 Yes
India 6 Samosas $2 .05 No
Italy 5 Gnocchi $4 .75 No
Mexico 7 Tostadas $5 .00 No
New Zealand 6 Kiwis $2 .70 No
Spain 6 Tapas $4 .35 Yes
Sweden 5 Knackebrod $1 .95 Yes
Thailand 4 Peanut Chicken $5 .25 Yes
USA 10 Hamburgers $5.10 Yes



Before You Begin

Before you open a report window and start defining a report, you Working in a list
should understand the relationship between report definitions and window
the open Database document. When you choose New Report from
the Report menu, Works opens a window displaying a report
definition that consists of selection rules, the order and width of
fields, and field sums .
When you choose New Report to create a new report, the initial
information in the report window comes from the open Database
document. Changes you make to the report definition will not
affect the Database document itself . This feature allows you to
define numerous independent reports, each containing different
information .
Since the initial values for a report definition are taken from the
open Database document, you can set up initial record selection
rules and field widths for a report definition either in a list win-
dow or in a report window. You may want to set up your rules
or widen any fields in a list window while you can see all the
records. When you are working in a report window, you'll see
only the first three records . 3:
To set up a new report definition, you'll choose the New Report

	

Setting up a new
command and follow these steps :

	

report definition

•

	

Specify headers and footers, paper size, printing orientation,
and margins with the Page Setup command from the File
menu .

•

	

Create or review any record selection rules, and make any
necessary changes .

•

	

Size and arrange fields, and specify which fields to print by
moving any you don't want printed outside the report margin .

•

	

Specify any fields to sum, using the TotalsPage menu .
•

	

Specify when to subtotal groups of records, using the Totals-
Page menu .

•

	

Specify when to start a new page after a subtotal, using the
TotalsPage menu .

•

	

Specify whether or not to print a grid, using the Format menu .
•

	

Give the report a new title if you want .

All of this information makes up your report definition . The rest
of this chapter details the procedures .
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To define a new
report

Setting Up a Report Definition

A report definition tells Works what information to print from a
Database document. You use record selection rules to choose just
the records that meet the criteria for your report . For example,
if you're looking at credit ratings for customers, you can print a
report of just those customers whose bills are 90 days past due .
Because you might want to print several different reports from the
same Database document, Works lets you store up to eight report
definitions with each document. Whenever you want to print a
report, you choose one of the report definitions and print the
report.
To define a new report :

0 Choose New Report from the Report menu .

Works displays the report window and adds the TotalsPage menu
to the menu bar .

The upper area of the report window displays selection rules .
Report window

	

Report title

	

New menu

r

	

file Edit Window Organize Format TotalsPage

Selection Rules :

. . . . . . . . . . . . . . .
Spain. . . . . . . . . . . . . . .
Sweden

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6

	

Tapas

	

$4 .35. . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . .
5

	

Knackebrod

	

$1 .95
Yes

	

May , J
Yes

	

May, J

. . . . . . . . . . . . . . . . . . . . .

Local Supplier? equals YES
or

	

Available contains MAY

Requests Report 1

Left edge Selection rules in effect are carried
marker over from the Database document .

The lower area of the report window displays
the first three records as they will be printed .

Team Number on Team Requested Food Cost per Pers Local Supplier? IArailabl
Argentina Steaks

	

$7 .20 Yes

	

May , June

Australia Barbequed Shrimp

	

$6.10 Yes

	

August, Se

Austria Wiener Schnitzel

	

$4.25 Yes

	

May, June



Once in a report window, you can set up selection rules . But you
cannot use the mouse to select records or entries . You can select
only individual fields . To change the selection from one field to
another, just click the field name you want to select .

Setting Up Paper Size, Printing Orientation,
Headers and Footers, and Margins

Use the Page Setup command from the File menu to set up your
report page. Paper size, printing orientation, and margins deter-
mine the amount of information that can be printed for each
record.
You will want to use wide orientation if you want to print more
fields in your report than will fit on a standard 8-1/2" x 11" page .
You'll be able to see your margins at once by looking at the edge
markers (downward-pointing triangles) in the report window .
If you need to fit more fields in, you can decrease the margins by
using the Page Setup command again .
For complete information about using the Page Setup command,
see "Page Setup" in Chapter 2 .

Arranging the Fields to Print

When preparing a report definition, you decide what order to
put the fields in and which fields to include in the printed report.
Once you have made these decisions, you may need to either
adjust some field widths or adjust the margins of your report .
Before you begin, look at the report window and locate the edge
markers. The two markers downward-pointing triangles show
you how wide your report will be . You determined where these
markers are when you set the left and right margins in the Page
Setup dialog box. Fields to the left of the right edge marker are
included in the report. Fields completely or partially to the right
of this marker won't be included .
To rearrange fields :

	

To rearrange fields
You can rearrange the horizontal position of the fields to be
printed .

a Drag the field name of any field left or right until the field
name of the field you want to be adjacent to is highlighted .
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To move fields in and If you have many fields in your Database document, some of them
out of a report

	

may not fit within the margins of your report. In this case, you
can take unwanted fields out of the report by dragging .
In other cases, however, you may not have enough fields to com-
pletely fill the space between the edge markers . When this occurs,
you will not be able to drag out unwanted fields until you either
widen one or more fields or change the margins with the Page
Setup command. The fields you include in a report must be wide
enough to fill the area between the margins .
To take a field out of a report :

D

D

Drag the field to the right of the right edge marker .

To put a field back into a report :

Drag the field to the left of the right edge marker .

Selection Rules :

or

Requested Food

Steaks. . . . . . . . . . . . . . . . . . . . . .
Barbequed Shrimp. . . . . . . . . . . . . . . . . . . . .
Wiener Schnitzel

Local Supp
Ruailable c

s e

tier? equals YES
ontains MAY

. . . . . . . . . . . . . . . . .
Spain. . . . . . . . . . . . . . . . .
Sweden

. . . . . . . . . . . . . . . . . . . . . . .
5

. . . . . . . . . . . . . . . . . . . . .
Tapas. . . . . . . . . . . . . . . . . . . . .
Knackebrod

. . . . . . . . . . . . . . . . . .
$4 .35
$1 .95

Nlay , June

	

Just like home

	

Fitzg

August, Sep i-mber Spicy barbeque _.auc' Kelly. . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
May , June

	

High-protein

	

Cafe

. . . . . . . . . . . . . . . . . . . . .
Yes	May , J
Yes

	

May, J

Cast per Person Local Supplier? IArailable
$7 .20

	

Yes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
$6 .10

	

Yes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
$4 .25

	

Yes

or

Comment

	

Supp

These fields are included
in the report.

File Edit Window 0 -ganize Format TotaIsPage

These fields are not
included in the report .



Using the TotaIsPage Menu

Your Database document might be enhanced by including totals
that are sums of a column of numbers . For example, a payroll
report might sum the total payroll . Works also lets you set up sub-
totals, such as payroll per department in addition to the total pay-
roll. With the TotalsPage menu in the Database, you can select
fields to be totaled or subtotaled . You can review the totals before
printing the report, and you can create summary documents with
just this totals information .
When you use the TotalsPage menu to specify totals, subtotals,
or new pages, the commands in effect for a selected field are
checked on the menu. To change your specifications, choose any
command again to remove the checkmark .
The simplest total sums all the numbers in a field .

	

To total a field
To total a field :

0 Select a numeric field that you want totaled .
Choose Sum This Field from the TotalsPage menu .

F

	

File Edit Window Organize Forma

The total for that field will appear at the bottom of the field when
you print the report .

Chapter 9 Making a Report 135

Tot alSPage

Sum This Field

Requests Repor

Selection Rules :

Local Supplier? equals YES

or

	

Available contains MAY

Team

	

Number on Team

Argentina

	

6

	

Steaks	:	
Australia

	

8

	

Barbequed Shrimp	:	
Austria

	

Wiener Schnitzel

. . . . . . . . . . . . . . . . . . . . . . . . .
$6 .1 0. . . . . . . . . . . . . . . . . . . . . . . . .

Requested Food Cost per Person Comment

	

jArailab
Just like home

	

May ) Ju. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Spicy barbeque save August,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
High-protein

	

ay , u
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For fields that you've specified to be totaled, you can also specify
two kinds of subtotals. In both cases, you will get more meaning-
ful results if you sort your records before specifying the subtotals .

To subtotal when field You can set up a report to print subtotals whenever the contents
data changes

	

of a specified key field change . Many Database documents can be
organized into divisions or groups . For example, payroll can be
divided into departments. For a payroll Database document, you
might want a subtotal whenever the department name changes .
In this case, the field containing department names would be
the key field .
Here's how to set up such a subtotal :

El

4

When you print the report, Works will print a subtotal every time
the contents of the key field change. For example, in a payroll
report, you'd get a subtotal after all the entries for Manufacturing,
and another after all the entries for Sales, and so forth . Then,
Works prints a grand total at the end of the report .

To subtotal when the

	

You can also set up a report to print subtotals whenever the first
first character in a

	

character in a specified key field changes . For example, you might
field changes

	

want to get subtotals for each group of records having an entry in
the last name field beginning with the same letter, so that you
subtotal A's, B's, C's, and so on .
To set up this kind of subtotal :

0

4

Select a numeric field that you want to subtotal. Just click the
field name .

•

	

Choose Sum This Field from the TotalsPage menu .
•

	

Select the key field that you want the subtotals based on .
Choose Total on Field Change from the TotalsPage menu .

Select a numeric field that you want to subtotal . Just click the
field name .

•

	

Choose Sum This Field from the TotalsPage menu .
•

	

Select the key field that you want the subtotals based on .
Choose Total-1st Char Field from the TotalsPage menu .

When you print the report, Works will print a subtotal each time
the first character of the entries in the key field changes .



To make reports easy to read, you may prefer to start a new page TO print a new page
after printing each subtotal . That makes a subtotal the last printed after a subtotal
line on each page .
To start a new page after each subtotal, first complete either of
the two procedures shown above for specifying subtotals . After
you choose either Total on Field Change or Total-1 St Char Field :

D Choose New Page After Total from the TotalsPage menu .

When you print the report, Works will skip to a new page after
it prints each subtotal .

Printing with or without a Grid

Works normally prints a grid separating the records and fields in
a report. To print the report without a grid :

Choose No Grid from the Format menu .a

0

A checkmark on the menu indicates whether Show Grid or No
Grid is currently in effect .

Changing a Report Title

Works proposes a title for a report based on the name of the assn- To change a report
ciated Database document. You can change this title at any time

	

title
to make it more meaningful to you .
To change a report title :

From the report window, choose Change Report Title from the
Edit menu .
Type a new name in the space provided .
Click the OK button .

Storing a Report Definition

After you have completed a report definition, you can choose
to either preview any subtotals or totals you may have specified
(see "Previewing Report Totals" below), print the report immedi-
ately, use the Window command to return to a list or form win-
dow, or close the report window . When you close the report win-
dow, Works stores the report definition with the associated Data-
base document . When you later save the Database document, the
report definition is saved along with it .
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To create summary
documents

To print a report

Previewing Report Totals

To preview totals

	

After setting up your report definition, if you've specified fields to
before printing

	

be summed, you can preview the totals and subtotals before you
print the report .
To preview the totals :

D From the report window, choose Copy Totals from the Edit
menu .
Copy Totals is available only after you have specified at least
one field to be summed .

When you specify subtotals with the Total on Field Change com-
mand, Works copies the records containing subtotals and the
grand total to the Clipboard. When you specify subtotals with the
Total-1st Char Field command, Works copies the first record of
each group to the Clipboard, substituting the subtotal of each
entire group for the number related to each particular record .
You can then open the Clipboard to see this information .

Once the data is on the Clipboard, you can use it just like any-
thing else on the Clipboard. For example, you can paste the infor-
mation into a Word Processor or Spreadsheet document to create
a summary document containing just the totals information,
without all the supporting numbers .

Printing a Report

There are three stages in printing a report: preparing the informa-
tion, opening a report window, and printing the report .
To prepare your information :

II Open the Database file from which you want to print a report .
•

	

Sort the records to have them appear in the order you want .
•

	

Review any formatting characteristics specified with the Set
Field attributes command .

To open a report window:

0 Choose Select Report from the Report menu .
The Select Report dialog box appears, containing a list of all
reports that you've defined for the active Database document .

•

	

Select the name of the report that you want to print .



4

El

0

4

•

	

Click the OK button .
Works displays the report window .
Make any changes to the definition .

To print the report :

Choose Print from the File menu .
•

	

Review the options to make sure they're all set as you want
them, and make any necessary changes .

•

	

Click the OK button .

Works prints your report. If your printer is disconnected or you
run out of paper, Works displays a message .

Working with Reports

Many businesses and professionals print regular revisions of
reports address lists, customer lists, bad check lists, or payment
overdue lists, for example . The first time you define such a report
may be the only time you need to, because you can select that
same report definition each time you need to print the report . As
long as your Database document contains the fields contained in
the report definition, there's nothing else to worry about, even if
the contents of the fields change completely .
It's easy to switch between a report window and a list or form
window by using the Window and Report menus . Remember that
any changes you make in the report window apply only to that
report they are not carried back into the list or form window .
Each report can use its own set of record selection rules . This
relationship also holds true for the order and width of fields,
which can be adjusted in the report window with no effect on
the Database document .
To select a previously defined report definition :

Sort or rearrange records in the Database so they'll print in the
desired order.
Choose Select Report from the Report menu .

The Select Report dialog box appears . Any reports that you've
defined for the active Database document appear in the box .

•

	

Click the name of the report definition that you want .
Click the OK button.

The menus change in the menu bar, and Works displays the
report definition you've selected .
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Changing a report

To duplicate a report
definition

To erase a report
definition

When a report definition window is active, you can change the
definition if you want or you can print the report as specified . For
example, you can rearrange fields, change the selection rules, or
add or change totals. The changes you make will be stored with
the associated Database document. When you save the Database
document, the report definition will be saved along with it .

Duplicating and Erasing Report Definitions
You may want to copy a previously defined report definition,
rather than create from scratch another report definition that's
only slightly different. You can have up to eight report definitions
for any Database document . If you already have eight, you'll need
to erase one definition in order to add another .
To duplicate a report definition :

In a form or list window, choose Duplicate Report from the
Report menu .
Select the report definition you want to duplicate from the list .
Click the OK button .

0

a

Works duplicates the report definition, displays it in a report win-
dow, and gives it a name . The name of the report consists of the
name of the Database document, the word "Report," and a num-
ber indicating how many reports are connected with that Data-
base document. You can now make changes to the duplicate to
create a new report.

To erase a report definition :

0

Fl

In a form or list window, choose Erase Report from the Report
menu.
Select the report definition you want to erase .
Click the OK button .

Works erases the report definition .



10 Database Command
Reference

The Apple, File, and Window menus are identical for all Microsoft
Works tools. For information on these menus, see Chapter 2,
"Common Tasks Command Reference ."
This chapter discusses all the shaded commands shown below .

Edit
Undo

. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .

Cut
Copy C
Paste
Clear

Select All
. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . .. . . .. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .

Insert Record

Edit

. . . . . . . . . . . . . . .. . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . .. . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . .. . . . .. . . . .

Change Field Name . . .
Add New Field . . .
Delete Field

Copy Totals

Organize

Record Selection .. .
/Show All Records

Sort. . .

Organize
Record Selection . . .

/Show All Records

Format
Show List

. . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . .

/Bold Field Name
Bold Field Data

. . . . . . . . . . . . . . . . . . . . . . . . . . . ... . . . . . . . . . . . . . . . . . . . . . . . ... . . . . . . .. . . . . . . . . . . . .

/Border Field Name
/Border Field Data

.. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . .

Show Grid
No Grid

.. . . . . . . .. . . . . . . . . . . . . . . . . . .. . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . .

Set Field Attributes . . .

Format
/Show Grid
No Grid

You can invoke some Works commands from the keyboard, as
well as by using the mouse . The available Command-key combina-
tions are shown on the menus and in Appendix D .
An alphabetical list of commands appears in the index under
"Command ."

Totals Page
Total On Field Change
Total-1st Char Field
New Page After Total

. . . . . . . . . . . . . . . . . . . . . . . . ... . . . ... . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sum This Field

Report
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Select Report .. .
New Report ...
Duplicate Report . ..
Erase Report . ..
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Select All

Edit
Undo
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Cut
Copy
Paste
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Select All
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Insert Record

Insert Record

Edit
Undo
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Cut
Copy
Paste
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Change Field Name . . .
Add New Field . . . A
Delete Field

C

C
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Select All
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Record

Change Field Name . . .
Add New Field . . . R
Delete Field

The Edit Menu

The first five commands on the Edit menu are common to all
tools in Works. For information on these commands, see "The Edit
Menu" in Chapter 2 .
This section explains additional Edit menu commands that are
available in the Works Database .

Select All

The Select All command selects all records in a Database docu-
ment in the list window . It does not select any records that are
not currently displayed because you have used the Match Records
or Record Selection command .
To remove the selection, click the deselect box to the far left of
the field names.

Insert Record

The Insert Record command inserts a blank record immediately
before the selected record in a list window or before the record
currently displayed in a form window. In a form window, the
command is dimmed until you make a selection.



Change Field Name

The Change Field Name command changes the name of a field .
To change a field name, either select a field and choose Change
Field Name, or double-click a field name in either a list or form
window.

Field Name :

Untitled2

Cancel

Type the new name in the Field Name box, then click OK .

Add New Field

The Add New Field command adds a new field to a list or form
window.

Field Name :

Untitled2

f Cancel Odd Field)

Type a name for the new field, then click the Add Field button .
In a list window, Works adds the field to the right of the right-
most field . In a form window, Works adds the field in the first
blank area it finds that is large enough to accommodate a field .
In either kind of window, you can move the field wherever you
want. You can add a field at any time .
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Change Field Name

Edit

Undo
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut
Copy
Paste
Clear

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .

Select fill
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Record
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Change Field Name . . .
Odd New Field . . .
Delete Field

Add New Field

Edit

Undo
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut
Copy
Paste
Clear

C

C
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Select fill
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert Record
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Change Field Name . . .
Odd New Field . . .
Delete Field
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Delete Field

Edit
Undo
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Select All
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Insert Record

R

U
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Change Field Name . . .
Add New Field . . .

Find Field

A
Delete Field

Organize
Find Field . . . #. F
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Match Records . . .

	

M
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Record Selection . . .
/Show All Records

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sort . . .

Delete Field

The Delete Field command deletes a field, including both the field
name and the data in the field, for all records .
First, select the field to be deleted by clicking the field name .
You can do this in either a list or form window . In a list window,
Works highlights all the data in the field ; in a form window,
Works highlights the data for the displayed record. Then, choose
Delete Field to delete the field .
You can undo Delete Field immediately after you use it with the
Undo command from the Edit menu .

The Organize Menu

Find Field

The Find Field command finds and selects, one at a time, all
fields in a Database document that contain a specified pattern of
characters .
When you choose Find Field, Works displays a dialog box in
which you can type the character pattern that you want to find .

Find NeHt Field That Contains :

® Search Text Fields Only

Cancel ) ([Find NeKt~,

Find Next Field That Contains Type the character pattern you
want to find .
Search Text Fields Only This is checked as a preset option .
It speeds your search for text in a document containing many
numeric, date, or time fields. If you want Works to look in all
fields, click this option to remove the checkmark.



Click the Find Next button or press the Return key to start the
search. Works selects the first entry that matches your criteria. To
find the next and successive occurrences of the specified pattern,
choose Find Field again. The text you typed will already be in the
text box, so you only need to click Find Next or press the Return
key to restart the search and have the next occurrence selected .

Match Records

The Match Records command finds and displays all records in a
Database document that contain a specified pattern of characters
anywhere in the record.
When you choose Match Records, Works displays a dialog box
in which you can type the character pattern that identifies the
records you want to find .

Match Records That Contain :

® Search Tent Fields Only

Cancel
L

OK 1

Match Records That Contain Type the character pattern you
want to find .
Search Text Fields Only This is checked as a preset option .
It speeds your search for text in a document containing many
numeric, date, or time fields . If you want to look in all fields,
click this option to remove the checkmark .
Click the OK button or press the Return key to start the search .
Works displays only those records containing the pattern . To end
the command and display all records again, choose Match Records
again.
When you choose Match Records from a form window, Works
displays the records in a form window, and you can scroll through
them.
When you choose Match Records from a list window, Works
displays the records in a list window, and you can scroll through
them. If you double-click a record in the list, Works displays that
record in a form window, and the Match Records command ends .
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Match Records

Organize
Find Field . . . F

. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Match R&:ords . . . #:M
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Record Selection . . .
,/Show All Records

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . .

Sort . . .
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Record Selection

Organize
Find Field . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Match Records . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Record Selection . . .
v'Show fill Records

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sort . . .

Record Selection

The Record Selection command defines up to six different selec-
tion rules by which records in a Database document are selected,
and then finds and displays those records . You can then work
with those records alone .
Record Selection is useful in preparing reports or in creating
other smaller Database documents with the Save As command .

First Name
Lest Name
Salutation
Address
City

∎

Record Comparison Information :

Selection Rules : No Rules Are I n Effect

•

	

€€

•

	

€€

•

	

€€

•

	

€€

OUr

•

	

Ur

•

	

Ur

•

	

Ur

•

	

Ur

Cancel

Record Selection :

Delete Rule

equals
contains
begins with
is greater than
is greater than or equal to

∎

y Install Rule Select

To use Record Selection, you build one or more selection rules
by selecting a field and a comparison phrase, and entering record
comparison information. In the list box on the left, select a field
on which you want Works to base the record selection. If you
have more fields in your document than can f t in the window,
scroll the window until you see the field you want .
In the list box on the right, select the comparison phrase to use
in your first record selection rule . Scroll the window to see all the
available phrases. Notice that for text fields you have more
phrases available than for numeric, date, or time fields .
Record Comparison Information Type the text of your com-
parison information to complete the record selection rule . Then
click the Install Rule button .
If you want to extend your selection rules, or if you want to make
your rule more specific, select a connector ("And" or "Or") from
those below and to the left of the completed rule and repeat the
process of selecting a field, selecting a comparison phrase, and
entering comparison information .



You can have up to six record selection rules .
Click the Install Rule button (or press Command-I) to install each
new selection rule . Before you click this button, be sure to review
the components of your rule . You can make any changes you
want, including pressing the Cancel button, up until you click
Install Rule. Thereafter, you'll need to delete the rule and start
over to make any changes .
When you are satisfied with your selection rules, and want to find
records based on them, click the Select button .
Click Delete Rule (or press Command-D) to delete the last rule
you installed.
Click Cancel to leave the Record Selection rules as they were
before you chose the command and to return to the original Data-
base document .
If no records meet the rules you specify, Works displays an alert
box.
To turn off these rules and display all the records, click Show All
Records from the Organize menu .

Show All Records

The Show All Records command terminates the effect of the
Record Selection command and displays all the records in a Data-
base document in either a list or form window .
Show All Records is useful for expanding the display that results
from the Record Selection command .

Sort

The Sort command arranges all the records in a Database
document in order, based on the entries in a specified field.
To select the field you want to sort on, either click the field
name, or select one or more entries in the field .

Chapter 10 Database Command Reference 147

Show All Records

Organize
Find Field . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Match Records . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Record Selection . . .
/Show RII Records

Sort

Organize
Find Field . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Match Records . . .

Record Selection . . .
/Show RII Records

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sort . . . #; A
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Show List

	

Show List/Show Form
Show Form

Format
Show Form

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

'Bold Field Name
Bold Field Date

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Border Field Name
/Border Field Data

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Grid
No Grid

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Field Attributes . . .

Sort the Document on This Field :

Last Name

Arrangement Order :

} From A to Z
C) From Z to A

Cancel ~

Click an option to select the sequence you want . Then click the
OK button or press the Return key .

Note Each type of field text, numeric, date, or time has
two possible sort orders : forward and reverse. For example, if
you select a date field, the available options are Chronological
and Reverse Chronological .

The Format Menu

The Show List and Show Form commands tell Works what format
to use in displaying your data .
Choose Show List to view your data as a list of records in tabular
form. This format allows you to see multiple records at the same
time. If you have many fields, you may see only parts of records
on your screen. To see other records or fields, use the scroll bars .
Choose Show Form to view your data as a form with one com-
plete record displayed .
You can switch back and forth between these views at any time
by choosing these commands from the menu . You can also switch
views by double-clicking in the white space of a form or in a
record selector box in a list . When you do the latter, the form
window displays the record you selected . You can then scroll
to see other records.



These commands display the field name, the field data, or both,
in bold type in a form window.
Choose Bold Field Name to make the field name bold . Choose
Bold Field Data to make the data in a field bold. When chosen,
the commands are checked on the menu. Choose again to
remove the checkmark .

These commands display the field name, the field data, or both,
with a border in a form window .
Choose Border Field Name to display the field name with a
border. Choose Border Field Data to display the data in a field
with a border. When chosen, the commands are checked on the
menu. Choose again to remove the checkmark .

These commands tell Works whether or not to display the grid
lines on your Database document . They are available when you
are working in a list window or a report window .
Choose Show Grid to display grid lines . Choose No Grid to show
no grid lines. The active command is checked on the menu .
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Bold Field Data
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Set Field Attributes

Format
Show Form
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Set Field Attributes

The Set Field Attributes command specifies the attributes of
field data .
When you create a new field, the information in the field is
treated as normal text, left-aligned .
To specify the attributes of a field, select a field and choose Set
Field Attributes, or double-click an entry . Works then displays
a dialog box .

Set Field Attributes For Available

Type :
® Text
•

	

Numeric
•

	

Date
•

	

Time

Align :

	

Style :
® Left

	

fl Bold
•

	

Center LI Underline
•

	

Right

Decimal Places

OK(Cancel

Type Options

Text Field data can be any alphanumeric characters .
Numeric Field data must be numbers .
Date Field data must be entered in one of eight specified date
formats. For more information, see "Changing the Format of a
Field" in Chapter 7 .
Time Field data must be entered in one of four specified time
formats . For more information, see "Changing the Format of a
Field" in Chapter 7 .
Computed If you define your data as Numeric, you can specify
that the contents of a field are to be computed by arithmetic
operations performed on numeric data i n other fields .
Click Numeric, then click the Computed box . When you leave the
dialog box, the insertion point, preceded by an equal sign (=), is
placed in the entry bar. You can then type a formula .



Type a formula for a computed field using field names, numbers,

and the following symbols :

Symbol

* (asterisk)

()

Meaning

Add

Subtract

Negate (if used with one

operand only)

Multiply

Divide

Group of operations

Raise to a power

You can also include all functions available in the Spreadsheet,

except those that require ranges for arguments. For more informa-

tion, see Chapter 15, "Spreadsheet Functions ."

Instead of typing field names into a formula, you can also click

them .

Display Options

General Values are displayed as precisely as possible, given the

width of the entry. Trailing zeros are not displayed .

Fixed Values are displayed with a fixed number of places to the

right of the decimal point .

Works uses Fixed format for all Database values unless you specify

otherwise .

Initially, the fixed number of places is two, unless you change it

in the Decimal Places box .

Dollar Values are displayed in dollars and cents format, that

is, with dollars to the left of the decimal point and two digits

representing cents to the right. Or, values are displayed as whole

numbers with no decimal point. A dollar sign ($) appears to the

left of the most significant digit .

Negative numbers are enclosed in parentheses.

Type O in the Decimal Places box to display whole dollars with

no decimal point. Type 2 to display dollars and cents .

The value is adjusted to the nearest whole dollar or whole penny

depending upon your choice of 0 or 2 decimals . For example, the

value 9.505 is displayed as $10 if zero decimal places are speci-

fied; it is displayed as $9.51 if two decimal places are specified .
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Percent The numeric value of an entry is multiplied by 100 and
displayed with a percent sign (%) to its immediate right .
You can also specify the number of decimal places to be displayed
in the percentage. The value .156, for example, is displayed as
15 .6% if you type 1 in the Decimal Places box, and 16% if you
type 0 .
Scientific Scientific notation allows you to express very large
or very small numbers . In scientific notation, a numeric value has
three parts : a decimal number in the form n. nn, the exponentia-
tion symbol E or e, and an integer in the form ± i i for the
exponent.
For example, the value 1,210 would be displayed as 1 .21 E + 03,
where 1 .21 is the decimal number, E is the exponentiation sym-
bol, and +03 is the exponent .
Show Day If you define your field type as Date, you can specify
that the day of the week be displayed as well .
Decimal Places The number in this box specifies the number
of digits to be displayed to the right of the decimal point, if you
define a field as Fixed, Dollar, Percent, or Scientific .
The preset value is 2 . Change this by typing a number from 0
to 15 .

Align Options

These options allow you to align the contents of selected entries .
All entries in the selected fields will be displayed as you specify
here.

•

	

Left
•

	

Center
•

	

Right

Style Options

These options allow you to change the style of your data . All
entries in the selected fields will be displayed as you specify here .

•

	

Bold
•

	

Underline
•

	

Commas: This option is available only for numeric fields .



The Report Menu

Select Report

The Select Report command selects a previously defined report
definition. Once it's selected you can make changes to it or print
the report. If you change the selection rules, these changes will be
saved automatically along with the report definition .

Select Report :
Personnel Notes Report Z

Cancel C OK )

Select the report definition you want, then click the OK button or
press the Return key ; or, double-click the report name .
Works opens a report window containing the selected report
definition .

New Report

The New Report command creates a new report definition .
When you choose New Report, Works opens a report window .

Selection Rules :

No Rules Are In Effect

Rddresses Report 1
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Select Report

Report
Sele~:t Report . . .
New Report . . .
Duplicate Report . . .
Erase Report . . .-

New Report

Report
Select Report . . .
New Report . . .
Duplicate Report . . .
Erase Report . . .

First Name

	

Last Name (Salutation Address

	

City (State

Barbara

	

Smith

	

Ms .

	

2122 Broad Street

	

New Orleans

	

LA

Thomas

	

Reinhardt

	

Mr .

	

1212 Evergreen Lane Santa Clara

	

CA

Hiram

	

Wheeler

	

1 020 Wheeler Way

	

Wheelerville

	

OH
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Duplicate Report

Report
Select Report . . .
New Report . . .
Duplicate Report . . .
Erase Report . . .

Selection Rules With commands from the Organize menu, you
can specify the records you want to include in your report. If you
specify selection rules in the Database document immediately
before choosing New Report, those rules will appear in the report
window as well .
When you close the report window, Works adds the definition to
your list of available reports .

Duplicate Report

The Duplicate Report command duplicates a previously defined
report definition . This is useful for creating two or more reports
that are very similar .

Duplicate Report :
1986 Sales Projections
Regional Sales Report

Cancel ,~ OK

Select the report definition you want to duplicate, then click the
OK button or press the Return key .
Works opens a report window with a copy of the selected defini-
tion, but with a new title . Now you can make any changes you
want.
When you close the report window, Works adds the definition to
your list of available reports .



Erase Report

The Erase Report command deletes a report definition from your
Database document .

Erase Report :
1986 Sales Projections
Regional Sales Report

I Cancel

Select the report you want to delete, then click the OK button or
press the Return key .
Works deletes the definition from the Database document .

In the Report Window

Once you open a report window, the menu bar changes and a
different set of commands is available to you . Some of these com-
mands are identical to the regular Database commands ; others are
completely new. All of the report window commands are
described in this section .

The Edit Menu

Copy Totals

The Copy Totals command copies totals and subtotals, specified
with commands from the TotalsPage menu in a report window, to
the Clipboard. This allows you to preview the information before
printing the report.
Once information is on the Clipboard, you can paste it into
another document, just as you can any other information on the
Clipboard. For example, you can use the totals and subtotals as
a summary of the data in your Database document .
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Erase Report

Report
Select Report . . .
New Report . . .
Duplicate Report . . .
Erase Report . . .

Copy Totals

Edit

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Totals

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Change Report Title . . .
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Change Report Title

Edit

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Copy Totals

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Change Report Title . . .

Record Selection

	

Record Selection

Organize
Record Selection . . .

/Show All Records

Show All Records

Organize
Record Selection . . .

,/Show fill Records

Show Grid

	

Show Grid/No Grid
No Grid

Format
,/Show Grid
No Grid

Change Report Title

The Change Report Title command changes the title of a report .
The new title appears in the title bar of the report window and
in the dialog boxes that contain a list of report titles . It is also
reflected in the header or footer of a report if you specify the
filename to be printed with the &F command .

The Organize Menu

The Record Selection command specifies which records in a Data-
base document to print in a report . It works exactly the same as
the Record Selection command from the main Database Organize
menu.
When you print the report, Works prints only those records meet-
ing your record selection rules .

Show All Records

The Show All Records command tells Works to print all records
in a Database document in a report, rather than only those that
match the selection rules .
When you choose Show All Records, Works puts all records on
the desktop ; however, you will see only the first three records
in the report window .

The Format Menu

These commands specify whether a report should be printed with
or without grid lines .
Choose Show Grid to print a report with grid lines. Choose No
Grid to print a report without grid lines . The active command
is checked on the menu .



The TotaIsPage Menu

Total on Field Change/Total-1st Char Field

These commands tell Works when to print subtotals of the
numeric values in the field you've specified to be summed .
To use either Total on Field Change or Total-1 St Char Field, you
select a key field which is different from the field designated to be
summed, then choose one of these commands . After the contents
of each record is printed, Works compares the contents of the key
field in the printed record with the contents of the key field in
the next record to be printed .
When you choose the Total on Field Change command, Works
looks to see if the contents of the two compared fields are dif-
ferent. If they are, Works temporarily stops printing records, and
prints the subtotal of those fields specified by the Sum This Field
command.
When you choose the Total-1st Char Field command, Works looks
to see if the first character of the two compared fields is different .
If it is, Works temporarily stops printing records, and prints the
subtotal of those fields specified by the Sum This Field command .
In both cases, the subtotals for the entire report are accumulated
as they are printed . At the end of the report, Works prints a grand
total of all the subtotals.

New Page After Total

The New Page After Total command tells Works to print the next
Database record on a new page after a subtotal is printed.
After you select a field to be summed, choose either Total on
Field Change or Total-1st Char Field. Then choose the New Page
After Total command .
New Page After Total is associated with the specific Total on Field
Change or Total-1st Char Field command you choose immediately
before you choose New Page After Total . This way, you can spec-
ify that a new page be started after one type of subtotal, but not
after another.
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Total on Field Change
Total-1st Char Field

Tot aIsPage
Total On Field Change
Total-i st Char Field
New Page After Total

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sum This Field

New Page After Tota

Tot aIsPage
Total On Field Change
Total-i st Char Field
New Page After Total

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sum This Field
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Sum This Field

	

Sum This Field

Tot aIsPage
Total On Field Change
Total-1st Char Field
New Page After Total

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sum This Field

The Sum This Field command tells Works which fields to sum
and then print totals for . Subtotals are derived from the numeric
values of the specified fields and are accumulated as the records
are printed or when you choose Copy Totals from the Edit menu .
Select the field you want Works to total, then choose Sum This
Field. When the command is checked on the menu, it is effective
for the currently selected field .
When you print the report, Works prints the specified totals .
If you choose to sum one or more fields, but do not specify when
to print subtotals with Total on Field Change or Total-1st Char
Field, totals are printed at the end of the report for all specified
fields .
After all records have been printed, Works prints a grand total
the sum of all previously printed totals .



The Spreadsheet

The Works Spreadsheet automates the kind of figuring you do
with a sheet of paper and a calculator : taxes, sales projections,
cash-flow analyses, or personal net worth statements . The
Spreadsheet gives you cells to fill with labels, numbers, and formu-
las. You type in the data, and Works does the calculating for you .
You can change the numbers to see what happens, and let Works
recalculate again, automatically . Once you have the numbers in
place, you can chart your figures to see how they look . Then,
when you change a number, you can watch the chart change
at the same time. When you have the result you want, you can
print it .
The formulas you enter into the Spreadsheet can include every-
thing from simple addition and subtraction to trigonometric
equations and logical comparisons .
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These six chapters explain how to use the Spreadsheet :

•

	

Chapter 11, "Entering Information," shows you what a Spread-
sheet document looks like, how to type labels, numbers, and
formulas into the Spreadsheet, and how to use the Spread-
sheet's built-in functions .

•

	

Chapter 12, "Working with the Spreadsheet," shows how to
make changes or additions to your Spreadsheet document, and
different ways to look at it .

•

	

Chapter 13, "Formatting and Printing," shows how to arrange
your information on the screen and prepare for printing .

•

	

Chapter 14, "Charting a Spreadsheet Document," describes the
Spreadsheet's charting capability .

•

	

Chapter 15, "Spreadsheet Functions," describes the Spread-
sheet's built-in functions .

•

	

Chapter 16, "Spreadsheet Command Reference," describes all
the Spreadsheet commands.



11 Entering Information

In this chapter, you'll learn how to :

•

	

Recognize the parts of a Spreadsheet document, and design
your own documents.

•

	

Select parts of a Spreadsheet document .
•

	

Enter and correct information .
•

	

Use labels and values .
•

	

Build a formula using operators, references, and functions .
•

	

Avoid circular references .

An Overview

This section shows you what a Spreadsheet document looks like
in Works, explains what a spreadsheet is, and shows how to
design one for maximum effectiveness . The Spreadsheet helps you
analyze numbers that you arrange in rows and columns, such as
budgets or financial statements . Change the numbers to see what
happens the Spreadsheet makes the calculations. You can also
chart your numbers with the Spreadsheet. Change a number in a
document the chart instantly reflects it .

An overview

1 61
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Looking at a

	

Looking at a Spreadsheet Window
Spreadsheet window

Parts of a
Spreadsheet
document

A Spreadsheet window looks like this :

Column headings
Enter box

Cancel box

b

14

File Edit

X

Row headings
The cell reference
A 1 refers to this cell .

Formula in the active cell
Entry bar

Window Select

-841$B$1

Format Options Ch

Budget I.SS1
A

	

B

	

C

	

D

$6,o00 9%
$20

000

	

30, I

. . . . . . . . . . .

	

.j$5,000

	

~
$12000

	

,1:3%
Total Expenses	:	$126 ,000

	

94 . E 1

	

$53 ,000

	

?9 I

Label

art

E

I

Cell
Active cell

I

Value

Row
Page break
indicator

A Spreadsheet document is made up of columns and rows . Each
column has a lettered heading (labeled A to Z, then AA, AB, and
so on to N), and each row has a numbered heading (1 to 9,999 ) .
Columns and rows intersect to form cells . You can locate a cell or
refer to it with a cell reference its column heading and row
heading. For example, A 1 is the cell reference for the cell in the
upper-left corner of a Spreadsheet document .
You tell Works where you want to enter information by selecting
cells. As you type, the information appears in the entry bar. You
enter the information into the active cell by clicking the enter
box or pressing the Enter key. The number of cells you can fill is
dependent upon the amount of memory available to you .
You put numbers, formulas, and labels into cells to create a
Spreadsheet document . When you change numbers, you can see
how the changes affect the outcome of Spreadsheet calculations .

Special Food Requests $6,00c 4 44'
Lodging $60 ,000

	

44.44%
Bicycles $~O ,000

	

14.` 1 '
Promotions $1 2,000

	

8.E9%



You set up a calculation by entering a formula . 2 + 2 is a simple
formula. A 1 + A2 is also a formula. Using this formula, Works looks
for numbers in cells A 1 and A2, and adds them .
Labels make your Spreadsheet documents easier to understand .
Labels are text, such as Total Expenses, Percent, or 1986 Projec-
tions, that explain your numbers and formulas .

Designing a Spreadsheet Document

You may not realize it, but you've probably prepared something
similar to a Spreadsheet document already . Maybe it was several
columns of figures you jotted down for a promotional campaign,
or a departmental budget you wrote on filler paper . But chances
are that you've done something like this before .
These steps will help you clarify your thoughts :

•

	

Choose a subject. For example, if your major purpose is to set
up an expense report document, don't get sidetracked by put-
ting a travel budget in the same Spreadsheet document .

•

	

Choose the components . Write down all the types of informa-
tion you need for your calculations. When you type them into
a column in a Spreadsheet document, you will be setting up
your labels.

•

	

Decide on a structure. Map out what goes where . A good
structure not only lends itself to easy calculation by Works, it
also makes it easy to find the information you need after the
calculations are complete .

•

	

Plan the calculations . Determine equations that produce the
results you want. These equations will become your Spread-
sheet formulas .

•

	

Decide on the numbers . When your labels and formulas are
entered in your Spreadsheet document, you will need only the
numbers to find your answers .

Selecting Parts of a
Spreadsheet Document

Before you can enter information into a Spreadsheet document,
you tell Works where to put the information by selecting a cell or
a range of cells . The information you type goes into the active cell
in the selection. The cell indicator shows you which cell is the
active cell . In a range of selected cells, only the cell outlined with
a solid white line is active .
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The following table describes how to select various ranges

	

To select a range of
of cells .

	

cells

To select this range

	

Do this

A block of cells

	

Drag from the cell in one
corner of the block to the cell
in the opposite corner .

One row or column

	

Click the row or column
heading.

Many rows or columns

	

Drag from the first row or
column heading to the last
heading.

All cells through the last cell

	

Choose All Cells from the
Select menu .

When selecting a range of cells, if you drag past the last row or
column on the screen, Works scrolls the window and adds to the
selection. You can also use the Shift key to extend a selection
beyond one screen :

a Select the cell that marks the beginning of the range .
Scroll the document to the end of the range you want to
select.
Hold down the Shift key while you select the cell that marks
the end of the range .

Works selects all the cells between and including the two
selections.

Works considers the last cell in your Spreadsheet document to be To select the last cell
the cell at the intersection of the last row and column containing
a value or formula. To select the last cell, choose Last Cell from
the Select menu .

Entering Information
into a Spreadsheet Document

You can enter either constant values or formulas into the cells
of a Spreadsheet document . Constant values can be text (labels)
or numbers.

Chapter 11 Entering Information 165

To extend a selection



166 The Spreadsheet

To move through a
selection

To enter a constant value, you select a cell and type the value .
To enter a formula, you select a cell, type an equal sign (=), and
then type the formula .
As you type the information you want to put in the active cell,
it appears in the entry bar . That way, you can be sure that your
entry is correct before you use it for a calculation or a label . It
won't appear in the active cell until you enter it. You can type
up to 238 characters in the entry bar .

Enter box
Cancel box

r

	

File
Ed t

A1

Formula

Win

	

Select Format Options Chart

To enter what you

	

When you enter a constant value or a formula, Works stores it in
type

	

the active cell and displays the formatted value in the cell .
There are several ways to enter what you type . You can click the
enter box, or use the keyboard as described below :

To enter what you type and
make the active cell

	

Press these keys

The cell on the right

	

Tab
The cell on the left

	

Shift-Tab
The cell below

	

Return
The cell above

	

Shift-Return
The same cell

	

Enter

You can also use these keys to move around in the document
when you are not entering information .
To enter a constant value, and select any other cell at the same
time, just click the other cell .
If you select a range of cells, you can press the Tab or Return key
to move the active cell within the range without changing the
selection . You can quickly enter information into many cells by
selecting the range, and typing, then pressing the Tab key or
Return key, depending on which direction you want to move .

Making Corrections to an Entry

If you make a mistake while you're typing information in the entry
bar, you can correct it .



To cancel your typing in the entry bar :

D Click the cancel box to the left of the entry bar .

Works cancels your typing and restores the original entry . If the
original entry was blank, the entry bar will also be blank .

To edit an entry you can use the usual Macintosh editing tech-

	

TO edit an entry
niques: Use the Cut, Copy, and Paste commands, or the Backspace
key, or select what you want to change and type to replace it .

Entering a Label

Labels let you write explanatory information in a Spreadsheet
document. Labels make the numbers and formulas easier to under-
stand. You can label the contents of a column or row, or include
notes to explain how you perform a certain calculation . Labels
help other people understand your Spreadsheet document, and
also help you when you return to a document that you haven't
used in a long time .
You can do all sorts of creative things with labels : a line of
hyphens can separate values in a column from their total ; a
number followed by a letter can specify a quarter of the year ;
a number can label a year . The following illustration gives some
examples of how you can use labels .

Labels can be made up of. . .

.letters

	

. .numbers

.r}.}. .}}	::	r	r	::. :r}}•1}}:}}. . :}. .rrr:r}. :rr::. :. . . } . . . .

	

. ::::.:::

	

. :
Untitled LSS)	
C

	

a

2
3
4
5
6
7
8
9
10
11
12

File Edit

A
January. . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .1 982

. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
1 ~t Quarter. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .

B
February. . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . .
19 :33. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . .

	

.
. . . . . . . . . . . . . . . . . .
end Quarter. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . .
. . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . .

Marr.:h. . . . . . . . . . . . . .
. . . . . . . . . . . . . .

1984. . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . .

.3rd Quarter. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .

.or letters and numbers .

Window Select Format Options Chart

April. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
1985. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .
4th Quarter. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . .
. . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .

You can type up to 238 characters in a label .

May. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . .
19:36

June. . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . .

. . . . . . . . . . . . . . . .
1987
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To cancel your typing
in the entry bar
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To enter a label

To fit labels into cells

To begin a label with
a number or symbol

To enter a label :

Select a cell .
Type the label .
Click the enter box or press the Enter key .

0

El

If a label doesn't fit in a cell, Works automatically runs the label
into any blank cells that follow, cutting off the label at the first
non-blank cell, if necessary . If you don't want the label to over-
flow into an adjacent blank cell, select the cell and press the
spacebar. The cell now contains a character, even though you
can't see it, so the label will not run into that cell. Alternatively,
you can widen the column to hold the label . For more informa-
tion, see "Changing Column Width" in Chapter 13 . The entry
bar shows the full entry, regardless of the width of the column .
Whenever you start an entry with a letter, Works stores the entry
as a label . You can, however, start labels with numbers or math
symbols, if you tell Works that you're typing a label rather than
a value or formula .
You might need to begin a label with a number . For example, you
might abbreviate thousands by typing 1000s, or you might want
to use a label such as 1986 Budget.
To tell Works that you want to begin a label with a number or
a symbol :

Select a cell .
Type a quotation mark (") .
Type the label.
Click the enter box or press the Enter key .

0

4

Works enters the label in the active cell .

The quotation mark is a signal to Works that you're typing a label .
It appears in the entry bar, but not in the cell .
When Works encounters a label while performing a calculation,
it treats the label as a zero .



Entering a Number

To enter an integer or decimal number :

II Select a cell .
Type a number.
Include a decimal point, if necessary . For a negative number,
begin with a minus sign. Do not type commas or dollar signs .
Click the enter box or press the Enter key .

Works enters the number and displays it in the active cell .

If the number you enter cannot be accurately represented, given
the width of the cell, Works fills the cell with # symbols . When
you widen the cell, you see the actual value .
For very large and very small numbers, you can use scientific

	

To type a number i n
notation. Works accepts exponents to ±99 . If you enter an

	

scientific notation
exponent outside this range, Works displays * Error * in the cell .
To type a number in scientific notation, type an integer or
decimal number, followed by an E and an integer that represents
an exponent of 10 .
When you enter a number in scientific notation, it looks like this :

F

	

File Edit Windo

LI

1

2

Mantissa

A 1

	

1 .86E23

Exponentiation symbol
Exponent

w Select Format Options Chart

Budgets SS)
G

	

D
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If the result of a calculation is a number with an exponent outside
the acceptable range, Works displays * Exponent * in the cell .
The format of a cell is separate from the cell's numeric value .
A cell's format determines how the value is displayed . For more
information, see "Changing Number Formats" in Chapter 13 .
In a new Spreadsheet document, Works displays numbers as pre-
cisely as possible within the width of each cell . However, Works
stores number values up to 18 places long, regardless of how they
are displayed.

To enter a number

About numbers and
formats
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What is a formula?

Building a Formula

Formulas make the Spreadsheet a useful tool . Without them you'd
just have rows and columns of numbers . Formulas tell Works what
to do with the numbers .
A formula makes up the content of a cell . When you select a
cell, Works displays its content in the entry bar . In the cell itself,
Works displays its formatted value . When the selected cell con-
tains a constant value (either text or numbers), the display in the
entry bar and in the cell may be the same . When the selected cell
contains a formula, Works calculates it and displays the resulting
value in the appropriate format in the cell . You can always exam-
ine the content of a cell by selecting the cell and looking in the
entry bar.
Here's an example of what a formula might look like :

Equal sign
References

Value

Operators

A formula calculates a new value from existing values . A formula
can consist of values, cell references, operators, and functions .
A formula can be as simple as = B 1 + B2, which adds the values
in cells B 1 and B2 . Or, a formula can be complex :

= Pi( )/2 - ATan( B 1/Sgrt(1 - B 1 A2))

To enter a formula

	

Every formula begins with an equal sign . The equal sign tells
Works that what follows is a formula, and so needs to be
calculated .
You can set up much of a formula by pointing and clicking with
the mouse. You can point to cells, drag across blocks of cells, and
paste functions without typing .



To enter a formula :

0
a
a
4

Select a cell.
Type an equal sign (=).
Type the formula in the entry bar .
Click the enter box or press the Enter key .

Works enters the formula in the active cell, and displays the
resulting value . The formula still shows up in the entry bar, so
that you can see both the formula and the result simultaneously.

You can set up a simple total of a group of cells by pointing and

	

To get a total
clicking. The formula for a total looks like this :
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F

	

File Edit Window Select Format Options
Churl

B d e (SS)

El
a

59

z
3

S
6
7

9
10
11

To enter this formula :

=54+55+55+57+5E1

Alpine ace Budget

	

I
I

Expenses

	

May

	

Percent

	

June

	

Percent j
	 P°. . .2 :22

	

,95':

	

$10,000

	

1595 1	
Special Food Requests

	

$6,000	4 :44% •

	

$6,000 •	99+oI . .

Lodging

	

$60,000

	

44 .44%

	

$20,000

	

30%i
Bicycles

	

$20,000

	

14 .S1%

	

$5,000

	

795	
Promotions

	

$12,000

	

8 .8995 :

	

$12,000

	

1895 1	
Total Expenses	$12 ..000

	

: .?Q00	~

	

I
I

Total Budget Available

	

$135,000

	

00 .0095 :

	

$67,500

	

10095j
	12

	

.
13 Under (over) Budget

	

$7,000 . :	5 :1995	$. 1. 4 .,500 . :	21.951
14

	

I

C

When you click a cell to put
a reference in the entry bar,
Works outlines the cell .

The formula will be
entered in the active cell.

Select a cell .
Type an equal sign (=) .

Click each cell that you want to add. (Notice that you cannot
use a range of cells in this particular formula, so do not drag
across the cells.)
Works inserts addition operators (+) between the cells
you click.
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a

Relative references

	

Relative References

Click the enter box or press the Enter key

Works enters the formula in the active cell, calculates it, and
displays the resulting value .

You can also sum a range of numbers with the Sum function .
For more information, see "Sum" in Chapter 15 .

References

In Works, columns are labeled A through IV, beginning with col-
umns A through Z, and then AA, AB, AC, and so on, to IV . Rows
are labeled 1 through 9,999 . The cell in column A, row 1, is
referred to as A 1 . The number of cells you can fill is dependent
upon the amount of memory available to you .
References make formulas flexible . You can use the same value in
many formulas by entering the value in a cell and referring to that
cell in the formulas . Then, if you change the value of the cell,
Works recalculates the formulas using the new value .
When you build a formula, you can refer to cells using relative
references or absolute references .

A relative reference gives general directions to Works, rather than
a specific location. It's like saying, "Go up two blocks and over
one." If you copy a relative reference to another cell, the refer-
ence changes relative to its new position . For example, if a rela-
tive reference in a formula points two rows up and one column
to the right, and you copy the formula to another location, it still
points two rows up and one column to the right, but it points
to a different cell than it did originally .

PYCopy
3

1



Absolute References

An absolute reference is like a mailing address : 9522 Almont
Street. No matter where you copy the reference to, it still points
to the same cell. For example, an absolute reference to cell B 1
always points to cell B 1, even if the formula containing the refer-
ence is copied to another location in the Spreadsheet document .
Works uses dollar signs to indicate that a reference is absolute .
$B $1 is an absolute reference to cell B 1 .

Original
Copy

2
3

The difference between relative and absolute references is impor-
tant only when you cut or copy a formula from one cell and paste
it into another or when you use the Fill Right or Fill Down com-
mand. For information on copying references, see "Copying Cells"
in Chapter 12 .
You can enter a cell reference in a formula either by clicking the

	

TO enter a reference
mouse or by typing . When you use the mouse, Works puts the

	

i n a formula
reference into the entry bar for you .
To enter a reference :

0 Select a cell, then start a formula by typing an equal sign (=) .
Click the cell that you want to refer to, or type the cell
reference .

You can refer to as many cells as the formula needs . If you do not
type an operator in the formula before you select each cell after
the first one, Works supplies the addition operator (+). For
example, if you type an equal sign, then click two cells, Works
adds the contents of the two cells .

You can also refer to a range (or block) of cells with one refer-

	

TO enter a range
ence. The reference includes the beginning reference, a colon

	

reference in a formula
standing for "to," and the ending reference. For example, the
range reference A2 :B 5 refers to all the cells from A2 to B5,
inclusive. You can use range references only in functions ; for
example, Sum(C 1 :E 10) .
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Absolute references
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To make a reference
absolute

To enter a range reference in a formula :

0
Fl

F 1

	

File Edit

Alpine Race Budget

	

I
I

May

	

Percent

	

June

	

. Percent j
22 .22 5

	

$1 a aaa

	

15gg I	
ests

	

4 :

	

~a ~	I
44 .44 :

	

$2Q000

	

3a 114 .81

	

$5)000	I	

$ .89

	

$12,aaa

	

18 81	
aas~

	

$53,aaa	~g l
	:	 I

1 aa .a •

	

$ 7,5aa '

	

1 aoss ;	

5
6

0

B9

2

4

7

8

9

Select a cell, then start a formula by typing an equal sign.
Drag across a block of cells, or type a reference for a range
of cells .
If you drag with the mouse, an outline shows you the range of
cells you're referring to. If you type, remember to include the
colon. You can use a combination of clicking and typing .

Basic Food. . . . . . . . . . . . . . . . . . . .
Special Food Requ

Lodging. . . . . . . . . . . . . . . . . . . .
Bicy cles. . . . . . . . . . . . . . . . . . . .
Promotions. . . . . . . . . . . . . . . . . . . .
Total Expenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Drag down this range of cells . . .
. . . to enter this reference in the formula .

endow Select Format Options Chart

Cell into which the
formula will be entered

1

	

C

First cell in the range
Last cell in the range

Changing Reference Styles
When you click or drag to enter a reference in a formula, the
reference will be relative . You can change the style of a reference
by using the Absolute Cell Ref command from the Edit menu . This
command takes effect on the cell reference immediately preced-
ing the insertion point or the selected reference in the entry bar .
To make an absolute cell reference from a relative one :

. . . . . . . . . .

Select the cell containing the formula that includes the relative
reference you want to change .



Fl

F-

In
~~`~~

~~~~~»~« %~~~ position ~~
.~

	

K~~~ ~~point

	

~«~~~~

	

~~ J ^'~~~~

	

~--~' ---~~----^^ ~.^^---~ immediatelyy ~^'
~~u~~ r

^~~~

	

^~%~~ ~~~~~ the relative reference,~`

	

reference, or select ~~~

	

~=~~~~~

	

~~

	

the reference .~^

m~ File Edit Windo

sThis the reference you want to change.

SeUect Format Options Chart

1 14

Budget (55)

~

	

~

	

. .!

.

.

EIJ

B/51

	

z11!~-'!

04

1
2
3

7

~

	

~

	

~ t

	

'

	

~~

	

''
^	 ~

	

~~-'

	

^'---

	

~ ^^	 ~»~~~~~~~ 	Percen

	

~^~~~ n~~~

	

~~~~~~«• ~

	

~

	

.

	

~

	

!

F-
~~ F'UK9

Edit
NN'nd0U00

Rz1/~R~1 1-_^','*~~ . .

Expenses

•

	

n,~~,r""a ~ ~~nnnn! ! ~~nnnn~ ~~vn~.~	 ~~~ .~~~ .~ • •
•

	

Special Food Requests $6 .00Ci 4 .44 $6 .000 9% !

•

	

Lodging $60 .OOO~

	

44.44~~ ~

	

$2O~OO~

	

30%i. .

	

. .

	

~

	

~

	

.

	

~ .~

	

~~~~~~

	

14 ~_~~~ ~~~_~ ~~'Bicycles ~n/' /xx/' x~vx' ~~ /xx/' /ym .--= .--

	

.

	

-_-'--- .

	

-~~ . .

	

--'---	
~~ .nrm .
~''

_ ._ ._-_

	

- .- .___

	

.~~ .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . '~~

	

.~~~~~~~~
~

•

	

Total Expense~
~ ~128l)OO~ 9481~~~ ~53OOO~ 79~~!~

	

.~
~

	

.
l[a*~~~~n~~~~ ~kv,~i~~~~~ !~1~5OOO •

	

1OOOOq~ . .675OO~

	

1OOq~|Total Budget -

	

- -.--- .- .

	

~--'--- .

	

~--_-~ . .

	

-~'--- .

	

.-- .-/

. ~7OOO : 5 :1 99J~

	

~145OO~

	

21~~!~	
~~~^ ~~~ ~~~- -- ~~~- - - -- ^~~- `~- -

Choose Absolute C=~ Ref from the Edit menu,

Works inserts dollar signs before the column letter and row
number, indicating that the reference is now absolute .

aWorks dds

	

^

	

to show
that the reference is now absolute .

SK9UK9ct Format Options Chart

~

	

dqet. .~~

	

~

	

!~~~~~~

	

~ .

May 	Percent

	

June

	

~ Percent
/
.

•

	

BasioFood ~3
.
O/ ~OOO

. . .~.1•9
/OOO~ . . . . . . . .

J• SpeoiolFood Requests

	

.6~/]OO

	

444~~

	

$6^OOO

	

9~~!
~-J

~~~~~

	

~
~	!Lodging$6O/]OO44 .44Y3$2O)OOO~~~~~~~ ~~3O96!

Bicycles

	

~

	

-~2O~OO~

	

14 .819J ~

	

-~5~/~OOO~

	

7~~ /
!.~~~~~~~~~~~~

	

~~~~~~~~~
•

	

Prommtions ~120OO 8~899J ~12 .OOO
	~~ .~	~~~ .~ . .~~	~~~~

	

~	
~.128~OOO~~~ ~ ~94~8196 .53/]O

10

	

!
Total Budget Available

	

$135,OOO

	

1OO~OO96

	

.67,5~]O

	

100% !
'-

iid
~e~

	

~7OOO

	

519~~

	

~14/5OO

	

219~!
.1"~!

	

. ~

	

~

	

~

	

!
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~~~~~~

	

=~~ absolute ~~~~~~~^~~~~~c^^J ~~]~~~~~ dollar signs
before the column letter and row number of a relative reference .

-

^

.

,
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• 	.
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To make a reference
relative

To make a relative reference from an absolute one :

0

Works removes the dollar signs, indicating that the reference is
now relative.

You can also remove the dollar signs by using the Backspace key .

Mixing References

If you want to refer to cells in such a way that only the column or
the row reference is absolute (or relative), you can use mixed
references. For example, in the reference $B3, only the column
reference is absolute. In the reference B $3, only the row refer-
ence is absolute. It's like giving a street but no address the
second house down on Almont Street . The house depends on
where you are, but the street remains the same .

F
~i File Edit Windo

56

D

3

5 Special Food Requests	$6,OOG	4.4495 :

	

$6,000	995
6 Food Subtotal

	

$3r. ,iioo

	

I

7 Lodging

	

. .'.r ~ - r

	

44.44'35 :

	

$20,000 :	
33. 1	

8 Bic:u cles

	

$2G OOG

	

14.8195 :

	

$5,000 :

	

7981	

9 Fromot,ons

	

$12 ,000 :

	

8.89 V

	

$12 ,000

	

18951
10 Total Expenses

	

$164 ,OGG

	

121 .48

	

$53,000 :

	

79951

	 :	:	:	:	 I
Total Budget Avaiilable

	

$135,000 :

	

100.0095 :

	

$67,5GG

	

10095 1
I

Under(Over)Budget

	

($29,000) :

	

21 .4895 :

	

$14,500 :

	

21951

11
12
13
14
15

Select the cell containing the formula that includes the abso-
lute reference you want to change .
In the entry bar, position the insertion point immediately to
the right of the absolute reference, or select the reference .
Choose Absolute Cell Ref from the Edit menu .

With these mixed references, the formula
always uses cells in rows 4 and 5 (the
absolute references), but may not always
use cells in column B (the relative reference),
if the formula is copied elsewhere .

w Select Format Options Chart

Budge LSS I
1

	

G
Alpine Race Budget

	

I

I

Expenses

	

:

	

May

	

: Percent :

	

June

	

Percent j	 :	
Easir: Food

	

$3G ,00C'

	

22.22

	

$10 GGG :

	

1595 1



You can enter a mixed reference by typing it into the entry

	

To enter or reverse a
bar. Just put a dollar sign before the reference you want to be

	

mixed reference
absolute .
You can reverse a mixed reference either by typing and using the
Backspace key or by using the Absolute Cell Ref command from
the Edit menu .

Operators

An operator is an instruction, such as + or -, that tells Works
to calculate a new value from existing values . For example, in
the formula = 3+6, the addition sign (+) is the operator that
instructs Works to add the operands 3 and 6 to produce the
new value 9 .
Works uses two kinds of operators : arithmetic and comparison .

Arithmetic Operators

The arithmetic operators represent standard calculator functions .
These include :

+

	

Addition
Subtraction
Negation (if used with one operand only)
Multiplication
Division
Exponentiation

To use an arithmetic operator :

Select a cell .
•

	

Type an equal sign to start a formula .
•

	

Type the first number or click a cell reference .
Type an arithmetic operator .

•

	

Type the second number or click a cell reference .
Type as many additional numbers and operators as you need .
Click the enter box or press the Enter key .

0

4

s
Ii

Works enters the formula in the active cell, calculates it, and
displays the resulting value .

Remember that if you don't type an operator after an operand
(number or cell reference) in a formula, Works automatically
inserts an addition sign (+) before the next cell reference .
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To use an arithmetic
operator
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Comparison Operators

A comparison operator compares two values and produces
the value 1 (TRUE) or 0 (FALSE). Works has six comparison
operators :

Equals
<

	

Less than
< -

	

Less than or equal to
>

	

Greater than
> =

	

Greater than or equal to
<>

	

Not equal

For example, 3<2 produces the value 0 (FALSE), while 2<3 pro-
duces the value 1 (TRUE) . If cell B17 contains 5 and cell B52
contains 13, then B 17 > B 5 2 produces 0 (FALSE) and B 17 < B 52
produces 1 (TRUE) .

Order of Operators

If you combine several operators in a single formula, Works
performs the operations in this order :

Exponentiation
Negation

* and /

	

Multiplication and division
+ and -

	

Addition and subtraction
- < < _ > > _ <> Comparison operators

If you want to change this order, use parentheses. Works first cal-
culates the expressions in parentheses, and then uses those results
to calculate the rest of the formula . For example :

Without parentheses

	

With parentheses

43+2=14

	

4*(3+2)=20
- 3A2= - 9

	

( -3)'2=9

Functions

A function is a built-in calculation . A function is similar to an
arithmetic operator, such as + or -, in that it produces a new
value from other values, called arguments .



Works has 54 built-in functions that you can paste or type into
formulas. For a detailed description of each function, see Chapter
15, "Spreadsheet Functions ."

Syntax of Functions

Each function consists of the function name, a set of parentheses,

	

Parts of a function
and arguments (the values the function uses to produce a new
value) separated by commas .

Arguments separated by a comma

The parentheses are very important. They tell Works where the
arguments begin and end . When you paste a function using the
Paste Function command from the Edit menu, Works provides the
parentheses and positions the insertion point between them . All
you do is type the arguments and the commas .
If you type the function instead of pasting it, remember to type
the parentheses. Do not leave any space before the left paren-
thesis . Be sure to finish with a right parenthesis. Otherwise, Works
displays an alert box .
In Works, an argument to a function can be a number, a refer-
ence, a range reference, another function, or an expression such
as C3/2. You can click cells to insert references into the argu-
ments of a function .
Many functions have more than one argument . For example,
Average(F1,F2,F3,F4,F5) calculates the average value of cells
F 1 through F5 . It uses a series of references to find an average .
Pmt(0.0167, 36,12000) calculates the amount you'd have to pay
back on a loan of $12,000 over a period of 36 months at 1 .67
interest per month .
You can include functions in a formula either by typing them or
pasting them .
To paste a function into a formula in the entry bar :

0

Name of function

Parentheses

-Average~3O000 10000

Select the cell to hold the formula .
Position the insertion point where you want the function to go
in the formula.
Choose Paste Function from the Edit menu .
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Arguments to
functions

To enter a function
into a formula
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4

6

a

8

r 1

	

File Edit

Select the function you want from the list .
Click the OK button .
Works pastes the function into your formula, including the
parentheses . The insertion point is inside the parentheses,
ready to accept arguments to the function .

-Sum)

Type any values or click any cell references required by the
function .
Include any additional operators and operands that you need
in your formula.

Sum(54:5)

Click the enter box or press the Enter key .

Works enters the formula in the active cell, calculates it, and
displays the resulting value .

When you enter the formula, Works
displays the formula in the entry bar. . .

. . .and displays the result of the
calculation in the selected cell.

endow Select Format Options Chart
59

	

-Sur (54 :58)

E

The insertion point shows
where the arguments go .

Budget (S S1

z	 C	i
. . . . . . . . . . . . Alpine Race Budget

	

I
2

	

I
z	3 Expenses

	

:

	

May

	

Percen#

	

June

	

. Perce ntI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . .
4 Basic Faad

	

$30,000 . :	2

	

:	1595 . .1
5 Special Faad Reques#s

	

$6,000

	

4.4498 ;

	

$6,000

	

9981. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6 Lodging

	

$60,000

	

44.44% •	$20,000

	

30981	:	:	
7 Bicycles

	

$20000

	

14.8198 :

	

$5,000

	

951	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . :	:	: . . . .
$ F "motions

	

$1

	

8.8998 :

	

$12 ,000

	

1898 1 .
Total Expenses	$128,Q00

	

94.81.98 :	$53,000

	

7998

	 :	:	:	 I
Total Budget Available

	

$135,000

	

100.0098

	

$67,500

	

100	

13 Under (over) Budget

	

$7,000 . :	519:98 :	$. 1. 4.,500

	

21.981



If you choose to type a function rather than paste it, be sure to
type an equal sign to begin the formula, and include parentheses
before and after the arguments .

To help Works perform as efficiently as possible, avoid circular
references in your formulas . A circular reference is a reference
that has no ending point. The cells involved in a circular refer-
ence cannot be calculated. It is like a child asking his father if he
can go out and play. His father says it's okay if his mother says it's
okay. His mother says it's okay if his father says it's okay . So the
child doesn't know what to do . When Works encounters a circular
reference, it displays an alert box .
A circular reference in a Spreadsheet document is a reference that
refers to a cell which in turn refers back to the original cell . More
specifically, a circular reference occurs when, in order to calcu-
late a formula in a particular cell, Works needs the value of the
same cell that contains the formula . An example of such a refer-
ence is the formula = Sum(A 1 : A6) when entered in cell Al .
A more common example of a circular reference involves a
chain of cells and references . For example, a formula in cell E 1
may refer to cell E2, which contains a reference to cell E3, which
contains a reference to cell E4, which contains a reference back
to cell El . In Works, a circular reference like this cannot be
resolved.
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Avoiding Circular References

	

Avoiding circular
references





12 Working with the Spreadsheet

After you've set up a Spreadsheet document, you're ready to start
playing with the numbers to see the results of various scenarios .
This chapter shows you ways you can work with a completed
Spreadsheet document .
This chapter shows you how to :

•

	

Play What-If change the content of a cell to see the effect
that change has on the rest of your information .

•

	

Choose when to recalculate, rather than having Works do
it automatically.

•

	

Display formulas to help analyze the design of a Spreadsheet
document .

•

	

Divide the Spreadsheet window into panes, so that you can
view different parts of the Spreadsheet document at the
same time .

•

	

Find a cell anywhere in a Spreadsheet document .
•

	

Work with blocks of cells, copying, pasting, turning rows into
columns and back, filling empty cells, and moving .

•

	

Sort a Spreadsheet document by rows .
•

	

Insert blank rows and columns .

These tasks help you analyze the information in your Spreadsheet
document. If you want to polish the appearance of your docu-
ment, or prepare it for printing, see Chapter 13, "Formatting
and Printing ."

Changing the Content of a Cell

One of the Spreadsheet's most important assets is its ability to
recalculate whenever you make a change .
Each time you make a change, you play What-If . What if the rate
on your building loan goes up by 2%? What if it goes up 5%?
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To change the
content of a cell

As long as you've saved your original Spreadsheet document on a
disk, you're working with a copy. None of the changes you try are
permanent unless you want them to be . On the other hand, if you
find several alternative scenarios that you'd like to keep, you can
print each one, or save each with a different name .
You can change the entire content of a cell by selecting the cell
and typing the new information . The new information replaces the
old. Or, you can change part of a cell's formula or constant value
in the entry bar using standard Macintosh editing techniques .
Click in the entry bar and type the information you want to add,
or use the Cut, Copy, and Paste commands from the Edit menu
to replace information .
When you click in the entry bar, Works activates it and displays
a cancel box, an enter box, and an insertion point .
When you are done making changes, click the enter box (or press
the Enter key) to enter the new information into the cell. If you
decide not to keep your changes, click the cancel box . Works
restores the previous contents of the entry bar .

r
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Expenses		May	 Percent

	

June

	

Percent I. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . .
. . I	Basic Faod

	

.3oCu1~a

	

2298

	

$10aaa

	

5.,
Special Foad Requests

	

$6000 :

	

493 :

	

$6000 :

	

998 1
Lodging

	

$60000

	

4498 :

	

$20000 :

	

30931,,	
Bicycles

	

15%

	

$S,OOU

	

793
Promotions I$1200099312Oaa

	

1893.,

	

.	Total Expenses

	

$128000

	

9598

	

$53 000

	

7993 I,:	
I

Total Budget Available

	

$135000 :

	

10098 :

	

$67500 :

	

10098],,

Under (Over) Budget

	

$7,000 :

	

5%

	

$14,500 :

	

21% I

I

. . . . . . . . . . . . . . . . . . . . . . . .

The cancel and enter boxes are
visible when the entry bar is active .

When the entry bar is active, you
can edit the cell's value or formula .

Window Select Format Options Chart

3000

Budget (SS)

J

	

o

	

Click the enter box or press
the Enter key to enter the edited
value or formula in the active cell.



Controlling Calculation

The Works Spreadsheet normally calculates automatically when-

ever you enter or change a value . Each recalculation takes some

time. But with Works, you don't have to wait. While calculations

are being performed, you can continue to enter values or perform

other Spreadsheet functions .

While Works is recalculating the Spreadsheet document, the icon

representing the pointer changes slightly. If the pointer is an

arrow, Works inverts its colors to white on black ; if the pointer

is an I-beam, Works adds a circle to the stem of the I . When the

pointer returns to its normal appearance, recalculation is done .

You should not use numbers displayed on the screen until calcula-

tions are complete, since the numbers may change as a result of

the calculations .

If you have many numbers to enter and don't want calculations to

be performed until you are finished, you can switch to manual cal-

culation. With manual calculation, you tell Works when you are

ready to recalculate .

To set manual calculation :

0 Choose Manual Calculation from the Options menu .

Then, when you've entered all your information and are ready

to recalculate manually :

0

0

Choose Calculate Now from the Options menu .

Choose Automatic Calculation from the Options menu .

When you're examining the effects of changes to a single cell,

automatic calculation saves you the trouble of repeatedly telling

Works to recalculate .
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To set manual

calculation

If you no longer have many changes to make, you can switch back To return to

to automatic calculation .

	

automatic calculation
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To show values

Showing Formulas or Values

The Spreadsheet normally displays the values that result from cal-
culations. The entry bar displays the content of the active cell . But
sometimes you may want to see all the formulas in a Spreadsheet
document, so you can figure out the logic behind its design .

To show formulas

	

To have Works display all the formulas and unformatted values :

0

F

	

File Edit Window Select Format Options Chart

Oudget 1551 a

H

f

A B C D E F

a

Choose Show Formulas from the Options menu .

Alpine Race Budget

	

I

I

Expenses

	

May

	

. June

	

Percent I.
I	BasicBasic Food 30000 : =B4/$B$1 1 10000 =D4/$D$1 1

Special Food Requests

	

6000 =B5/$B$1 1

	

6000 : =D5/$D$1 1 I. . . . .
Lodging

	

60000 : -B6 /$B$1 1

	

20000 : =D6/$c:$1 1 I. . . . . . . . . . . . . . . . . . . . .
Bicycles

	

20000 : =B7/$B$1 1

	

5000 : =D7/$D$1 1 I. . . . . . . . . . . . . .
Promotions

	

12000 : =B8/$B$1 1 12000 : =D8 /$G$1 1

Total Expenses

	

=Sum(B4 :B8j =B91$B$11

	

=SurrifU4 UBj =D9/$D$1 1 I:	 :	 . . . . :	
I

Total

	

Budget Available

	

135000 : - B 1 1 1$B$1

	

67500 : D1 1, '$U$1 'I. . .
I

Under (over) Budget

	

=E1 1-B9 =B13 /$B$1=E' 1 1-[ 9 =E> 1 3!'$E:' :# 1 I.

	

. . . . . .
I

For analyzing numbers, it's better to look at values than formulas .
To have Works display values :

Choose Show Values from the Options menu .

Works now shows you the formatted values .
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4
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7
8
9
10
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13
14

Dividing the Spreadsheet Window
into Panes

Often you'll want to see the results of a change in one cell on
another cell far away . Scrolling back and forth from the cell with
the change to the cell with the result could get tiresome . So
Works provides split bars that divide the Spreadsheet window into
panes. The panes scroll together along the direction of the split .
The two panes on either side of the vertical split bar scroll
together vertically. The two panes above and below the horizontal
split bar scroll together horizontally. That means you can leave
one pane stationary while you scroll the other pane until it shows
the second cell. When you make a change, you'll see the effects
of it instantly, even across an entire Spreadsheet document .
Dividing the window into panes also lets you freeze row and
column labels while you scroll through numbers in another pane .
If you have a very wide or very long Spreadsheet document, you
won't have to guess what the numbers at the far end of the docu-
ment refer to .
You can divide the window into both side-by-side and upper and

	

To divide the window
into two paneslower panes .

0 Position the pointer on either the horizontal or vertical
split bar .
The pointer turns into a two-way arrow.
Drag the split bar until it lines up with the right edge of the
column or the bottom edge of the row at which you want to
divide the Spreadsheet document.

When you release the mouse button, Works divides the window
into two panes .
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Expenses

	

May

Alpine Race Budge#

Percent June Percent j
Basic Food

	

$30,000 : 22% $10,000 : 15%
Special Food Requests

	

$6,000 : 4% $6,000 : 9% I. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Lodging

	

$60,000 : 44% $20,000 : 30%i
Bicycles

	

$20,000 : 15% $5,000 : 7%
Promotions

	

$12,000	9% $12,000 18%
Total Expenses

	

$128,000 : 95% $53,000 : 79%

Total Budget Available

	

$135,000 100% $67,500 :
I

100981

Under (Over) Budget

	

$7,000 : 5% $14,500 : 21%
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Note If you create a pane containing only one or two rows, that
pane will not have a scroll bar .

Drag the horizontal split bar
to divide the window into
two side-by-side panes .

D

F
i File Edit Window Se

Special Food Requests. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Lodging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Bicycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Promotions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Total Expenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Scroll bars

B

	

I

	

c

If you drag the vertical split
bar instead, Works divides the

window into upper and lower panes.

lest Format Options Chart

Alpine Race Budge
	

I
May

	

. Percent

	

June

	

Percent j
$34,440 :

	

22 .22% ;

	

$10,000 ;	15%
$6,000 :

	

4 .44%	$6,400 :	9%I

To divide the window With four panes you can see even more parts of a Spreadsheet
into four panes

	

document at once because you can scroll each pane both verti-
cally and horizontally .
To divide the window into four panes :

Drag both split bars into the positions you want .



F

	

File Edit Window

D

Scroll bars

Now you have four sets of scroll bars . Each scroll bar controls the
two panes that are in line with it. For example, the upper scroll
bar controls the two upper panes, and the left scroll bar controls
the two left panes. Otherwise, the scroll bars work normally .
To close a pane :

	

To c ose a pane

Drag the split bar back to the far left or upper edge of the
pane.

Finding a Cell

Drag both the horizontal and vertical split
bars to divide the window into four panes .

Scroll bars

Options Chart

If you want to look at a cell that's just beyond the edge of the
window, you can find it easily by scrolling . But a cell that's far
away on a very large Spreadsheet document may be difficult
to find .
If you specify the coordinates of a cell, Works will find it for you .
If you know only what's in the cell, you can specify its value, and
Works will try to find a cell that matches what you type .
Works can also find the last cell and the active cell in a Spread-
sheet document .
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13
14

lis
116

17
18

Bicycles
Promotions
Total Expenses
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5 .8998 :
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$ 12,000
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7981

	$53.000 :	7998
:
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. . . . . . . . . . . . . . . . . . . .
•

. . . . . . . . . . .

. .
:
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To find and select
a cell

Using Cell References or Cell Content

There are two commands from the Select menu that allow you
to find a particular cell : Find Cell and Go To Cell. Use Find Cell to
have Works select a particular cell, and use Go To Cell when you
just want to see the value of a cell, but do not want to select it .
With the Find Cell command, you can find and select a cell by
specifying its reference or value . If the value you're looking for is
a label, you can specify a portion of the text, and Works will look
for the cell containing it .
To find a cell containing the error value * Error * or N/A, type
=Error() or =NA() in the Find Cell dialog box . When you type
a formula (beginning with an equal sign) in the dialog box, Works
calculates the formula and looks for a cell displaying the resulting
value. For example, since = Error( ) gives the value *Error *,
Works looks for a cell containing * Error * .
To find and select a cell :

[i1 Choose Find Cell from the Select menu .

11

Type the reference or the value of the cell you're looking for,
or type a formula whose resulting value is in the cell .
Click the Find Next button .

If you type 60000 or B6 in the Find Cell
dialog box, Works finds and selects this cell .

F

	

File Edit Window Select Format Options Chart
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=a

5

6

7
8
9

60000

Budget (SS)
A B I

	

C I

	

D E

Expenses

Alpine

May

Race Budget

	

I

Percent

	

June

	

Percent I

Basic Food $30,000 : 22 .22'%

	

$10,000 :

	

15%I

Special Food Requests $6 .000 4 .44%

	

$6,000 :

	

9951

Lodging ° .•°°° 44 .4495

	

$2a 000 :

	

305 1

Bicycles 20,000 14 .8195

	

$5,000 :	7%I
Promotions $12.0O0 $1 2,O00 :

	

1 8%I
Total Expenses $128,000 : 94 .81%

	

$53,000 :

	

79%

Total Budget Available $135,000 100 .00%

	

$67,500 ;

	

100951

Under (over) Budget $7,000 :

I

5 .19%

	

$14,500 :

	

21%:



If you type a reference, Works moves to the cell and selects it . If
you type the cell value or formula, Works looks across each row
for a cell whose value matches what you typed . If it finds a match,
Works moves to and selects the cell . If Works can't find anything
to match the text you typed, it displays an alert box .
With the Go To Cell command, you can find a particular cell by

	

To find a cell without
specifying its cell reference . Works finds the cell and makes it

	

selecting it
visible in the window . It does not select the cell .
The Go To Cell command is useful while you're typing a formula
and want to see a particular cell . Because the cell is not selected,
it will not appear in the entry bar as a reference . Go To Cell is
also useful when you want to select a large range of cells .
To find a cell without selecting it :

0 Choose Go To Cell from the Select menu .
Type the reference of the cell you're looking for .
Click the OK button .

Works moves to the cell but does not select it .

The cell you specify in the Go To Cell dialog
box appears in the window, but is not selected.

Budget (SS)

r File Edit Window Select Format Options Chart
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t

I

A B

	

I C I D I E
1 Alpine Race Budget I

2
3 Expenses May

	

Percent June Percent 1
4 Basic Food $30,000 : 22 .22% $10,000 : 15%I
5 Special Food Requests $6.0O0 4.44% $6,000 : 9%
6 Lodging $60 000 : 444498.,

. . . . . . . . .
$20000 3098 1

7 Bicycles $20000 : $5aa0 798, .,148198':
8 Promotions 	:	$12000 :, .,88998	:	$12000 18
9 Total Expenses $128000 :, .,9481% $53000 : 79%
10
11 To#al Budget Available $135000 :, .,1000098:$67500 :. . . . . . . . . . . . . . . . .100%
12

: .13 Under (Over) Budget $7000 :, .,51998 $1450019812 . .
14
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What happens when
you copy references?

Finding the Last Cell or Active Cell
The Last Cell and Active Cell commands from the Select menu
help you move quickly around a Spreadsheet document .

To find the ast cell

	

Works considers the last cell in a Spreadsheet document to be the
cell at the intersection of the last row and column that contain a
value or formula .
To select the last cell of your existing Spreadsheet document :

a
Works scrolls to the last cell, which marks the lower right boun-
dary of your document, and selects it for you .

To find the active cell

	

If you have been scrolling all around the document looking at
various cells, the Show Active Cell command takes you back to
where you were last working .
To scroll to the currently selected cell :

D

Choose Last Cell from the Select menu .

Choose Show Active Cell from the Select menu.

Works scrolls to the active cell .

Copying Cells

It doesn't take long to type the content of a cell . But why type the
same thing over and over again? With Works, you don't have to .
Using commands from the Edit menu, you can copy it . For exam-
ple, if you have sales projections for four quarters, you can set up
the formulas for the first quarter and then copy them for the rest .
When you copy and paste a formula that contains relative refer-
ences, the references are adjusted to reflect their new locations . If
you copy and paste a formula containing a relative reference that
refers up two rows and over one column, the adjusted reference
will refer up two and over one to whatever new cell holds that
relative position . For example, if the formula in cell C7 is = C4
and you copy it to cell D7, Works changes the formula to = D4
so that it still refers to the cell "three up from the formula cell ."
When you paste relative references, the new references look dif-
ferent from the old ones, and refer to different cells . However,
a copy of an absolute reference refers to exactly the same cell
as the original reference .



Copying and Pasting Values and Formulas

When you copy, Works places a copy of the selected cells onto
the Clipboard for you to paste somewhere else .
To copy and paste a selection :

0

4

Select the area you want to copy .

r
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30000

Budget (SS)
	B	I	C	I	D	I	E	I

alpine Race Budget
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . . . . . . :	:	
Expenses

	

Percent

	

June

	

Percent II
Basic Food	• . . . • . •	$30 .0 0i	10.,000

	

i	
Special Food Requests

	

$6 .0 iii

	

4.44'.:r,

	

$6000 :	9ggl

Lodging

	

$60 .000

	

44.44$20 000 ;

	

30981
:Bicycles	 :$~20 iii-iii

	

14 ...1

	

$s ,000

	

7%i

RYOmotions	 $' 1 : ~~-~~

	

r

	

$1.2.,000	1898	
Total Expenses

	

.	3
.0 i iii	' .:r.

	

$53 000

	

7998 1

:	I	
Total Budget Available

	

' ; 135 .000

	

1 %iii iii, . # _

	

$67,500 :

	

100981. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Under (Over) Budget

	

$7 OCO

	

5 .19

	

$14 500 :

	

2198

Selection to be copied to the Clipboard

Choose Copy from the Edit menu .
Works puts the selection onto the Clipboard . It stays there
until you replace it with another selection or turn off your
Macintosh .
Click the upper-left cell of the area you want to paste into .
Make sure that the cells you want to paste into are blank or
can be replaced .
Choose Paste from the Edit menu .

Works pastes the full contents of the Clipboard back into the
Spreadsheet document, adjusting relative references to reflect
their new location .
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To copy and paste
a selection



194 The Spreadsheet

To paste values only

r

	

file Edit Window Select
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B	I	c	I
Alpine Race Budget

	

1

Expenses

	

May

	

Percent

	

June

	

Percent
Basic Food

	

$30,000 :

	

22.22%

	

$30,000 :

	

22 .229811
Special Food Requests $6,000 : 4 .44% $6)O00

Lodging

	

$60,000 :

	

44.449x :

	

$60,000 :

	

44 .4498 1
Bicy cles

	

$20,000 :

	

14.8198 :

	

$20,000 :

	

14 .8198 1
Promotions

	

$12,000 :

	

8.89%

	

$12,000 :

	

8 .89931
Total Expenses

	

$128,000 :

	

94.81%

	

$128,000 :

	

94 .81%i	 :	:	:	
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Total Budget Available

	

$135,000 :

	

100.0093'

	

$135,000 :

	

100 .00 /

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Contents of the Clipboard
pasted into the new location

Pasting Values Only

Sometimes you will want to paste just resulting values, without
the formulas . The Paste with Options command lets you choose
to paste just values from the Clipboard back into a Spreadsheet
document.
For example, if you have an accounts receivable ledger in one
Spreadsheet document and a general ledger in another, you could
paste just the total of the accounts receivable (that is, values only)
to the general ledger . You don't want to paste the formulas that
produce the values, however, since those would produce different
values in the general ledger .
To paste values only :

Select the area you want to copy, and choose Copy from the
Edit menu .

•

	

Click the upper-left cell of the area you want to paste into .
Make sure that the cells you want to paste into are blank or
can be replaced.

•

	

Choose Paste with Options from the Edit menu .
Click the Values Only option .

•

	

Click the OK button .

Notice that if you click the Both Values and Formulas option,
Works proceeds exactly the same as if you had chosen the normal
Paste command .



Transposing Rows and Columns

You might want to turn a column into a row if you want to plot
that column as a bar chart. Or you might want to turn a row into
a column so you can make a pie chart out of it . Transposing rows
and columns is also useful for converting records and fields that
you copy from the Database . For information about copying infor-
mation from the Database, see the last part of this manual, "Using
the Tools Together ."
To transpose rows and columns :

El

4

11

r
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Basic Food	$
.
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22.22%	1.0.,u0	1
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94.8193
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$a
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-
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I
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kt

	

t

	

~~

515

-D

Cut or copy a selection to the Clipboard .
The selection can be a single row or column or any range
of cells .
Click the upper-left cell of the area you want to paste into .
This cell can be in the same Spreadsheet document, or you
can move to another one . Make sure the cells you want to
paste into are blank or can be copied over .
Choose Paste with Options from the Edit menu .
Click the Transpose option .
Click the OK button .

$30,000

B
Budge (SS)

I	o	I
Alpine Race Budge#

	

I
I

Expenses

	

May

	

Percent

	

June

	

Percent j	 :	:	:	

The contents of cells B4: B 13 . . .
. . .have been transposed into this row .
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To transpose rows
and columns
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Works transposes the rows into columns or vice versa, then
adjusts relative references to reflect their new location .

Filling

To fill into adjacent

	

Filling lets you copy the content of a row or column into adjacent
cells

	

rows or columns . Within a selection, you fill cells to the right of
the first column of the selection or below the first row of the
selection . Filling fills in all cells within the selection, replacing
their content if they are not blank, so you should be sure that
any cells containing information can be replaced .
To fill into adjacent cells :

0

F
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C4

D

Drag across one column or row containing the data you want
to copy and as many blank adjacent rows and columns as you
want to fill .
Make sure the entire block is highlighted .

2
3
4
5
6
7
8
9
10
11
12
13
14

10000

Basic Food
Expenses

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Special Food Requests. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Lodging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Bicycles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Promotions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Total Expenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

B

	

C

. . . . . . . . . . . . . . . . . .
$30,00101
$6,0010

$60,000
$20,000. . . . . . . . . . . . . . . . . .
$12,000

$128,000. . . . . . . . . . . . . . . . . .

Budgets (SS)

Alpine Race
Budget

I

Ma

	

June

	

Jul

	

I

I
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

$10 u:' :':'
$6 ,000. . . . . . . . . . . . . . . . . .	 • •-•0 i,r,i,
$5 ~,_,I„ I. . . . . . . . . . . . . . . . . . .

$12 ,0,00,

. . . . . . . . . . . . . . . . . . .$53 .000

. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . .

I

:	:	 I

Total Budget Available

	

$135,000 ::

	

67,500	 :	
:	:	

Under (Over) Budget

	

:

	

$7,000

	

14,500. . . . . . . . . . . . . . . . . .

	

. . . . . . . .

	

. . . . . . . . .

. . . . . . . . . . . . . . . . . .

Choose Fill Right or Fill Down from the Edit menu .

The contents of these cells . . .
. . . will fill these cells .

Works copies the contents of the original cells into the adjacent
cells .

I



~j;6
i::%

$20 01:11:1

!j;5 ,00CI
$ 12,1:11:11:1

	

5~ 1 ., I_Iin i
. . . . . . . . . . . . . . . . . . .

$53 .000. . . . . . . . . . . . . . . . . . .

I

iiiii'

	

I$10 ,
$6,000 I

ii Ii

. . . . . . . . . . . . . . . . . .
$53 ,fiiJiJ. . . . . . . . . . . . . . . . . . .

F

File
hilt

Window Select Form

	

Op ions Chnrt

10
11
12
13
14

Moving Cells

Suppose you developed a whole Spreadsheet document and then
decided you wanted your totals at the top, instead of at the bot-
tom. The Move command lets you select a block of cells and
move it to a new location within that same Spreadsheet docu-
ment.
When you move cells, all references in the cells in the new loca-
tion refer to the same cells that they did before you moved them ;
the formulas still calculate from the same values . Works adjusts
any other formulas on the Spreadsheet document that contain
references to the moved cells, so that they refer to the new
location of the moved cells .
To use the Move command, you must know the coordinates of
the cell at the upper-left corner of the location you want to
move to.
To move a block of cells :

0

C4

2

4
5
6
7
8

The contents of the original

	

. . . when the new cells are filled
cells remain unchanged . . .

	

with the Fill Right command.

10000

Expenses. . . . . . . . . . . . . . . . . . . . . . . . . .
Basic Food. . . . . . . . . . . . . . . . . . . . . . . . . .
Special Food Requests. . . . . . . . . . . . . . . . . . . . . . . . . .
Lodging. . . . . . . . . . . . . . . . . . . . . . . . . .
Bicy cles. . . . . . . . . . . . . . . . . . . . . . . . . .
Promotions. . . . . . . . . . . . . . . . . . . . . . . . . .
Total Expenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Budgets (SS)
•

	

C
Alpine Race Bud

May
$30,000
$6,000
$60,000
$20,001]
$12,000

$128,000. . . . . . . . . . . . . . . . . .

June
' 1iI,i11111

et

I

Total Budget Arailable

	

$135,000 :

	

$6?,500

	

I

Under corer) Budge#

	

$7 ,000

	

$14,500 :

	

I

Select the block that you want to move .
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I . . . .

I

If you have any relative references in copied formulas, Works
adjusts them relative to their new positions . Absolute references
stay the same.

•

	

3

•

	

9

To move a block
of cells
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r

	

File Edit Window Select Format Options Chart

10
11
12
13

El Budgets (SS)

Fl

n

4

r

Expenses
Basic Food
Special Food Requests
Lodging
Bicy des
Promotions
Total Expenses

Original selection to be moved

The original location is now blank .

$6 .C1C1C1

#:12 CI':" :'

$53 .oo':'

If you type E15 in the Move dialog box,
Works moves the selected cells here .

File Edit Window Select Format Options Chart

Choose Move from the Edit menu .
Type the reference of the cell that will contain the upper-left
corner of the moved selection .
Works will replace the contents of any cells that aren't blank,
so make sure their contents can be replaced .
Click the OK button .

4
5
6
7
8
9

12
13
14
15
16
17
18
19
20

10000

Basic Food $30,000
Special Food Requests . $6 .,000
Lodging . $60,000
Bicycles . $20,000
Promotions . $12,000
Total Expenses

	

$128,000

Total Budget Available .

	

$135,000

Under (Over) Budget

	

$7 .000

Budgets (SS)



Works moves the selection from its old location and pastes it into
the new one . All relative references in the moved cells refer to
the same cells they referred to before the move .
If you don't know the exact coordinates of the location where
you want to move the selection, there's another way to move
cells. After you select the block you want to move, position the
pointer on the cell at the upper-left corner of the destination
block, but don't select it . Then hold down the Command and
Option keys and click .

Sorting

You can change the order of rows in a selection by sorting. You
might want to sort a payroll document in alphabetical order by
last names, or you might want to sort a stockroom inventory by
part number.
Works lets you sort in ascending and descending order .
If you have numbers and text in the same column, the numbers
come first, whether you're sorting in ascending or descending
order. Blank cells are always sorted last .
You can sort on up to three key columns. This allows you to have
subgroups for subtotals. For example, you could sort a payroll
document by department, supervisor, and last name, setting up
subtotals for each category. That would let you analyze payroll
expenses by department and supervisor .
In the example below, the selected cells are being sorted in
ascending order on key column A .

F

	

file Edit

A4

=a

2
3
4
S
6
7
8
9
10
11
12
13
14

Alpine Race Budge. . .
I

t

	

IPercent

	

June

	

Percen
. . . . . . . . . . . . . . . . . .
Expenses

If you type A in the Sort dialog box, Works sorts the
entire selection based on the contents of column A .

Window Select Format Options Chart

B~si c Food

Budget (SS)
C

E:.y=u:: Food
:=;peg_ i .- 1 Fuiid F:egiiests

F'r':urciotiori -:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3iIc.I. . . . . . . . . . . .
?cV 1

lliliI
. . . . . . . . . . . . . . . . . ..

$6 ,EIEIEI

	

4'

II CICIO

	

15'r

22
$6 fnJO

$20 .000
$5 •0Ci0

I_II II_I

. . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Total Expenses

	

$1 ~8 000

	

95

	

$53000 ? .'? I

I

Total Budget Available

	

$135,000 :

	

1009 :

	

$6 ,501x

	

1 oo%

Under (Over) Budget

	

$? OOO

	

5

	

14 ,500 :
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.`~z,rsxz?:;os',i.:aRZ;tiz~yg:a'~zxCce?«e;>a4».'«F> :;e'fsA ae

To sort a Spreadsheet
document

r 1 File Edit Window Select Format Options Chart

Sorting affects only selected cells . Works rearranges the selected
cells in each row according to the order you specify for the
key column. When you change the order, most cells will have dif-
ferent cell references . Works changes both absolute and relative
references, inside and outside the selection, to reflect new cell
locations .
To sort a Spreadsheet document :

II

4

6

Works reorders your selection .

Note You can only sort rows . If you try to sort columns based
on key row headings, Works displays an alert box .

Select the cells you want to sort .
Choose Sort from the Edit menu .
Type the letter of the column heading on which you want to
sort the key column .
Click the order you want to sort in (ascending or descending) .
If you have a second or third key column, move the insertion
point into the appropriate box and type the letter .
Click the OK button or press the Return key .

44 Basic Food

(SS)-0 Budget
A B I

	

c I

	

D E F
1 Alpine Race Budget

	

I

2 I
	 :	 :	 :	 :	

I3 Expenses

	

Percent

	

June

	

Percent
4 E: .~_ ic_ F • "d

	

s':'
!'I'II

5 $20 ,fujfi

	

15'r

	

$5,000 7' I

6	 44'r 3c'% I
7 Fi r c'rn itic. r,_

	

1 f
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

8 '=peci.31 Fc 'd

	

4V

	

$6 ('00 	; . : . ;
9 Total Expenses

	

$128,000

	

95%

	

$53,000 79981
10 I

11 Total Budget Available

	

$135,000 :

	

100%

	

$67,500 :

	

100%
12
13 Under (over) Budget

	

,

	

5

	

$14,500 :

	

21%
14 I



Inserting Rows or Columns

You can insert rows or columns in a Spreadsheet document when-
ever necessary. So if you have just finished a large document after
hours of work and you discover that you need just one more row,
Works can help you.
When you insert rows or columns, both relative and absolute
references are adjusted accordingly . So if you have a cell referring
to cell A1 and insert a row above row 1, the changed reference
will be to cell A2, one row down .
To insert a row or column :

0 Click the row or column heading where you want to insert a
new row or column.
Choose Insert from the Edit menu .

Works inserts the new row or column at the selection, moving
the selected row beneath the insertion, or the selected column to
the right of the insertion. All the rows or columns that follow the
new one are renumbered . If you need to insert more than one
row or column, you can repeat the procedure .
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To insert a row or
column





13 Formatting and Printing

The first two chapters of this part of the manual explained how
to set up a Spreadsheet document and calculate with it . In this
chapter, you'll learn hove to change the way it looks its format .
This chapter also explains how to print a Spreadsheet document
when you have the format adjusted to your liking .
Read this chapter to learn how to :

•

	

Change the way numbers are displayed.
•

	

Realign the content of cells .
•

	

Emphasize cells with bold type or underlining .
•

	

Display or remove the grid .
•

	

Change column width .
•

	

Protect cells from changes .
•

	

Set page breaks for printing .
•

	

Print a Spreadsheet document .

The value of a cell and how Works displays that value within the

	

About cell formats
cell are different . The value of a cell is determined by its formula .
How that value is displayed is determined by the format of the
cell .
You can change the appearance of a Spreadsheet document in a
variety of ways without affecting formulas or values in cells . When
you change a cell's format, its value does not change . Works
displays the cell's value in the new format .
Using commands from the Format menu, you can specify the for-
mat of a cell before or after you enter the content of the cell .
When you want to enter data that all use the same format, you
can format selected cells before you start typing . Then, when you
enter the data into those cells, Works displays it in the format you
chose. Or, you can enter your data first, then select the cells and
choose a format .
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To change the
number of decimal
places

Works adjusts the format of the selected cells accordingly .

Changing Number Formats

Unless you specify otherwise, Works displays numbers in General
format (that is, as accurately as possible, given the cell width) .
For example, if you type 12345 .6789, Works may display it in a
variety of ways, depending on the width of the cell : 12345.6789,
12 34 5.7, 12346, 1E+4, and so on .

To change the format Numbers can be displayed in General format, as fixed decimals,
of numbers in cells

	

dollars, percents, or in scientific notation . With all formats except
General, you can set a fixed number of decimal places to display .
One Spreadsheet document can contain many different cell for-
mats. For information about the number formats you can use,
see "The Format Menu" in Chapter 16 .
To change the format of cells :

0
F'

F

	

File Edit Window Select Format Options Ghdrt

0

Select the cells you want to format .
Choose General, Fixed, Dollar, Percent, or Scientific from the
Format menu .

Unless you specify otherwise, Works displays two decimal places
in your numbers in all formats except General . You can choose to
display up to 15 decimal places .
To change the number of decimal places :

Select the cells for which you want to change the number of
decimal places .



El
4

Choose Number of Decimals from the Format menu .
Type the number of decimal places you want displayed .
Click the OK button or press the Return key .

Works adjusts the numbers accordingly .

You can choose to display numbers with or without commas . If

	

To display numbers
you type commas into your numbers as you enter them, Works

	

with commas
treats the number as text .
To choose whether or not to show commas :

Select the cells you want to format .
Choose Commas or No Commas from the Format menu .

0

Aligning Cell Contents

Numeric values in Works are automatically right-aligned (they line To change alignment
up on the right of the cell), so that columns of numbers are easy
to read . Labels automatically line up on the left of the cell . How-
ever, you might want to center or right-align your labels, or left-
align your numbers. So Works lets you specify the alignment of
cells. You can select columns, rows, a single cell, or a block of
cells to realign.
To change the alignment of cells :

Select the cell(s) whose alignment you want to change .
Choose Align Left, Align Center, or Align Right from the
Format menu .

0

Works adjusts the alignment of the selected cell or cells .

Adding Emphasis

Spreadsheet cells contain normal (plain) type unless you change

	

To change type style
the type with the Format menu. You can add emphasis to the con-
tent of any cell by changing the style of the cell to bold and/or
underlined text .
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r

	

File Edit

0

To display the grid :

D

To remove the grid :

D

Normal Text

Window Select Format Options Chart

Underline

Displaying the Grid

To display or remove You can choose whether or not to display the grid .
the grid

Budget (SS)

Works changes the type style of the selected cells .

Choose Show Grid from the Options menu .

Choose No Grid from the Options menu .

Bold

If you format a cell to have underlined text, the underlining
extends across the full width of the cell .
To change the type style of cells :

Select the cells whose type style you want to change .
Choose Bold, Underline, or Normal Text from the Format
menu .

C

Alpine Race Budget I

2 I

3 Expenses May Percent

	

June Percent I
4 Basic Food $30,000 : 22 .2298

	

$10 000 : 1598

5 Special Food Requests $6,000 : 9

Lodging

4 .4498	
$6 .00.. .	I	

6 $60,000 : 44 .44% $20,000 30%

	

I

7 Bicycles $2 , 14 .81% : $5,000 : 798	 . . . . . . . . . . . .
8 Promotions $12,000 : 8 .8998 $12,000 : . . . . . . . . . . . .18%

9 Total Expenses $128,000 : 94 .8193 $53,000 : 7998

	

I

10 I

1 1 Total Budget Available $135,000 : . . 100 .0098 . . :	$67,500 : 100% I

12
13 Under (Over) Budget $7,000 : 5 .1998 $14,500 : 2198

	

I

14 I



Changing Column Width

The standard width of a column is 12 characters . A single column
can display up to 40 characters . That's large enough to show long
labels like Advertising and Total Invoices .
When something doesn't fit in a cell, you can widen the cell . In
General format, numbers are displayed as accurately as possible
given the width of the column, using scientific notation if
necessary .
You change the width of a column by dragging the line at the
right of the column heading or by choosing Column Width from

	

width
the Format menu .
To change column width by dragging :

Position the pointer on the right edge of the column heading .
The pointer becomes a two-way arrow .

•

	

Drag to the right to make the column wider, or to the left to
make the column narrower .

0

0

To change column width by using the Format menu :

Select a cell in the column you want to change .
You can select cells in multiple adjacent columns if you want
to change the width of all of them .

•

	

Choose Column Width from the Format menu .
•

	

Type a number, up to 40, for the overall column width .

When you enter a label, if you type more characters than will fit
in a cell before you've widened it, Works continues the label into
adjacent blank cells, if possible . When you enter a number that is
too long for a cell, Works displays the cell filled with number
signs (#).

Protecting Cells from Changes

When you set up forms for other people to fill in, or if you have
important formulas that took a long time to set up, you probably
would like to protect this work from being changed . In Works,
you can do this with cell protection . Later on, if you need to
change the contents of a protected cell, you can remove cell
protection .
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To set cell protection

	

You can set protection separately for each cell or range of cells .
To set cell protection :

To remove cell
protection

To set a page break

0 Select the cell or range of cells you want to protect.
Choose Protected from the Options menu .

Works protects the selected cells .

You won't be able to type in the protected cells unless you
remove cell protection . The values in cells with formulas still
change, but you won't be able to change the formulas themselves
until you remove cell protection .
To remove cell protection:

0

Printing

When you're ready to print a Spreadsheet document, you can
specify page breaks and set up headers and footers to print at the
top and bottom of every page .
For a detailed explanation of the printing process, including how
to fill out the necessary dialog boxes, see "Printing a Document"
in Chapter 1 . This section discusses only items that are specific
to printing a Spreadsheet document .

Setting Page Breaks

In a Spreadsheet document, you can set both horizontal and verti-
cal page breaks. Works automatically sets page breaks according
to the margins you choose in the Page Setup command from the
File menu . But you may want to specify your own page breaks .
That's what the Set Page Break command is for .
To set a page break :

El

Select the cell or range of cells whose protection you want
to remove .
Choose Not Protected from the Options menu .

Select the cell that you want to be at the upper-left corner of
the new page .
Choose Set Page Break from the Options menu .

Vertical and horizontal dashed lines (page break indicators) show
where you've set the page break .



F

	

File Edit Window Select

a

D3

7
8
9
10
11
12
13
14

June

If you select cell D3, Works
inserts these vertical and horizontal
page break indicators .

Format Options Chart

en#
1

	

June

	

Percent	. . . . . . . . . . . . . .

	

. . . . . . . . . . . .

	

$10,000

	

15%
%I

	

$6,000 :	
6 Lodging

	

$60,000	44%1

	

$20.,00.0' . .

	

. .30%
Bicycles

	

$20,000 :	15% j	$5.,000 :	7%
Promotions	$. 1. 2. 000: .

	

99	$12 000 :

	

18%
To#al Expenses

	

$128,000

	

$53,000 :	79%

Select the cell in the upper-left corner of the page .
Choose Remove Page Break from the Options menu .
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I
Total Budget Available

	

$135,000	100%I

	

$67,500	1 .00%

Under (Over) Budge#

	

$7,000 :

	

5%I

	

$14,500 :	1%	
.

	

I

To set a page break across an entire row or column, select the
row or column heading before choosing the Set Page Break
command .
To remove a manual page break :

Works removes the manual page break both the horizontal and
vertical dashed lines .

You can remove just the horizontal page break or just the vertical
page break by selecting any cell just below or to the right of the
dashed line, respectively, before choosing Remove Page Break .

Printing a Spreadsheet Document

When you're ready to print a Spreadsheet document, you have
three options . You can choose to print :

•

	

All cells through the last cell .
•

	

Only cells that appear in the window .
•

	

Only selected cells .

If you use the Print command without selecting any cells, Works
prints all cells through the last cell .

I

To remove a manual
page break
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To print an entire
Spreadsheet
document

With each of these options, you can choose whether or not to
print row and column headings. If you want these printed, click
the Print Row and Column Numbers option in the Page Setup
dialog box .
With the ImageWriter printer, you can also choose to print any
selection reduced to 50% of its original size by clicking the 50
Reduction option in the Page Setup dialog box .
To print an entire Spreadsheet document :

El

4

11
s
0

Works prints your entire Spreadsheet document . If the docu-
ment is too wide to fit on one page, Works prints the remaining
columns for the rows that fit on one page, on subsequent pages
before continuing to print the remaining rows .

To print a Spread-

	

Normally, the Spreadsheet prints across the narrow part of the
sheet document

	

page. Because Spreadsheet documents are often wider than they
horizontally

	

are long, you may want to print in the wider direction .
To print a Spreadsheet document horizontally :

El

4

s

Make sure that no more than one cell is selected in the docu-
ment. (Otherwise, Works will print only the selected cells .)

•

	

Choose Page Setup from the File menu.
Click the appropriate options and type any text you want for
a header and footer .
Click the OK button or press the Return key .
Choose Print from the File menu .
Click the appropriate options .
Click the OK button or press the Return key .

Choose Page Setup from the File menu.
•

	

Click the icon showing horizontal (wide) printing for the
Orientation.

•

	

Click the OK button or press the Return key .
Choose Print from the File menu .

•

	

Click the appropriate options .
Click the OK button or press the Return key .

Works prints your Spreadsheet document horizontally on
the paper.



To print just the active window :

a

To print a selected range of cells :

Select the range of cells you want to print .
Choose Print from the File menu.
Click the appropriate options.
Click the OK button or press the Return key .

0

4

Choose Print Window from the File menu .

Works prints just the selected range of cells. If the selection
crosses a page break, Works prints the selection on two pages .
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14 Charting a Spreadsheet
Document

This chapter explains how to use the Spreadsheet's charting
capability to plot the information in your Spreadsheet documents .
You'll learn how to :

•

	

Create series charts .
•

	

Create pie charts.
•

	

Work with chart definitions and charts .

The Spreadsheet's charting capability converts information from
Spreadsheet documents into charts . Each Spreadsheet document
can have up to eight chart definitions stored with it. A chart def-
inition consists of the information you specify in a dialog box for
either a series chart or a pie chart .
When you're trying out different scenarios in the Spreadsheet
changing the numbers or the formulas you use for calculation
the results show up immediately on your chart . Charts can speed
up your analysis of numbers . Relationships that are otherwise hard
to see show up easily on a chart .
Charts also enhance presentations . If you use an overhead projec-
tor and have a LaserWriter printer, you can make changes up to
the last minute, and print the charts directly on overhead trans-
parencies. Or, you can have your printed charts made into slides .
You can use information from other spreadsheet or database pro-
grams to make charts . Just copy the information into a Works
Spreadsheet document; then you're ready to create a chart . For
more information, see Appendix B, "Using Works with Other
Applications ."
Works can create two types of charts : series charts and pie charts . Types of charts

Works can create
•

	

Series charts show relationships between numbers. For exam-
ple, a series chart might illustrate a company's total sales for
each of the last four quarters .

•

	

Pie charts help you see proportions of a whole . For example,
a pie chart might show a breakdown of your expenses as part
of an overall budget.
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r
I File Edit Window

n

t

n

13~

II

Bar Chart

American Sales Projections

June

	

Ju1N

	

August

Months .after Great Alpine Face

North America

	

o South America

Line Chart

r I File Edit Window

1

	

American Sales Projections
3Ii

11'

104

91

~.5

52

39_

June

	

.J.Jlu

	

Auouct

Month after Great Alpine Face

©North America

	

I '_:0uth America

Series Charts

This section gives a brief overview of the different kinds of series
charts, and describes how to create them . Works draws four types
of series charts : line charts, bar charts, stack charts, and combina-
tion (called "combo" in the dialog box) charts .

=0	 Sales Pro Chart 3	

_LiJ	 Sales Pro Chart 3

F

I File Edit Window
_~	 Projected Chart 4

0

a

d

Projected and Actual Sales : American
c•'0
603

536

Frolected Tot .;lc

0rkrth Arr erica

	

0Ocuth America

Actual Totals

Stack Chart

r
I File Edit IlPindow

;I

Combination Chart

_LI	 Sales in Chart 1

,

,

Each of these charts gives you a different way of looking at the
same information. The type you use depends on the information
you're analyzing, or how you want to show it . It's similar to work-
ing with an artist : you supply the information and explain what
kind of chart you want, and the artist draws it. Of course, with
Works you can use the same information with different types of
charts to see quickly which one works best .
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Line and Bar Charts

A line chart uses a line to link together points that represent

	

Line charts
numbers. When you compare more than one set of numbers, each
set of numbers has one line . As each line crosses the categories on
the horizontal axis, it marks the intersection with a distinct sym-
bol called a point marker . In the following illustration, for exam-
ple, the point marker representing South America is a square .

r
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For a single set of numbers (three months of North American

	

Bar charts
sales projections, for example), a bar chart draws a series of bars,
each representing one number . When you're comparing more
than one set of numbers, such as three months of sales projections
for North America and South America, a bar chart groups the
numbers by category (months, in this case), so you can see at
a glance how the figures for each month compare .
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Bars for each category
are grouped together .

When to use line or

	

Line charts are very effective at showing a trend a growth or
bar charts

	

decline in numbers over time . Use line charts when it's important
to see trends over a period of time how last year's growth
curve compares to this year's, for example .
Bar charts compare sets of numbers divided into discrete cate-
gories. Use bar charts when it's important to compare numbers
within a category of numbers April of this year and April of
last year, for example .

Stack and Combination Charts

Stack charts

	

Stack charts are a variation on bar charts. Stack charts illustrate
component parts of a total as they change . For example, the stack
chart below shows how sales projections in North and South
America compare with actual sales .



Components stack to show totals,
and are easily compared .
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A regular bar chart doesn't show these amounts added up,
so although you see how the amounts compare, you don't see
their total .
Combination charts combine a bar chart with a line chart . Use
combination charts when you want to see one set of numbers
(with bars) and the trend of another set of numbers (with a line)
at the same time .
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Combination charts
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Creating a Series Chart

To create a series

	

To set up a chart definition for a series chart, you use a chart
chart

	

definition dialog box. In this dialog box, you provide all the infor-
mation Works needs to draw a series chart of your Spreadsheet
data. You specify the chart type, a chart title, titles for the vertical
and horizontal scales, the headings of the columns and rows to be
charted and to be used for the data legend and the horizontal
titles, and the vertical scale of the chart .
To see the chart definition dialog box :

art
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,Iijlia

	

AugIJ=t

	

.eptE'rrib?r-

The bars show the
monthly sales .

Choose New Series Chart or Select Definition from the Chart
menu
Choosing New Series Chart takes you directly to a new chart
definition dialog box .
Choosing Select Definition gives you the Select Chart dialog
box. Select a chart definition name and click the OK button
to see the chart definition dialog box .

The following illustration shows how you use the information
in your Spreadsheet document to set up a chart definition in the
dialog box and to create a chart .



The column range
and row number

you specify here . . .

. . . determine
the horizontal titles.

Rows and columns you specify as Values
to be Plotted define the parameters of your chart .
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To specify a chart

	

You can put a title on the chart itself by typing it in the Chart
title

	

Title box of the chart definition dialog box. If you don't specify
a title, Works will plot the chart without any title .
To specify a chart title :

To choose a chart
type

To specify titles for
scales

Specifying a Chart Title

a Type a title in the Chart Title text box .

When you plot the chart, this title appears directly above
the chart .

Choosing a Chart Type

The four icons in the upper-left corner of the New Series Chart
dialog box let you choose between a line chart, a bar chart, a
stack chart, or a combination (combo) chart .
To choose a chart type :

Click the icon that represents the type of chart you want
to make .

D

If you aren't sure what type you want, review the descriptions at
the beginning of this section, or just choose a type to experiment
with. You can easily change to another type later.

Specifying Titles for the Horizontal and Vertical Scales

You can specify titles for the horizontal and vertical scales of the
chart . Scale titles help to explain the units of information shown
on the scales . If you don't type scale titles in the text boxes,
Works will not show any vertical and horizontal scale titles .
To specify titles for the scales :

D In the New Series Chart dialog box, type titles in the Vertical
Scale Title and Horizontal Scale Title text boxes .

When you plot the chart, these titles appear on the chart itself .

Choosing the Information To Chart

Numbers define the chart, telling Works how high to make a bar
or where to put a point on the scale .
The numbers that define a chart are in the rows and columns of
your Spreadsheet document. Works lets you plot up to four sets
of information in a series chart . That means you can choose up to
four rows from a Spreadsheet document for charting .



To specify the rows and columns that you want to chart :

Move the New Series Chart dialog box aside by dragging
its title bar so you can see the rows and columns you want
to chart.

•

	

In the Values to be Plotted boxes, type the headings (num-
bers) of the rows that contain the values you want to chart
from the Spreadsheet document .
If the data you want to chart is in columns, you'll need to
transpose it into rows before charting. Activate the Spread-
sheet document and use the Copy and Paste with Options
commands from the Edit menu .

•

	

In the From Column and To Column boxes, type the headings
of the columns which begin and end the information you want
in the rows you specified in step 2 .
Works will chart numbers in the specified rows from the
beginning column to the ending column. The columns must
be adjacent to one another .

a

0

Labels help you identify your numbers . Your Spreadsheet row
labels (the text that describes the information in the rows)
become the data legend. The data legend describes the sets of
information in the chart . Your Spreadsheet column labels (the
text that describes the information in the columns) become
titles for the horizontal axis. Works calls these horizontal titles .
To specify a data legend and horizontal titles :

In the Data Legends in Column box, type the heading of the
column containing the labels for the rows of information
you're charting .
The data legend will appear at the bottom of the chart, and
will identify the shading patterns used for each bar in a bar
chart, or the shape of the point marker used for each line in
a line chart .

•

	

In the Horizontal Titles in Row box, type the heading of the
row containing the labels for the columns that you're charting .
These labels will appear along the horizontal scale to label
each bar in a bar chart or each point in a line chart . (If you
are charting many columns, there may not be room for every
label on the chart, so Works will show representative labels .)
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To specify rows and
columns to chart

To specify a data
legend and horizontal
titles
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To set the vertical

scale

Setting the Vertical Scale

You can choose to have a numeric scale or semi-logarithmic scale

for the chart. A numeric scale is divided into ten regular incre-

ments

	

10, 20, 30, 40, . . .100, for example. A semi-logarithmic

scale exaggerates the size of smaller numbers and minimizes the

size of larger numbers. It makes it easier to show very large

numbers and very small numbers on the same chart . For example,

with a semi-logarithmic scale, the distance on the chart below

between 1000 and 10,000 is the same as the distance between

10,000 and 100,000 .
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Semi-logarithmic scale

You can also choose to limit the chart to a certain range, between

a minimum and a maximum . You might want to do this if all your

amounts were greater than a certain amount, like a million, or less

than a certain amount, like two million, or between two amounts .

If your minimum were one million and your maximum two mil-

lion, you could use the full range of the chart to see the numbers

between those two figures .

Setting a maximum can also make a chart with a numeric scale

easier to read. When you choose a numeric scale, Works uses the

largest number in the chart as the top of the scale. Works divides

the scale into ten segments. For example, if the largest number is

793, each marker on the vertical scale will be a multiple of 79

(79, 158, 237, . . . ). To establish more standard divisions, you can

1983

	

01 ' 34



set a maximum that is a multiple of ten. For example, with a max-
imum of 1,000,000, you'll have divisions at 100,000, 200,000, and
so forth .

r K ,File Edit Window

a

D

D

rJ19: :1

	

E19:2

To set the vertical scale :

Four-Year Profits	
Profits 1981-1984

1983

	

Ei1984

. . . . . . . . . . . . . . . . . . . . . . .

Numeric scale with maximum set to 1,000,000

In the New Series Chart dialog box, click Numeric or
Semi-Logarithmic for the vertical scale .
Type a maximum, a minimum, or both, if you want them .

Choosing To Show a Grid or Labels

A grid helps you see where points on the chart line up on the
scales. Labels (titles) help you identify what the numbers mean.
You can choose whether or not a chart will show the grid or
the labels.
To show the grid or labels, if they are not already checked in the
New Series Chart dialog box :

Click the Draw Grid option .
or
Click the Label Chart option .
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If the options are checked already, and you do not want either a
grid or the labels on your chart, click to remove the checkmark .

To choose a grid or
labels
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Your chart definition is now complete .

Click an icon to tell Works what

	

Set a maximum or minimum
type of chart you want .

	

for the vertical scale here .
Works abbreviates the chart
definition name, if necessary.

D

Type of Chart :

LINE

BAR

STACK

COMBO

Chart Title :

Vertical Scale Title :

To plot the chart

	

To plot the chart :

Click the Plot It! button .

Dollars in Thousands

N. and S . Europe Sales Pro jecti ions

Months after Great Alpine Race

Cancel )

	

Plot It!

Works draws the chart and stores the definition with the
Spreadsheet document .

Click here to draw a series chart .

Click to remove the checkmarks if you don't
want a grid or labels on the chart .

Plotting the Chart

After you've filled out the dialog box, you can take any of the
following actions.

Values to be Plotted :

	

Vertical Scale :

1st Row : S ® Numeric
0 Semi-Logarithmic

2nd Row : 7

3rd Row : MaHimum :

4th Row : Minimum : 0

From Column : B

To Column :

Data Legends in Column : R ® Draw Grid
® Label ChartHorizontal Titles in Row : 1



To then return to the chart definition dialog box :

0

To store the chart definition without drawing the chart :

0

0

Double-click anywhere in the chart window .

Click the close box .

Works stores the definition and returns you to the Spreadsheet
document .

To return to the Spreadsheet document without storing the chart
definition or drawing the chart :

Click the Cancel button .

If you want to continue working with your series chart before
you begin to learn about pie charts, skip ahead in this chapter to
"Working with Charts and Chart Definitions ."

Pie Charts
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This section explains what pie charts show, what you might use
them for, and how to create them .
Pie charts compare parts of a whole . For example, a pie chart can
illustrate which parts of a company's budget are allocated to pro-

	

Chart
duction, marketing, development, and overhead .

To avoid plotting the
chart

When to use a pie
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You can supply a title in
the Chart Title text box .

p.-

File Edit Window

You can change the chart definition name
using the Change Chart Name command
from the Edit menu .

Untitled Chart 1	

Preliminary Budget

® Production

	

24 .0%
Marketing 21 .0%

® Development 38 .0%
0 Overhead

	

17 .0%

Specify value titles in the Column
of Value Titles text box .

Specify column and rows to be charted in
the Plot Values in Column, From Row, and

Through Row text boxes .

Creating a Pie Chart

Pie charts compare only one set of information, dividing it into
parts of a total the pie. In a Spreadsheet document, this corre-
sponds to one column of numbers . A column of labels provides
the key for each slice of the pie . Works calls these labels value
titles .
If you have a Spreadsheet document with several columns of
information that you want to chart as pie charts, you can define
a pie chart for each column . Each of the pie chart definitions will
be stored with your Spreadsheet document, so that you can look
at them at any time .

To create a pie chart

	

To set up a chart definition for a pie chart, you use a chart defini-
tion dialog box . In this dialog box, you specify the column con-
taining the values you want to plot, the beginning and ending row
headings, and the column containing the labels for the value titles .



To see the chart definition dialog box :

Select New Pie Chart or Select Definition from the Chart
menu .
Choosing New Pie Chart takes you directly to a new chart
definition dialog box .
Choosing Select Definition gives you the Select Chart dialog
box. Select a chart definition name and click the OK button
to see the chart definition dialog box .

0

Specifying a Chart Title

You can put a title on the chart itself by typing it in the Chart
Title box of the chart definition dialog box . If you don't specify

	

title
a title, Works will plot the chart without any title .
To specify a chart title :

0 Type a title for the chart in the Chart Title box .

When you plot the chart, this title appears directly above the
chart.

Completing the Chart Definition

When you define a pie chart, you need to tell Works which values
to plot. Fill in the rest of the New Pie Chart dialog box to indicate
which values you want to plot and which value titles you want to
use. Remember that you can move the dialog box to see the
Spreadsheet document by dragging the title bar of the window .

Prelimina Chart 2

Pie Chart Definition :

Chart Title :

Plat Values in Column :

From Row :

Through Raw :

Column of Value Titles :

Preliminary Budget

B

2

5

A

Cancel ([PlotIt!])
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To specify a chart
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Plotting the Chart

After you've filled out the dialog box, you can take any of the
following actions .

To plot the chart

	

To plot the chart :

To avoid plotting the
chart

D Click the Plot It! button .

Works draws the chart and stores the definition with the Spread-
sheet document.

To then return to the chart definition dialog box :

D

D

D

Double-click anywhere in the chart window .

To store the chart definition without drawing the chart :

Click the close box .

Works stores the definition and returns you to the Spreadsheet
document .

To return to the Spreadsheet document without storing the chart
definition or drawing the chart :

Click the Cancel button .

To learn about more ways to work with your pie chart, con-
tinue on to the next section, "Working with Charts and Chart
Definitions ."

Working with Charts and Chart Definitions

Once you've set up a chart definition for either a series chart or
a pie chart, you can continue to work with it . You can :

•

	

Change the name of a chart definition .
•

	

Select either a chart or a chart definition to look at again .
•

	

Change a chart by changing information in the Spreadsheet
document or by changing its definition .

•

	

Copy or remove chart definitions from a Spreadsheet
document .



This section tells you how to work with all types of charts .

Changing Chart Definition Names

The title bar of a chart definition dialog box shows the name of
the chart definition. When you set up several chart definitions for
a single Spreadsheet document, you'll be able to identify each one
by name .
Unless you specify a name with the Edit menu as described below,
Works automatically names each chart definition with the name of
the Spreadsheet document plus the word "Chart" and a number
from 1 to 8. If the Spreadsheet document name is too long to fit,
Works abbreviates it .
If you prefer, you can change the name of a chart definition to

	

To change a chart
make it more meaningful to you .

	

definition name
To change the name of a chart definition :

When a chart definition dialog box is open, choose Change
Chart Name from the Edit menu .

•

	

Type a new name in the box .
•

	

Click the OK button or press the Return key .

0

The name in the title bar of the dialog box changes to reflect
what you typed . You'll see this same name in the title bar of the
chart when you plot the chart, and in the dialog boxes that appear
for other commands from the Chart menu . The name of the chart
definition doesn't appear on the chart itself, however . You can put
a title on your chart by typing it in the Chart Title box in the
chart definition dialog box .

Selecting a Chart

After you've defined a chart, you can choose to draw it directly
from the Chart menu . You don't have to set up a new definition
every time you want to chart something.
Here's how to draw a chart quickly :

	

To draw a chart

El Choose Draw Chart from the Chart menu .
Works displays a dialog box listing the chart definitions stored
with the active Spreadsheet document .

•

	

Select the chart you want to see .
•

	

Click the OK button or press the Return key .

Works draws the chart .

Chapter 14 Charting a Spreadsheet Document 229



230 The Spreadsheet

Selecting a Chart Definition

If you've set up a chart definition, you might want to look it over
or make changes. You can move to a chart definition dialog box
either from the Chart menu (when you're working in the Spread-
sheet) or from the chart itself.

To see a chart

	

When you want to look at a chart definition for a Spreadsheet
definition from the

	

document, you can use the Chart menu .
Chart menu

0

Works opens the dialog box containing the definition you
specified .

To see a chart

	

The Chart menu is not available when you're looking at a chart .
definition from

	

But you can still return to the chart's definition if you want to
the chart

	

make changes :
To see the chart definition when a chart window is open :

D

Choose Select Definition from the Chart menu .
Works displays a dialog box listing the chart definitions stored
with the active Spreadsheet document .
Select the definition you want to see .
Click the OK button or press the Return key .

Double-click anywhere in the chart window .

Works displays the chart definition dialog box .

Changing a Chart

You may find that you need to change something about a chart .
You can change the actual contents of a Spreadsheet document
and see those changes reflected immediately in the chart. Or you
can change the chart definition : the information you want to
chart, the type of chart, the titles on the chart, or the scale .

To change the

	

You can work on a Spreadsheet document and a chart at the same
Spreadsheet while

	

time, as you analyze your information . If you're making projec-
charting

	

tions or comparing alternatives, you see graphically how alterna-
tive numbers or calculations affect your results without waiting,
because the chart is linked directly to the Spreadsheet document .
To change Spreadsheet information while charting :

0 Click anywhere in the Spreadsheet window to activate it .
Select the cells you want to change and make the changes .

As you enter the changes in the Spreadsheet document, the chart
will reflect them .



The chart definition tells Works what information to plot and
where to put it. You can change a chart definition whenever
you want.
To change a chart definition :

Open a chart definition dialog box .
You can do this from the Chart menu or by double-clicking
a chart .
Change the appropriate information in the definition .
Click Plot It! to see the changed chart, or click the close box
to save the changes to the definition and discard the original
definition .

0

Remember, if you change your mind, you can always click Cancel
to return to the Spreadsheet document without storing the
changes to the definition or seeing the chart .

Copying a Chart Definition
Works lets you make a copy of a chart definition . Then you can
make changes to the copy without changing the original . You'll
find this useful if you need to make several similar charts from
the same Spreadsheet document .
To copy a chart definition :

El

a

Choose Duplicate Chart from the Chart menu .
Works displays a dialog box listing the chart definitions stored
with the active Spreadsheet document .
Select the definition you want .
Click the OK button or press the Return key .

The chart definition dialog box appears . You can change the title
of the chart and its characteristics .

When you click Plot It! or the close box, you store the new def-
inition with the Spreadsheet document. The original definition
remains on the disk as well .
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To change a chart
definition

To copy a chart
definition
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To remove a chart
definition

Removing a Chart Definition

Suppose you decide you no longer need a chart, or accidentally
make a chart you don't want . Or perhaps you already have the
limit of eight definitions, and you want to make a new one . You
can remove a chart definition you don't want to make room for
another.
To remove a chart definition :

Choose Erase Chart from the Chart menu .
Works displays a dialog box listing the chart definitions stored
with the active Spreadsheet document .
Select the definition you want to remove .
Click the OK button or press the Return key .

El

Works removes the chart definition .



15 Spreadsheet Functions

This chapter is divided into three sections :

•

	

A discussion of the arguments expected by Works functions .
•

	

A brief listing of the available Spreadsheet functions arranged
by subject category .

•

	

A detailed alphabetical directory of these functions .

Arguments to Functions

A function can have no arguments or it can have one or more
arguments. Arguments can be numbers, formulas, cell references,
or range references. Arguments can also be other functions that
evaluate to a number .
An empty cell or a cell containing text is normally treated as 0
when used as an argument to a function . However, the functions
Average, Count, Max, Min, SSum, StDev, Sum, and Var ignore these
cells completely .
In Works, all function arguments have a numeric value . In some
cases, however, these values represent a logical value of either
TRUE or FALSE. The first argument in the If function is an exam-
ple. For such arguments, the number 0 represents the logical
value FALSE, and all other numbers represent the logical value
TRUE .
For example, If(A1,3,4) equals 3 where A1 contains - 1 or 2, and
If (A 1, 3,4) equals 4 where A 1 contains 0 or is blank.
Similarly, all functions in Works return numeric values as results .
In some cases, however, these values represent a logical value of
either TRUE or FALSE. The IsNA function is an example . As the
result of such functions, the number 0 represents the logical value
FALSE, and the number 1 represents the logical value TRUE .
For example, IsNA(A 1) equals 1 where A 1 contains N/A, and
IsNA(A 1) equals 0 where A 1 contains a label or a number, or
is blank .

233



234 The Spreadsheet

Notation conventions

	

In the function directory that follows, arguments are described

with this notation :

The And, Or, and Not functions are examples of both these types

of functions in that their arguments, as well as their results, are

logical values represented by numbers .

For example :

Value or

	

Refers to an argument that must be a number,

number

	

cell reference, or formula, as in Min(2,3 ),

Min(A 1,B 1), or Min(3 + A 1,Sgrt(4) )

Range

	

Refers to an argument that must be a range

reference, such as B9:F9

Values

	

Refers to an argument that can be any of

the above

To distinguish different arguments in a function, numbers are

added to the standard notation, as in value-1, value-2, range-1,

range-2, values-1, values-2, and so on. When there is a useful

descriptive word for an argument, such as "rate" in a financial

function, that word is used in place of the generic term "value."

Sometimes, the standard notation is modified by another word,

as in lookup-number or compare-range.

Functions by Subject Category

The detailed directory of functions in this chapter is presented

in alphabetical order for quick reference . However, to help you

more readily see what functions are available in Works, they are

also presented below, grouped by subject category .

Mathematical

	

Mathematical Functions

functions

Abs(number)

Absolute value of number

Exp( number)

e to the power number

Not(1) equals 0 And( - 1,2,4) equals 1

Not(2) equals 0 And( - 1, 2,0) equals 0

Not(0) equals 1 Or(0,0, 5) equals 1



Int(number)
Integer part of number

Ln(number)
Logarithm, base e, of number

Log l 0(number)
Logarithm, base 10, of number

Mod(number,divisor-number)
Remainder of number divided by divisor-number

Pi()
Value of irr

Rand ( )
Random number between 0 and 1

Round(number,number-of digits)
Number rounded to number-of-digits

Sign( number)
Sign of number

Sgrt(number)
Square root of number

Statistical Functions

Average( values-1, values-2, . . .)
Average of values in values

Count( values-1, values-2, . . .)
Count of values in values

Max( values-1, values-2, . . .)
Maximum value in values

Min( values-1, values-2, . . .)
Minimum value in values

SSum( values-1, values-2, . . .)
Sum of values displayed on the screen

StDev( values-1, values-2, . . .)
Standard deviation of values

Sum( values-1, values-2, . . .)
Sum of values

Var( values-1, values-2, . . .)
Variance of values
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Trigonometric

	

Trigonometric Functions
functions

ACos( number)
Arccosine of number

ASin(number)
Arcsine of number

ATan( number)
Arctangent of number

ATan2(x-number,y-number)
Arctangent of point (x-number,y-number)

Cos(number)
Cosine of number

Degrees( number)
Converts number from radians to degrees

Radians( number)
Converts number from degrees to radians

Sin(number)
Sine of number

Tan( number)
Tangent of number

Logical functions

	

Logical Functions

And( values-1, values-2, . . .)
1 (TRUE) if all values are non-zero (TRUE) ; otherwise,
0 (FALSE)

Choose(index, number-1, number-2, . . . )
Uses index to select a value from numbers

False( )
Returns the value 0 (FALSE)

If(number, number-if-true, number-if-false)
Number-if-true if number is non-zero (TRUE) ; number-if-false
if number is 0 (FALSE)

IsBlank( values-1, values-2, . . .)
1 (TRUE) if all values are blank or text ; otherwise, 0 (FALSE)

IsError( value)
1 (TRUE) if value is any error value

IsNA( value)
1 (TRUE) if value is the error value N/A

Not(number)
1 (TRUE) if number is 0 (FALSE); 0 (FALSE) if number is
non-zero (TRUE)



Or(values-1, values-2, . . .)
1 (TRUE) if any logical value in values is non-zero (TRUE) ;
otherwise, 0 (FALSE)

True( )
Returns the value 1 (TRUE)

Financial Functions

	

Financial functions

FV(rate,nper,pmtpv,type)
Future value of investment

IRR(range,guess )
Internal rate of return of range

MIRR( range, safe, risk)
Modified internal rate of return of range

NPer(rate,pmt,pv,fv, type)
Number of payments of investment

NPV(rate, values-1, values-2, . . .)
Net present value of values

Pmt( rate, nper,pv,fv, type)
Periodic payment of investment

PV(rate,nper,pmt,fv,type)
Present value of investment

Rate( nper,pmt,pv,fv, type,guess)
Rate returned on investment

Special-Purpose Functions

Error( )
Returns the value * Error

HLookup( lookup-number, compare-range, index-number)
Value in a table selected by lookup-number

Index(range, row, column)
Reference in range selected by index values row and column

Lookup(lookup-number, compare-range, result-range)
Value in a table selected by lookup-number

Match( lookup-number, compare-range, type)
Number of a value selected by lookup-number

NA()
Returns the value N/A

Type(value)
Type of value

VLookup( lookup-number, compare-range, index-number)
Value in a table selected by lookup-number
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Abs

ACos

And

Alphabetical Directory of Functions

The directory that follows gives detailed information and exam-
ples for each of the 54 Spreadsheet functions .

Ab5(number)

The Abs function gives the absolute value of number.

Examples

Abs(2) equals Abs( -2) equals 2

ACOS(number)

The ACos function gives the arccosine of number. The arccosine
is the angle in radians whose cosine is number. Number must be
in the range - 1 to 1 . The angle will be in the range 0 to ii .

Examples

ACos(- 0.5) equals 2.094 (2'rr/3 radians)
ACos( - 0.5) * 180/Pi( ) equals 120 (degrees)

Afld(values-1 ,values-2, . . .)

The And function gives the value 1 (TRUE) if all the values in the
list of arguments are non-zero (TRUE) . If any of the values is 0
(FALSE), And gives the value 0 (FALSE) .
If a reference argument contains text or blank values, those values
are ignored.

Examples

And(2+2=4,2+3=5) equals 1
And(2+2=5,2+3=5) equals 0



l4$111(number)

	

ASin

The ASin function gives the arcsine of number. The arcsine is the

angle in radians whose sine is number . Number must be in the

range - 1 to 1 . The angle will be in the range - IT/2 to it/2 .

Examples

ASin( -0.5) equals - 0.524 (- •rr/6 radians)
ASin( - 0.5) * 180/Pi( ) equals - 30 (degrees)

ATan(number)

	

ATan

The ATan function gives the arctangent of number . The arctan-

gent is the angle in radians whose tangent is number. The angle

will be in the range - 7r/2 to Tr/2 .

Examples

ATan(1) equals 0.785 (IT/4 radians)

ATan(1) * 180/Pi( ) equals 4 5 (degrees)
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ATan2(x-number,y-number)

	

ATan2

The ATan2 function gives the arctangent of x-number and

y-number. The arctangent is the angle in radians determined by

the point whose x and y coordinates are x-number and y-number .

The angle will be in the range - IT to IT, excluding - IT .

If both x-number and y-number are 0, ATan2 gives the value 0 .

Examples

ATan2(1,1) equals 0 .785 (IT/4 radians)

ATan2( - 1, - 1) equals - 2 .3 56 (- 3'rr/4 radians)

ATan2( - 1, - 1) * 180/Pi( ) equals - 135 (degrees)
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Average

Choose

Cos

Average(values-i ,values-2, . . .)

The Average function gives the average of the numbers in the list
of arguments .
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .

Examples
If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
Average(A 1 :A5) equals 11
Average(A 1 : A 5, 5) equals 10
Average(A 1 :A5) equals Sum(A 1 :A5)/Count(A 1 :A5 )

Choose(index,number-1 ,number-2, . . .)

The Choose function uses index to select a value from the follow-
ing arguments in the list . If index is 1, Choose gives number-1 ;
if index is 2, Choose gives number-2 ; and so on .
If index is less than 1 or greater than the number of the last value
in the list, Choose gives the error value * Error * .

Example

Choose(2,10,20,30,40) equals 20

COS(number)

The Cos function gives the cosine of number, where number is
an angle in radians .

Examples

Cos(1 .047) equals 0.5
Cos(60 * Pi( )/180) equals 0.5



COUflt(values-1 ,values-2, . . .)

	

Count

The Count function gives the count of the numbers in the list of
arguments.
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .

Examples

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
Count(A 1 :A5) equals 5
Count(A1 :A5,5) equals 6

Deg rees(number)

	

Degrees

The Degrees function converts an angle in radians to degrees .

Example

Degrees(Pi( )) equals 180

Error()

The Error function takes no arguments and returns the value
* Error* .

Example

Given that A 1 contains the formula = Error( ) :
If( IsError(A 1 ),0, 1) equals 0

Error

EXp(number)

	

Exp

The Exp function gives e raised to the power of number. The
mathematical constant e is 2 .7182818 . . ., the base of the natural
logarithm .
Exp is the inverse of the Ln function (natural logarithm) .
To calculate powers of other bases, use the exponentiation
operator ().
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False

FV

HLookup
VLookup

Examples

Exp(1) equals 2 .7182818 (the value of the natural base, e )
Exp(Ln(3)) equals 3

False()

The False function takes no arguments and returns the value
0 (FALSE) .

Example

Choose( 2,False( ),True( ),True( ),False( ),True( )) equals 1

FV(rate,nper,pmt,pv,type)

The FV function gives the future value of an investment involving
constant cash flows .
If you omit either pv or type, it is assumed to be 0 .
For a complete description of the arguments in FV, see PV .

H Lookup(iookup-number,compare-range,index-number)
VLooku p(Iookup-number,compare-range,index-number)

The HLookup function searches the first row of compare-range
for the largest value that is less than or equal to lookup-number.
Having found that value in some column of the first row, HLookup
moves up or down in that column by an amount specified by
index-number and gives the value found there .
If index-number is 1, HLookup gives the value from the current
row. If index-number is 2, HLookup gives the value from the row
below. If index-number is 0, HLookup gives the value in the row
above the current row . If index-number is - 1, HLookup gives
the value in the row that is two rows above the current row .
The values in the first row of compare-range must be in ascend-
ing order . If lookup-number is smaller than the smallest value in
the first row of compare-range, HLookup gives the error value
* Error* .



The VLookup function is identical to HLookup except that it
searches the first column of compare-range, and moves left or
right in that row by an amount specified by index-number.

Examples
If Al :El contains the values 10000, 20000, 30000, 40000, and
50000, and A5 :E5 contains the values .01, .02, .03, .04, and
.0 5, then:
HLookup(35000,A1 :E1,5) equals .03
HLookup(3 5000, A 1 : E 1,1) equals 30000
HLookup( 5000,A 1 : E 1,5) equals * Error
HLookup( .035,A5:E5, - 3) equals 30000

If(number,number-if-true,number-if-false)

	

If

The If function gives number-if-true if number is non-zero
(TRUE), and number-if-false if number is 0 (FALSE).

Example

Given that A5 contains the number 98, and B 10 contains the
number 90 :

If(Or(A5<80,B10<75),1,0) equals 0
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Index(range,row,column)

	

Index

The Index function gives the content of the indexed cell, selected
by the indices row and column starting from the cell in the
upper-left corner of range.

Examples

Index(B2:D4,2,3) equals the value of D3
Index(B 2 :D 2,1, 2) equals the value of C 2
Index(B 2 :B4, 2,1) equals the value of B 3

Index(B 2 :D2,0,0) equals the value of A 1
Index(C4 :D4, - 1, - 1) equals the value of A2

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :

Index(Al :A5,3,1)/3 equals 3
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Int

IRR

IsBlank

Iflt(number)

The Int function gives the largest integer less than or equal to
number.

Examples

Int(8.9) equals 8
Int( - 8.9) equals - 9

I RR(range,guess)

The IRR function gives the internal rate of return of a series of
cash flows, represented by the numbers in range. The internal
rate of return is the interest rate that gives the series of cash flows
a net present value of zero .
Works uses an iterative technique to compute IRR, which can
have more than one solution . If the successive results of IRR do
not converge after 20 iterations, IRR gives the error value
*Error* .
Range should be a reference that contains numbers . If range con-
tains text or blank values, those values are ignored .
Guess specifies the starting value of the iteration . If IRR does not
converge, try different values for guess. Usually, a starting value
between 0 and 1 will yield a meaningful result .

Example
If you have an investment represented by the cash flows ($5000),
$1000, $1500, $2000, ($3000), $2500, and $5000, which are
entered in A1 :A7, then :
IRR(A 1 : A7,10 %) equals 15 .05%

IsBlank(values-1,values-2, . . .)

The IsBlank function can have any number of arguments. All argu-
ments must be cell references. IsBlank gives the value 1 (TRUE) if
all cell references in the list of arguments are blank or contain
text. Otherwise, it gives the value 0 (FALSE) .



IsError(value)

The IsError function gives the value 1 (TRUE) if value is the error
value * Error* . Otherwise, it gives the value 0 (FALSE) .
If you want to see if a range of cells contains any * Error * values,
use the Sum function to sum the range . If any cells contain
* Error*, the result of the Sum function will be *Error* .

Example
Given that A 1 contains the formula = 3/0 :
If(IsError(A1),0,1) equals 0

IsNA(value)

The IsNA function gives the value 1 (TRUE) if value is the error
value N/A. Otherwise, it gives the value 0 (FALSE) .

Example
Given that A 1 contains the formula = NA():

If (IsNA(A 1),0,1) equals 0

L11(number)

The Ln function calculates the natural logarithm of number.
Natural logarithms use the mathematical constant e, 2 .7182818. . .,
as a base.
Number must be positive .
Ln is the inverse of the Exp function,
number.

Examples

e raised to the power

Ln(2.7182818) equals 1
Ln(Exp(3)) equals 3
Ln( 8 )/Ln( 2) equals 3 (the base 2 logarithm of 8 )
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Log10

Lookup

Logi0(number)

The Log10 function gives the base 10 logarithm of number.
Number must be positive .
Log 10 is the inverse of base 10 exponentiation .

Examples

Log 10(10) equals 1
Log 10(1 E 5) equals 5
Log 10(10A 5) equals 5
Log l 0(8)/Log 10(2) equals 3 (the base 2 logarithm of 8 )

Lookup(lookup-number,compare-range,resuIt-range)

The Lookup function searches compare-range for the largest value
that is less than or equal to lookup-number. Lookup gives the
corresponding value in result-range .
The values in compare-range must be in ascending order . If
lookup-number is smaller than the smallest value in compare-
range, Lookup gives the error value *Error* . Compare-range and
result-range should have the same length . Each of these range
arguments must be one-dimensional, but they need not both be
in the same direction .

Examples

If Al : E 1 contains the comparison values 10000, 20000, 30000,
40000, and 50000, and A4: E4 contains the values 10, 20, 30, 40,
and 50, then :
Lookup(35000,A1 :E 1,A4 :E4) equals 30
Lookup(5000,A 1 : E 1,A4 : E4) equals *Error*
Lookup(3 5000, A 1 : E 1,A1 : E 1) equals 30000



then Match (40,A 1 :C 3,0) equals 4
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Match(Iookup-number,compare-range,type)

	

Match

The Match function gives the number of the comparison value in
compare-range that matches lookup-number. If lookup-number
matches the first comparison value, Match gives 1 . If lookup-
number matches the second comparison value, Match gives 2, and
so on. If lookup-number does not match any of the comparison
values, Match gives the error value * Error * . If compare-range
contains multiple rows, Match searches from left to right, one row
at a time ; that is, it first searches the first row, then the second
row, and so on.
The rules for matching the values are determined by type. If type
is 1, lookup-number matches the largest comparison value that
is less than or equal to lookup-number. If lookup-number is less
than the smallest comparison value, then it does not match any
of them. The comparison values should be in ascending order .
If type is - 1, lookup-number matches the smallest comparison
value that is greater than or equal to lookup-number. If lookup-
number is greater than the largest comparison value, then it does
not match any of them. The comparison values should be in de-
scending order.
If type is 0, lookup-number matches the first comparison value
that is equal to lookup-number. If lookup-number is not equal to
any of the comparison values, then it does not match any of them .
The comparison values can be in any order .

Examples
If Al :A5 contains the numbers 60, 70, 80, 90, and 100, then :
Match(75,A 1 :A5,1) equals 2
Match(55,A1 :A5,1) equals *Error*
If Al :A5 contains the numbers 100, 90, 80, 70, and 60, then :
Match(75,A1 :A5, - 1) equals 3
Match(105,A1 :A5, - 1) equals *Error*
If Al :C3 contains the numbers :
10 20 30
40 50 60
70 80 90
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Max

Min

MIRR

Max(values-1 ,values-2, . . .)

The Max function gives the largest number in the list of
arguments.
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .

Examples

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
Max(A 1 :A5) equals 27
Max(A 1 :A5,30) equals 30

Mi11(values-1 ,values-2, . . .)

The Min function gives the smallest number in the list of
arguments .
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .

Examples

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
Min(A1 :A5) equals 2
Min(A 1 :A5,0) equals 0

MI RR(range,safe,risk)

The MIRR function gives the modified internal rate of return of a
series of cash flows, represented by the numbers in range, given
safe and risk. Safe is the rate returned by the investment that will
finance the negative cash flows . Risk is the rate at which the
positive cash flows can be reinvested .
Range should be a reference that contains numbers . If range con-
tains text or blank values, those values are ignored .



Where n is the number of cash flows in range, the formula
used is :

(-NPV(risk ,values [positive ] )* (1 + risk )n	i
n-1

\ NPV(safe,values [negative ])* (1 + safe))

Example

If you have an investment represented by the cash flows ($5000),
$1000, $1500, $2000, ($3000), $2500, and $5000, entered in
Al :A7, and you hope to finance your negative cash flows with
money borrowed at 12% and reinvest your positive cash flows
at 17%, then :
MIRR(A 1 :A7,12 % ,17%) equals 15.19

MOd(number,divisor-number)

	

Mod

The Mod function gives the remainder (modulus) after number
is divided by divisor-number. The result has the same sign as
divisor-number.
If divisor-number is 0, Mod gives the error value *Error * .

Examples

Mod(3,2) equals Mod( - 3,2) equals 1
Mod(3, -2) equals Mod( - 3, - 2) equals -1
Mod(7,4) equals 7 - Int(7/4 )* 4 equals 3

NA()

	

NA

The NA function gives the error value N/A.

Examples
Given that A 1 contains the formula = NA( ):

If(IsNA(A 1),0,1) equals 0
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Not

NPer

NPV

Or

NOt(number)

The Not function gives the value 0 (FALSE) if number is non-zero
(TRUE), and gives 1 (TRUE) if number is 0 (FALSE).

Examples

Not(1 + 1=2) equals 0
Not(1 + 1 =3) equals 1

N Per(rate,pmt,pv,fv,type)

The NPer function gives the number of periods of an investment
involving constant cash flows .
If you omit either fv or type, it is assumed to be 0 .
For a complete description of the arguments in NPer, see PV .

N PV(rate,values-1 ,values-2, . . .)

The NPV function gives the net present value of a series of future
cash flows, represented by the numbers in the list of values, dis-
counted at a constant interest rate specified by rate .
The cash flows are assumed to occur at equal time intervals, the
first cash flow occurring at the end of the first period .
The list of values can contain one or more arguments . The values
arguments should be numbers, or references that contain num-
bers. If a reference argument contains text or blank values, those
values are ignored.

Or(values-1 ,values-2, . . .)

The Or function gives the value 1 (TRUE) if any of the values in
the list of arguments is non-zero (TRUE) . If all of the values are 0
(FALSE), Or gives the value 0 (FALSE) .
If a reference argument contains text or blank values, those values
are ignored.



Examples

Or(1 + 1 =2,2+2=5) equals 1
Or(1 + 1 = 3 , 2 + 2 = 5) equals 0

The Pi function takes no argument and gives the number
3.14159 . . ., an approximation of the mathematical constant ?T .

Example

ATan(1) * 180/Pi( ) equals 4 5 (degrees)

Pmt(rate,nper,pv,fv,type)

	

Pmt

The Pmt function gives the periodic payment of an investment
involving constant cash flows .
If you omit either fv or type, it is assumed to be 0 .
For a complete description of the arguments in Pmt, see PV .

PV(rate,nper,pmt,fv,type)

FV(rate,nper,pmt,pv,type)

N Per(rate,pmt,pv,fv,type)

Pmt(rate,nper,pv,fv,type)

Rate(nper,pmt,pv,fv,type,guess)

Present value (pv), future value (fv), number of periods (nper),
periodic payment (pmt), and interest rate per period (rate) are
the five standard parameters in cash flow problems involving con-
stant payments. Each of the above functions gives the value of one
of these financial arguments, given the values of the others .
For the arguments pv, fv, and pmt, use the following cash flow
convention : cash received is represented by a positive number ;
cash paid out is represented by a negative number. The examples
below illustrate this convention.
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Rate and nper must refer to the same period . For example, if nper
is the number of months, then rate must be the effective monthly
interest rate .
Type indicates whether payments occur at the beginning or the
end of the periods. If type is 0, the first payment is assumed to
occur at the end of the first period ; if type is 1, the first payment
occurs at the beginning . If you omit type, it is assumed to be 0 .
Works uses an iterative technique to compute Rate, which can
have zero, one, or two solutions . If the successive results of Rate
do not converge after 20 iterations, Rate gives the error value
*Error* .
Guess specifies the starting value of the iteration . If you omit
guess, it is assumed to be 0 .1 or 10% . If Rate does not converge,
try different values for guess . Usually, a starting value between 0
and 1 will yield a meaningful result .
All of the arguments must be numbers . In PV, FV, NPer, and Pmt,
you can omit the last two arguments ; in Rate, you can omit the
last three arguments. Any argument (except guess, as noted
above) that is omitted is assumed to be 0 .
Works uses the following equations to solve for one financial
argument in terms of the others :

1 +ratenper -	1pv*( 1 +rate)nper+pmt*(1 +rate*type)*	rate

	

+fv =0

(for rate<>0)

pv +pmt* nper + fv = 0
(for rate =0)

Examples

You have received a loan of $12,000 at an interest rate of 9
(monthly rate of 0 .75%), and you must pay it off in 24 monthly
payments made at the end of each month . Pv is 12000, rate is
0.75%, nper is 24, and fv and type are 0. The monthly payment
is calculated by :

Pmt(0.0075,24,12000) equals - 548.22

A limited partnership plans to buy an apartment building for
$750,000 with the expectation of selling the building for
$1,500,000 in 6 years. The rent from the apartments amounts
to $100,000 annually . Pv is - 750000, fv is 1500000, nper is 6,
pmt is 100000, and type is 0. The numbers $100,000, $750,000,



and $1,500,000 are entered in cells A1, B2, and C3 . If your guess
at the annual rate of return is 10%, the actual annual rate of
return is calculated by :

Rate(6,A1, - B2,C3,0,0.1) equals 22 .73

You now have $1,000 in your savings account earning 6 % annual
interest (0.5% monthly interest), and you plan to deposit $100
at the beginning of every month for the next 12 months . Pv is
- 1000, rate is 0 .5%, pmt is - 100, nper is 12, and type is 1,
so the amount of money in your savings account at the end of
12 months is calculated by :

FV(0.00 5,12, - 100,- 1000,1) equals 2301 .40

Radians(number)

	

Radians

The Radians function converts an angle in degrees to radians .

Example

Radians(180) equals 3.14159 . . . (the value of IT)

Rand()

The Rand function gives a random number in the range 0 to
0.999 . . . . Rand generates a new random number every time the
Spreadsheet document is recalculated.

Rand

Rate(nper,pmt,pv,fv,type,guess)

	

Rate

The Rate function gives the interest rate per period of an invest-
ment involving constant cash flows .
If you omit fv or type, it is assumed to be 0 . If you omit guess,
it is assumed to be 0.1 or 10% .
For a complete description of the arguments in Rate, see PV .
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Round

	

Roufld(number,number-of-digits)

The Round function gives number rounded to number-of-digits.
If number-of-digits is positive, number is rounded to that many
decimal places. If number-of-digits is 0, number is rounded to
the nearest integer . If number-of-digits is negative, number is
rounded to the left of the decimal point .

Examples

Round(2.15,1) equals 2 .2
Round(2.149,1) equals 2.1
Round( - 1 .475,2) equals - 1 .48
Round(891, - 2) equals 900

Sign

	

Sign(number)

Sin

	

$111(number)

The Sign function gives 1 if number is positive, 0 if number is 0,
and - 1 if number is negative .

Examples

Sign( 7+3) equals 1
Sign(4 -4) equals 0
Sign( 3 - 7) equals - 1

The Sin function gives the sine of number, where number is an
angle in radians.

Examples

Sin(0) equals 0
Sin(Pi( )/2) equals 1
Sin( (3 * Pi( ) )l2) equals - 1



SCE Pt(number)

	

Sqrt

The Sqrt function gives the positive square root of number.
Number must be greater than or equal to 0 . If number is negative,
Sqrt gives the error value * Error * .

SSum(values-1 ,values-2, . . .)

	

SSum

The SSum function gives the sum of the numbers in the list of
arguments as they are displayed on the screen . Arguments dis-
played in Fixed, Dollar, or Percent format are truncated to the
value displayed on the screen .
If a reference argument contains text or blank values, those values
are ignored.
This function is intended to guarantee that the sum of values
displayed matches the screen exactly . In other words, it is the
result you get by using a calculator to add all the values in the
argument list as they are displayed on the screen .

Examples
If Al : A5 contains the numbers 10 .2, 7.12, 9 .0, 27.031 (displayed
with two digits after the decimal point), and 2, then :
SSum(A1 :A5) equals 55.35
Notice that the same formula using the Sum function gives a
different result :
Sum(A1 :A5) equals 55.351
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StDev(values-1 ,values-2, . . .)

	

StDev

The StDev function gives the sample standard deviation of the
numbers in the list of arguments.
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .
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Sum

Tan

The formula used is :

Sgrt(Var(values - l,values -2, . . . ))

The sample standard deviation is the best estimate of the popula-
tion standard deviation based on a sample of the population . If
your sample represents the entire population, you can compute
the true population standard deviation by including the average
of the sample in the list of arguments to StDev :

StDev(Population ,Average(Population))

Examples

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
StDev(A 1 :A5) equals 9.460
StDev(A 1 :A5, Average(A 1 :A5 )) equals 8.462

Sum(values-1,values-2, . . .)

The Sum function gives the sum of the numbers in the list of
arguments.
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .

Examples

If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
Sum(A 1 :A5) equals 55
Sum(A 1 :A5, 5) equals 60

Tan(number)

The Tan function gives the tangent of number, where number
is an angle in radians.

Examples

Tan(0.785) equals 0.999
Tan(4 5 * Pi() / 180) equals 1



True()

The True function takes no arguments and gives the value 1
(TRUE).

Example

Choose(2,False( ),True( ),True( ),False( ),True( )) equals 1

Type(value)

The Type function gives the type of value .
If value is a cell reference and the cell referenced is blank or
contains text, Type gives 2 .
Otherwise, Type gives 1 when value is a number, 8 when value
is the error value N/A, and 16 when value is the error value
* Error* .

Examples

If A 1 contains the text "Smith", then :
Type(Al) equals 2
Type(5) equals 1
Type(1/0) equals 16

Var(values-1 ,values-2, . . .)

	

Var

The Var function gives the sample variance of the numbers in the
list of arguments .
The arguments should be numbers, or references that contain
numbers. If a reference argument contains text or blank values,
those values are ignored .
The formula used is :

n * ( ,(x 2 )) - ( ,x )2
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VLookup

The sample variance is the best estimate of the population vari-
ance based on a sample of the population . If your sample repre-
sents the entire population, you can compute the true population
variance by including the average of the sample in the list of
arguments to Var :

Var(Population ,Average(Population))

Examples
If Al :A5 contains the numbers 10, 7, 9, 27, and 2, then :
Var(A1 :A5) equals 89.5
Var(A1 :A5,Average(A1 :A5)) equals 71 .6

VLookup(lookup-number,compare-range,index-number)

See Hlookup .



16 Spreadsheet Command
Reference

The Apple, File, and Window menus are identical for all Microsoft
Works tools. For information on these menus, see Chapter 2,
"Common Tasks Command Reference."
This chapter discusses all the shaded commands shown below .

Edit
Undo

Cut
Copy

	

C
Paste
Clear
Moue . . .
Paste with Options . . .

Insert

Paste Function . . .
Absolute Cell Ref

	

R

Fill Right
Fill Down

. . . . .. . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . ... . . . . . . . . . . ... . . . . . . . .

Sort . . .

Options
Calculate Now
Manual Calculation

/Rutomatic Calculation
. . . . . . . . ... . . . . . . . . . . ... . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Formulas
/'Show Ualues

. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . .

Protected
/Not Protected
. . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . .. . .

Set Page Break
Remove Page Break

. . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . .

/Show Grid
No Grid

Select

Chart
Draw Chart . . .
New Series Chart .
New Pie Chart . . .
Select Definition . . .
Duplicate Chart . . .
Erase Chart . . .

Format
/General
Fiiced
Dollar
Percent
Scientific
Number of Decimals . . .

. . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..

Align Left
Align Center
Align Right

. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..

/Normal Text N
Bold B
Underline

	

U
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas
/No Commas

Column Width . . .

Edit

Change Chart Name . . .
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Move

Edit
Undo

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut
Copy
Paste
Clear

Paste Function . . .
Absolute Cell Ref

Sort . . .

z

Moue . . .
Paste with Options . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert

You can invoke some Works commands from the keyboard, as
well as by using the mouse . The available Command-key combina-
tions are shown on the menus and in Appendix D .
An alphabetical list of commands appears in the index under
"Command ."

The Edit Menu

The first five commands on the Edit menu are common to all
tools in Works. For information on these commands, see "The Edit
Menu" in Chapter 2 . For specific information on using the Copy
and Paste commands in the Spreadsheet, see "Copying Cells" in
Chapter 12 .
This section explains additional Edit menu commands that are
available in the Works Spreadsheet .

Move

The Move command moves a selected cell or range of cells from
one location to another in a Spreadsheet document .
Use Move to move information within a single Spreadsheet docu-
ment. When you use Move, the relative cell references point to
the same cell value that they pointed to before the move .

Note When you want to move information from one Spread-
sheet document either to another Spreadsheet document or to
another type of document, use the Cut and Paste commands .

You can also moue cells by holding down the Option
and :#: keys and clicking on the destination cell .

~, C:anc:el .~ ( OK )

Type the reference of the destination cell in the text box .
Works moves the selection from its present location to the desti-
nation cell, beginning with the upper-left cell of the selection .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Fill Right

	

~€R
Fill Down

	

D Enter Destination Cell A1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . for Moue :



Paste with Options

The Paste with Options command pastes a Spreadsheet selection
from the Clipboard to the same or another Spreadsheet document .

Paste with Options :

Q Values Only

0 Both Values and Formulas

LI Transpose

Cancel (OK 3

Use the Cut or Copy command to put your selection on the Clip-
board, and select a cell to be the starting point of the paste . Then
choose Paste with Options .
Values Only Click this option to paste only the formatted
values in a selection.
Both Values and Formulas Click this option to paste the full
content of the cells in a selection .
If you choose to paste both values and formulas, Works adjusts
the relative cell references in the pasted cells according to their
new location .
Transpose Click this option to paste rows into columns or
columns into rows . The selection can contain multiple rows
or columns .
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Paste with Options

Edit

Undo
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut
Copy
Paste
Clear
Moue . . .
Paste with Options . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . .

I nsert
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Paste Function . . .
Absolute Cell Ref

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Fill Right
Fill Down

C

R
D

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sort . . .
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Insert

Edit
Undo

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut
Copy
Paste
Clear
Moue . . .
Paste with Options . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

.

Insert
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Paste Function . . .
Absolute Cell Ref

	

:A
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Fill Right

	

:R
Fill Down

	

'D
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sort . . .

Paste Function

Edit
Undo

	

Z
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cut

	

s!

Copy [:
Paste U
Clear
Moue . . .
Paste with Options . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Insert
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Paste Function . . .
Absolute Cell Ref CR

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Fill Right
Fill Down

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sort . . .

at

u

~€ R

Insert

The Insert command inserts a blank row or column into a
Spreadsheet document .
To insert a blank row or column, select a row or column and
choose Insert . Works inserts a blank row at the selected row, and
moves the selected row below the inserted row . Works inserts a
blank column at the selected column and moves the selected
column to the right of the inserted column . Works then incre-
ments by one all rows or columns after the inserted row or
column, and adjusts all cell references according to the new
row or column headings.

Paste Function

The Paste Function command inserts a function into a formula
in the entry bar.
Select the cell to contain the formula, and click in the entry
bar where you want to insert the function . Then choose Paste
Function .

Paste Function :
Absl.l
AC os(1
Andll
ASin I P
ATaniI
ATan2(I
Aueragel.l
Choose(1

[:anc.eI
t

OK

The list box contains a list of all available Works functions . To
paste a function, select the function you want from the list, then
click the OK button .
If the formula bar is inactive, Works activates it and pastes an
equal sign (=), followed by the selected function . If the formula
bar is active, Works pastes the function at the insertion point .



If you don't type an operator after the preceding operand, Works
adds a plus sign (+) before the pasted function. Works also pastes
the required parentheses, with the insertion point between them,
so you can enter the function's arguments .
For information on specific functions, see Chapter 15, "Spread-
sheet Functions ."

Absolute Cell Ref

The Absolute Cell Ref command allows you to switch between
a relative cell reference and an absolute cell reference .
Absolute cell references are indicated by a dollar sign ($) pre-
ceding the reference to the column, to the row, or to both as
in $B$4 .
To change a reference or range reference in the entry bar, posi-
tion the insertion point to the immediate right of the reference
or select it, then choose Absolute Cell Ref . If the reference is
absolute, Works changes it to relative by deleting the dollar signs .
If the reference is relative, Works changes it to absolute by insert-
ing dollar signs. If the reference is mixed, Works reverses each
part of the reference .

Fill Right/Fill Down

The Fill Right command copies the cells in the leftmost column
of a selection into the remaining columns of the selection . The Fill
Down command copies the cells in the top row of a selection into
the remaining rows of the selection. If the cells in the remaining
columns and rows are not empty, Works replaces the existing data
in those cells .
When you choose Fill Right or Fill Down, Works adjusts relative
cell references in formulas to reflect their new positions .
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Absolute Cell Ref

Edit

Undo
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Cut
Copy

	

C
Paste
Clear
Moue . . .
Paste with Options . . .

Fill Right
Fill Down
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Sort
The Sort command sorts the rows of a selection according to the
contents of key columns within the selection .
You tell Works which rows to sort by selecting them . Then you
specify which columns are the key columns, and whether to sort
in ascending or descending order . You can specify up to three key
columns .

2nd Key
Column

3rd Key
Column

Select Sort Keys :

1st Key
Column

A

Cancel

Q Ascending

•

	

Descending

•

	

Ascending

•

	

Descending

•

	

Ascending

0 Descending

C
OK 1

Columns Specify a key column by typing the column heading
(letter) of the column you want Works to sort the selection on .
If there are duplicates in the key column, Works looks beyond the
first key column to see if you have defined more than one key
column. Specify second and third key columns by typing the head-
ings of the columns in order of importance, with the most impor-
tant key column first .
Next to each Key Column box, click Ascending or Descending to
tell Works what order to sort in . In ascending order, Works sorts
in this order: numbers, error values, text, blanks. In descending
order, Works sorts in the following order : error values, numbers,
text, blanks .
Numbers are sorted from the smallest negative value to the largest
positive value . Text is sorted in the following order :

space !
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The numbers in the text sorting order refer to numbers that are
typed in a Spreadsheet document as text values. Numbers that
appear in a Spreadsheet document as numeric values are sorted
separately .
Works ignores capitalization and accent marks when sorting text .
You can sort on more than three key columns by doing two sorts .
When you do sorts based on more than three key columns, keep
in mind the following :

•

	

The most recent sort takes precedence .
•

	

Works retains the previous sort order in places where the
current sort produces equal items .

If you want Works to take into account more than three key
columns, sort the data three key columns at a time, starting with
the least important group of columns and progressing to the most
important group, but listing the most important column first
within each group .
For example, if you have five key columns you want to use to sort
the rows of a selection, do one sort with the fourth and fifth most
important columns selected as the first and second key columns .
Then do a second sort with the three remaining columns, begin-
ning with the most important column .

The Select Menu

All Cells

The All Cells command selects all the cells from A 1 to the last
cell. (The last cell is at the intersection of the last row and
column that contain a value or formula .)
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All Cells

Se let:t
fill Cells
Last Cell

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Find [:ell . . .

	

€F
Go To Cell . . .

	

:G
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Active Cell
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Last Cell

Select

fill Cells
Last [:ell
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Select
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Last Cell

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Find Cell . . . :F
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Show Actiue Cell

Go To Cell

Select
RII Cells
Last Cell

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Find Cell . . .

	

F
Go To [:ell . . .

	

:#:G
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show fictive Cell

Last Cell

The Last Cell command selects the cell at the intersection of the
last row and column that contain a value or formula .

Find Cell

The Find Cell command finds and selects either the specified cell
or the cell containing the specified text .

Enter Cell to Select or
Text to Find :

Cancel Find Nent 1

Works proposes the cell or the text you last specified . You can
either accept the proposed response or type a new one .
To find cells containing * Error * or N/A, type = Error() or
=NA() in the text box. When you type a formula in the dialog
box, Works calculates the formula, then looks for the cell con-
taining the resulting value .
Click the Find Next button to have Works begin the search .

Go To Cell

The Go To Cell command finds a specified cell and displays it in
the window. It does not select the cell .
Use Go To Cell when you are building a formula in the entry bar
and want to see the contents of a particular cell . Because Works
doesn't select the cell, it will not appear as a reference in your
formula.



Go To Cell :

Cancel OK

Works proposes the cell you last specified. You can either accept
the proposed response or type a new one .
Click the OK button to have Works begin the search .

Show Active Cell

The Show Active Cell command scrolls the Spreadsheet document
so that the active cell is visible . Use this command when you
scroll the Spreadsheet document away from the active cell and
want to return to it quickly .

The Format Menu

General

The General command displays numeric values as precisely
as possible, given the width of the cell. Leading zeros are not
displayed.
Initially, Works displays all values in a Spreadsheet document in
General format. To change this, select one of the four commands
that follow .

Note The Number of Decimals command does not affect cells
with General format .
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Show Active Cell

Select
All Cells
Last Cell

. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . .

Find Cell . . .
Go To Cell . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Active Cell

General

Format
/General
Fined
Dollar
Per(:enI
Scientific
Number of Decimals . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left
Align Center
Align Right

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Width . . .

/Normal Text :# N
Bold ` B
Underline : U

Commas
/No Commas
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Fixed

Format

General

Fined

Dollar

Percent

Scientific

Number of Decimals . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left

Align Center

Align Right
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Normal Tent

Bold

Underline
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas

No Commas
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Width . . .

Dollar

Format

General

Fined

Dollar

Percent

Scientific

Number of Decimals . . .

Align Left

Align Center

Align Right

Normal Tent

Bold

Underline

Commas
No Commas

Column Width . . .

B

U

N

B

. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Fixed

The Fixed command displays values with a fixed number of places

to the right of the decimal point .

Initially, the fixed number of places is two. You can change it

with the Number of Decimals command.

Dollar

The Dollar command displays values in dollars and cents format,

that is, with dollars to the left of the decimal point and either no

digits or two digits representing cents to the right . A dollar sign

($) appears to the immediate left of the most significant digit .

Negative numbers are enclosed in parentheses .

Choose Number of Decimals to display either whole dollars or

dollars and cents. Type 0 to display whole dollars with no decimal

point. Type 2 to display dollars and cents .

The value is adjusted to the nearest whole dollar or whole cent

depending upon your choice of 0 or 2 decimals . For example, the

value 9.505 is displayed as $10 if you specify 0 decimal places ;

it is displayed as $9.51 if you specify 2 decimal places .



Percent

The Percent command displays values as percentages.
The numeric value of a cell is multiplied by 100 and displayed
with a percent sign (%) to its immediate right .
With the Number of Decimals command, you can specify the
number of decimal places to be displayed in the percentage. The
value .156, for example, is displayed as 15.6% if you set Number
of Decimals to 1, or 16% if you set Number of Decimals to 0 .

Scientific

The Scientific command allows you to express very large or very
small numbers .
Scientific notation consists of three parts : a decimal number in
the form n. nn, the exponentiation symbol E or e, and an integer
in the form ± ii for the exponent . With the Number of Decimals
command, you can specify the number of decimal places to be
displayed in the decimal number .
For example, the value 1,210 is displayed as 1 .21E + 03, where
1 .21 is the decimal number, E is the exponentiation symbol, and
+03 is the exponent . The value .00121 is displayed as 1 .21 E - 03 .
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Percent

Format
General
Fined
Dollar
Per(:ent
Scientific
Number of Decimals . . .

Align Left
Align Center
Align Right

. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Normal Tent
Bold
Underline

Scientific

Format
General
Fined
Dollar
Percent
Scientific
Number of Decimals . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left
Align Center
Align Right

Normal Tent

	

. . N
Bold
Underline

B
U

B

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas
No Commas

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Width . . .

. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .

. . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas
No Commas

. . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Width . . .
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Number of Decimals

Format

/General
Fined
Dollar
Percent
Scientific.
Number of Decimals . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left
Align Center
Align Right

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

,/Normal TeHt

	

N
Bold

	

:,B
Underline

	

, U
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas
/No Commas

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Width . . .

Align Left
Align Center
Align Right

Format

/General
Fined
Dollar
Percent
Scientiii( :
Number of Dec:imals . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left
Align Center
Align Right

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

	

.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas
/No Commas

Column Width . . .

Number of Decimals

The Number of Decimals command tells Works how many digits
to display to the right of the decimal point when you specify
Fixed, Dollar, Percent, or Scientific format .

Enter Number of Decimal
Places from 0 to 15 :

(Cancel

2

COK

In the text box, type the number of decimals, from 0 to 15,
you want displayed. For more information, see "Fixed," "Dollar,"
"Percent," and "Scientific," above

Align Left/Align Center/Align Right

These commands align the contents of selected cells .
The Align Left command aligns the cell content to the leftmost
position in the cell .
The Align Center command centers the cell content in the cell .
The Align Right command aligns the cell content to the rightmost
position in the cell .

/Normal TeHt :,N
Bold B
Underline :,U



Normal Text/Bold/Underline

	

Normal Text
Bold
UnderlineThese commands change the type style of values in selected cells .

Values can be either plain or bold, underlined or not .
The Underline command underlines the entire cell .

Commas/No Commas

These commands tell Works whether or not to display commas
in numeric values .
When you select a cell or a range of cells and choose Commas,
Works displays a comma between each group of three digits to
the left of the decimal point .
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Format
General
Fixed
Dollar
Percent
Scientific:
Number of Decimals . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left
Rlign Center
Rlign Right

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

,/Normal Teot

	

r#:N
Bold
Underline

Commas
~/Na C:ammas

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column Lhidth . . .

Commas
No Commas

Format
,General
Fined
Dollar
Percent
Sr.ientific
Number- of Decimals . . .

Rlign Left
Rlign Center
Rlign Right

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Commas
~/No C:ommas

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column lhidth . . .

/Normal Tent
Bold
Underline

~~N
'~ B
'~ U
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Column Width

Format
/General
Fined
Dollar
Per(:ent
Scientific:
Number of Decimals . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align Left
Align Center
Align Right

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

./Normal Text N
Bold B
Underline

	

U
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Commas
No Commas

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Column LVidth . . .

Calculate Now
Manual Calculation

Options
Calculate Now : :=
Manual Calculation

/Automatic Calculation
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Formulas
./Show Values

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Protected
,/Not Protected

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Page Break
Remove Page Break

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Show Grid
No Grid

Column Width

The Column Width command sets the width of selected columns .
You don't have to select an entire column . If you select any cell
in a column, the new column width applies to all cells in that
column. To adjust all of the columns in a Spreadsheet document,
select an entire row by clicking a row heading .

Enter Column Width
from 1 to 40

Cancel

12

You can also change column width by clicking and
dragging the column divider bars .

In the text box, you can either accept the proposed response or
type a new number. The standard column width is twelve spaces .
To change the width of a column with the mouse, point to one of
the lines that divide the column headings. When the pointer
becomes a two-way arrow, drag to the left or right .

The Options Menu

Calculate Now/Manual Calculation

The Calculate Now command allows you to recalculate a
Spreadsheet document. The Manual Calculation command tells
Works to recalculate a Spreadsheet document only when you
choose Calculate Now .
You don't need to choose Calculate Now when calculation is
automatic, because in that case, whenever you make a change,
Works automatically recalculates dependent formulas in all open
Spreadsheet documents and charts .



Automatic Calculation

When you create a new Spreadsheet document, Automatic Calcu-
lation is checked . This command tells Works to recalculate the
Spreadsheet document whenever you change the content of a cell .
Since calculation is done in the background, and doesn't interfere
with your work, you'll probably want to have this command in
effect most of the time .

These commands tell Works to display or print either the format-
ted value or the unformatted content of cells.
These commands affect all cells in a Spreadsheet document .
If you choose Show Formulas, Works places the formulas on the
Clipboard when you cut or copy cells, or prints the formulas
when you print a range of cells .
If you choose Show Values, Works places the formatted values on
the Clipboard when you cut or copy cells, or prints the formatted
values when you print a range of cells .
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Automatic Calculation

Options
Calculate Now
Manual Calculation

/Automatic C:al(:ulation
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Show Formulas

/Show Values
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Protected
Not Protected

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Set Page Break
Remove Page Break

Show Formulas/Show Values

	

Show Formulas
Show Values

Options

/Show Values
. . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Protected
/Not Protected

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
/Show Grid
No Grid

Calculate Now
Manual Calculation

/Automatic Calculation
. . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Formulas

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Page Break
Remove Page Break

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Show Grid
No Grid
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Protected
Not Protected

Options

/Not Protected
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Page Break
Remove Page Break

Options

Remove Page Break
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Show Grid
No Grid

Calculate Now
Manual Calculation

/Automatic Calculation
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Show Formulas
Show Values
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Protected
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/Show Grid
No Grid

Set Page Break
Remove Page Break

Calculate Now

	

_
Manual Calculation

/Automatic Calculation
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Show Formulas
Show Values

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Protected
Not Protected

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Page Break

Protected/Not Protected

These commands set and remove cell protection for selected
cells .
The Protected command protects a cell or range of cells from
accidental loss or change. The Not Protected command removes
this protection .
When you choose Protected, Works won't allow you to enter
numbers, formulas, or labels . If you try, Works displays an alert
box telling you to remove cell protection before entering
your data.

Set Page Break/Remove Page Break

These commands set and remove manual page breaks for a
printed Spreadsheet document .
Works automatically determines where pages break, based on
column widths and the margin settings you enter with the Page
Setup command from the File menu. You can manually insert page
breaks, however, in places other than where pages would auto-
matically break .
To set a manual page break, select the cell you want to be in the
upper-left corner of the page, then choose Set Page Break . Works
inserts vertical and horizontal dashed lines (page break indicators)
to mark the manual page break, then repaginates the rest of the
document.
To remove a manual page break, select a cell immediately to the
right of a vertical break or below a horizontal break, then choose
Remove Page Break. Works removes the page break indicator and
automatically repaginates the rest of the document . To remove
both a vertical and a horizontal page break indicator at once,
select the cell in the upper-left corner of the page before choos-
ing Remove Page Break .



Show Grid/No Grid

These commands tell Works whether or not to display and print
grid lines on your Spreadsheet document .
Choose Show Grid to display and print grid lines . Choose No Grid
to display and print without grid lines . The active command is
checked on the menu .

The Chart Menu

Draw Chart

The Draw Chart command draws a chart that you have already
defined with either the New Series Chart or New Pie Chart
command .

Draw Chart :
Budget Chart 1
Budget Chart 2

Cancel 0K

To draw a chart, select the chart you want, then click the OK
button. Works draws the chart and makes the chart window the
active window.
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Show Grid
No Grid

Options
Calculate Now
Manual Calculation

/Automatic Calculation
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.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

/Protected
Not Protected

.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set Page Break
Remove Page Break

Draw Chart

. . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
,/Shoo' Grid
No Grid

Chart
Draw Chart . . .
New Series Chart . . .
New Pie Chart . . .
Select Definition . . .
Duplicate Chart . . .
Erase Chart . . .
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New Series Chart

Chart
Draw Chart . . .
New Series Chart . . .
New Pie Chart . . .
Select Definition . . .
Duplicate Chart . . .
Erase Chart . . .

New Series Chart
The New Series Chart command defines a new series chart . Use a
series chart when you want to compare different sets of data . You
can plot up to four rows at once . You can define up to eight chart
definitions for each Spreadsheet document . If New Series Chart is
dimmed on the menu, you need to remove a chart definition with
the Erase Chart command before you can create a new one .

o

COM

BAR

0
STACK

Chart Title :

Vertical Scale Title :

Horizontal Scale Title :

Type of Chart :

LINE

Cancel J

Untitled

Untitled

Untitled

Plot It!

The name of the chart definition (not the chart title) is displayed
in the title bar. You can leave the name as is or rename the defini-
tion to something more meaningful to you . To change the name,
use the Change Chart Name command from the Edit menu . For
more information, see "Change Chart Name" at the end of this
chapter.
Since you may need to refer to the Spreadsheet document to set
the chart parameters, you can move this dialog box just like a reg-
ular window. Drag the title bar to move the box and see the infor-
mation you need .
After you set up the chart definition, you have three choices :

•

	

Click the Plot It! button to plot the chart and to store the
definition with your Spreadsheet document .

•

	

Click the close box to store the definition with your Spread-
sheet document and to make the Spreadsheet document the
active window .

•

	

Click the Cancel button to return to the Spreadsheet docu-
ment and discard the definition .

Chart 1Untitled
Values to be Plotted :

	

Vertical Scale :

1St Raw : 3 ® Numeric

2nd Row :
Q Semi-Logarithmic

4

3rd Raw : MaHimum :

4th Row : Minimum : D

From Column : B

To Column :

Data Legends in Column :

Horizontal Titles in Row :

H ® Draw Grid
® Label Chart1



When you save your Spreadsheet document, chart definitions are
also saved and are available when you later open the Spreadsheet
document .
Type of Chart Click the type you want .

Line

	

For analyzing trends .
Bar

	

For making comparisons .
Stack

	

For analyzing cumulative effects .
Combo

	

For seeing both trends and comparisons .

Values to be Plotted

1st Row Type the row heading (a number) of the first of the
four rows of values you want to plot. Works proposes row 3,
assuming row 1 contains a title for your Spreadsheet document
and row 2 contains column labels .
2nd Row Type the row heading of the second row of values
you want to plot. Works proposes row 4. If you want to plot only
one row of values, press the Backspace key to erase the 4 and
leave the box blank.
3rd Row Type the row heading of the third row of values you
want to plot .
4th Row Type the row heading of the fourth row of values you
want to plot .
From Column Type the column heading (a letter) of the first
column of values you want to plot. Works proposes column B .
TO Column Type the column heading of the last column of
values you want to plot . Works proposes column M.
Data Legends in Column Type the heading of the column con-
taining the data legends (the labels that describe the rows you are
plotting) . Works proposes column A.
Horizontal Titles in Row Type the heading of the row contain-
ing the horizontal titles (the labels that describe the columns you
are plotting). Works proposes row 1 .
Chart Title Type a title to appear on the chart . If you type noth-
ing here, Works will put no title on the chart .
Vertical Scale Title Type a label for the vertical scale, such
as Units, Dollars, or Millions of Dollars . If you type nothing here,
Works will put no vertical scale title on the chart.
Horizontal Scale Title Type a label for the horizontal scale .
If you type nothing here, Works will put no horizontal scale title
on the chart .
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New Pie Chart

Chart
Draw Chart . . .
New Series Chart . . .
New Pie Chart . . .
Select Definition . . .
Duplicate Chart . . .
Erase Chart . . .

Vertical Scale

Numeric Click this box to scale the data numerically. This is
initially checked .
Semi-Logarithmic Click this box to scale the data logarithmi-
cally. The vertical scale on the chart is logarithmic . Works auto-
matically computes the number of cycles based on the range
of values in the rows you are plotting .
Maximum Type the maximum value you want to plot . If you
leave this box blank, Works plots all values in the specified rows,
and divides the vertical scale based on the largest plotted value .
Minimum Type the minimum value you want to plot . Works
proposes 0. If you leave this unchanged, Works plots all values
in the specified rows and begins the vertical scale with 0 .

New Pie Chart

The New Pie Chart command defines a new pie chart . Use a
pie chart when you want to compare individual parts of a whole .
If New Pie Chart is dimmed on the menu, you need to remove
a chart definition with the Erase Chart command before you
can create a new one.

=a Untitled Chart 3

Pie Chart Definition :

Chart Title :

Plot Values in Column :

From Row :

Through Row :

Column of Value Titles :

Untitled

B

3

7

It

[Cancel Plot It! 1

The name of the chart definition (not the chart title) is displayed
in the title bar. You can leave the name as is or rename the defini-
tion to something more meaningful to you . To change the name,
use the Change Chart Name command from the Edit menu . For
more information, see "Change Chart Name" at the end of this
chapter.
Since you may need to refer to the Spreadsheet document to set
the chart parameters, you can move this dialog box just like a reg-
ular window. Drag the title bar to see the information you need .



After you set up the chart definition, you have three choices :

•

	

Click the Plot It! button to plot the chart and to store the
definition with your Spreadsheet document .

•

	

Click the close box to store the definition with your Spread-
sheet document and to make the Spreadsheet document the
active window.

•

	

Click the Cancel button to return to the Spreadsheet docu-
ment and discard the definition .

When you save your Spreadsheet document, chart definitions are
also saved and are available when you later open the Spreadsheet
document .
Chart Title Type a title to appear on the chart . If you type noth-
ing here, Works will put no title on the chart .
Plot Values in Column Type the heading (a letter) of the
column of values you want to plot . Works proposes column B .
From Row Type the heading (a number) of the first row con-
taining values you want to plot. Works proposes row 3 .
Through Row Type the heading of the last row containing
values you want to plot . Works proposes row 7 .
Column of Value Titles Type the heading of the column con-
taining the titles of the values you want to plot. Works proposes
column A.

Select Definition

The Select Definition command allows you to change or verify
an existing chart definition before plotting the chart .

Select Chart :
Budget Chart 1
Budget Chart 2

Cancel OK
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Select Definition

C: hart
Draw Chart . . .
New Series Chart . . .
New Pie Chart . . .
Selet:t Definition . . .
Duplicate Chart . . .
Erase Chart . . .
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Duplicate Chart

Chart
Draw Chart . . .
New Series Chart . . .
New Pie Chart . . .
Select Definition . . .
Duplicate C:hart . . .
Erase Chart . . .

Select the chart definition you want to change or verify, then click
the OK button. Works displays the definition in the appropriate
definition dialog box .
After you change whatever specifications need to be changed, you
have three choices :

•

	

Click the Plot It! button to plot the new chart . This button also
replaces the original chart definition with the modified one
and stores it with the Spreadsheet document .

•

	

Click the close box to store the modified definition with your
Spreadsheet document without plotting the chart and to make
the Spreadsheet document the active window .

•

	

Click the Cancel button to return to the Spreadsheet docu-
ment and discard any changes you made to the definition .

When you save your Spreadsheet document, the modified chart
definition is saved and will be available when you later open the
Spreadsheet document.

Duplicate Chart

The Duplicate Chart command duplicates an existing chart defini-
tion. If Duplicate Chart is dimmed on the menu, you need to
remove a chart definition with the Erase Chart command before
you can duplicate one .

Duplicate Chart :
Budget Chart 1
Budget Chart 2

Cancel

Select the chart definition you want to duplicate, then click the
OK button. Works displays the definition with a proposed new
name in the appropriate chart definition dialog box .



After you change whatever specifications need to be changed, you
have three choices.

•

	

Click the Plot It! button to plot the chart and store the new
definition with your Spreadsheet document .

•

	

Click the close box to store the new definition with your
Spreadsheet document and to make the Spreadsheet document
the active window .

•

	

Click the Cancel button to return to the Spreadsheet docu-
ment and discard the new definition .

When you save your Spreadsheet document, the new definition
is saved with it and will be available when you later open the
Spreadsheet document.

Erase Chart
The Erase Chart command erases a chart definition stored with
a Spreadsheet document .

Erase C:hdrt :
Budget C:hdrt 1
Budget Chart 2

~` C:ancel ,~ f°K]l

Choose the chart definition you want to erase .
Works removes the chart definition from the list of definitions
stored with the Spreadsheet document.
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Erase Chart

[:hdrt
Draw Chart . . .
New Series [:hart . . .
New Pie Chart . . .
Select Definition . . .
Duplicate Chart . . .
Erase Chart . . .
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Change Chart Name

Edit

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Change [:hart Name . . .

The Edit Menu

Change Chart Name

The Change Chart Name command changes the name of a chart
definition .

Enter Chart Name : Budget Chart 1

Cancel ) IOK t

Type the new name and click the OK button .
The new name also appears in the title bar of the chart window
and in the dialog boxes that contain a list of chart names .
This command is available only when a chart definition dialog box
is the active window.



Communications

Works Communications opens up a world of opportunities for
you. Using Communications, you can talk with computers just
about everywhere . You can browse through files on computer
libraries, send and receive information, or make financial
transactions .
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The chapters in this part of the manual explain how to use Works
Communications .

•

	

Chapter 17, "Specifying Settings and Calling a Computer,"
shows how data communications works, how to match the
way your computer communicates with the way other com-
puters communicate, and how to store telephone numbers
and have Works dial them automatically .

•

	

Chapter 18, "Sending and Receiving Information," explains
how you can send and receive both messages and information,
such as a Spreadsheet document that a spreadsheet program
on another computer can use.

•

	

Chapter 19, "Communications Command Reference," describes
the Communications commands .



17 Specifying Settings
and Calling a Computer

To use Works Communications, you need to make sure that the
Works settings match those of the computer you're calling. Infor-
mation services, like Dow Jones or CompuServe, and other acces-
sible computers will provide you with the necessary information .
Then, you need to put the phone numbers of the services into
your Works phone book so you can get in touch with them .
In this chapter, you'll learn how to :

•

	

Understand how data communications works .
•

	

Specify settings .
•

	

Use the Works phone book .
•

	

Dial another computer and respond when the connection
is made.

•

	

Adjust the echo .
•

	

Hang up the phone .
•

	

Prepare to answer calls .
•

	

Call an information service or personal computer .

An Overview

This section gives an overview of how data communications
works, and explains the terms you'll use in Works Communi-
cations .

Connecting Computers

Data communications travel over telephone lines or through
cables .
Usually you'll send messages over the telephone . To do that, you

	

The modem
need a modem or an acoustic coupler devices that convert digi- connection
tal signals into voice-frequency signals that can travel over the
telephone. A modem (modulator-demodulator) modulates electri-
cal impulses into telephone signals when you send messages .
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The cable connection

Baud rate

Character settings

When you receive messages, it demodulates, or translates the
telephone signals back into electrical signals your computer can
understand. An acoustic coupler receives sound signals through
a standard telephone receiver, rather than electrical signals over
cables. An acoustic coupler is more vulnerable to noise and static
than a modem, and more suitable for low-speed transmissions .
You can also send information directly from computer to com-
puter using a cable. Your computer dealer can show you how .
When two computers are directly connected, you'll be able to
send information faster than you usually can over the telephone
line, but only over short distances (among offices in a building,
for example) .

Speed of Transmission

Your Macintosh sends information through a modem in tones that
represent zeros and ones . These zeros and ones are binary digits,
or bits . Each bit is only a fraction of a single letter, and hundreds
of them go out every second. The rate of speed at which the bits
are sent is the baud rate . You set the baud rate to tell Works how
fast to send out information . Because of static and other random
noises in the telephone lines, messages you send over the tele-
phone travel at relatively slow speeds but still much faster than
you can type. If you lease direct lines or use a satellite, you can
send messages at very high rates of speed .

How Information Travels

To make sure that your message gets through accurately, com-
munications programs at both ends have to send and receive
information the same way . When you subscribe to a computer
service or plan to connect with another computer, somebody
at the other end tells you in advance what settings to choose.
In addition to setting the speed of transmission, you specify three
characteristics about the characters that make up your message .
When you send a message, it goes out in pulses of sound or elec-
tricity. The data size tells the receiving computer how many
pulses make up one character . Stop bits tell when one character
ends and another begins. Parity is a method the computer uses
to check for errors in the data transmission .
Unless both computers send and receive information using
the same settings, they won't understand each other like two
people talking to each other in different languages .



Greetings

Just as diplomats follow a specified ritual when they greet each

other, so do computers. The handshake setting tells one computer

how the other computer will send and receive information .

The handshake is a form of protocol computer diplomacy . Not

all computers use the same protocol, but most information ser-

vices and personal computer communications programs use the

protocols that Works provides.

Creating a New

Communications Document

For each computer that you intend to call, you can create a new

document to contain the appropriate settings. Each computer you

call may use different settings .

To create a new Communications document :

0 In the Open dialog box, click the Communications icon .

Click the New button.

Works displays the Settings dialog box . Whenever you create

a new Communications document, the Settings dialog box is

automatically displayed. You can have only one Communications

document open at a time .

Communications Settings :

Baud Rate :

Data Size :

Stop Bits :

Parity :

Handshake :

Phone Type :

Line Delay :

Connect To :

O 300

	

0 2400

	

0 9600
•

	

1200 04800 019200

•

	

8 Bits 0 7 Bits

•

	

1 Bit 0 2 Bits

•

	

None 0 Odd 0 Even

0 None

	

® lion/Hoff

0 Hardware

Touch-Tone

Both

0

0

Character Delay :

Cancel `

0 Rotary Dial

0

t OK J
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Handshake setting

To create a new

Communications

document



288 Communications

Specifying Settings

When you first create a new Communications document, the
preset options are those normally used by information services .

To specify settings

	

To specify settings :

0 Click the appropriate settings, and type the line or character
delay, if any .
Click the OK button or press the Return key .

Works stores the settings with the Communications document,
and saves them when you save the document .

For a complete description of the Settings options, see "Settings"
in Chapter 19 .

To change settings

	

To change the settings at any time :

D Choose the Settings command from the Communications
menu, and repeat steps 1 and 2 of the procedure described
above.

Adding or Changing Numbers
in the Phone Book

Each Communications document has its own phone book stored
with it, which contains up to eight phone numbers . The phone
book also stores a name for each number, so that you'll know
which computer you're dialing . The phone book is empty until
you put numbers into it .

To add a number to

	

To add a number to the phone book :
the phone book

0 Choose Dial from the Communications menu .
The phone book appears, with the insertion point in the first
blank Name box .



4

0

4

Type the name here. Type the number here .

Phone Number:

Gdncel f OK

Choose Dial from the Communications menu .
•

	

Select the name or number by dragging across it .
•

	

Press the Backspace key to remove the selected name or
number, or type the correction to change or replace the
selected name or number .
Click the OK button or press the Return key .

Works stores the change with the Communications document .
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•

	

Type a name .
•

	

Press the Tab key to move the insertion point into the number
box, and type a phone number .
A number can be up to 50 digits long . Be sure to include all
the digits you'd normally dial if you were making the call
yourself any long distance access codes or internal account-
ing codes, for example .
If you have a Hayes or Hayes-compatible modem, you can
insert commas for pauses and hyphens for easier reading . If, for
example, you must dial 9 for an outside line, you can type 9,
111-0000 so Works will pause after it dials 9 .
If you have a different kind of modem, see your modem docu-
mentation for information on commas and hyphens .
Click the OK button or press the Return key .

Works stores the new name and number with the Communica-
tions document .

To change or remove a name or number : To change or remove
a name or number
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To dial a number with
a Hayes-compatible
modem

To respond when a
connection is made

Dialing a Phone Number

Before dialing, make sure your modem is connected to the Mac-
intosh and to a telephone wall outlet .
If you have a Hayes or Hayes-compatible modem, you can use the
Dial command to send the appropriate command to the modem
to tell it to dial the number. For other modems, you must send
the dialing command as well as the phone number .
To dial a phone number (Hayes or compatible modem) :

El

Works dials the number for you and displays the message
"Dialing. . ." to tell you that the modem is dialing . When you
are connected, Works displays the message "CONNECTED" .

To dial a number with To dial a phone number (non-Hayes-compatible) :
a different modem

a

a

Choose Dial from the Communications menu .
Click the Dial button next to the number you want .

Type the dialing command for your modem in the Com-
munications document window .
Refer to your modem documentation for information on
dialing commands .
or
If you have an acoustic coupler, dial the number, then place
the telephone receiver in the headset .

Once you're connected, respond to the prompts of the service
you've dialed, or if you're calling another personal computer, type
something like "Hello" to let the other person know you're
connected .



Getting an Echo

Some computers send back each character they receive, so that

	

To adjust the echo
you see two of each character on your screen . This is called an
echo. If you're seeing two of each character when you connect
with another computer, turn the echo off. If you're not seeing any
characters as you type, turn the echo on .
To adjust the echo :

D

D

Choose Echo On or Echo Off from the Communications menu .
The command in effect has a checkmark on the menu .

Echo On is often called "full duplex" and Echo Off "half duplex ."

Hanging Up

Hanging up with Works Communications is just as easy as hanging To hang up
up a telephone . After you've finished your session with an infor-
mation service or another computer operator, you're ready to
hang up. Remember that hanging up does not necessarily log you
off from the system you were connected with, so it is a good
practice to log off before you hang up .
To hang up :

Choose Hang Up from the Communications menu .
Works displays the messages "Hanging up. . .", " + + + ", and
"NO CARRIER" .

The last two messages indicate that the connection has been
broken. You can then close or save the document .

The carrier is the signal that carries your message over the phone
lines . Periodically something will go wrong with a transmission .
If you are disconnected in the middle of a session, Works displays
the message, "NO CARRIER . . ." . The message means that you've
been disconnected. You can quit or try again .
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To answer a call

Preparing to Answer a Call

When you're expecting a call from another user, you need to get
ready.

El

Then, to set your Hayes-compatible modem to auto-answer :

Choose the Answer Phone command from the Communica-
tions menu .

D

This tells your modem to answer the telephone when it rings .
When the Answer Phone command is in effect, it is checked on
the menu.

When you finish your Communications session and break the con-
nection with the other user, you may want to change the setting
on your modem .
To set the modem so that it won't answer the telephone :

D

Create a new Communications document, or open an existing
Communications file .
Confirm that the settings in the Settings dialog box are correct .

Choose the checked Answer Phone command .

Works removes the checkmark from the menu .

If your modem is not Hayes-compatible, consult your modem
documentation, and type the appropriate command in the
Communications document window .



Completing a Connection

Once you're connected to another computer, what do you do?
It depends on the kind of computer you're calling . This section
explains briefly about information services and other personal
computers.

Calling an Information Service

Information services, like Dow Jones or CompuServe, have more

	

To call an information
information than many reference libraries . Although they all work service
differently, this section shows you some of their similarities, so
you'll know what to expect when you call one .
To call an information service :

Dial the service .
When you connect, the service will probably ask for an identi-
fication code and a password. (Your service provides this
information when you subscribe .)
Type your identification code and password .
Now you're logged on to the service . The time from when you
log on to when you log off is your session. The service should
guide you with prompts through the session . By answering
questions and choosing from menus, you should be able to
find what you're looking for.
Some information services have a system operator whom you
can ask for help if you have difficulties .
Because many information services charge you for the time
you are connected, Works Communications provides some
commands that let you save time when you send and receive
information . For more information, see Chapter 18, "Sending
and Receiving Information ."
When you're finished, log off and hang up .

El
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Note Commercial information services, such as CompuServe,
The Source, and Delphi, may require that you transmit control
characters to utilize some functions of the service . To transmit a
control character in Works, hold down the Option key and press
whatever character key you need . For example, to transmit
Control-C, hold down the Option key and press the C key .
For Works Communications documents :

•

	

Option-3 corresponds to Break
•

	

Option-Backspace corresponds to Delete
•

	

Option-[ corresponds to Escape
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Calling a Personal Computer
To call a personal

	

Personal computers from different manufacturers can communi-
computer

	

care with each other through programs like Works Communica-
tions. Using the telephone lines with Communications, you can
send messages and documents to acquaintances who have
personal computers .
To call a personal computer :

0

Fl

Make sure your settings in the Settings dialog box match those
of the receiving computer's program .
Dial the number .
When Works says "CONNECTED", begin typing .

Once you're connected, you can type messages and send and
receive information .

Saving a Communications Document

When you save a Communications document, Works automatically
stores the settings along with it. You might want to name the
document after the information service or person you called .
When you want to dial that service or personal computer again,
you can open this file and dial, and the settings will be in place .

Note Information that appears in the Communications window,
which is used for interaction between the modem and the com-
puter you connect to, is not stored with the Communications
document.



18 Sending and Receiving
Information

Sometimes you'll want to interact with another computer by send-
ing or receiving messages . This type of information is called text .
When you're using an information service, you usually send and
receive text. What you see on the screen while you're using Com-
munications is text .
At other times you'll want to send files, like Spreadsheet docu-
ments, for someone else to look at, or you'll want to get a copy of
an application program available on an information service . A file
can be either a file created with an application, or an application
program itself that you send or receive . You can't read the partic-
ular file that you're sending or receiving while the transmission is
in progress . You can, however, use other Works tools at this time .
This chapter shows you how to :

•

	

Send both text and files .
•

	

Receive both text and files .

If you want to gain access to a bulletin board or information ser-
vice, see "Sending Text" and "Capturing and Saving Text" in this
chapter. If you plan to send or receive an application program or
application file, see "Sending a File" and "Receiving and Saving a
File" in this chapter .

Sending Information

Works Communications gives you two ways to send information :
•

	

As text: You can type the information in the Word Processor,
save it, and send it out with Communications as text . This is
especially useful for sending messages through electronic mail .
Communications will send the information much faster than
you could type it, so you can save on long-distance bills .

Ways to send
information
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To send text as you
type it

∎ As a file : If you send a file to another Macintosh, or to other
types of computers, the recipient will be able to save the file
and then open it later with the appropriate tool or program .

Information sent as text is meant to be read and used during the
course of communicating with the other computer. Information
sent as a file is meant to be used later, with another tool or
application .

Sending Text

Text is whatever you type with the keyboard . Everything you type
with the Word Processor, for example, is text . The formatting in
a Word Processor document is not text, however . Nearly every
computer reads plain (normal) text the same way, which makes
it possible for you to send text to other computers . When you call
up an information service, you type text to tell it who you are and
what you want to do .
To send text as you type it :

0 Connect with the receiving computer .
Start typing .

That's it! Once you connect with another computer, you can start
typing. Most information services or bulletin boards will prompt
you for commands, guiding you through a session . If you're con-
necting with another personal computer, you can just type mes-
sages as though you were talking.

To send blocks of

	

You don't have to type everything you send while you're sending
text

	

it. With the Send Text command, you can send large amounts of
text faster than you can type . First, you save information in the
Word Processor. Then you send that document with the Send
Text command just as though you were typing it. Since much of
the expense of using an information service depends on how long
you're connected, you can save money by sending large amounts
of text from a document, rather than by typing them as you send
them.
To send blocks of text :

0 Connect with the receiving computer .
Make sure the disk containing the Word Processor file is in the
disk drive.



4

•

	

Choose Send Text from the Communications menu .
Works displays a dialog box listing files to choose from .
Select a file from the list.

•

	

Click the Send button .

The information zips across the screen as Works sends it .

Sending a File

Works Communications lets you send complete files, as well as

	

To send a file
text. The receiver of a file can save it and use it, just as though
you had sent a copy of the file on a disk . You can send formatted
Word Processor files containing different fonts or type sizes ; or
Database files that can be sorted and analyzed ; or Spreadsheet files
with formulas that work, so that they can be recalculated .
To send a file :

Connect with the receiving computer .
•

	

Choose Send File from the Communications menu .
Works displays a dialog box listing files to choose from .

•

	

Select a file from the list .
Click a protocol option .
For a complete description of the available options, see
"Receive File" in Chapter 19 .

•

	

Click the Send button.

0

4

Works sends the file and tells you when the transmission is com-
plete . The recipient can save the file for later use .

Receiving Information

As soon as you connect with another computer, you can receive
whatever someone sends from the other end . The information
goes into the memory of your Macintosh but it's stored there
only until you turn the computer off
With Works Communications, you can save the information you
receive for review by using the Capture Text command, and you
can save files for later use with the Receive File command.
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Capturing and Saving Text

To capture and save

	

When you want to reduce the amount of time you're connected
text for review

	

to an information service or on the phone, you can save every-
thing you type or receive as a Word Processor document . Then
after you hang up the phone, you can review the entire session
at your leisure . You'll be able to scroll back and forth through the
text so that you can examine anything that went by too fast or
was confusing.
You can start saving text at any time while you're connected . For
example, if you call an information service to find out the average
housing costs in Indianapolis, but have to look through a lot of
extra material before you find what you want, you can wait until
you're ready before saving anything .
To capture and save text :

To stop saving text

0

4

D

Connect with another computer .
Whenever you're ready to start saving text, choose Capture
Text from the Communications menu .
Works displays a dialog box in which you can name the docu-
ment that will hold the text .
Type a name for the document .
Click the Capture button .

Works saves everything that you type or receive from the other
computer. You will see text appear on your screen as it is
received .

You can stop saving text at any time :

Choose End Text Capture from the Communications menu .

Works stops saving text, but you continue to receive the informa-
tion on your screen.

Receiving and Saving a File

To receive a file and

	

Information services often have whole files or application pro-
save it on a disk

	

grams that you can transfer for storage on a disk . For example,
you might want to transfer a new stock analysis application pro-
gram so that you can examine your portfolio . Or a friend with a
personal computer might want to send you a copy of a new game
(if it's in the public domain) .



Works Communications can take such information and save it in
a file on a disk. If it is an application program, it must go onto a
disk before you can use it. If it is a file, you may only be able to
use it with a particular application . Such information is useful only
if you store it on a disk.
Before you can receive a file, you have to make sure that your
computer and the other computer are using the same language,
or protocol .
To receive and save a file :

Connect with another computer .
•

	

When you know you're about to receive a file, choose Receive
File from the Communications menu .
(The information service or computer operator at the other
end should tell you to get ready to receive the file .)
Works displays a dialog box in which you can name a file to
be received and choose a protocol .

•

	

Type a name for the file.
Click a protocol option .
For an explanation of the available options, see "Receive File"
in Chapter 19 .

•

	

Make sure the correct disk is in the disk drive .
Click the Receive button.

0

4

s

As the file comes in, Works saves it with the name you've chosen
and tells you when the transmission is complete . If you receive
a Macintosh application program, you can open it like any other
application. If you receive a file, you'll be able to open it with
the appropriate application .
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19 Communications
Command Reference

The Apple, File, and Window menus are identical for all Microsoft
Works tools. For information on these menus, see Chapter 2,
"Common Tasks Command Reference."
This chapter discusses the shaded commands shown below :

Edit

Cut
Copy "C
Paste
Clear

[:ommunic:at ions
'Echo On
Echo Off

. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Dial . . .
Hang Up
Hnswer Phone

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Capture Teut . . .
Send Tent . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Receive File . . .
Send File . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Settings . . .

An alphabetical list of commands appears in the index under
"Command."
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Select All

Edit
€€€3

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..

Cut H
Copy C
Paste U
Clear

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Select HII

Echo On
Echo Off

C:ommunit:ations
VEc:ho On
Echo Off

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Dial . . .
Hang Up
Answer Phone

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Capture Teet . . .
Send Tent . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Receive File . . .
Send File . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Settings . . .

The Edit Menu

For information on the first five commands on the Edit menu see
"The Edit Menu

Select All

in Chapter 2 .

The Select All command selects an entire document .

The Communications Menu

Echo On/Echo Off

These commands control whether or not Works echoes characters
on your screen .
Many computers send the characters they receive back to the
sending terminal, which then displays these characters a second
time. As you type, it looks as if you are typing the characters
twice. If you are seeing two of each character, choose Echo Off .
If you are not seeing any characters, choose Echo On .



Dial

The Dial command allows you to record names and telephone
numbers. The Dial command also dials the numbers automatically
when you have a Hayes-compatible modem.

Name : Phone Number:

f Cancel 11

	

OK

	

J
C	

You can record up to eight names and telephone numbers in the
text boxes . Type the numbers for the services or other computers
you dial most frequently. With a Hayes-compatible modem, you
can type a comma for a pause so Works will pause after dialing a
number, such as 9 for an outside line, and hyphens so you can
read your phone number more easily . (Consult your modem or
telephone system documentation for any dialing codes you may
have to include .)
Click the OK button to store the names and numbers with your
Communications document . When you save this document, Works
also saves these names and numbers .
To dial a number with a Hayes-compatible modem, click the Dial
button to the left of the name and number you want .
Without a Hayes-compatible modem, you won't be able to use
the Dial command. In the Communications window, type the dial
commands specified for your modem .
After dialing, you should see the following sequence on your
screen :

Dialing . . .
CONNECT
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Dial . . .
Hang Up
Answer Phone
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Capture Teut . . .
Send Teut . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Receive File . . .
Send File . . .
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Settings . . .
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Hang Up

[:ommunications

,/Echo On
Echo Off

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Dial . . .
Hang Up
Answer Phone

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Capture Tent . . .
Send .Tent . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Receive File . . .
Send File . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Settings . . .

Answer Phone

If you are communicating with another Macintosh or other per-
sonal computer, either you or the other party can start typing as
soon as the connection is made .
If you are communicating with an information service, such as
CompuServe, The Source, or Dow Jones, follow the instructions
in the service's manual .

Hang Up

The Hang Up command ends a Communications session and
disconnects the modem from the telephone line .

Answer Phone

The Answer Phone command tells Works to have the modem
answer all incoming calls on the first ring .
Without a Hayes-compatible modem, you won't be able to use the
Answer Phone command. In the Communications window, type
the appropriate commands specified for your modem .
Answer Phone is not initially checked on the Communications
menu. When you choose it, Works puts a checkmark on the
menu. The command is in effect when it is checked on the menu .
To tell Works not to answer any incoming calls, choose Answer
Phone when it is checked . Works removes the checkmark .

[:ommuniration .

/Echo On
Echo Off

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Dial . . .
Hang Up
Answer Phone

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Capture Teat . . .
Send TeHt . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Receive File . . .
Send File . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Settings . . .



Capture Text/End Text Capture

The Capture Text command saves everything you receive while
connected to another computer .

. :̀

	

€€ €

	

' 3€3€

Save Captured Teut As :

Captured Tent

Capture ]

Imo]Works Program

Cancel

( Works Progr .

Eject

[ Dnu	

Use the Eject and Drive buttons to choose the disk on which you
want to save . When you click the Capture button, Works begins
to save everything displayed on your screen in the specified
Works Word Processor file.
After you choose Capture Text, the command on the menu
changes to End Text Capture. When you want to stop capturing
text, choose End Text Capture .

Send Text

The Send Text command sends a specified Works Word Processor
file to the receiving computer.

Send TeHt :

® Works Pr .. .

Works Program I

U Hrticle
D Report
CJ System Folder ( Eject	

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Send

(Cancel )
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Settings . . .

Send Text

Communications
/Echo On
Echo Off
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Send File . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Settings . . .
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Receive File
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Hang Up
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Receiue File . . .
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Settings . . .

To send the text, select the file you want to send, then click the
Send button .
When you send a previously saved Word Processor file, only the
text is sent, not the formatting information . To send a text file not
created in Works, you must first import it to the Word Processor
and then save it .
Send Text is useful when you are using Works to prepare and
send electronic mail. For example, you can compose a letter with
the Word Processor and save it. Then, make the connection to
your electronic mail service . When the service instructs you to
type your letter, choose Send Text to send it to the service .

Receive File

The Receive File command receives formatted files or program
files from another computer .

i .

	

es(3s

i.i

	

(J(1

Save Received File Rs :

Hmodem File

Receive

Works Program

Receive Protocol :

Cancel

4

Q

Works Progr .. .

Eject J

® MacRinary
o Hmodem Tent (Remove IF)
0 Hmodem Data

Type a name for the file . Use the Eject and Drive buttons to
choose the disk on which you want to save the file .



Receive Protocol The protocol you use must match the pro-
tocol used by the other computer . There are three options to
choose from :

•

	

Click the MacBinary option to receive a file in the MacBinary
format from another Macintosh or from another computer
whose software supports the MacBinary format .

•

	

Click the Xmodem Text option to receive a file from a com-
puter other than a Macintosh or from a computer whose
software does not support the MacBinary format . Use this
option to receive text files files containing only alpha-
numeric characters and no formatting information .

•

	

Click the Xmodem Data option to receive a file from a com-
puter other than a Macintosh or any computer whose software
does not support the MacBinary format. Use this option to
receive files containing both alphanumeric characters and
formatting information .

With all of the above protocols, both computers will check for
errors in transmission using the Xmodem protocol . If an error
occurs, Works tells you .
As your computer receives a file, Works displays a message box
telling you the status of the transmission and alerting you when
transmission is complete .

Note If you are receiving a file sent by another user running
Microsoft Works, you do not need to use the Receive File com-
mand. Works Communications will automatically receive a file
when it is sent using MacBinary protocol . The file will be saved
on the current disk with the filename used by the sender . If you
already have a file of that name saved on your disk, Works will
automatically append a digit to the name .
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Send File
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Send File

The Send File command sends a formatted Macintosh data file
or Macintosh program file .

Send File :

1] Works Pr . . .

® Works Program

0 Addresses
D Article
•

	

Budget
•

	

Clipboard File
•

	

DeskTop
•

	

Final Report
•

	

Finder
•

	

I mageWriter
•

	

Requests

Send Protocol :

E ject

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

i

Send

Cancel

® MacBinary
C Hmodem Tent (Insert LF After CR)

Hmodem Data

The Send Protocol options are the same as those in the Receive
File command. For more information, see "Receive File" in this
chapter.
Select the file you want to send, then click the Send button .
Works displays a message box telling you the status of the transfer
and alerting you when transmission is complete .

Settings

The Settings command gives Works the parameters to use for
communications .
When you choose Settings, Works displays a dialog box identifying
the Macintosh, modem, and phone system parameters that must
be specified .
This dialog box is also displayed when you create a new Com-
munications document. This allows you to initialize the parame-
ters before you create a document .



Communications Settings :

Baud Rate :

Data Size :

Stop Bits :

Parity :

Handshake :

Phone Type :

Line Delay :

Connect To:

0 300

	

02400

	

09600

•

	

1200 04800 019200

•

	

8 Bits Q 7 Bits

•

	

1 Bit O 2 Bits

•

	

None Q Odd Q Euen

•

	

None
•

	

Both
Hon/Hoff

0 Hardware

® Touch-Tone

0

0

Character Delay:

Cancel )

0 Rotary Dial

The preset options are suitable for communicating with most
commercial services and with other Macintosh computers
equipped with modems manufactured by Apple Computer, Inc .,
Hayes Computer Products, Inc., and Prometheus Products, Inc . If
the service, computer, or modem that you want to communicate
with requires different settings, change the settings by clicking
the appropriate options .
When you save a Communications document, Works saves the
settings with the document .
If you regularly use a service requiring settings other than those
proposed, you should create a new Communications document
and change the necessary parameters in the Settings dialog box .
Name and save the document with the Save As command from
the File menu. When you want to use the service, open the file .
Your parameters will be properly set .
Baud Rate Baud rate is a measure of the speed of data trans-
mission. It is roughly the same as the number of bits per second .
Each letter or numeric digit is comprised of 8 bits . Thus, 300
baud is approximately 30 characters per second . Most modems
used over the switched telephone network operate at 300, 1200,
or 2400 baud. You need to know the baud rate at which your
modem operates and then set this parameter by clicking the
appropriate option. Works proposes 1200 baud .
Data Size While data is represented internally in your Macin-
tosh as 8 bits per character, it can be transmitted in either 8-bit
or 7-bit segments. Most commercial services transmit 8-bit char-
acters, so Works proposes 8 bits . You don't have to change this
setting unless the system you are communicating with can receive
data only in 7-bit segments .
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Stop Bits Most commercial services use one stop bit to identify
the end of the transmission of a single character, so Works pro-
poses 1 . You don't have to change this setting unless the other
computer can transmit only two stop bits .
Parity Parity describes the bit, if there is one, added to transmit-
ted characters for error checking . (After the receiving computer
or terminal uses the parity bit to check for transmission errors,
the bit is automatically removed from the characters .) Most com-
mercial services use no parity, so Works proposes None . If neces-
sary, change this by clicking the appropriate option.
Handshake Handshake refers to the way terminals or comput-
ers being used as terminals tell each other whose turn it is to
send or receive data. It is normally used when transmitting data at
very high rates of speed to synchronize the sending and receiving
systems .
Handshaking, if used, is done by either hardware or software . Most
commercial services support Xon/Xoff handshaking, so Works pro-
poses Xon/Xoff. If you are communicating at 2400 baud or
greater, or intend to use the Capture Text command, use Xon/Off .
Phone Type The telephone system uses two kinds of dialing :

•

	

Rotary Dial
•

	

Touch-Tone

Your modem uses different codes to dial automatically. Works
needs to know which dialing method you're using . Works pro-
poses Touch-Tone . If your telephone system is rotary dial, change
the setting by clicking the Rotary Dial option .
Line Delay/Character Delay When transferring files over
communications facilities, it is sometimes impossible to establish
handshaking between the two systems . If the transmitting system
sends data as fast as it can, and if the receiving computer cannot
keep up with the sender, data can be lost . Most of the time you
can prevent this if you slow down the transmitting computer by
delaying between characters or between lines as they are sent .
Enter an amount of time to delay, by changing either Line Delay
or Character Delay from the proposed setting of 0 . The delay you
specify is in increments of 1/60 of a second . For example, if you
type 3, the delay will be 3/60 of a second .
Connect To Click the option that corresponds to the Macintosh
port to which your modem is attached. Works proposes the tele-
phone port. It is strongly recommended that you connect your
modem to this port. (This may not be practical, however, if you
use the telephone port for connecting a hard disk .)
When all the parameters are set, click the OK button .



Using the Tools Together

Microsoft Works is more than four separate tools. While each
tool helps you in one area of your work, the tools can also work
together to perform additional tasks they can't perform alone .
The Word Processor is ideal for writing, and with information
from the Database you can also use it to make business forms, cus-
tomized letters, and mailing labels . You can copy Communications
information and Database figures to the Spreadsheet, and you can
include Spreadsheet figures and Communications information in
Database documents. You can also copy Communications and
Spreadsheet information, including charts, to the Word Processor .
Then you can use the Word Processor's special type styles and
other features to make the information more attractive .
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This part of the manual explains how to use the Works tools
together :

∎ Chapter 20, "Moving Information Between the Tools," tells
you how to move information and pictures between the four
Works tools. It also explains how to move charts from the
Spreadsheet and other graphics programs into the Word Pro-
cessor. You'll also see how to add text, lines, and shapes to
enhance your integrated documents .

∎ Chapter 21, "Merging: Creating Mailing Labels, Form Letters,
and Forms," shows you how to use the Database to create
form letters and mailing labels, to address envelopes, and to
fill in forms you create in the Word Processor .

For information on using Works with other programs, see
Appendix B, "Using Works with Other Applications ."
For information on the specific tools in Works, see the
appropriate parts of this manual .



20 Moving Information
Between the Tools

This chapter explains how to move information between the
Works tools . You'll learn how to :

•

	

Copy information to the Word Processor .
•

	

Copy information from other application programs to the
Word Processor.

•

	

Copy Word Processor information to the Database or
Spreadsheet.

•

	

Copy Database information to the Spreadsheet .
•

	

Copy Spreadsheet information to the Database .
•

	

Copy Communications information .
•

	

Add finishing touches and edit pictures .

The Word Processor is the most convenient tool for integrating
information. The Word Processor's drawing and formatting capa-
bilities give you the most flexibility for combining information
from the various tools .
You'll often want to include information from a Database,
Spreadsheet, or Communications document in a Word Processor
document. For example, a business report might require inventory
information from a Database document, sales projections from a
Spreadsheet document, and travel information or stock quotes
from a Communications document .
To learn how to work with the information once you move it, you
should turn to the appropriate chapters in this manual for each
tool. Before you try the procedures in this chapter, you should
already know how to select information within each tool .
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About memory usage

To copy information
between the tools

Copying information between tools is subject to available
memory, particularly if you are copying large selections . When
you copy information to the Clipboard, you increase memory
usage by the amount you copy . When you paste the Clipboard's
contents, you paste a copy of the Clipboard's contents, increasing
memory usage again by the same amount . If the Clipboard's con-
tents are large, you may not have enough memory to paste .
If Works displays an alert box, try copying your information in
smaller sections .

Copying Information Between Tools

Copying information between the Works tools is easy . Just open
the documents you need ; the rest is as simple as pointing and
clicking. Select the information, copy it to the Clipboard, and
paste it at its destination.
You can copy information from open documents only. Depending
on document size and available memory, you can have up to ten
document windows open at a time . This makes integrating your
information that much easier .

Note The procedures in this chapter discuss moving information
in terms of copying from one tool or program to another . You can
also move information by cutting it out of a tool or program . This
process works exactly the same as copying, except that the infor-
mation is deleted from the original document . If this is the result
you want, substitute the Cut command for the Copy command in
any of these procedures.

This section explains the general procedure you'll follow to copy
information between the tools . The sections that follow contain
specific information for particular situations .
To copy information between the tools :

El Make sure that the file you want to copy from is open .
Activate the document you want to copy from by choosing its
name from the Window menu .
Works brings the document to the front and displays the scroll
and title bars to show you that the window is active .
Select the information you want to copy .
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0	 Article (WP)	

The new Hilltop Climber will hit the slopes in the Great Alpine
Race, sponsored by the Wheeler Bicycle Company .

Teams from around the world will challenge each other on
the tough mountain slopes of France, Switzerland, and Italy .

Fireworks in the Alps

At major stops along the way, citizens of Alpine towns and

Choose Copy from the Edit menu .
Open the file you want to paste into .
To copy into the Word Processor, position the insertion point
in a blank line or select the text that you want to paste over .
(Scroll if necessary.) If you select text, Works replaces it with
the contents of the Clipboard .
To copy into the Database or Spreadsheet, select the entry
or cell at the upper-left corner of the area you want to paste
into. You can also select a range of entries or cells as the
paste area .
Choose Paste from the Edit menu .

Works pastes the copied information .

F
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To copy between
Word Processor
documents

To copy a chart to the
Word Processor

As long as the information remains on the Clipboard, you can
paste the information as many times as you want . For example,
to use the same chart at the beginning of each section of a docu-
ment, you can copy it once from the Spreadsheet, then scroll
through your document, pasting a copy of it each time you come
to a new section .

Copying Information to the Word Processor

When you select information to copy to the Word Processor, you
need to consider how it will look in a Word Processor document.
Your selection may be longer than a single page, or wider than a
standard page . Works divides selections longer than a page into
page-sized pieces for the Word Processor . If Database records or
Spreadsheet rows are wider than a Word Processor page, you can
format your information to fit after you paste it in .

Copying Between Word Processor Documents

You can copy information from one Word Processor document to
another. Just use the general procedure described above . Notice
that if you position the insertion point in a blank line, Works
automatically opens up enough space to paste the entire contents
of the Clipboard . Remember that you can copy text and pictures
together if you drag from one end of the text to the other end,
enclosing an entire picture in the process .

Copying a Spreadsheet Chart
to the Word Processor

You can copy a Spreadsheet chart into the Word Processor. (You
will not be able to choose Cut when a chart window is active .)
Then, you can use the Word Processor's drawing capability to
draw lines, boxes, and circles to accent the chart, and you can
add text to provide labels or additional information .
You cannot edit or format text that was originally part of a chart
after it is copied to the Word Processor .
Before you copy a chart to the Word Processor, you should insert
enough blank space for the chart, and the surrounding white
space that gets copied with it, by inserting return characters . Oth-
erwise, the chart will be pasted over existing text .



Note If you do paste the chart over text, you'll see the chart
overlaid on the text . Position the insertion point at the beginning
of the first line of the covered text, and press Return repeatedly
until the text scrolls out from under the chart . Or, you can move
the chart. For more information, see "Editing Pictures" later in
this chapter .

If you want to indent the chart from the left margin, press the Tab
key or spacebar to position the insertion point where you want it .
Works pastes the chart below and to the right of the insertion
point .
Once the chart is pasted into the Word Processor, you can treat
the chart as a picture . For more information, see "Editing Pictures"
later in this chapter .

Copying Spreadsheet Information
to the Word Processor

When you copy Spreadsheet information to the Word Processor,
each column arrives separated by a tab character . Each row ends
with a return character . If the rows are wider than the Word Pro-
cessor page, paste the information first, then select and format it
to fit . Spreadsheet information is always pasted in Geneva 9, but
you can change the font and type size once the information is in
the Word Processor .
When you copy Spreadsheet numbers or formulas to the Word
Processor, Works pastes them as text . The relationship between
the cells in the Spreadsheet no longer exists . For example, if you
change a number in a column copied to the Word Processor, the
total for that column will not change . You need to select the total
as text and change it by using the standard Macintosh editing
techniques .
You may want to adjust tab stops to change the appearance of the
columns. For more information, see "Setting and Using Tabs" in
Chapter 4 .

Copying Database Information
to the Word Processor

When you copy records from the Database, each field arrives

	

To copy Database
separated by a tab character. Each record follows on its own line,

	

information to the
ending with a return character . Records that are wider than the

	

Word Processor
Word Processor page can be selected and formatted to fit after
you paste . Database information is always pasted in Geneva 9, but
you can change the font or type size once the information is in
the Word Processor.
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To copy pictures to
the Word Processor

When you copy Database information, Works normally copies
field names as well as the selection . To copy only the selection,
without the field names, hold down the Option key while you
choose the Paste command .
When you copy Database numbers or the results of a calculated
field to the Word Processor, Works pastes them as text, and you
won't be able to recalculate them . If you want to adjust any
numbers, select them as text and use the standard Macintosh
editing techniques .
You should copy from a list window, because in the form window
you can copy only one field at a time . In the list window, you can
copy a field, a record, or a range of adjacent records, entries, or
fields .

Copying from Other Applications
to the Word Processor

To copy information

	

You copy information from other Macintosh applications in one
from other

	

of two ways :
applications

•

	

To copy small amounts of information, use the Clipboard or
Scrapbook. For more information, see "Using the Scrapbook
and Clipboard" in Appendix B .

•

	

To copy large amounts of information or an entire document,
use the Import File option in the Open dialog box . For more
information, see Appendix B, "Using Works with Other
Applications ."

Copying Pictures and Graphics
to the Word Processor

You can copy pictures created with any Macintosh drawing appli-
cation, such as MacPaint or MacDraw, by using the Clipboard or
Scrapbook. For more information, see your Macintosh owner's
guide .

Copying Information
to the Database or the Spreadsheet

Works copies information to the Database and Spreadsheet in the
same way. Each entry or cell content ends with a tab character to
indicate the end of a field or column, and each record or row
ends with a return character . This section explains how to copy
information to these tools, using spaces, tab characters, and/or



return characters to keep the information in its characteristic
columns and rows .

Copying from the Word Processor
to the Database or Spreadsheet

You may have information in a Word Processor document that

	

To copy from the
you want to copy to the Database or Spreadsheet . You can copy

	

Word Processor
the information as you normally would, but you need to tell
Works how to distinguish between fields and records or columns
and rows. Each piece of information that will go into a field or
cell should be separated from the next piece by a tab character
or by two or more blank spaces. Each record or row should be
ended with a return character. Any blank lines become blank
records or rows .
To copy Word Processor information to the Database or
Spreadsheet :

II In the Word Processor, insert tab characters between text that
you want to appear in separate fields or columns. Insert return
characters to start new records or rows .

r
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Dear Mr . McGrath :

Alligator Bicycle Repair is proud to sponsor the

	

t
for the 1986 Racing Season . This year's team includes :

Shelley Schmidt 3957 Palm Court Wheelerville OH 44444
Richard Dolan 9357 Circle Court Cincinnati OH 39555
Leslie Poulin 111 Maple Street Wheelerville OH 44444
Susan Stanton 3976 Cherry Way Cincinnati OH 44839
Pamela Partridge

	

105 Coalinga Way Santa Cruz CA

	

95060

Tab characters are inserted to prepare for
pasting into the Database .

Return characters follow each line .

In the Word Processor document, select the text that you
want to copy .
Choose Copy from the Edit menu .
Activate the Database or Spreadsheet document .
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To copy from the
Database to the
Spreadsheet

11

6

Works pastes the copied information .

You can now use Database or Spreadsheet commands to manipu-
late the information. After adjusting the width of several columns,
the Spreadsheet document looks like this :

r

	

File Edit Window Organize format Report

0

1

Select the entry or cell in the upper-left corner of the area you
want to paste into . Since the information fills fields and cells
to the right, and records and rows down, make sure that the
records or cells in this area are blank .
Choose Paste from the Edit menu .

'6ator Team (DB)

:.:hill€.

	

hri iidf

Richard Dolan. . . . . . . . . . . . . . . . . . . . . . .
Leslie Poulin. . . . . . . . . . . . . . . . . . . . . . .
Susan Stanton. . . . . . . . . . . . . . . . . . . . . . .
Pamela Partridge. . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . .

Shel l ey Schmi dt

Address

3957 Palm Court. . . . . . . . . . . . . . . . . . . . . . . .
9357 Circle Court. . . . . . . . . . . . . . . . . . . . . . . .
111 Maple Street. . . . . . . . . . . . . . . . . . . . . . . .
3976 Cherry Way. . . . . . . . . . . . . . . . . . . . . . . .
105 Coalinga Way. . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . .

(city
Wheelerville. . . . . . . . . . . . . . . . . . . . . . . .
Cincinnati. . . . . . . . . . . . . . . . . . . . . . . .
Wheelerville. . . . . . . . . . . . . . . . . . . . . . . .
Cincinnati. . . . . . . . . . . . . . . . . . . . . . . .
Santa Cruz. . . . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . . .

State

	

IZip
OH

	

44444. . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . .
OH	39555

OH

	

44444. . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . .
OH

	

44839. . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . .
C A

	

95060. . . . . . . . . . . . . . . . . . . . . . . .

	

. . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

The copied information is pasted into the Database
document, beginning with the selected entry .

l

Copying Database Information to the Spreadsheet

When you copy Database information to the Spreadsheet, each
entry becomes one cell in the Spreadsheet, each record becomes
part of a row, and each field becomes part of a column .
To copy information from the Database to the Spreadsheet :

Select the information in a Database list window . You can
select individual or adjacent records, fields, or field entries .
When you copy Database information, Works normally copies
field names as well as the selection. To copy only the selec-
tion, without the field names, hold down the Option key while
you choose the Paste command .
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To copy from the
Spreadsheet to the
Database

r

	

File Edit Window Select Format Options Chart

Text becomes Spreadsheet labels, and numbers become Spread-
sheet values . Works copies the field names as labels in one row,
with each record in a separate row . The information is displayed
in the existing cell format .

Copying Spreadsheet Information to the Database

When you copy Spreadsheet information to the Database, each
Spreadsheet column becomes a Database field . Each Spreadsheet
row (or portion of a row) you copy becomes a Database record .
If you paste a Spreadsheet column below an existing field, or a
Spreadsheet row to the right of an existing record, the new and
existing information combine to make one field or one record .
In the Database, you'll need to set up enough fields to accommo-
date all the columns you're copying from the Spreadsheet. The
columns that don't fit won't be pasted into the Database .
To copy information from the Spreadsheet to the Database :

II

When you copy from the Database,
Works always pastes the field
names as well as the selection .

d

Select the information in the Spreadsheet . You can select a
single cell, a block of cells, or entire rows or columns .
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To copy Communica-

tions information

To format text

	

∎

Copying Communications Information

You copy information from a Communications document in dif-

ferent ways, depending on how you received it .

If you used the Capture Text command to gather the information,

the information is already stored in a Word Processor file . In this

case, follow the procedures for copying from Word Processor

documents.

If you used the Receive File command to gather the information,

use the procedure that is appropriate to the file you received . For

example, if you received a Spreadsheet file and want to copy it

into a Works Database document, see "Copying Spreadsheet Infor-

mation to the Database" in this chapter .

Adding Finishing Touches

Once you've moved information from one tool to another, you

can modify it as you would any information in that tool . Since the

Word Processor gives you the most options for formatting, this

section gives you some ideas on how you can enhance the appear-

ance of information you've integrated in a Word Processor

document .

Formatting Text

Here are some ideas for changing the appearance of the overall

document :

Change the font, type size, or type style of the entire docu-

ment or portions of it .

•

	

If you've copied a large amount of information, you may wish

to repaginate by inserting manual page breaks .

•

	

Move the tab stops to adjust columnar tables .

•

	

Change the line spacing or indent certain pieces of information

for emphasis .

•

	

Add headers and footers using the range of options available in

the Word Processor.

•

	

Use the Draw command to add lines, boxes, or circles to

separate and draw attention to important information .



Editing Pictures

A picture is a chart from the Spreadsheet, graphics from a Macin-

	

To edit pictures
tosh drawing program such as MacPaint or MacDraw, or lines and
shapes from the Word Processor. When you add a picture to a
Word Processing document, you can still work with it :

•

	

Add text for titles and labels .
•

	

Add lines from the labels to the picture .
•

	

Draw additional lines or shapes with the Word Processor Draw
command.

•

	

Change the proportions to make the picture wider or taller .
•

	

Move pictures .
•

	

Delete pictures .

For more information on using the Word Processor's drawing
capability, see Chapter 4, "Formatting a Document ."

Selecting and Sizing a Picture

Once you've copied a picture into a Word Processor document,
you may find that it's not in the right place, it doesn't quite fit, or
it would look better in a different size .
In order to manipulate a picture in the Word Processor, you first
must select it . After you've selected a picture, you can change its
size, or copy, move, or delete it .
To select a picture :

	

To select a picture
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0 Click on or to the left of the picture .
Choose Select Picture from the Edit menu .
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A blinking dashed line surrounds the highlighted picture . The
picture remains selected until you click elsewhere .

Note Remember, text that you type with the Word Processor
is not part of a picture and can't be selected while a picture is
selected. You can, however, select both text and a picture by
dragging over text that encloses a picture .

If you have several pictures close together, continue to choose
Select Picture from the Edit menu without moving the insertion
point. Works will continue to select the next picture .

To change the size of You can adjust the size of pictures in a Word Processor
a picture

	

document .
To change the size of a picture :

0

El

F
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Select the picture .
Position the pointer directly over one of the borders until the
pointer changes to a cross (+) .
Drag horizontally or vertically to change the width or height
of the picture .

mountain Wheeler

If you're not satisfied with the change, you can choose Undo from
the Edit menu and try again .



If you're not satisfied with a picture's location, you can move it .
To move a picture by dragging it:

Select the picture.
•

	

Position the pointer on the picture .
The pointer changes to a hand .

•

	

Drag the picture to the new location .

0

To move a picture with Cut or Copy :

0

Adding Text to Pictures

You can type text directly over a picture in a Word Processor
document or in any area around it . You can add special labels to
a graph, add a large title to a chart for a presentation, or call out
special points using lines and text .
To add text to a picture :

0

Select the picture .
•

	

Choose Cut or Copy from the Edit menu, position the inser-
tion point, and paste it at the new location .

Position the insertion point where you want to type on the
picture .
Unless you want to begin typing at the left margin, you'll need
to use the spacebar or the Tab key to reach the location you
want.

•

	

Start typing .

F
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Text that crosses a line or dark area of a picture may be difficult
to read . Experiment with different type styles such as Shadow or
Outline until you get the desired effect .
Text that you type over a picture in the Word Processor is the
same as text you type anywhere else . Standard Macintosh editing
commands work normally.

To remove text from

	

To remove text from a picture :
a picture

d Select the text .
Choose Cut or Clear from the Edit menu .

Note You can only remove text you've added in the Word
Processor. You cannot remove any text that was pasted as part
of the picture .

This chapter gives you the skills you need to move information
between tools . Chapter 21, "Merging: Creating Mailing Labels,
Form Letters, and Forms," gives you another way to automatically
combine information from different tools with the Word
Processor's merge capability .



21 Merging :
Creating Mailing Labels,
Form Letters, and Forms

The Word Processor and the Database work together to let you
combine information from a Database document into a form you
create in a Word Processor document . With this merge capability,
you can create form letters, address mailing labels and envelopes,
and print on preprinted continuous forms . By using the Word
Processor's drawing and formatting capabilities, you can design
an attractive form that Works fills out for you automatically .
This chapter begins with an overview of the merge procedure,
followed by several examples of how to use merging in your
work. You'll learn how to :

•

	

Create a merge document using the Word Processor and
Database.

•

	

Print a series of customized documents .
•

	

Create mailing labels .
•

	

Create a form letter .
•

	

Fill out forms those you design yourself using the Word
Processor and preprinted forms .

Creating a Merge Document

A merge document looks like any other Word Processor docu-
ment, except that it contains placeholders in place of some regu-
lar text. A placeholder is a rectangle containing the name of a
Database document and a field name . A merge document looks
something like this :
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September 12, 1986

,IAddresses :salutation) IAddresses:First Namel IAddresses :Last Flame)

4Addresses :Citvl, IAddresses :state) IAddresses :ZipI

Dear IAddresses :salutation) IAddresses :Last 11lamel :

We are pleased to welcome you
Bicycle dealer in the greater
selected as a Mountain nlheele
records of sales service and

Placeholders

su

as our ne est Mountain Wheeler
area . You have been

ause of your outstanding
with our continuedel

1

Name of Database field

Name of Database document

About the merge

	

To create a merge document, you add information from a Data-

procedure

	

base document to a Word Processor document . First you indicate

where you want information to go by inserting placeholders into

your Word Processor document with the Prepare to Merge com-

mand. Then you use the Print Merge command to print custom-

ized copies of the Word Processor document . For each entry in

a Database field you specify, Works prints one Word Processor

document, replacing the placeholder with an entry from the speci-

fied field. So, each record in the Database document produces one

customized Word Processor document .

The general procedure for creating a merge document and print-

ing the customized copies is summarized below. Specific examples

follow on how to use merging to create mailing labels, form

letters, and customized forms .

To create a merge

	

Begin by opening both the Database document you want to merge

document

	

information from and the Word Processor document you want to

merge information into .

Create a Database document with the information you need, or

open an existing Database file .

You can have more than one Database document open to

merge from.

Create a new Word Processor document, or open an existing

Word Processor file .
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In the Word Processor document, type any text that will
remain the same for all the copies .
Position the insertion point where you want to insert the first
placeholder.
Choose Prepare to Merge from the Edit menu .

Select the Database
document containing the
information you want to
merge .

Select Merge Data Base :
Wheeler PR Articles
Addresses

Prepare to Merge :

Select the appropriate field
name here.

Select Merge Field :
Title
Publication
Date
Comments
Author
PR Rep

Cancel Merge

Select the Database document you want to use .
Works displays a list of the field names for that document .
Select the appropriate field name .
Click the Merge button.
Works inserts a placeholder, containing the name of the Data-
base document and the specified field name, at the insertion
point in the Word Processor document .

Note Works will wordwrap a placeholder to the next line if
the placeholder will not fit . However, the actual information
may or may not wordwrap, depending on its length. To check,
choose Show Field Data from the Edit menu .

After you insert each placeholder, you can add any appropriate
spacing or punctuation around it before inserting another .
Repeat steps 4 through 9 for each piece of Database informa-
tion you want to include in your Word Processor document .
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To view merge

	

Anytime you want to view Database information as it will look in
information

	

your finished document :

To delete a
placeholder

To change the font or
style of a placeholder

D Choose Show Field Data from the Edit menu .

Works displays information from the first record in the specified
Database document if no record is selected, or from the currently
selected record. You can change the information displayed by
activating the Database document and selecting another record .
When you activate the Word Processor document again, you'll
see information displayed from the newly selected record .
When you choose Show Field Data, the command name changes
to Show Field Names on the Edit menu . Choose Show Field
Names to see the placeholders again .

Note If you close a specified Database document, or if you open
the Word Processor merge document before you have opened a
specified Database document, you'll see the message "NOT ON
DESKTOP" in the appropriate placeholder . You need to open the
Database document in order to print or see information displayed
from the records.
If you delete a specified field or change a specified field name in a
Database document, you'll see the message "FIELD NOT IN DB" in
the appropriate placeholder .

You can delete placeholders in a Word Processor document at
any time .

Select the placeholder as you would any text .
Press the Backspace key, or use the Cut or Clear command
from the Edit menu .

0

The placeholder disappears .

You can change the font, type size, or type style of a placeholder .

0 Select the placeholder as you would any text .
Choose commands from the Font or Style menu .

The information in the placeholder changes to reflect your
choices .



Printing Customized Documents

You use the Print Merge command to print your customized
documents. To prepare for printing :

In the specified Database document(s), sort the records to
arrange them in the order you want them to print .

•

	

If you want to print only a subset of the records in the Data-
base, use the Record Selection or Match Records command
from the Organize menu to select the records you want
to print.

•

	

Activate the Word Processor merge document, and choose
Page Setup from the File menu and make any changes.
Prepare your printer for printing, adding special forms or
paper.

0

4

To print your customized documents :

0 Choose Print Merge from the File menu .
You'll get the same dialog box as for normal printing .

•

	

Click any appropriate options, then click the OK button .

Works begins to print the customized documents .

If you choose Print instead of Print Merge from the File menu,
Works prints one copy of the Word Processor merge document
with the placeholders in place . If you choose Show Field Data and
then choose Print, Works prints one copy of the document with
the data from the first record or the selected record .

Creating Mailing Labels

To create mailing labels, you change options in the Page Setup

	

To create mailing
dialog box to correspond to the measurements of your mailing

	

labels
label, then create a merge document in the Word Processor con-
taining only placeholders . You can save the document to use
whenever you want to print mailing labels .

Note These instructions assume you are using continuous " 1 up"
labels and an ImageWriter printer . You cannot use continuous
forms with the Apple LaserWriter .
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To change options
with Page Setup

To set up the merge
document

First, change options in the Page Setup dialog box .

El

4
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r
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: F

	

< l Font
style

8

0

Create a new Word Processor document .
•

	

Choose Page Setup from the File menu .
•

	

Click the Custom Size option.
Measure the width of the mailing label . Type this measurement
in the Paper Width box .

•

	

Measure the height of the mailing label, plus the gap between
labels . (Measure from the top of one label to the top of the
next.) Type this measurement in the Paper Height box .
Click the No Gaps Between Pages option .
Change the margins .
Type numbers to represent inches or fractions of inches . For
example, typing .25 would leave a quarter of an inch margin,
and typing .125 would leave an eighth of an inch margin .
The completed dialog box will look something like this :

Click the OK button .

Next, set up the merge document .

Open the Database file you want to use for the mailing labels .

Ima eWriter v2 .2 [ OK

0 us LetterPaper: O 114 Letter

Orientation

o
o

us Legal

	

O
Computer Paper

	

®
Special Effects :

International Fanfold
Custom Size

Tall Adjusted
50 Reduction
No Gaps Between Pages

[Cancel )

:-,

Paper Width : 3 .5

€ .

	

€ €

	

~ Paper Height : 1

Header:

Footer:

Left Margin : Right Margin :.125 .125

Top Margin : Bottom Margin :.125 .125
a



0

Activate the Word Processor merge document and design your
mailing label by choosing the font, type size, and type style
you want from the Font and Style menus .
Choose Prepare to Merge from the Edit menu to insert the
placeholders . To review this procedure, see "Creating a Merge
Document" earlier in this chapter .
Arrange the placeholders as you normally would a name and
address usually with the name on the first line, street
address on the second, and city, state, and zip on the third .

Remember to add spaces and appropriate
punctuation between placeholders .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

r

	

File Edit

	

endow Search Format Font Style
Untitled (WP)

Hints You can use the Word Processor's ruler to indicate the
width of your label in the Word Processor . Set the margins to
correspond to the width of the label minus the Right and Left
Margin measurements you specified with Page Setup .
To see the amount of vertical space available in your label, you
can press the Return key until you see a page break line . The
space between the beginning of the document and the page break
is the amount of vertical space you have to work with .

To see how the actual information looks, and to adjust the align-
ment if necessary :

Choose Show Field Data from the Edit menu .
If a page break indicator appears, you've reached the end of
the label .
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To print the labels Now you're ready to print the mailing labels .

0 Choose Print Merge from the File menu .
Works displays the regular Print dialog box .
Click the OK button.

You may need to experiment with label alignment. Test your
alignment with a few records first . Adjust the horizontal alignment
of the labels in the printer until you are satisfied .

Other ideas

	

You can use this same method to create other label-like docu-
ments. Here are a few suggestions :

•

	

Address envelopes.
•

	

Print continuous index cards to catalog your phonograph
record or tape collection .

•

	

Print membership cards for a club .

Creating a Form Letter

A form letter contains some standard text, but also adds informa-
tion specific to each recipient . Names and addresses are the most
common types of information you would want to merge into a
form letter . But you can also create a Database document with
specific phrases or sentences that apply to individual recipients .
For example, if you sell bicycles to bike shops, you might want to
thank each shop individually for its order, mentioning the amount
the shop purchased .

To set up a form

	

To set up a form letter, you create a merge document by typing
letter

	

all the text that will remain the same in each letter, and inserting
placeholders for the information that will vary . If you need to
review this procedure, follow the instructions in "Creating a
Merge Document" earlier in this chapter.
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Thank you for your continued support of Wheeler Bicycle Company .
As a valued dealer for our products, I am sure you will be pleased
to know that your recent order IOrders:Order #I of IOrders :Amountl
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From the Desk of

Marvin A. Carlson
Regional Sales Manager

September 18, 1986

IAddresses :First Namel IAddresses :Last I1lamel
[Addresses :Addressl
[Addresses :Citvl, IAddresses : State) IAddresses :Zipi

Dear IAddresses :Salutation) IAddresses :Last Namel :

12

Filling Out Forms

Creating Your Own Form

1 st Quarter Orders (WP)

iiiliiiiiiiliii hill

Nearly any office or business uses a variety of forms :
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•

	

Expense reports
•

	

Address lists of customers, clients, friends, and contacts
•

	

Invoices and statements

You can set up a form in the Word Processor as though you were
preparing a document for an individual client . By merging with
the Database, you can set it up once, and have Works fill it out
whenever you need it.
Your entire form can come from your Word Processor document,
or you can design a layout that prints information on a preprinted
continuous form .

By creating your form in the Word Processor, you'll have flexibil-
ity with alignment, positioning, fonts, type sizes, type styles, and
shapes and lines from the Draw feature .
With a drawing program, such as MacDraw or MacPaint, you can
prepare an entire form with shading, icons, trademark symbols,
rounded boxes, and other professional-looking touches . Then you
can copy the form to the Word Processor as a picture, and add
merge field names .
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To set up a form

	

To set up a form that you can later complete during a print
merge:

11

r

	

File Edit Window Search format font Style
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Open or create the Database document that contains your
information .
Create a new Word Processor document and design your form .
Type any standard text. Use Page Setup from the File menu
and Draw from the Edit menu . Use the type options available
to you from the Style and Font menus .
When you are satisfied with your form, add placeholders and
complete your merge document .
If you need to review this procedure, see "Creating a Merge
Document" earlier in this chapter .

1076 Evergreen Street
Youngstown, 0H 66999

Statement Form (WP)

To : IAcct Rec _Com as n y Name l

IAcct Rec _Address l

IAcct Rec :Ci t ul, IAcct Rec :State l (Acct Rec :Zi o I

Invoice No

IOrders :I nvoice #I

Des cri pt i on

IOrders :Descri ationl

Payment

IOrders :PaymentI

Using Preprinted Forms

If you decide to use preprinted continuous forms, measure one of
the forms and include the measurements in the Page Setup dialog
box. If you need to review this procedure, see "Creating Mailing
Labels" earlier in this chapter .
Using preprinted forms will take some experimentation to get pre-
cise alignment . But once the merge document is set up, you can
save it and use it over and over again to print that form .



Appendix A
Disk Space and Memory

Microsoft Works contains two double-sided disks :

•

	

Master Microsoft Works Program disk
•

	

Backup Microsoft Works Program disk

The master and backup Works Program disks each contain the fol-
lowing files :

•

	

Works application
•

	

System
•

	

Finder
∎ ImageWriter printer driver
•

	

Help
•

	

Works Hard Disk Install program
•

	

Sample files for Lessons

To save space, you can move the Help file from the Program disk

	

Removing files to
to another disk. When you choose the Help command, Works

	

save space
looks for the Help file on both the internal and external disk
drives. If the file is not there, Works asks you to insert a disk con-
taining the Help file . Insert the appropriate disk and choose the
Help command again .
You can also move the sample files from the Program disk to
save space .
You can start Works with any disk that contains a System (Version
2.0 or later), a Finder (Version 4 .1 or later), and, if you want to
print, a printer driver . The Macintosh uses the current System and
printer driver. The System contains the fonts available for the
Works Word Processor.

Starting Works with
another system disk

339
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What happens when

	

When you start Works with the Program disk in the internal disk
you start Works?

	

drive, the Macintosh uses the System on this disk . The System
determines which fonts are available . When you print a document
on a Macintosh printer, the Macintosh also uses the printer driver
on the Program disk . To use another System, or other fonts or
printer drivers, copy the ones you want to your Program disk .

Using an external

	

Using an External Drive
drive

Works operates more efficiently with an external drive . You can
store documents on a separate, formatted disk in the extra drive.
You don't need the Works program on this "document disk ."
When you open a file from the Open dialog box, you can click
the Drive button to see a list of files on the disk in the external
disk drive. When you save a document, use the Save As command
and click the Drive button to save to the external disk drive ; or
use Save to save a document to the disk that it was opened from .
Works saves to the disk whose name appears above the Eject but-
ton. This disk will be the one you last specified with the Drive
button in either the Open or Save As dialog box .

Using Works with

	

Using Works with a Hard Disk
a hard disk

You can install and use Works on a hard disk . The Works Program
disk has a program called Works Hard Disk Install . This program
helps you to install Works on certain hard disks. More impor-
tantly, if you use the Works Hard Disk Install program to install
Works on your hard disk, you will not have to insert the master
Program disk each time you start Works after turning on your
Macintosh .
To see a list of the hard disks that Works Hard Disk Install
works with :

D Double-click the Works Hard Disk Install icon .

If your hard disk is listed in the dialog box, and you want to
install Works on your hard disk, click the OK button . Otherwise,
click the Cancel button. If your hard disk is not on the list, you
can still copy Works to your hard disk by following the directions
in "Copying Works to a Hard Disk" later in this appendix .



Note Installing Works on your hard disk does not change or
harm your master Works Program disk. If you install Works on
your hard disk, you can still use the Program disk in a regular
disk drive .

Installing Works on a Hard Disk

	

Installing Works on
a hard disk

You can install Works on a hard disk only once, so make sure
you have organized your hard disk the way you want before you
install Works .
To install Works on a hard disk :

Double-click the Works Hard Disk Install icon .
Follow the directions in the dialog boxes .
You have several opportunities during the install procedure to
cancel it if you want .

0

Note Although you can install Works on a hard disk only once,
you can make copies of Works on the hard disk. For example,
to make sure you don't inadvertently lose your installed copy of
Works, you might want to put a copy of Works on another part of
your hard disk. See your hard disk owner's manual for information
on how to copy files from one part of your hard disk to another .

Copying Works to a Hard Disk

If you are using Works with a hard disk, and the Works Hard Disk
Install program does not work with your hard disk, copy Works
using the procedure below .

Warning Be sure to double-click the master Works Program
disk icon before you drag the Microsoft Works application icon .
Do not drag the Program disk icon over the hard disk icon .
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El From the Finder, double-click the master Works Program
disk icon.
Drag the Microsoft Works application icon over the icon for
the volume of your hard disk where you want to put Works .
Drag the Help icon over the hard disk icon .

You can copy the sample files to the hard disk as well, or you can
use them from the internal disk drive .

The first time you start Works with the hard disk after you turn
on the Macintosh, you will be prompted to insert the master
Works Program disk so that the Macintosh can read the identifica-
tion number. When it has read the number, the master disk will
be ejected, and you can begin to work .



Appendix B
Using Works
with Other Applications

With Works, you can import information created with other
Macintosh applications . You can also export information from
Works to other applications . This appendix explains how to :

•

	

Import non-Works files to create Works Word Processor,
Database, and Spreadsheet documents.

•

	

Export Works documents to create files you can use with
other applications .

•

	

Import database files from AppleWorks and III E-Z Pieces .
•

	

Use SYLK files from Microsoft Multiplan® or Microsoft Excel .
•

	

Use the Scrapbook and Clipboard to move items between
applications .

•

	

Use Switcher to automatically install Works with a set of
frequently used applications .
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Importing Non-Works Files

	

Importing non-Works
files

With Works, you can import files from numerous programs and
create Works documents from them .

Word Processor Documents

You can create a Works Word Processor document from a file
created in any of the following programs :

•

	

Microsoft Word
•

	

Mac Write
•

	

Any application program that can create a text file . Text files
contain only the alphabetic, numeric, and tab characters of a
document, as well as the spaces and carriage returns. (Text
files are sometimes called ASCII files .) SYLK files are a type
of text file .
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To import a Word, MacWrite, or text file to the Works Word
Processor :

Choose Open from the File menu .
Click the Word Processor icon .
Click Import File .
Works lists all Word, MacWrite, and text files on the
current disk.

Note You should not open SYLK files from the Word
Processor . If you do open one, just close it and open another
file instead .

Click the name of the file you want to import as a Word
Processor document .
Click the Open button .

0

4

Works opens a Word Processor window, called Untitled, contain-
ing the document you specified.

Database Documents

You can create a Works Database document from a text file
created by other programs, such as Microsoft File .
Works can import files to the Database created in any of three
formats :

•

	

Fields within each record in the database are separated by a
tab character, and records are separated by a return character .
(Microsoft File uses this format when saving files as text .)

•

	

Fields within each record in the database are separated by
two or more spaces, and records are separated by a return
character.

•

	

Fields within each record in the database are separated by
a return character, and there is a fixed number of fields per
record. You will need to tell Works how many fields there are
per record. (AppleWorks uses this format when converting
database files to Macintosh text files .)

To import a text file to the Works Database :

El Choose Open from the File menu .
Click the Database icon .
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Click Import File.

Works lists all text files on the current disk .

Note You should not open SYLK files from the Database . If

you do open one, just close it and open another file instead .

Click the name of the file you want to import as a Database

document.

Click the Open button.

A dialog box appears, asking you to specify the format of

the file .

Separate Data Base Fields By :

Tabs (Each Record Ended By R Return)

Two Or More Spaces (Treated Hs R Tab)

C Returns

	

Field(s) Per Record

[ OK ]
Cancel

Click the appropriate format option, and type the number of

fields per record, if necessary .

If you do not know the format of the text being imported,

experiment with each one of the options . As long as you don't

save a document with the wrong format, this is perfectly safe .

Click the OK button.

Works opens a Database window, called Untitled, containing the

document you specified. The fields will be named "Field 1," "Field

2," and so on. You can rename the fields with the Change Field

Name command from the Edit menu . The first record may consist

of the field headings (field names) . After you rename your fields,

you may want to delete this record .

For specific information on how to import database documents

from AppleWorks or III E-Z Pieces, see "Importing a Database File

from AppleWorks or III E-Z Pieces" in this appendix .

Spreadsheet Documents

You can create a Works Spreadsheet document from a text file

created in other applications .
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Works can import files created in either of two formats :

•

	

As a SYLK file created in Microsoft Multiplan or Microsoft
Excel
SYLK files contain both data and formatting information .
These files include values, formulas, text for labels, and infor-
mation describing in which cells to place the labels .
For more information on using SYLK files from other spread-
sheet applications, see "Notes for Porting SYLK Files to or from
Works" in this appendix .

•

	

As a text file in which text or numeric information is separated
by tab characters, return characters, or both .
Information from a text file is placed into a Works Spreadsheet
document beginning at cell Al . A return character tells Works
to begin a new row. A tab character indicates the beginning of
the content of a new cell .

To import SYLK or other text files to the Works Spreadsheet :

El

4

Choose Open from the File menu .
•

	

Click the Spreadsheet icon .
•

	

Click Import File .
Works lists all SYLK and other text files on the current disk .
Click the name of the file you want to import as a Spreadsheet
document .

•

	

Click the Open button .
A dialog box appears asking you to specify the format of the
text file .

Load Text Format :

C!, SYLK (from Multiplan or Eu :ell

Teut with Values/Formulas

Cancel ,~
	OK	:3

•

	

Click SYLK if the file was created by Multiplan or Excel .
•

	

Click Text with Values/Formulas if it is a text file with
values, or formulas, or both .



s Click the OK button .

Works opens a Spreadsheet window, called Untitled, containing
the document you specified .

If a SYLK file that you are importing contains a formula that
Works cannot read, Works loads the file and turns the unreadable
formula into text by inserting a quotation mark (") in front of it .
To have Works use the text as a formula, make any necessary
changes and delete the quotation mark .
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Exporting Documents to Files

	

Exporting documents
That Can Be Used with Other Applications

You can export any Works Word Processor, Database, or
Spreadsheet document .
You save a Word Processor document as a text file with no
pictures or formatting .
You save a Database document as a text file with records
separated by return characters, and fields within each record
separated by tab characters . Works automatically saves the field
names as the first record of the text file .
You save a Spreadsheet document in the SYLK format or as a
text file .
To export a Works document :

0 Choose Save As from the File menu .
•

	

Click Export File and type a name for the document .
•

	

Click the Save button .

For a Spreadsheet document, after you click Export File and Save,
Works displays another dialog box asking you to specify the for-
mat to save with .

Saue TeHt Rs :

SYLK (to Multiplan or EHcel)

•

	

TeHt with Values Only
•

	

TeHt with Values/Formulas

Cancel
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Importing from
AppIeWorks or
111 E-Z Pieces

∎ Click the SYLK option if you want to use the document with
Multiplan or Excel .

∎ Click the Text with Values Only option to save the document
as text with only the values in the cells .

∎ Click the Text with Values/Formulas option to save the docu-
ment as text with both the values and the formulas .

After clicking an option :

D

Importing a Database File from
AppleWorks or 111 E-Z Pieces

There are three phases to the process of importing database files
from AppleWorks or III E-Z Pieces .

Phase 1
In the first phase, you'll convert a database file from AppleWorks
or III E-Z Pieces into a text file .

El

4

s
Ii
8

9

Click the OK button.

Start AppleWorks or III E-Z Pieces .
•

	

Load the database you want to export to the Macintosh .
•

	

Look at your database in single-record layout and note the
number of fields in the database. (You'll use this number in
Phase 3.)
Press Open Apple-P to see the Report menu .

•

	

Choose the option for creating a new "tables" format .
Type a name for the report .
Press Open Apple-P to print the report .
Choose the option for a text (ASCII) file on disk .
Type a pathname and press Return. Your file will be recorded.
(You'll use this pathname again in Phase 2 .)
Exit AppleWorks or III E-Z Pieces when you are done .



Phase 2

In the second phase, you'll connect the Apple IIe/c or Apple III to
the Macintosh and transmit the text file .

Connect the Macintosh terminal port to the RS-232 port on
the Apple IIe/c or Apple III .
Start Works on the Macintosh .
Works displays the Open dialog box .
Click the Communications icon and the New button .
Works displays the Settings dialog box . All the preset options
are acceptable, with the possible exception of the baud rate
and the port connector .
1200 baud is recommended. If you're using the printer port
on the Macintosh, click the printer icon for the Connect To
setting .
Then, click the OK button .
Choose Capture Text from the Communications menu .
Use the Eject and Drive buttons to arrange your disks so that
the disk receiving the imported file has sufficient space (about
three times the size of the file you're importing) . Use the pro-
posed filename, "Captured Text" .
Click the Save button.

0
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Start the Apple IIe/c or Apple III with Access II or Access III.
For an Apple III, the RS-232 driver should be configured at the
same baud rate set on the Macintosh .
Go to Terminal Mode .
Press Open Apple-S.
Set the settings as shown below :

•

	

Ansi Mode
•

	

No LF after CR
•

	

8 Bits
•

	

Enable XON/XOFF
•

	

Normal Video
•

	

Half Duplex
•

	

Wraparound
•

	

Speed = 1200 (or same as Macintosh)
•

	

Parity = none

Exit Terminal Mode.
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The file will be transmitted to the Macintosh . You'll see the data
on both screens. As it is received, the data will be saved as a
Word Processor file named Captured Text .

Phase 3

In the third phase, you'll convert the new Word Processor file to
a Works Database file . All of the steps in the procedure below
refer to actions you'll take using Works on the Macintosh .

When the Apple IIe/c or Apple III indicates that transmission is
complete, choose End Text Capture from the Works Commu-
nications menu.

•

	

Choose Open from the File menu, then click the Word Proces-
sor icon .

•

	

Select the filename Captured Text in the list box, then click
the Open button.
When the file has been opened, choose Save As from the File
menu .

El

4
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•

	

Select "Transmit a file" .
Enter the pathname you typed in step 9 of Phase 1 .

•

	

Enter a line delay of 60 .
•

	

Enter a delay between characters of 30 .
Press Y when prompted "Are you ready to start transmitting?"

Click Export File, then click the Save button .
Close the Captured Text Word Processor document .
Works displays the Open dialog box .
Click the Database icon, then click Import File .
Select the filename Captured Text from the list box, then click
the Open button.
Works displays a dialog box in which you specify the format of
the file .
Click the Returns option . Type the number of fields you noted
in step 3 of Phase 1 .
Click the OK button .

Works opens a Database window, called Untitled, containing the
imported text .



The fields in the newly created document are named "Field 1,"
"Field 2," and so on . To rename them, use the Change Field Name
command from the Edit menu. You can then make any other
changes you want to the document .
To save the Database document with a name other than Captured
Text, use the Save As command .

Notes for Porting SYLK Files
to or from Works

If you plan to import SYLK files created either with Microsoft
Multiplan or Microsoft Excel, or to export Works Spreadsheet
documents to Multiplan or Excel, you should consider differences
in the three programs that may make spreadsheets created in one
program perform differently (or not at all) in another program .

Features of the Three Spreadsheet Programs

External references ; named cells, rows, columns, or selections ;
and linked spreadsheets are features of Excel and Multiplan that
are not implemented in Works . However, Works is able to read
spreadsheets from Multiplan and Excel that contain named cells .

Differences in Formatting Numeric Values

Each of the three programs uses a different way of representing
numeric values .
Works ignores all formatting of values specified in a SYLK file and
treats all values as if they were in Works General format .

Differences in Data Type Supported

Works treats date and time data in SYLK files as text .

Differences in Error Values

Error values are different in Works and Excel .

Differences i n Operators

Works does not support the intersection (space), union (, ), or
concatenation (&) operators that Excel and Multiplan support .
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Differences in the Built-In Functions

There are a number of differences in the functions supported by
the three programs .

Differences in the Arithmetic Results Produced
by the Built-In Functions

The functions built into Works should produce results nearly
identical to those produced by Excel .
Extremely large and extremely small numbers may produce small
differences in the results of calculations due to the different inter-
nal representation and methods of performing arithmetic used by
the two programs .
Works performs arithmetic using the Standard Apple Numeric
Environment (SANE) package . This package has a precision of 80
bits (64-bit precision), or approximately 18 decimal digits .

Differences in Implementation

The functions HLookup, Index, Lookup, Match, Type, and
VLookup are implemented differently in Works than in Excel or
Multiplan. If you use argument values that are acceptable to Excel
or Multiplan, Works gives the same results that Excel or Multiplan
gives . Works also allows some argument values that Excel and
Multiplan do not .
Also, the IsError function in Works gives 0 if the argument
is N/A . In Excel and Multiplan, IsError gives TRUE if the argument
is #N/A.

Differences in Logical Values

The functions And, Or, Not, True, and False give the values TRUE
or FALSE in Excel and Multiplan . These functions give the values
1 or 0 in Works .

Built-In Functions Available for Use in Formulas

Not all functions are available in all three programs . Some argu-
ments that are optional in Excel are required by Works, such as in
the Index function. The following table identifies those functions
that are available in one or two of the programs, but not in all
three. An "X" means that the function is available for that
program .



Different Functions in Microsoft Works,
Excel, and Multiplan
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Function Works Excel Multiplan

ACOS X X
AREAS X
ASIN X X
ATAN2 X X
CHOOSE X X
COLUMN X X
COLUMNS X
DATE X
DAVERAGE X
DAY X
DCOUNT X
DEGREES X
DELTA X
DMAX X
DMIN X
DOLLAR X X
DSTDEV X
DSUM X
DVAR X
ERROR X
FIXED X X
GROWTH X
HLOOKUP* X X
HOUR X
INDEX (Form 2) X
ISBLANK X
ISREF X
ITERCNT X
LEN X X
LINEST X
LOG EST X
LOOKUP (Form 2) X
MATCH* X X
MID X X
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Different Functions in Microsoft Works,
Excel, and Multiplan

* The Works implementation of this function is more general than that of the oth-
ers . If you use the function in a form acceptable to Excel, Works gives the same
result that Excel does. Works also allows some inputs that Excel does not .

* * In Works, the TRANSPOSE operation is available as an option in the Paste with
Options command.

Function Works Excel Multiplan

MINUTE X
MONTH X
NOW X
RADIANS X
RAND X X
REPT X X
ROW X X
ROWS X
SEARCH X
SECOND X
SSUM X
TEXT X
TIME X
TRANSPOSE** X
TREND X
TYPE* X X
VALUE X X
VAR X X
VLOOKUP* X X
WEEKDAY X
YEAR X



Using the Scrapbook and Clipboard

Use the Scrapbook when you want to move many items from one
application to another .
To move information into the Scrapbook :

0

4

Repeat this procedure for each item you want to move into the
Scrapbook.

To move items from the Scrapbook, quit the application you were To move items from
using and copy the Scrapbook file to the disk that has your copy

	

the Scrapbook
of the destination application . Then :

Start the application .
•

	

Choose Scrapbook from the Apple menu .
•

	

Scroll the information in the Scrapbook until you find the item
you want to move .
Choose Cut or Copy from the Edit menu to move the selec-
tion onto the Clipboard .

•

	

Close the Scrapbook.
Select an insertion point and choose Paste from the Edit menu .

a

4

s

Select the information .
•

	

Choose Cut or Copy from the Edit menu to move the selec-
tion onto the Clipboard .

•

	

Choose Scrapbook from the Apple menu .
Choose Paste from the Edit menu .

Repeat this procedure for each item you want to move from the
Scrapbook.

Note When you transfer information using the Scrapbook, be
sure the Scrapbook file is on the same disk as your copy of the
destination application .
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To change a picture

MacPaint and MacDraw
Use the Clipboard or Scrapbook to copy or move pictures from
MacPaint or MacDraw into a Works Word Processor document .
Once you have moved the picture, you can change its size and
shape, and indent or align the picture .
For information on how to move or size it, see Chapter 20,
"Moving Information Between the Tools ."

Using Works with Switcher

You can use Works with Switcher if you regularly use Works with
other applications, such as Microsoft Word, Excel, or MacPaint .

To use Switcher

	

To use Works with Switcher :

0

4

n

Copy Switcher onto the Works Program disk .
Double-click the Switcher icon .
Choose Install Application .
Select Microsoft Works from the Switcher menu .
Click the Open button .

Switcher automatically installs Works with the recommended
amount of memory .

Now you can install any other applications you want to use .
Once they are all installed, you can save the set . Then, whenever
you open the set, all the applications will be installed auto-
matically for you.



Appendix C

Printing with the Apple

LaserWriter

You can print all of your Works documents on the Apple Laser-

Writer printer.

Before using the LaserWriter, you must install the LaserWriter

printer driver. For instructions, see the manual you received with

your LaserWriter.

After installing the LaserWriter software, choose the Choosey desk

accessory from the Apple menu. Works displays a dialog box con-

taining icons representing all printer drivers on the disk . Select

the LaserWriter icon and type a User name if you want the Macin-

tosh to remember who you are. Then click the close box .

LaserWriter Options

When you use the LaserWriter, the Page Setup and Print dialog

boxes are slightly different than those shown in this manual . You'll

see the following differences :

Custom Paper Size There is no Custom Paper Size option

available for the LaserWriter .

Font Substitution This is a preset option that tells the Laser-

Writer to substitute its built-in fonts for whatever font is displayed

on the screen. Choose this option for faster printing of Database

and Spreadsheet documents.

The font used in the Database and Spreadsheet is Geneva 9 .

When you print any Database or Spreadsheet documents on the

LaserWriter, the Font Substitution option automatically converts

Geneva 9 to Helvetica 12. In the Word Processor, there is no

automatic substitution for Boston, so you should choose a laser

font before you print .

Reduction When printing with the ImageWriter, you have a

choice of printing full size or at a 50% reduction .
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With the LaserWriter, you can enter any percentage of reduction .
Since the Font Substitution option on the LaserWriter converts
Spreadsheet and Database information to Helvetica 12, if you print
a Database or Spreadsheet document at 90% reduction, the
printed document will appear in Helvetica 10 . If you use 80
reduction, the printed document will appear in Helvetica 9 .
Use the Reduction option to increase the amount of information
you can print on a page . If you use the Reduction option for a
Database document, Works adjusts the right edge marker in the
report window. In the Word Processor and the Spreadsheet,
Works adjusts the page break indicators also .
Smoothing The smoothing option is preset . For faster printing,
the smoothing option should be turned off, unless you have
pasted a picture from MacPaint into the Word Processor.



Appendix D
Choosing Commands
from the Keyboard

Many menu commands in Works can also be invoked from the
keyboard.
To choose a command from the keyboard, hold down the Com-
mand key ( ) and press the letter corresponding to the particular
command. For example, to choose the Save command, hold down
the Command key and press the S key .
The following table lists all the Command-key equivalents for the
four Works tools .
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Key WP DB SS COM

A Sort Absolute
Cell Ref

B Bold Bold

C Copy Copy Copy Copy

D Draw Enter Date Fill Down

F Find Find Field Find Cell

G GoTo Go To Cell
Page #

I Italics Insert Record Insert

K Copy Format

L Show List/Form

M Prepare to Match Records
Merge

N Normal Text Normal Text

O Open Open Open Open

P Print Print Print Print

Q Quit Quit Quit Quit

R Replace Fill Right

S Save Save Save Save

T Enter Time

U Underline Underline

V Paste Paste Paste Paste
W Small/ Small/ Small/ Small/

Full Window Full Window Full Window Full Window

X Cut Cut Cut Cut

Y Paste Format

Z Undo Undo Undo
Calculate Now Hang Up

Duplicate field
in previous
record

Hang Up

Activate last Activate last Activate last Activate last
document in document in document in document in
Window Window menu Window menu Window
menu menu



Appendix E
Limits and Capacities
of the Tools

The tables below show specific data limitations for the Database
and the Spreadsheet . These numbers apply to both the 512K
Macintosh and the Macintosh Plus .

Database

	

Limits

Fields in a record

	

60
Characters in a field

	

248
Characters in a field name

	

64

Spreadsheet

	

Limits

Characters in the entry bar

	

238
Characters in a formula

	

200
Number of columns in a series chart

	

80
(except bar charts)
Number of rows in a pie chart

	

15

361
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The table below shows the approximate memory capacities for
the Word Processor, Database, and Spreadsheet .

Spreadsheet
Number of filled cells

	

7,500

	

22,500

Word Processor capacities are reduced by text containing
graphics, many font changes, or both .
Database capacities are affected by the average number of
characters per record .
Spreadsheet capacities are affected by the average length
of formulas, and by the amount of text in labels .

512K
Macintosh

Macintosh
Plus

Word Processor
Pages in a document 60-80 180-240
(text with formatting)

Database
Records in a database 2,000 6,000
(at 100 characters
per record)



Index

& formatting commands 24

III E-Z Pieces, importing files from 348-351
512K Macintosh limits 361-362

About MS-Works command 16
Abs function 234, 238
Absolute Cell Ref command

Command-key equivalent 360
reference style changing 174-175, 176,

177, 263
Absolute reference

changing to relative reference 176, 263
copying 192, 197
defined 173
sorting, adjustment 200
symbol 173, 175, 263

Absolute value 234, 238
Accent 39
ACos function 236, 238
Acoustic coupler

defined 285
dialing 290

Activate Window command 31
Active cell

description 163
moving within cell range 166
scrolling to 192, 267

Active entry 98
Active window printing 13, 26, 211
Add New Field command 90, 143
Addition operator

arithmetic operator 177
inserting automatically 171, 173, 177, 263
performance order 178

Address list sorting 117-118
Alert box

cell matching 191
cell protection 2 74

Alert box (continued)
circular reference 181
column sorting 200
Database text, pasting over 323
document saving 18, 27
field name nonexistent 104
field overlapping 106
file not found 14
function syntax error 179
margin indentation conflict 24, 59
memory insufficiency 314
merging documents 70
record matching 124, 147
searching 75, 76

Align Center command 205, 270
Align Left command 205, 270
Align Right command 205, 270
Alignment

cells 205, 270
center See Centering
entry 152
labels 205
left See Left alignment
numbers 205
paragraphs 78
right See Right alignment

All Cells command 165, 265
Alphanumeric character searching 74, 75
Ampersand (&) printing 24
And function 236, 238, 352
Answer Phone command 292, 304
Apple LaserWriter printer See LaserWriter

printer
Apple menu commands 16
AppleWorks, importing files from 348-351
Arccosine

defined 238
function See ACos function

Arcsine
defined 239
function See ASin function



364 Index

Arctangent
defined 2 39
function See ATan function ; ATan2 function

Argument See Function
Arithmetic operator

defined 177
entry into Spreadsheet formula 177
performance order 178

ASCII file defined 343
ASin function 236, 239
Asterisk (* ), multiplication operator 151,

177, 178
ATan function 236, 239
ATan2 function 236, 239
Athens command 81
Automatic Calculation command 185, 273
Average function 235, 240

&B formatting command 24
Backspace key

blank line deleting 42-43
cell content editing 167
character deleting 42, 114
paragraph joining 43
phone number deleting 289
placeholder deleting 332
selection deleting 44, 115

Bar chart
defined 215
labels 221
use suggestions 216

Baud rate See Communications
Bit defined 286
Blank cell See Cell
Blank line

deleting 42-43
inserting 38

Bold command 81, 206, 271, 360
Bold Field Data command 99, 149
Bold Field Name command 99, 149
Bold style

cells 206
entries 99-100, 149, 152
field names 99-100, 149
footers 2 3
formatting command 24
headers 23

Border Field Data command 99, 149
Border Field Name command 99, 149

active cell See Active cell
addition 171-172
alignment 205, 270
blank cell

argument value 233
label overflow 168
sorting 199

constant value entry 165-166
content changing 184
copying 192-197
defined 162
editing 167
empty cell See herein blank cell
entering information 165-169
filling 196-197
finding 189-192, 266-267
format defined 169, 203
formula See herein Spreadsheet formula
label entry 168
last cell See Last cell
moving 197-199, 260
named cell 351
number entry 169
protection 207-208, 274
range See Cell range
reference See Reference

Boston command 81
Box drawing 65-67
Bytes free display 21

&C formatting command 24
Calculate Now command 185, 272, 360
Calculation

See also Spreadsheet formula
Excel/Works differences 352

Canceling
chart definition 225, 228, 276, 2 79
entry bar typing 167
pie chart definition 228, 279
printing 13, 360
Quit command 27
record selection rule 126-127, 147
searching 75, 76
selection 97, 142

Capitalization, search option 75, 76
Capture Text command 298, 305, 349
Caret O, exponentiation operator 151, 177, 178
Carrier defined 291
Cell



Cell (continued)
selecting

All Cells command method 165, 265
extension 165
Find Cell command method 190-191, 266
methods 165

Spreadsheet formula
entry 166, 171-172
value display 170

type style setting 205-206
value See Value

Cell indicator defined 163
Cell range

active cell moving 166
entering information 166
error value 245
filling 196-197
moving 197-199, 260
printing 211
protection 207-208, 274
reference See Reference
selecting 165

Centered command 78
Centering

cell 205, 270
entry 152
footer 23-24
header 23-24
text 78

Change Chart Name command 229, 276,
278, 282

Change Field Name command 104, 143
Change Report Title command 137, 156
Character

defined 37
deleting 42, 114
optional characters 39
sort order 264

Chart
bar chart See Bar chart
combination chart See Combination chart
copying to Word Processor 316-317
definition See Chart definition
drawing 229, 275
label drawing 316, 327-328
line chart See Line chart
name See Chart definition
overhead transparencies 213
pasted over text 316
pie chart See Pie chart

Index 365

Chart (continued)
selecting 71
series chart See Series chart
slides 213
Spreadsheet document changing 230-23 1
stack chart See Stack chart
types 213
use suggestions 213

Chart definition
canceling 225, 228, 276, 279
changing 231, 279-280
copying 231, 280-281
defined 213, 231
dialog box display 218, 227, 280
duplicating 280-281
erasing 232, 281
name

automatic 229
changing 229, 282
display 229, 276, 278

number allowed 213, 232, 2 76
pie chart See Pie chart definition
removing 232, 281
saving 277, 2 79
selecting 2 30
series chart See Series chart definition
setting up 218-224, 226-227
storing 225, 228, 231, 276, 2 79

Chart menu commands 275-281
Chicago command 81
Choose function 236, 240
Circle drawing 65-67
Circular reference

avoidance 181
defined 181

Clear command
picture text removing 328
placeholder deleting 332
selection clearing 29, 42, 44, 116
undoing 116

Clearing
defined 115
selection 29, 42, 44, 116
undoing 115

Clipboard
closing 30
contents erasing 44
copying to 28, 44, 193, 261, 318, 355-356
cutting to 28, 44, 261
defined 44



366 Index

Clipboard (continued)
display 30
editing 30
hiding 30
Macintosh applications, copying to Works 318,

355-356
memory requirements 314
moving items to/from Scrapbook 355
pasting from 29, 44, 116, 193-194, 261
picture moving 356
report totals preview 138, 155
summary document creating 138

Close box
Clipboard closing 30
document closing 8, 18
Help window closing 10, 31

Close command
Clipboard closing 30
document closing 8, 18

Colon ( : ), cell range reference symbol 173
Column

character display, maximum 207
charting See Chart
copying to Database 322-323
copying Word Processor selection to 319-320
filling 196-197, 263
heading 23, 162, 210
inserting 201, 262
key column

defined 200
row sorting 264-265

label
defined 221
freezing 187
series chart horizontal title 221

named column 351
selecting 165
series chart, number allowed 361
sorting restriction 200
transposing with row 195-196, 221, 261
width setting 207, 272

Column Width command 207, 272
Combination chart

creating 277
defined 217

Comma (, )
number, display 152, 205, 271
phone number, inserting 289, 303

Command
About MS-Works 16

Command (continued)
Absolute Cell Ref

Command-key equivalent 360
reference style changing 174-175, 176, 177,

263
Activate Window 31
Add New Field 90, 143
Align Center 205, 270
Align Left 205, 270
Align Right 205, 270
All Cells 165, 265
Answer Phone 292, 304
Apple menu commands 16
Athens 81
Automatic Calculation 185, 273
&B24
Bold 81, 206, 271, 360
Bold Field Data 99, 149
Bold Field Name 99, 149
Border Field Data 99, 149
Border Field Name 99, 149
Boston 81
&C24
Calculate Now 185, 272, 360
Capture Text 298, 305, 349
Centered 78
Change Chart Name 229, 276, 278, 282
Change Field Name 104, 143
Change Report Title 137, 156
Chart menu commands 275-281
Chicago 81
choosing from keyboard 359
Clear

picture text removing 328
placeholder deleting 332
selection clearing 29, 42, 44, 116
undoing 116

Close
Clipboard closing 30
document closing 8, 18

Column Width 207, 272
Commas 205, 271
common tasks command directory 15-31
Communications menu commands 302-310
Copy

cell content editing 167, 184
Command-key equivalent 360
copying between tools 315
copying to Clipboard 28, 44, 193, 261, 355
Database selection, copying to Spreadsheet

321



Command (continued)
Copy (continued)

entry copying 113
picture moving 327
record copying 112
Scrapbook, moving items to/from 355
selection copying 28
Spreadsheet selection, copying to Database

323
Spreadsheet selection, copying within

document 193
value pasting 194
Word Processor selection, copying to

Database/Spreadsheet 319
Word Processor selection, copying within

document 45
Copy Format 61, 79, 360
Copy Totals 138, 155
Cut

cell content editing 167, 184
chart window, restrictions 316
Command-key equivalent 360
cutting to Clipboard 28, 44, 261
Database selection cutting 115
picture moving 327
picture text removing 328
placeholder deleting 332
Scrapbook, moving items to/from 355
selection cutting 28, 42, 44, 115
Spreadsheet selection, moving between

documents 28, 260
Word Processor selection cutting 42, 44

&D24
Delete 8-9, 20-21
Delete Field 116, 144
Dial
phone number adding 288-289, 303
phone number dialing 290, 303-304
phone number removing 289

Dollar 268
Draw

Command-key equivalent 360
Draw pattern creating 65, 72
turning off 67, 72

Draw Chart 229, 275
Draw Off 67, 72
Duplicate Chart 231, 280-281
Duplicate Report 140, 154
Echo Off 291, 302
Echo On 291, 302

Command (continued)
Edit menu commands
common commands 28-29
Communications 302
Database 142-144
report window 155-156
Spreadsheet 260-265, 282
Word Processor 71-74

Eject Page 13, 26
End Text Capture 298, 305, 350
Erase Chart 232, 281
Erase Report 140, 155
&F24
File menu commands 16-27, 70
Fill Down 196, 263, 360
Fill Right 196, 263, 360
Find 46-47, 74-77, 360
Find Cell 190, 266, 360
Find Field 120, 144-145, 360
Fixed 268
Font menu commands 50, 81
Format menu commands
Database 148-152
Spreadsheet 267-272
Word Processor 77-80

formatting commands (&) 2 4
Full Window 29, 360
General 267
Geneva 81
Go To Cell

cell finding 190, 191, 266-267
Command-key equivalent 360

Go To Page # 76, 360
Hang Up 291, 304
Help 9-10, 30-31, 339
Hide Clipboard 30
Hide Ruler 56, 77-78
&124
Insert

column inserting 201, 262
Command-key equivalent 360
row inserting 201, 262

Insert Page Break 62, 79
Insert Record 110, 142, 360
Italic 81, 360
Justified 78
keyboard procedure 359
&L24
Last Cell 165, 192, 266
Left 78

Index 367
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Command (continued)
Manual Calculation 185, 272
Match Records

Command-key equivalent 360
Database document, full display 121, 145
record matching 121, 145, 333

Monaco 81
Move 28, 197-198, 260
New 5, 16, 88
New Page After Total 137, 157
New Pie Chart 227, 278-279
New Report 131, 132, 153-154
New Series Chart

chart type choosing 220
series chart, definition creating 218, 276-

278
series chart, scales titling 220
series chart, vertical scale setting 223

No Commas 205, 271
No Grid

Database grid removing 111, 149
report grid removing 137, 156
Spreadsheet grid removing 206, 275

Normal Text 81, 206, 271, 360
Not Protected 208, 274
Number of Decimals 205, 270
Open

Command-key equivalent 360
document creating 5, 17-18
file opening 4, 17
importing files 344-345, 346

Organize menu commands
Database 144-148
report window 156

Outline 81, 328
&P24
Page Setup

column heading printing 23, 210
Database restrictions 21
footer setting 12, 23-24, 63-64
header setting 12, 23-24, 63-64
LaserWriter printer differences 357-358
mailing labels creating 334
margins setting 24, 133
page setup 11-12, 21-24, 113
printing paper orientation 23, 210
printing paper size specification 12, 22
printing reduction 2 3
report setup 133
row heading printing 23, 210

Command (continued)
Paste

cell content editing 167, 184
Clipboard contents pasting 29, 44, 116,

193-194, 261
Command-key equivalent 360
Database selection, copying to Spreadsheet

321
Database selection, copying to Word

Processor 318
entry copying 113
pasting between tools 315
record copying 112
Scrapbook, moving items to/from 355
Spreadsheet selection, copying to Database

323
Spreadsheet selection, copying within

document 193-194
Spreadsheet selection, moving between

documents 28, 260
Word Processor selection, copying to

Database/Spreadsheet 320
Word Processor selection, pasting 29, 46
Word Processor selection, replacing 49

Paste Format 61, 79, 360
Paste Function 179-180, 262-263
Paste with Options 194, 195, 261
Percent 269
point size commands 81
Prepare to Merge

Command-key equivalent 360
documents merging 73, 330, 331

Print
cell range printing 211
Command-key equivalent 360
document printing 13, 2 5
LaserWriter printer differences 357-358
merge document printing 333
report printing 139
Spreadsheet document printing 210
Word Processor document printing 65

Print Merge
customized document printing 330, 333
documents merging 70
mailing labels printing 336
restrictions 2 7

Print Window 11, 13, 26, 211
Protected 208, 274
Quit 13-14, 27, 360
&R24



Command (continued)
Receive File 299, 306-307
Record Selection

Database subset creating 127-128, 156, 333
record selection rule creating 123-124,

125-127, 146-147
Remove Page Break 63, 79, 209, 274
Replace 49, 75-76, 360
Report menu commands 153-155
report window commands 155-158
Right 78
Save

Command-key equivalent 360
document saving 7, 18

Save As
Database document saving 127-128
document exporting 8, 347
document saving 6-7, 19-20
file importing 350

Scientific 269
Search menu commands 74-76
Select All

Communications document selecting 302
record selecting 142
Word Processor document selecting 41,

53, 71
Select Definition 218, 227, 230, 279-280
Select menu commands 265-267
Select Picture

chart selecting 71
Draw pattern selecting 67, 71
picture selecting 41, 71, 325-326

Select Report 138-139, 153
Send File 297, 308
Send Text 296-297, 305-306
Set Field Attributes

computed field creating 103
field attributes setting 101-102, 150-152

Set Page # 65, 80
Set Page Break 208-209, 274
Settings 288, 308-310
Shadow 81, 328
Show Active Cell 192, 267
Show All Records 124, 127, 147, 156
Show Clipboard 30
Show Field Data

mailing label display 335
merge information display 332
placeholder text display 331
record field display 74

Index 369

Command (continued)
Show Field Names 74, 332
Show Form 92, 148, 360
Show Formulas 186, 273
Show Grid

Database grid display 111, 149
report grid display 156
Spreadsheet grid display 206, 275

Show List 92, 148, 360
Show Ruler 56, 77-78
Show Values 186, 273
Small Window 29, 360
Sort

Command-key equivalent 360
record sorting 118-119, 147-148
row sorting 200, 264-265

Spacing 54, 78
Style menu commands 81-82
Subscript 81
Sum This Field 135, 136, 158
Superscript 81
&T24
Title Page 12, 65, 80
Total-1st Char Field 136-137, 157
Total on Field Change 136-137, 157
Underline
Command-key equivalent 360
type style setting 81, 206, 271

Undo
clearing undoing 115, 116
Command-key equivalent 360
command undoing 28, 39
cutting undoing 115
Delete Field command undoing 116, 144
deleting undoing 42, 115
mistakes undoing 39

undoing 28, 39
Window menu commands 29-31

Command-key equivalents 359-360
Command-Option 199
Commas command 205, 271
Commercial symbol 39
Common tasks command directory 15-31
Communications

acoustic coupler See Acoustic coupler
baud rate

defined 286, 309
setting 286, 309

bit defined 286
call answering 292, 304
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Communications (continued)
carrier defined 291
character delay 310
Command-key equivalents 359-360
computer connections

call answering 292, 304
breaking 291, 304
cable connection 286
modem See Modem
personal computers 294
responding 290
telephone connection 286-287, 290

control character transmitting 293
data size

defined 286
setting 309

dialing See Phone number
disconnection 291, 304
document See Communications document
echo

defined 291
setting 291, 302

file
defined 295
receiving 298-299, 306-307
saving 298-299
sending 296, 297, 308

handshake
defined 287, 310
setting 287, 310

hanging up 291, 304, 360
importing files 349-351
information service See Information service
line delay 310
logging off 291
modem See Modem
parity

defined 286, 310
setting 310

personal computer calling 294
phone number See Phone number
protocol 287, 307
Rotary Dial setting 310
session ending 291, 304
settings specifying 286, 288, 308-310
stop bit

defined 286
setting 310

text
capturing/saving 297-298, 305

Communications (continued)
text (continued)

defined 295, 296
sending 295-296, 305-306

Touch-Tone setting 310
transmission speed

delaying 310
setting 286, 309

use suggestions xvi
Xon/Xoff option 310

Communications document
copying to tools 324
creating 287
key equivalents 293
phone number See Phone number
printing 11
saving 294
selecting 302
settings specifying 288, 308-310

Communications menu commands 302-310
Comparison operator

defined 178
performance order 178

CompuServe 293, 304
Computed field

creating 103, 150-151
defined 102
formula entry 103-104, 150-151

Computer connections See Communications
Constant value

defined 165
editing 184
entry into cell 165-166

Control character transmitting 293
Copy command

cell content editing 167, 184
Command-key equivalent 360
copying between tools 315
copying to Clipboard 28, 44, 193, 261, 355
Database selection, copying to Spreadsheet

321
entry copying 113
picture moving 327
record copying 112
Scrapbook, moving items to/from 355
selection copying 28
Spreadsheet selection copying

to Database 323
within document 193



Copy command (continued)
value 194
Word Processor selection copying

to Database/Spreadsheet 319
within document 45

Copy Format command 61, 79, 360
Copy Totals command 138, 155
Copying

absolute reference 192, 197
between tools 314-316
cell 192-197
chart definition 231, 280-281
chart to Word Processor 316-317
column 196-197, 263
Communications document to other tools 324
Database selection

to Spreadsheet 320-322
to Word Processor 317-318

entry 112-114, 320-322
field 112, 320-322
font to Program disk 340
indentation 61, 79
justification 61, 79
line spacing 61, 79
Macintosh applications to Works 318, 355-356
memory requirements 314
paragraph formatting 61, 79
picture 316, 318, 356
printer driver to Program disk 340
Program disk xviii
record 112, 320-322
relative references 192, 197
row 196-197, 263
selection 28, 45, 193, 261, 318, 355-356
spacing 61, 79
Spreadsheet selection

to Database 322-323
to Word Processor 317
within document 193-194

System to program disk 340
tab stops 61, 79
Word Processor selection
between documents 316
to Database/Spreadsheet 319-320
within document 28, 45

Works to hard disk 341-342
Cos function 236, 240
Cosine 236, 240
Count function 235, 241
Criteria matching See Record selection rule

Customized document printing 330, 333
Cut command

cell content editing 167, 184
chart window, restrictions 316
Command-key equivalent 360
cutting to Clipboard 28, 44, 261
Database selection cutting 115
picture moving 327
picture text removing 328
placeholder deleting 332
Scrapbook, moving items to/from 355
selection cutting 28, 42, 44, 115
Spreadsheet selection, moving between

documents 28, 260
Word Processor selection cutting 42, 44

Cutting
See also Deleting
between tools 314-316
Database selection 115-116
defined 115
selection 28
undoing 115
Word Processor selection 44, 46

&D formatting command 24
Data legend

defined 221, 277
setting 221, 277

Data size See Communications
Data type, Multiplan/Excel/Works differences

351
Database
Command-key equivalents 359-360
document See Database document
formula See Database formula
importing files 344-345, 348-351
limits 361
memory capacity 362
Page Setup command restrictions 21
report See Report
use suggestions xvi

Database document
appearance 99-100
copying

to Spreadsheet 320-322
to Word Processor 317-318

creating 88-89
date format 94, 101
exporting 347-348

Index 371
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Database document (continued)
full display 121, 145
information removing 115-116
merging See Merging
planning 87-88
report definition relationship 131
saving 127-128
scrolling 87
sorting 88
subset See Record selection rule
summary document 138, 155
time format 94, 104

Database formula
conventions 103

printing 24
Date field

comparison phrases 122
format 101, 150, 152

Decimal number
entering into cell 169
places setting 152, 204-205, 270

Degrees function 236, 241
Delete command 8-9, 20-21
Delete Field command 116, 144
Deleting

blank line 42-43
character 42, 114
chart definition 232, 281
Draw pattern 72
entry 144
field

procedure 116, 144
report fields 134

field name 144
file 8-9, 20-21
page break 63, 209, 274
phone number 289
picture text 328
placeholder 332
record selection rule 127, 147
report fields 134
selection 29, 44, 115-116
tab stop 60
undoing 21, 42, 115

Delphi 293

Desk accessory 16
Dial command
phone number

adding 288-289, 303
dialing 290, 303-304
removing 289

Dialog box
moving 221, 227, 2 76
Open command 3-4
option selecting 24, 49, 289

Disk
document disk defined 340
free space display 21
initializing 6

Division operator 177, 178
Document

activating 314, 360
closing 8, 18
Communications document

See Communications document
creating 3-4, 5, 16, 17
Database document See Database document
defined xviii
display 29
exporting 8, 20, 347-348
file distinction xviii
merging See Merging
name printing 24
naming 6
partial document printing 2 5
printing 11-13, 2 5
replacing 7
saving

frequency 5, 18, 39
new name 6, 7, 19-20
same name 7, 18
text file method 8, 20

Spreadsheet document See Spreadsheet
document

summary document 138, 155
Word Processor document See Word

Processor document
Document disk defined 340
Dollar command 268
Dollar format 151, 268

entry 103-104, 150-151
symbols 151

Date
data, Multiplan/Excel/Works differences 351

Program disk See Program disk
types 339

Disk drive
external drive 340

Database, format 94, 101, 150, 152 switching 6, 9, 18, 19, 21



Dollar sign ($), absolute reference symbol 173,
175, 263

Dow Jones 293, 304
Draft printing 2 5
Draw Chart command 229, 275
Draw command

Command-key equivalent 360
Draw pattern creating 65, 72
turning off 67, 72

Draw Off command 67, 72
Draw pattern

creating 65-67, 72
deleting 72
selecting 67, 71

Drawing See Chart; Draw Pattern; Picture
Drive See Disk drive
Duplicate Chart command 231, 280-281
Duplicate Report command 140, 154

Echo
defined 291
setting 291, 302

Echo Off command 291, 302
Echo On command 291, 302
Edit menu commands
common commands 28-29
Communications 302
Database 142-144
report window commands 155-156
Spreadsheet 260-265, 282
Word Processor 71-74

Editing
cell content 167
Clipboard 30
constant value 184
entry 99
Spreadsheet formula 184

Eject Page command 13, 26
Electronic mail 295, 306
End Text Capture command 298, 305, 350
Enter key

cell, information entry 162, 166
entry inserting 94, 95

Entry
active entry 98
alignment 152
bold style setting 99-100, 149, 152
border 99, 149
content display 99

Index 373

Entry (continued)
copying 112-114, 320-322
creating 92-94
defined 92
deleting 144
display format setting 151-152
editing 99
finding 120
length 94
selecting
form window 98
list window 97-98
report window 133

Spreadsheet entry See Cell
style setting 152
types 150-151

Entry bar
cell

content display 170
information entering 162

character limitation 166
entry, content display 99
equal sign (=), formula symbol 103, 150
label display 168
text

copying 28
selecting 115

typing canceling 167
Equal sign (=)

Database formula symbol 103, 150
operator symbol 178
Spreadsheet formula entry 166, 170

Equals operator 178
Erase Chart command 232, 281
Erase Report command 140, 155
Error function 237, 241
Error value

Excel/Works differences 351
finding 245, 266
numeric value 257

European letter size 22
Excel See Microsoft Excel
Exp function 234, 241-242
Expense report form See Form
Exponentiation defined 102
Exponentiation operator 102, 151, 177, 178
Exporting Works documents 8, 20, 347-348, 351
External disk drive 340
External references 351
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&F formatting command 24, 156
False function 236, 242, 352
FALSE, numeric value 233
Field

changing types 102
computed field See Computed field
contents display 74
copying 112, 320-322
creating 89-91, 143
data See Entry
date field setting 101, 150
deleting 116, 144
description 86
duplication 360
finding 144-145
formatting 99-102, 150-152
key field 136, 157
length 361
moving
form window 105-106
list window 107-108

name See Field name
number allowed per record 361
report field

arranging fields 133-134
key field 136, 157
removing 134
subtotaling 135-136, 157
totaling 135-136, 158

selecting
list window 97
report window 133

sizing
form window 105
list window 106-107

sorting 117-119, 147-148
subtotaling 136, 157
time field setting 102, 150
totaling 135-136, 158
type setting 150-151

Field attributes
defined 100
setting 101-102, 150-152

Field data
See also Entry
defined 86

Field name
bold style setting 99-100, 149
border 99, 149
changing 104, 143

Field name (continued)
conventions 89
creating 89, 90
deleting 144
length 361
location 90
merging See Merging
record selection rule component 122

File
arrangements saving 13-14
ASCII file defined 343
Communications file See Communications
defined xviii
deleting 8-9, 20-21
document distinction xviii
exporting 8, 20, 347-348
importing See Importing files
listing 5, 17
opening 3-5, 17-18
sample file

copying to hard disk 342
moving 339

text file defined 8, 343
type specification 5, 17

File menu
commands 16-27, 70
Undo command ineffective 28

Filename conventions 6
Fill Down command 196, 263, 360
Fill Right command 196, 263, 360
Filling

defined 196
procedure 196-197

Financial functions 237
Find Cell command 190, 266, 360
Find command 46-47, 74-77, 360
Find Field command 120, 144-145, 360
Finding See Searching
Fixed command 268
Font

availability 340
changing 50, 51
copying to Program disk 340
defined 50
footer, setting 23-24, 64
header, setting 23-24, 64
LaserWriter printer fonts 81, 357
listing 50
mailing labels 335
optional characters 39



Font (continued)
placeholder, changing 332
removing from disk 81
setting 81
type size See Type size
type style See Type style

Font menu commands 50, 81
Font Mover program 50, 81
Footer

defined 63
exclusion from first page 12, 65, 80
font setting 23-24, 64
formatting commands 23-24
setting 12, 23-24, 63-65

Foreign letter 39
Form 337-338
Form letter 336-337
Form window

display 92, 148
entry

inserting 95
selecting 98-99

field
creating 90, 91, 143
moving 105-106
sizing 105
sorting 117

information copying 112
List window, switching to 92, 148
record

appearance changing 99-100
inserting 110-111, 142
matching 145
sorting 117

report window, changing to 139
Format defined 5 3
Format menu commands

Database 148-152
Spreadsheet 267-272
Word Processor 77-80

Formatting
cell

defined 169
value display 203

copying 61, 79
decimal places 152, 169, 204-205, 268, 270
defined 5 3
dollars 151, 268
fields 99-102, 150-152
footer 23-24

Index 375

Formatting (continued)
General format 204, 267
header 23-24
integration document 324
number format 204-205
paragraph

copying 79
ruler, display 77

percentages 269
records 99-100
scientific notation 169, 269
Word Processor document 53, 62-65

Formatting commands 23-24
Formula See Database formula ; Spreadsheet

formula
Freezing row/column labels 187
Full duplex 291
Full Window command 29, 360
Function

See also specific function
argument

defined 178, 179
function component 179
largest number 248
logical value 233
multiple arguments 179
notation conventions 234
number of 233
numeric value 233
reference inserting 179
sample standard deviation 255-256
smallest number 248
sum 255, 256
types 179, 233
variance 257

availability 352-354
defined 178
directory 238-258
financial functions 237
inserting into formula 179-181, 262-263
listing 262
logical functions 236-237
mathematical functions 234-235
Multiplan/Excel/Works differences 352-354
parentheses 179
parts 179
result

logical value 233-234
numeric value 233

special-purpose functions 237
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Function (continued)
statistical functions 235
syntax 179
trigonometric functions 2 36

FV function 237, 242, 251-253

General command 267
General format 204, 267
Geneva command 81
Go To Cell command

cell finding 190, 191, 266-267
Command-key equivalent 360

Go To Page # command 76, 360
Graphics See Chart ; Draw Pattern ; Picture
Greater than operator 178
Greater than or equal to operator 178
Grid

Database document 111, 149
report 137, 156
series chart 223
Spreadsheet document 206, 275

Half duplex 291
Handshake See Communications
Hang Up command 291, 304
Hanging indentation

defined 5 7
setting 58

Hard disk 340-342
Hayes modem

call answering 292, 304
dialing 290, 303
phone number, commas, hyphens 289, 303

Header
defined 63
exclusion from first page 12, 65, 80
font setting 23-24, 64
formatting commands 23-24
setting 12, 23-24, 63-65

Help command 9-10, 30-31, 339
Help file, moving to another disk 339
Help window 9-10, 30-31
Hide Clipboard command 30
Hide Ruler command 56, 77-78
Highlight reversal 40
HLookup function 237, 242-243, 352
Horizontal title

defined 221, 277

Horizontal title (continued)
setting 221, 277

Hyphen (- ), in phone numbers 289, 303

&I formatting command 24
If function 236, 243
ImageWriter printer

mailing labels printing 333
printing reduction 210, 357
setting up 11

ImageWriter printer driver 22
Importing files

III E-Z Pieces 348-351
AppleWorks 348-351
Database files 344-345, 348-351
MacWrite 343-344
Microsoft Excel 346-347, 351-354
Microsoft File 344-345
Microsoft Multiplan 346-347, 351-354
Microsoft Word 343-344
Spreadsheet files 345-347, 351-354
SYLK files 351
Word Processor files 343-344

Indentation
copying 61, 79
entire paragraph 58
first line 57
hanging indentation

defined 5 7
setting 58

margin
conflict 24, 59
distinction 59

options 56
ruler, display 77

Index function 237, 243, 352
Information service 293
Initializing disks 6
Insert command

column inserting 201, 262
Command-key equivalent 360
row inserting 201, 262

Insert Page Break command 62, 79
Insert Record command 110, 142, 360
Inserting

addition operator 171, 173, 177, 263
blank line 38
column 201, 262
function into formula 179-181, 262-263



Inserting (continued)
page break

Spreadsheet document 208-209, 274
Word Processor document 62-63, 79

phone number 288-289
picture text 327-328
placeholder 73, 330, 331
record 110-111, 142
return character 37
row 201, 262
text 39

Int function 235, 244

procedure 314-316
Spreadsheet to Database 322-323
Spreadsheet to Word Processor 316-317
Word Processor to Database/Spreadsheet

318-320
Word Processor to Word Processor 316

document
formatting 324
picture editing 325-328

use suggestions xvi-xvii, 311
Internal rate of return

defined 244
function See IRR function ; MIRR function

International Fanfold 22
Investment functions See Financial functions
Invoice form See Form
IRR function 237, 244
IsBlank function 236, 244
IsError function 236, 245, 352
IsNA function 236, 245
Italic command 81, 360
Italic style 23, 24

Justification
copying 61, 79
fully justified defined 54
setting 54-55, 78

Justified command 78

active entry moving 98
cell, entering information 166
entry inserting 94, 95
paragraph starting 37
return character entry 37
Shift-key combination See Shift-Return

Shift 165
Shift-Enter 62
Shift-Return

cell, entering information 166
entry inserting 94, 95

Shift-Tab
cell, entering information 166
entry inserting 94, 95

spacebar, blank cell display 168
Tab

active entry moving 98
cell, entering information 166
dialog box, option selecting 24, 49, 289
entry inserting 94, 95
Shift-key combination See Shift-Tab
tab stop, moving to 59, 60

Key column
defined 200
row sorting 264-265

Key field 136, 157
Keyboard, command choosing 359

&L formatting command 24

Index 377

Key
Backspace

cell content editing 167
character deleting 42, 114
paragraph joining 43
phone number deleting 289
placeholder deleting 332
selection deleting 44, 115

Command-key equivalents 359-360
Command-Option 199
Communications document, equivalents 293
Enter

Integer, entering into cell 169
Integration

copying information
Communications 324
Database to Spreadsheet 320-322
Database to Word Processor 317-318

cell, entering information 162, 166
entry inserting 94, 95
Shift-key combination See Shift-Enter

Option
control character transmitting 293
Database selection copying 318, 320

Macintosh applications to Word Processor
318

Option-key equivalents 293
Return
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Label
alignment 205
calculation value 168
defined 163
display 168, 207, 223
entry 167-168
length 167, 207
picture 71, 327-328
purpose 223
use suggestions 167

LaserWriter printer 23, 81, 357-358
Last cell

defined 165, 192, 265
selecting 165, 192, 266

Last Cell command 165, 192, 266
Left alignment

cells 205, 270
entry 152
footer 24
header 24
labels 205
paragraphs 78

Left command 78
Less than operator 178
Less than or equal to operator 178
Letter See Form letter
Line

blank line
deleting 42-43
inserting 38

break 37
selecting 40
spacing

copying 61, 79
setting 78

Line chart
creating 277
defined 215
labels 221
point marker 215
purpose 277
use suggestions 216

Line drawing 65-67
Linking 351
List window

copying to Spreadsheet document 320-321
copying to Word Processor document 318
display 92, 148
entry

inserting 94

List window (continued)
entry (continued)

selecting 97-99
field

creating 90-91, 148
moving 107-108
selecting 97
sizing 106-107
sorting 117

Form window, switching to 92, 148
grid setting 111
information copying 112
panes

closing 110
creating 108-110

record
inserting 110, 142
matching 145
selecting 97, 142
sorting 117

report window, changing to 139
splitting 108-110

Ln function 235, 245
Log off, Communications 291
Log 10 function 235, 246
Logarithm See Log 10 function ; Natural

logarithm; Semi-logarithmic
Logical functions 236-237
Logical value 233, 234, 352
Lookup function 237, 246, 352

MacBinary format 307
MacDraw

copying pictures to Word Processor 318, 356
form creating 337

Macintosh applications
copying to Works 318, 355-356
exporting documents to 8, 20, 347-348
importing files See Importing files

Macintosh Plus limits 361-362
MacPaint

copying pictures to Word Processor 318, 356
form creating 337

MacWrite file, importing to Works 343-344
Mail, electronic 295, 306
Mailing labels 333-336
Mailing sorting 118
Manual Calculation command 185, 272
Manual description xvii-xviii



Margin
indentation

conflict 24, 59
distinction 59

mailing labels 335
report 133, 134
setting 24

Master Program disk xviii
Match function 237, 247, 352
Match Records command

Command-key equivalent 360
Database document, full display 121, 145
record matching 121, 145, 333

Matching See Searching
Mathematical functions 234-235
Mathematical symbol 39
Max function 235, 248
Memory

availability display 16, 21
copying, requirements 314
Database, capacity 362
Spreadsheet, capacity 362
Word Processor, capacity 362

Merge document
creating 329-331
description 329
example 330
form 337-338
form letter 336
mailing labels 334-335
printing 70, 333

Merging
Database document selecting 73
documents See Merge document
field name selecting 73
form 337-338
form letters 336
information display 332
placeholder See Placeholder
preparing to merge 73
use suggestions 329, 336

Microsoft Excel
exporting documents to 347-348
functions 352-354
importing files to Works 346-347, 351-354
Works differences 351-354

Microsoft File, importing files to Works 344-345
Microsoft Multiplan

exporting documents to 347-348
functions 352-354
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Microsoft Multiplan (continued)
importing files to Works 346-347, 351-354
Works differences 351-354

Microsoft Word, importing files to Works 343-
344

Microsoft Works
copying other Macintosh applications to 318,

355-356
disk types 339
exporting documents 8, 20, 347-348, 351
hard disk 340-342
importing files See Importing files
information display 16
Multiplan/Excel differences 351-354
quitting 13-14, 27
startup with other system disk 339
Switcher use 356

Min function 235, 248
Minus sign (- )

negation operator symbol 151, 177
subtraction operator symbol 151, 177

MIRR function 237, 248-249
Misspelled words, finding 47
Mixed reference

defined 176
entry 177
reversing 177, 263

Mod function 235, 249
Modem

call answering 292, 304
connection port 310
defined 285-286
dialing 290, 303
dialing codes 303
disconnection 304
Hayes modem See Hayes modem
phone number dialing 290, 303
phone type setting 310
Rotary Dial phone 310
setting 308-310
Touch-Tone phone 310

Modulator-demodulator See Modem
Monaco command 81
Move command 28, 197-198, 260
Moving

cell 28, 197-199, 260
dialog box 221, 227, 2 76
field
form window 105-106
list window 107-108
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Moving (continued)
Help file to another disk 339
picture 327, 356
sample files 339
tab stop 60

Multiplan See Microsoft Multiplan
Multiplication operator 177, 178

NA function 237, 249
N/A value

finding 266
function See NA function
Multiplan/Excel/Works differences 352

Named cell 351
Naming document 6-7
Natural logarithm

e, value 241, 245
Exp function inverse 241, 245
function See Ln function

Negation operator 151, 177, 178
Net present value See NPV function
New command 5, 16, 88
New Page After Total command 137, 157
New Pie Chart command 227, 278-279
New Report command 131, 132, 153-154
New Series Chart command

chart type choosing 220
series chart

definition creating 218, 276
scales titling 220
vertical scale setting 223

No Commas command 205, 271
No Grid command

Database grid removing 111, 149
report grid removing 137, 156
Spreadsheet grid removing 206, 275

Normal Text command 81, 206, 271, 360
Not equal operator 178
Not function 236, 250, 352
Not Protected command 208, 274
NPer function 237, 250, 251
NPV function 237, 250
Number

absolute value 234, 238
alignment 205
average 240
comma display 152, 205, 271
Database document numbers totaling See

Report

Number (continued)
decimal places

entry into cell 169
setting 152, 204-205, 270

degree to radian conversion 236, 253
entering into cell 169
exponents 102, 151, 177, 178
format 204-205, 351
label, beginning with 168
length, display in cell 169, 207
negative number enclosure 151, 268
radian to degree conversion 236, 241
random number 235, 253
remainder 235, 249
rounding off 235, 254
sign 235, 254
sort order 264
Spreadsheet document, entry 169
square root 235, 255

Number of Decimals command 205, 270
Number sign (#) 169, 207
Numeric field

comparison phrase 122
display format 151-15 2
setting 150
totaling 135-136, 158

Numeric value 351

Open command
Command-key equivalent 360
document creating 5, 17-18
file opening 4, 17
importing files 344-345, 346

Open dialog box 3-4
Operator

defined 177
Multiplan/Excel/Works differences 351
performance order 178
types 177-178

Option key
Command-key combination See Command-

Option
control character transmitting 293
Database selection copying 318, 320

Option-key equivalents 293
Optional character 39
Or function 237, 250-251, 352
Organize menu commands

Database 144-148



Organize menu commands (continued)

report window 156

Outline command 81, 328

Overhead transparencies 213

&P formatting command 24

Page

scrolling to 76

setup 11-12, 21-24

Page break

Spreadsheet document 208-209, 274

Word Processor document 39, 62-63, 79

Page break indicator defined 39, 208

Page number

consecutive 64-65, 80

display 39

printing in header/footer 24

setting 64-65, 80

Page range printing 2 5

Page Setup command

column heading printing 23, 210

Database restrictions 21

footer setting 12, 23-24, 63-64

header setting 12, 23-24, 63-64

LaserWriter printer differences 357-358

mailing labels creating 334

margins setting 24, 133

page setup 11-12, 21-24, 113

printing paper
orientation 23, 210

size specification 12, 22

printing reduction 2 3
report setup 133

row heading printing 23, 210

Panes See List window; Spreadsheet window

Paper See Printing

Paragraph

alignment 78

end symbol 37

formatting

copying 79

ruler, display 77

indenting See Indentation

joining 43
selecting 40

Parentheses (( ) )

function component 179

negative number enclosure 151, 268

operator grouping 151, 178

Index 381

Parity See Communications

Paste command

cell content editing 167, 184

Clipboard contents pasting 29, 44, 116, 193-

194, 261

Command-key equivalent 360

Database selection, copying

to Spreadsheet 321

to Word Processor 318

entry copying 113

pasting between tools 315
record copying 112

Scrapbook, moving items to/from 355

Spreadsheet selection

copying to Database 323

copying within document 193-194

moving within document 28, 260

Word Processor selection

copying to Database/Spreadsheet 320

pasting 29, 46
replacing 49

Paste Format command 61, 79, 360

Paste Function command 179-180, 262-263

Paste with Options command 194, 195, 261

Pasting

chart into Word Processor 316-317

Clipboard contents 29, 116, 193-194, 261

function into Spreadsheet formula 179-180

memory requirements 314

Spreadsheet selection 29, 193-194, 261

Word Processor selection 29, 45-46

Pattern matching See Match Records command ;
Searching

Payroll subtotals 136

Percent command 269

Percent sign (%) 152, 269

Personal computer calling See Communications

Phone number

adding to phone book 288-289, 303

changing 289

commas, hyphens 289, 303

dialing 290, 303

length 289

number allowed 288, 303

removing 289

Pi function 235, 251

Picture

See also Chart; Draw Pattern

copying 316, 318, 356

defined 41, 325
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Picture (continued)
editing 325-328
labeling 71, 327-328
moving 327, 356
selecting 40, 41, 71, 325-326
sizing 326, 356
text 327-328

Pie chart
copying to Word Processor 316-317
creating 226-227, 278-279
defined 213
definition See Pie chart definition
drawing 229, 275
label drawing 316, 327-328
overhead transparencies 213
plotting 228, 279
rows, number allowed 361
selecting 71
slides 213
Spreadsheet document changing 230-231
title 227, 2 79
use suggestions 225
value titles 226, 279

Pie chart definition
canceling 228, 279
changing 231, 279-280
copying 231
creating 226-227, 278-279
dialog box display 227, 280
duplicating 280
name

automatic 229
changing 229, 282
display 229, 278

number allowed 213, 232
removing 232, 281
saving 279
selecting 230
setting up 226-227, 278-279
storing 228, 231, 279

Placeholder
defined 73, 329
deleting 332
display 74, 332
font changing 332
inserting 73, 330, 331
mailing labels 335
messages 332
wordwrap 331

Plotting
pie chart 228, 279
series chart 224, 276

Plus sign (+), addition operator symbol 151,
177

Pmt function 237, 251
Point marker defined 215
Point size commands 81
Prepare to Merge command

Command-key equivalent 360
documents merging 73, 330, 331

Preprinted forms 338
Print command

cell range printing 211
Command-key equivalent 360
document printing 13, 25
LaserWriter printer differences 357-358
merge document printing 333
report printing 139
Spreadsheet document printing 210
Word Processor document printing 65

Print Merge command
customized document printing 330, 333
documents merging 70
mailing labels printing 336
restrictions 27

Print Window command 11, 13, 26, 211
Printer driver 340
Printer message 139
Printing

active window 13, 26, 211
ampersand (&) 24
canceling 13, 360
cell range 211
column heading 23, 210
Communications document 11
customized document 330, 333
date 24
document 11-13, 2 5
document name 24
drafts 2 5
horizontally 23, 210
mailing labels 336
merge document 70, 333
number of copies 2 5
orientation See herein paper
page number 24
page range 2 5
paper

feed 25



Printing (continued)
paper (continued)

height 2 3
message 139
options 22-23
orientation 23, 210
size, LaserWriter printer restrictions
size, specification 12, 22, 23, 133
starting on new sheet 13, 26
width 2 3

partial document 2 5
preset options 13
quality 2 5
reduction 23, 210, 357
report

new page after subtotal 137, 157
orientation setting 133
procedure 138-139

resolution 25
row heading 23, 210
smoothing 358
Spreadsheet document 23, 208-211
Spreadsheet formula 273
time 24
value, formatted 273
window 13, 26, 211

Product Support xviii
Program disk

contents 339
copying xviii
hard disk installation 340-342
master disk xviii, 339, 342

Protected command 208, 274
Protecting cells 207-208, 274
Protocol

defined 287
options 307

PV function 237, 251-253

Quit command 13-14, 27, 360
Quitting Works 13-14, 27
Quotation mark ("), label symbol 168

&R formatting command 24
Radians function 236, 253
Rand function 235, 253
Rate function 237, 251-253
Receive File command 299, 306-307

Index 383

Record
appearance changing 99-100
contents 86
copying 112, 320-322
criteria matching See Record selection rule

146-147
Record selection rule

canceling 126-127, 147
changing 127, 147
comparison phrase

defined 122
list 122
range setting 125-126
scrolling 146

complex rules 124-126
components 122
connectors 124-126, 146
creating 123-126, 146-147
Database subset creating 127-128, 156, 333
deleting 127, 147
description 122
linking 124-126, 146
number allowed 147
report definition creating 131, 132-133, 154
simple rules 123-124

Reference
absolute reference See Absolute reference
cell range 173-174
cell reference defined 162
circular See Circular reference
column inserting, adjustment 201
description 172
inserting into argument 179
inserting into Spreadsheet formula 173-174
mixing See Mixed reference
moving cells, adjustment 197
relative reference See Relative reference

display 124, 127, 147, 156
23, 357 formatting 99-100

indicator defined 97
inserting 110-111, 142
matching 120-121, 145
number allowed per Database document 362
selected records saving 20
selecting 97, 133, 142
sorting 117-119, 147-148, 333

Record indicator defined 97
Record Selection command

Database subset creating 127-128, 156, 333
record selection rule creating 123-124, 126,



numbers totaling 135-136, 157
paper size setting 133
previously defined report selecting 139, 153
printing

new page after subtotal 137, 157
orientation setting 133
procedure 138-139

revisions 139
selecting 139, 153

header 24
numbers 205
paragraphs 78

Right command 78
Risk defined 248
Rotary Dial phone 310
Round function 235, 254
Row

charting See Chart
copying 196-197, 263

384 Index

Reference (continued)
row inserting, adjustment 201
style changing 174-176, 263

Relative reference
cell moving 199, 260
changing to absolute reference 174-175, 263
column copying, adjustment 263
copying 192, 197
defined 172
row copying, adjustment 263
sorting, adjustment 200

Report (continued)
subtotals
preview 138, 155
printing 137, 157
procedure 136, 157

summary document 138
title changing 137, 156
totals

preview 138, 155
procedure 135, 158
use suggestions 135

Report menu commands 153-155
Report window

closing 137, 154
commands 155-158
edge markers 133
entry selecting 133

Remainder function See Mod function
Remove Page Break command 63, 79, 209, 274
Replace command 49, 75-76, 360
Replacing
document 7
text 48-50, 75-76, 115

Report
defined 129

field selecting 133
opening 132, 138-139, 153

definition
changing 140
components 131
creating 132-133, 153-154

record
display 156
selecting 133

report printing 138-139
Database document relationship 131
defined 129, 132
duplicating 140, 154
erasing 140, 155
number allowed 132, 140

switching to list/form windows 139
Resolution defined 2 5
Resume Works file 4, 13, 14, 27
Return character

copying selection to Database document 319
repeated use 139
saving 137
storing 137

example 130
field

arranging 133
key field 136, 157
removing 134
subtotaling See herein subtotals
totaling See herein totals

entry 37
Return key

active entry moving 98
cell, entering information 166
entry inserting 94, 95
paragraph starting 3 7
return character entry 37
Shift-key combination See Shift-Return

Right alignment
cells 205, 270

grid 137, 156 entry 152
margins 133, 134 footer 24



Row (continued)
copying to Database document 322-323
copying Word Processor selection to 319-320
filling 196
heading 23, 162, 210
inserting 201, 262
label

chart data legend 221
defined 221
freezing 187

named row 351
pie chart, number allowed 361
selecting 165, 272
sorting 199-200, 264-265
transposing with column 195-196, 261

Ruler 56, 59, 77-78, 335

Safe defined 248
Sample file

copying to hard disk 342
moving 339

Sample standard deviation
defined 256
function See StDev function

Sample variance
defined 258
function See VAR function

SANE package 352
Save As command

Database document saving 127-128
document exporting 8, 347
document saving 6-7, 19-20
file importing 350

Save command
Command-key equivalent 360
document saving 7, 18

Saving
chart definition 277, 279
Communications
document 294
file 298-299
settings 309
text 298, 305

Database document 127-128
document

frequency 5, 18, 39
new name 6, 7, 19-20
same name 7, 18
text file method 8, 20

Index 385

Saving (continued)
external disk drive, saving to 340
file arrangements 14
report definition 137
selected records 20

Scientific command 269
Scientific notation
Database document 152
Spreadsheet document 169, 269

Scientific symbol 39
Scrapbook 318, 355-356
Scroll bars 87
Scrolling

Database document 87
list window panes 108
page number display 39
record selection rule comparison phrase 146
Spreadsheet window panes 187
Word Processor document 76

Search menu commands 74-76
Searching

criteria matching See Record selection rule
Database document

entries 120, 144-145
fields 120, 144-145

record selection rule See Record
selection rule

replacing See Replacing
Spreadsheet document

active cell 192, 267
cells 189-192, 266-267
error value 245, 266
last cell 165, 192, 266
N/A value 266

Word Processor document
alphanumeric character 74, 75
canceling 74, 75
capitalization option 47, 75, 76
misspelled word 47
text 46-47, 74-76
whole word option 46, 74, 75

Select All command
Communications document selecting 302
record selecting 142
Word Processor document selecting 41,

53, 71
Select Definition command 218, 227, 230, 279-

280
Select menu commands 265-267



386 Index

Select Picture command
chart selecting 71
Draw pattern selecting 67, 71
picture selecting 41, 71, 325-326

Select Report command 138-139, 153
Selecting

cell
All Cells command method 165, 265
extension 165
Find Cell command method 190-191, 266
methods 165

cell range 165
chart 71
chart definition 230
column 165
Communications document 302
Database document

entry bar text 115
merge document 73

dialog box option 24, 49, 289
dragging method 41
Draw pattern 67, 71
entry
form window 98
list window 97-98
report window 133

field
list window 97
report window 133

field names for merging 73
last cell 165, 192, 266
line 40
paragraph 40
picture 40, 41, 71, 325-326
record 97, 133, 142
report 139, 153
Resume Works file 13
row 165, 272
Word Processor document

entire document 41, 53, 71
text 40-41

Selection
alignment 78, 270
canceling 97, 142
changing 41-42
clearing 29, 44, 116
copying 28, 45, 193, 318, 355-356
cutting 44, 115-116
deleting 29, 44, 115-116
display 40

Selection (continued)
extending 41-42
named selection 351
pasting 29, 45-46, 261
reducing 41-42

Selection rule See Record selection rule
Semi-logarithmic scale 222, 278
Send File command 297, 308
Send Text command 296-297, 305-306
Series chart

bar chart See Bar chart
column

number allowed 361
specifying 221

combination chart See Combination chart
copying to Word Processor document 316-

317
creating 218-224
data legends 221, 277
defined 213
definition See Series chart definition
drawing 229, 275
grid 223
horizontal scale title 220, 277
horizontal title 221, 277
information

amount allowed 220
specifying 221

label
display 224
drawing 316, 327-328

line chart See Line chart
numeric scale 222-223, 278
overhead transparencies 213
plotting 224, 276
row specifying 221
scale 222-223, 277-278
selecting 71
semi-logarithmic scale 222, 278
slides 213
Spreadsheet document changing 230-231
stack chart See Stack chart
transposing columns/rows 221
types 214, 220
vertical scale 222-223, 277-278

Series chart definition
canceling 225, 276
changing 231, 279-280
copying 231
creating 218-224, 276-278



Series chart definition (continued)

dialog box display 218, 280

duplicating 280

name

automatic 229

changing 229, 282

display 229, 276

number allowed 213, 232, 2 76

removing 232, 281

saving 277

selecting 230

setting up 218-224, 276-278

storing 225, 231, 2 76

Set Field Attributes command

computed field creating 103

field attributes setting 101-102, 150-152

Set Page # command 65, 80

Set Page Break command 208-209, 274

Settings command 288, 308-310

Shadow command 81, 328

Shift-Enter 62

Shift key, cell selection extending 165

Shift-Return

cell, entering information 166

entry inserting 94, 95

Shift-Tab

cell, entering information 166

entry inserting 94, 95

Show Active Cell command 192, 267

Show All Records command 124, 127, 147, 156

Show Clipboard command 30

Show Field Data command

mailing label display 335

merge information display 332

placeholder text display 331
record field display 74

Show Field Names command 74, 332

Show Form command 92, 148, 360

Show Formulas command 186, 273

Show Grid command

Database grid display 111, 149

report grid display 156

Spreadsheet grid display 206, 275

Show List command 92, 148, 360

Show Ruler command 56, 77-78

Show Values command 186, 273

Sign function 235, 254

Sin function 236, 254

Sine 236, 254

Size box 29

Index 387

Slash (I), division operator symbol 151, 177

Slides 213

Small Window command 29, 360

Smoothing 358

Sort command

Command-key equivalent 360

record sorting 118-119, 147-148

row sorting 200, 264-265

Sorting

address list 117-118

alphabetical order 118

ascending order 199, 264

blank cell 199

chronological order 118

column restriction 200

Database document 88, 117-119, 147-148,

333

descending order 199, 264

fields 117-119, 147-148

key column 200, 264-265

mailing 118

multi-level sorting 117-118

numeric order 118

options 118

order 264

records 117-119, 147-148, 333

reference adjustment 200

row 199-200, 264-265

Spreadsheet document 199-200, 264-265

Source, The 293, 304

Spacebar, blank cell display 168

Spacing

copying 61, 79

setting 53-54, 78

Spacing command 54, 78

Special-Purpose functions 237

Split bars 103, 187

Spreadsheet

calculation 185, 272-273

Command-key equivalents 359-360

document See Spreadsheet document

functions See Function

importing files See Importing files

limits 361-362

memory capacity 362

MultiplanlExcel/Works differences 351-354

Paste command properties 29

use suggestions xvi

Spreadsheet document

calculation 185, 272-273



388 Index

Spreadsheet document (continued)
cell See Cell
changes, effect on chart 2 30
charting See Chart
column See Column
copying

to Database document 322-323
to Word Processor document 317
within document 193-194

designing 163
entry editing 167
exporting 347-348, 351
filled cell, number allowed 362
grid 206, 275
moving in 166
page break 208-209, 274
parts 162-163
planning 163
printing 23, 208-211
row See Row
selection copying 193-194
sorting 199-200, 264-265

Spreadsheet formula
arithmetic operator entry 177
calculation 185, 272-273
circular reference 181
defined 170
display 186, 273
editing 184
entry into cell 166, 171-172
example 170
function entry 179-181, 262-263
length 361
pasting 261
printing 273
reference entry 173-174
value display 170, 186, 273

Spreadsheet window
activating 230
example 162
panes 187-189
splitting 187-189

Sgrt function 235, 255
Square root 235, 255
SSum function 235, 255
Stack chart

creating 277
defined 216
purpose 277

Standard Apple Numeric Environment
package 352

Starting Works with other system disk 339
Statement form See Form
Statistical functions 235
StDev function 235, 255-256
Stop bit See Communications
Style menu commands 81-82
Subscript command 81
Subtraction operator 177, 178
Sum function 235, 245, 256
Sum This Field command 135, 136, 158
Summary document 138, 155
Superscript command 81
Switcher 356
SYLK file

Database restriction 345
defined 346
importing files 346-347, 351
Word Processor restriction 344

Symbol
fonts 39
Spreadsheet labeling 168

System 340

&T formatting command 24
Tab character

copying selection to field 319
Tab key

active entry moving 98
cell, entering information 166
dialog box option selecting 24, 49, 289
entry inserting 94, 95
Shift-key combination See Shift-Tab
tab stop, moving to 59, 60

Tab stop
copying 61, 79
defined 59
deleting 60
display 59, 77-78
moving 60
moving to 59, 60
setting 59-60, 77-78
table creating 61

Table creating 61
Tan function 236, 256
Tangent 236, 256
Telephone See Communications
Text

argument value 233
capturing See Communications



Text (continued)
centering 78
clearing 29, 44, 116
Communications text See Communications
copying 28, 45, 193, 318, 355-356
cutting 44, 115-116
deleting 29, 42-44, 115-116
finding 46-47, 74-75
inserting 39
justifying 78
left alignment 78
pasting 29, 45-46
picture text 327-328
replacing 48-50, 75-76, 115
right alignment 78
selecting 40-42
sort order 264
typing 37

Text field
comparison phrase 122
creating 150
searching 144-145
zip codes 118

Text file
defined 8, 343
exporting 20, 347-348
importing to Works 343-347

Time
data, Multiplan/Excel/Works differences 351
Database, format 94, 102, 150
printing 24

Time field
comparison phrases 122
format 94, 102, 150

Title
chart 327-328
pie chart 227, 279
report, changing 137, 156
series chart 220, 277

Title bar
chart definition name display 229, 276
pie chart definition display 278

Title page 12, 65, 80
Title Page command 12, 65, 80
Tools

See also Communications; Database ;
Spreadsheet; Word Processor

copying between 314-316
cutting between 314-316

Total-1st Char Field command 136-137, 157

Total on Field Change command 136-137, 157
Touch-Tone phone 310
Transposing rows and columns 195, 221, 261
Trigonometric functions 236
True function 237, 257, 352
TRUE, numeric value 233
Type function 237, 257, 352
Type size

changing 50-51
footer, setting 64
header, setting 64
mailing labels 335
placeholder, changing 332
setting 81-82

Type style
cell, setting 205-206
changing 50-51
footer, setting 64
header, setting 64
mailing labels 335
placeholder, changing 332
setting 81-82

Typing
mistake correction 114-115
text 37

Underline
cells 206, 271
entry 152

Underline command
Command-key equivalent 360
type style setting 81, 206, 271

Undo command
clearing undoing 115, 116
Command-key equivalent 360
command undoing 28, 39
cutting undoing 115
Delete Field command undoing 116, 144
deleting undoing 42, 115
mistakes undoing 39

US legal size 2 2
US letter size 2 2

Value
constant value See Constant value
decimal places, fixed 268
defined 203
display 186, 190, 203, 273

Index 389
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Value (continued)

	

Works See Microsoft Works
pasting 29, 194, 261

	

Works Hard Disk Install program 340-341
printing 273
style setting 271

Value title defined 226

	

Xmodem Data 307
Var function 235, 257-258

	

Xmodem Text 307
Variance 235

	

Xon/Xoff option 310
Vertical scroll box 39
VLookup function 237, 242-243, 352

Zip code, text field use 118

Window
activating 31, 360
form window See Form window
list window See List window
number allowed on desktop 3, 16, 17, 314
panes See List window
printing 13, 26, 211
report window See Report window
sizing 29

Window menu commands 29-31
Word Processor

Command-key equivalents 359-360
importing files 343-344
memory capacity 362
use suggestions xvi

Word Processor document
chart pasted over text 316
copying
between documents 316
to Database/Spreadsheet 319-320

creating 36
drawing See Draw pattern
example 36
exporting 347-348
format

defined 5 3
procedure 62-65

merging with Database document 73
number of pages 362
page breaks 39, 62-63, 79
selecting 41, 53, 71
typing 3 7

Word Processor file, sending with
Communications 306

Wordwrap
defined 37
line breaking 37
placeholder 331
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